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1.1

1.2

1.3

1. Navigation

This document provides an overview of the basic template, navigation, common operations
that can be performed, and keyboard short cuts available in Oracle Financial Services
Lending and Leasing. Since this section details the general options available in the User
Interface, some or all the parts of this section are applicable to you as per access provisions
& licensing.

The document is organized into below topics:
e Logging In
e Template and Navigation

e Common Operations
e Hot Keys

Note

The application can be best viewed in 1280 x 1024 screen resolution.

Audience

This document is intended to all Prospective Users who would be working on the application.

Conventions Used

Term Refers to

The system/application Oracle Financial Services Lending and Leasing

Mnemonic The underlined character of the tab or button

Logqging In

The pre-requisites to log into the system are a valid user ID and a password, defined by the
system administrator in Administration > User screen.

You can login to the system using a valid user ID and a password defined by the system

administrator, in Administration > User screen. A User ID is disabled automatically by the
system if it is inactive for a specified number of days.
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When you invoke the application, the Sign In screen is displayed.
opacLe: B O

Financial Services Lending and Leasing

sign In
Please enter userid and passviord

*User1d

Password

e User ID — Specify a valid User ID.
e Password — Specify a valid password for the specified User ID.

The system accepts the User ID and password in upper case only. After specifying valid
credentials, click Sign In to sign into the application.

1.4 Template and Navigation

This section provides a brief input on the template and navigation of the system. Details are
grouped into two categories to enable easy understanding. These include:

e Home screen
e Screens

141 Home Screen

Once you login to the application with valid credentials, the system authenticates the details
and displays the Home screen.

The Home screen consists of the following components:

e Header
e Left Pane
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e Right Pane/Work Area

ORACLE"
Financial Services Lending and Leasing

oy I ©

 Origination
> Servicing
> Collections
 WFP

> Tools

> setup

You can view the application version details and copyright information by clicking About link
at the right corner of the screen.

be errorfree. Ifyou find any errors, please reportthem o us i wrting.

Ifihis is softvare overnment or behaf of the U.S. Government, the follwing notice s
applicable:

U.S. GOVERNMENT END USERS:
s.

abity for

acte Corporation and s
Oracle Corporation and s

Header
In the Header, system displays the following:

e User ID that you have currently logged/Signed in. Click the adjoining drop-down arrow,
the system displays the following options:

Change Password

m  UserInfo 3]

— Change Password — Click to change the current password.
=~ A B g o O]

oot
-
L v

"’il
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Specify the current password in the Current Password field and a valid password,
you wish to maintain as a new password, in the New Password field. Re-enter the
password in Confirm Password field and click Submit to change the password.

User Info — Click to view the current user info.

Oracle Financial Services Lending and Leasing ®
User Info
Organization DMC Time Zone |JSER TIME ZONE ¥
Division U301 Level
First Name VARSHA User Time Zone UNDEFINED
Last Name VAIDVA Company US/CENTRAL (CENTRAL STANDARD
) i Branch Time TIME)
Responsibility SUPERUSER S
GLPost Date 02/10/2016 Server Time  ASIA/CALCUTTA (INDIA STANDARD
Last Login Date 02/10/2016 03:21:07 AM Zone TIME)
Session Language DEFAULT v Skin Family Skyros (Default) v

Debug Enabled Ind

|_—|5 Submit | 3% Close

In this screen, apart from viewing the user info, you can also set Session Language,
enable error log, and specify the time zone preference.

Session Language — Select a language that you need to set for the session, from
the drop-down list.

Debug Enabled Ind — Check this box to enable the debug indicator.

On selection, system records all the debugs into logs files depending on the
following two types of system parameters:

System Parameter Condition to record debug data

CMN_DEBUG_METHOD If parameter value is 1, then debug data is
recorded into a file in Database Server.

If parameter value is 4, then debug data is
recorded into the table LOG_FILES HEADER.

CMN_DEBUG_LEVEL If parameter value is greater than 0, only then the
debug data is recorded.

The debug data can be viewed from Dashboard > System Monitor > Database
Server Log Files.
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You can click on := List Files button to view the list of logged files.

ORACLE’
Financial Services Lending and Leasing

DashBoard 3 System Monitor [3] Close
Batch Jobs = Jobs | Services Database Server Log Files  Parked Transactions | Users o~
Database Server Log Files
View v Format~ Freezz i Detach Wrap W) :=Svstries [ Download File
File Name File Type File Size File Time
JSVPRC_EN_000_01 DB12C_2084400 fob 5706 02/18/2016 06:14:11 A) »
ALERT lob 395 02/22/2016 03:59: 15 A_|
CSYPRC_EN_100_01_DB12C_3794335 lob 6390 02/22/2016 04:53:00 AP =
CSVPRC_EN_100_01 DB12C_3854338 lob 116750 02/22/2016 05:36:42 AP
JSYPRC_EN_000_01_DB12C_2094362 lob 5706 02/18/2016 10:57:09 AP -
e - e :
v
File Content
View * Format v Freeze  CfiDetach ol Wrap B} ©Begring@End #oflines 50 [E] Show File

Text

: 45:FLL:1lv_use BI::Y [

: cmnsyp cl D00 0l.get syp pazemeter value value: weblogic

.get_syp parameter value value: http://ofss2221142.in.oracle.com:.

.get_syp_parameter_value valus: http://ofss2221142.in.oracle.com:

.get_sSyp parameter value parameter:

J5V_BI_USER
J5V_REPORT_ARCHIVE_DIRECTORY
: cmnsyp_cl_D00_01l.get_syp_parameter wvalus parameter: JSV_REPORTS_SERVER TIMECUT

11: cmnsyp_cl_000_0l.get_syp paramet alue parame

.get_syp_parameter value value: /scratch/work area/DEV/QA143REL/r.. |

Click on & Show File button to view the selected file contents in the ‘File Content’
section. You can also click & Download File button to extract a copy of debug
details.

Time Zone Level - Select the time zone preference as User/Company Branch/
Application Server Time Zone from the adjoining options list.

For more details on time zone selection, refer to Time Zone Preference section of
this user manual.

Click Submit to save the changes or Close to close the screen without changes.
e Accessibility — Click the link to view accessibility features of the system.
Refer accessibility document for further details.
e Sign Out — Click the link to sign off from the application. You can also click on
icon to sign off from the application.
Left Window

In the left pane, system lists and provides drop-down links for various modules available in
the product. Click > to expand the Module Master Tabs and < to collapse them.

» DashBoard
> Origination
Servicing
Eles 5
Customer Service Il
Securitization
Transaction Authorization
Post Date Checks
Escrow Transactions

m

Account Documents d
Collateral Management |
Reparts
Producers
vendors
Batch Transactions
Interfaces
AP Transactions
GL Transactions -
> Collections
> WFP
» Tools

> Setup
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To open a screen, navigate to Module Master Tab to which the screen belongs, expand the
tabs, and click the screen link you wish to open.

Menu Search in Left Window

In the left window you can make use of the search option to directly search and open the
screen that you are familiar with, and avoid multiple steps of navigation from the LHS menu.

The Search box in the LHS facilitates for an intuitive search of required screens in Oracle
Financial Services Lending and Leasing. For example, on typing the first letter of the screen,
the search box displays a list of all available screens starting with the letter entered in
alphabetical order. You can click on the required screen and press ‘Enter’. The screen is
displayed in the main window/work area.

ORACLE’
Financial Services Lending and Leasing

A @8 | Access x (0 Gose
Appication Retrieval(Origination) Data Scesn Reports | Correspondence  Transaction
Appiication Documents (Crigination)
Asset Types(setup Products) Access Grid Fpadd || ZEdt || [Fvien || At
, )
Account Documents(Serviding) vew~ Fomat~ | & Freeze ] Detach wrap )
Access(setup User)
o s o QOrganization Division Company Branch Allowed
‘rsnssc retsenieng inirfces) R R AL AL ¥
Application Entry(Origination) oG i AL ALL ¥
Audit Tables{setup System) c K AL AL ¥
Advances(Servicing Batch Transactions) e P04 AL AL \

> Origination
> Servicing
> Collections
> WEP

» Tools

> Setup

When there are multiple matches with same screen name, you can filter the results through
the module from which the screen is accessed which is indicated in angular brackets. For
example typing 'VEN' displays the following options for selection - Vendors(Collections),
Vendors(Origination), Vendors(Servicing), Vendors(Setup System). For subsequent search,
you need to clear the data in the search field.

Right Window

The Right Window can also be termed as work area. When you click the screen link on left
pane, system displays the corresponding screen in the right pane.

RACLE
Financial Services Lending and Leasing

Sales Lead x Close
> DashBoard s cedt -

/Le;aknl’l’v Follow-Up | Maintenance

Applicant Information a0 | P | Elwew || & avoe
v - Freez =p ]
anch R ary
i1+ Haws unco:
o o [ prvon
L-00003002 121772015 usra o1/01/1997 w HorE BoTHEL
L-o0o02002 127127201 usiia 10/10/1302 consuLTATION 1ot TRvINE
L-o0002004 12/12201 usii 12/03/1370 =l ot Junco!
L-o0o0co02 02/02/2010 usiia 077251300 CONSULTATION  OFTLINC APPLICA... 1I0ME ADD1 o
L 00001001 12/19/2015 usko o8/06/1980 consuLTATION = HowE LEAD e Lotza
L ooooso2 122372015 usko sam san 112372901 oHERS Wes ENTRY HowE UNITEDSTATES 123 ronce
ts || Request
b add |[ P oo || Elview || o avde
Feee i Detac @
Te Phone Current
CAR/MOBILE PHONE (0045323823 ¥
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You can open a maximum of 15 screens at a go. Once the maximum limit is reached, the
system displays an error message.

ORACLE"
Financial Services Lending and Leasing
5

2 Edt || Blview || 2 avsie

VEROUTHU
vEROUTIU

Paran Reauiied
TN DATE

4 Transaction processing Detalls

> Collections.
> wrp.
> Tools

> sctup

Each active screen is displayed as a tab at the top of right pane, across its width. To view a
screen, click the screen tab. You can identify the active screen with its white background.
Also, operation on any of the screen will not affect the data in other screens.

You can also open multiple Accounts at the same time as separate tabs in the right window,
provided your system administrator has enabled the option 'Mac_Multi_tab_Ind' ="Y’ in
MENU_ACCESS table.

Having this option enabled you can view and update a maximum of 15 Accounts in parallel

tabs and Oracle Financial Services Lending and Leasing renders dynamic data across all the
opened tabs.

However, this option is restricted only to the following screens in Servicing Module Master
Tab. In the Left Menu of Servicing Module Master Tab, you can open multiple accounts by

clicking on the Customer Service link. Each successive click, opens a new Customer Service
tab.

ORACLE
Financial Services Lending and Leasing

@8] Customer Service || Customer Service % || Customer Senvice » || Customer Service % | Customer Service x (36 Close=
Scarch | Customer Service: 20160700010076  Review Request (Pending: 0) | Queue Assgnment =
> DashBoard
o Account(s): 20160700010076: MILLEN JOHN Elten |[ o Audt
L View v Format ~ Freeze i Detach Wrap &, @ current ©) Show All ©) Group Follow-up
s o~ Fomat~ | Bp o @ a
_ Company Branch Sub Unit Account = Product Days Past Due Currency Pay Off Amt Amount Due st
Sepwcng NO2 NLHQ UNDEFINED 2060700010076 LOAN VEHICLE (FR) 23 ER 50,089.31 000}

Customer Service 4 = =E= SRS S22 = .

Seauitization

Transaction Authorization -

St Summary | Customer Service | AccountDetais | Customer Details | Transaction History | PmtModes || Bankruptcy || RepojForedosure | Defigency || Colateral | ursau | CrossUpsell activi > ¥

Escrow Transactions

Account Documents Alerts Conditions

Collateral Management

Reports Alerts Conditions

Producers Alert Condition Start Dt Followup Dt

Vendors PRIM CUSTOMER ( JOHN MILLEN ) MARKED AS DECEASED,UPDATED PERMISSION TO CALL FLAG AVAILABLE FOR REPOSESSION 08/03/2016 08/30/2016

b AS'N' FOR ALL CONTACTS ; :

Batch Transactions DEFICIENCY 08/09/2015 08/30/2016 [
pibiaticas LIEN PERFECTED 08/09/2016 08/30/2016 -
Payments
Fees

Interfaces

Account Details Other Information
#P Transactions
6L Transactions =
Dues Collateral Information
Conversion Accounts
Description Identfication # Year AssetClass  AssetType
0.00 0.00 0.00 0.00 0.00 0TOYOTA CAMRY 0 usep VEHICLE
<k il D < i v
DelgDue 0,00 Todeys Payoff 50,083.3L  AmtPeidExcess 0.00 . .
oG LCDue 0.00 Future Payoff 50,158.61 Memo Excess 0,00 Ci-touss Tafonnation
> - pay Customer
e NSFDue 20.00 Future Payoff 08/15/2016 t % Name Relation ssn National
% Date Paid Term 0§ =
. otieroe 0,00 . X 000000 JOHN MILLEN PRIMARY 003456 45678
> Tools TotalDue 20,00 Future PmtDt 08/28/2016  Remaining Term 6 . = 5
& enm Oldest Due Dt 08/28/2016  Days to Time Bar H

Copyright © 1398,2016, Cracle and/or its affiiates, Allrights reserved, About.

Few screens in Servicing and Collections are identical and are linked. Hence, when multi tab
option is not enabled, you can open only one screen at a time from the group. A sample of the
grouping structure is given below, based on stages of the screens:

Collection:

e Collection
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e Bankruptcy
e Repossession
e Deficiency

As per the above listing, you will be able to open only one screen in the corresponding list and
need to close the same to open any other screen.

Right Splitter/Action Window

The Right Splitter/Action Window has quick access to search and other options to avoid
switching between tabs or navigating into sub tabs periodically. You can access the Right
Splitter/Action Window while working on an Application or Customer Service screens. You
can click ﬂ and Fto toggle the view of Right Splitter/Action Window.

Origination Screens

In Origination > Application screens, you can use the Right Splitter/Action Window to do the
following:

& Welcome, VAVAIDYA ~  accessibilty  EROUNNN] O

RACLE
Financial Services Lending and Leasing

Close
— ongation EE
origination Search/Tack | Funding: 0000000378 | Review Requests (Pending 0) -
L Quick Search
Ongination .
Application: 0000000378: TIFFANY RUSSEL / GRACE Bl view || & audit e
View .. Format = | B Freeze i Detach wop | @) OverideOK ¥ v v ssn
Origination Stage e Duplcate )
o ap = Sub Unit Status Producer Niame Co Bxisting Customer Contact *
o e Applcaton [ submt || & Clear
oxfosf2012 0000000378 UNGEFINED APPROVED-FUNDED  FUNDED GA-000D4 : ADVANCELER... . N
» Summary
Requested  Approved
Advance 1500000 1500000
Summary | Applicant | Request | Decsion | Contract | Collateral | Comments || Tracking || Document | Verfication | Correspondence | Tools fate £.e00 om0
Term 3 S
> Applicant Grade  DGRADE  Score 0
v 1000 v
Stated PTI954
g AT B leage 0
As 2012 CHEVROLET MONTE CARLO
200
> Bureau
Quese FUNDED APPLICATIONS QUELE
b Checklist Change Status
Status APPROVED - FUNDED
Collateral Change status
Collateral Add Comment
Asset Type subType Primary  vear Vake Vodel Mileage New Wholesale Value ;
> Servidng VEHICLE car v w12 CHEVROLET MONTE CARLO on 10,000.00 Alort
> Collections Tipe v
= “sub .
RWED Trade-Tn Tipe
> Tools * Comment
> setup Trade-In : i

e Use Quick Search to search for an application based on application number, last 4
digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during ‘Identification # search, the system displays
an error message as “Multiple Matches found for the Identification #, Please use normal
Search”.

e Summary section displays critical information that has to be referred repeatedly during
origination like — DTI, PTI, Book Value, Grade, FICO Score, Approved Advance, Rate
and Term.

e Use Change Status section to change the application status to next level. If the
application edit status is restricted, then the ‘Change Status’ will be read-only.

e Use Add Comment section to post an alert or comment during Underwriting and
Funding stages.

For detailed information on the above options, refer to respective sections in the
document.
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Servicing and Collection Screens

In Servicing and Collection > Customer Service screens, you can use the Right Splitter/Action
Window to do the following:

ORACLE' _ _ 3 Vielcome, VAVAIDYA = pccasiilty o
Financial Services Lending and Leasing
Close
e Customer servie x ®d
> Origination femeh)| :0) =
i1 Quick Search
Servicing -
e Account(s): 20120200010231: YUTAKA OZAKA / AKANE o Audit e
View Format + Freeze [l Detach 8 Current © show all © Group Follovi-up Customer 1d
Branch Sub Unit Account # Product. a0
UsR1 UNDEFINED 2020200010231 LEASEVEHICLE Uentfication #
[B submit = @ Clear
story | Pt Hodes
Quese Condtion -
Alerts Conditions Auto Run
[ Next Account
Alerts Conditions add G "
Alett Condition Start 0t Followup Dt orumen
o data o displ LIEN DATA CHANGE w2j10/2016 0211072016 - alert
Type REGULAR -
Comment
Account Details Other Information
4
Dues Collateral Information e G
01/10/2015 12/10/2014 11/10/2014 10/10/2014 Identification # Year  Asset Class -
000 000 2012 MERCEDESE3004DR  2GAWSS2151110621 2012 NEW Add call Activity
= Acton v
DelgDue 0.00 Total Due 0.00 Future Pmt 02/10/2015 fa % R
- ——— rodaye 000 Dt Customer Information Result .
SF Due 000 Poyof OldestDue 02/10/2015 | | Customer E— v Mo =
Other Due 0.00 Future 0.00 ot il
Payoft Amtpaid 0.00 D00000... OZAKA A YUTAKA PRIMARY 310 Reason -
Future 01/032016 Bxcess D0000D... AKANE B YUTAKA SPOUSE oc00-3399
Payoff Date »
Delinquency Information =
Lte 30 B 2 s mail MARIECESSC.COM
o 0 0 o 0 0 0 EnGLIsH
)
BP(Life) 0 NsF(Life) 0 Collector GIRI Time Zone »
> Collections BR(Year) 0 Ns(vear) 0 Group Followup
> wep Activities & post Call actnty | [ @2 Clear
> Tools Active Dt 11/01/2012 App# 0000000540  Last Pmt 224576
> Las 122402015 paid OFf Dt ch <
> Setup il N i Address Information
Tates oout

‘Copyright © 1998,2015, Ora

e Use Quick Search to search for an account based on account number, or customer Id,
or last 4 digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during ‘ldentification # search, the system displays
an error message as “Multiple Matches found for the Identification #, Please use normal
Search”. You can also select the Queue Condition and Auto Run options during search.

e Use Add Comment section to post an alert or comment based on Type and Sub Type.

e Use Add Call Activity section to post all types of call activities including promise to pay,
account conditions and so on, irrespective of the screen you are working on. This is
similar to the option available in ‘Call Activities sub tab’ under Customer Service tab.

For detailed information on the above options, refer to respective sections in the
document.

The height of Header and width of the Left and Right Panes do not change, with resizing of
application screen.

The system facilitates toggling Header and Left and Right Panes of the home screen to
increase the visible area of the screens. Click =u to toggle upper pane and j to toggle left
pane. To un-toggle click == and |: respectively.
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Time Zone Preference

Oracle Financial Services Lending and Leasing %
User Info
Organization DMC Time Zone |JSER TIME ZONE v
Division S0 Level
First Hame VARSHA User Time Zone UNDEFINED
Last Name VAIDYA Company US/CENTRAL (CENTRAL STANDARD
Branch Time TIME)

Responsibility SUPERUSER Zone

G Bost Lere IR 20 Server Time ASIA/CALCUTTA (INDIA STANDARD
Last Login Date 02/10/2016 03:21:07 AM Zone TIME)

Session Language DEFAULT b skin Family Skyros (Default) il

Debug Enabled Ind

DE Submit || ¥ Close

You can select any of the following three time zones from the User Info screen:

e Application Server Time Zone
e Company Branch Time Zone
e User Time Zone

The time zones set up at each of these levels are displayed in the user info screen. However,
data is always stored in the application server time zone and based on the user preference of
time zone, the display time would be User or Company or Application Server time zone. Any
time zone related changes done at Ul does not impact the other time bound activities which
are dependant on database time.

Application Server Time Zone (Server Time Zone)

The Application Server Time Zone by default is the Production Server Time Zone. Selecting
this time zone will have all date and time fields defined as per the time stored in application
server. There is no offset in time if both storage (database server) and display (application
server) are in the same time zone.

Company Branch Time Zone (Organization - Division Time Zone)

This is the Company time zone and is setup at the organization - division definition level. The
various divisions defined under an organization can be set up with different time zones
depending on geographical locations. This time can be modified as per requirement.

To modify the Company Branch Time Zone:

e Navigate to Setup > Administration > User > Organization and select the company or
division listed under 'Division Definition'.

e Inthe Display Formats tab, select Time Zone and click ‘Edit’.

e Inthe Format field, select the required time zone from the adjoining options list and click
‘Save’.

If'Company Branch Time Zone'is selected as the time zone in User Info screen, then on save,
all the time and date fields are automatically updated with the time zone of the company
branch.

User Time Zone

User Time Zone or User Preference Time Zone can be set up at the User Level in the User
Definition screen. Various Users under same divisions defined under an organization can be
set up with different time zones depending on geographical locations.
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1.4.2

1.5

1.5.1

To modify the User Time Zone:

e Navigate to Setup > Administration > User > Users.
e Select the required User record listed in “User Definition” section and click Edit.

e Inthe Time Zone field, select the required time zone from the adjoining options list and
click Save.

If 'User Time Zone' is selected as the time zone in User Info screen, then on save, all the time
and date fields are automatically updated with the current updated time.

Screens

Details in few main screens are grouped into different sections. These sections are displayed
as tabs, horizontally within the screen. In turn, details in few of these tabs are again grouped
horizontally. The details are displayed when you click the tab under which they are grouped.
As similar to the main screen tabs, you can identify the active tab with its white background.

For example, Customer Service main screen has four main tabs. When you click on
‘Customer Service’ tab, the corresponding tabs are displayed.

Customer Service @

‘SEE\(\! Customer Service: 20120200010231 Pau\ewR!qhe:t‘\Penmng:D)‘

Account(s): 20120200010231: YUTAKA OZAKA |/ AKANE [E]view | o audt
Vieww Format 5} Freeze PfiDetach | Jwap | @) & @ Curent O showAll © Group Follow-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay OFf Amt Amount Due Status Oldest Due Dt
Uso1 USR1 UNDEFINED 2012020010231 LEASE VEHICLE 0 USD. 0.00 0.00 ACTIVE 02/10/2015

‘Eun'n'al‘,‘ Customer Service = Account Details | Customer Details | Transaction History | Pmt Modes =~ Bankruptcy | RepojForeclosure | Deficiency | Collateral | Bureau C\u::,‘bpSeH»‘-L‘t\‘,‘\tie:‘

‘CallAdi\lilies Maintenance ~ Comments Promises = Checdists Tracking Attributes ~ References  Correspondence  Letters  Document Tracking

call Activities dpadd | ZEit | [Fvien | o audt
Views Formatv [ Freeze A Detach wap @
Action Result Contact Reason Cancel Promise Dt Promise Amt Condition Appointr Follovup Dt Time Zone Adj Folloviup Dt Con
AT PH ANSWERING MACHINE N 12/30/2015 1,000.00 NONE N 12/30/2015 12/29/2015 12:30:00 PM
AT PH ANSWERING MACHINE N 12/302015 1,000.00 NONE N 12/30/2015 12/29/2015 12:30:00 PM

b

You can click # to view the hidden tabs, if any.

Common Operations

Some of the operations are common to most of the screens. These are grouped into three
categories, based on their features.

e Basic Operations
e Basic Actions
e Personalization Options

Basic Operations

All the screens contain buttons to perform all or few of the basic operations. The four basic
operations available are:

e Add
e Edit
e View
e Audit

e add | A Edit | S view | o Audit
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1.5.2

When you click any of the operation tabs, system displays the corresponding records inline,
below the respective setup tables.

The table below gives a snapshot of them:

Basic Operation

Description

Add

Click to add a new record. When you click Add, the system displays
a new record enabling you to specify the required data. It is
mandatory to specify details for the fields marked with *’ symbol.

Edit

Click to edit an existing record. Select the record you want to edit
and click ‘Edit’. The system displays an existing record in editable
mode. Edit the required details.

View

Click to view an existing record. Select the record you want to view
and click ‘View’. The system displays the record details in display
mode.

Audit

Click to view audit info. If an audit is set for a field, then the system
tracks the changes for that field. Select the record for which you
want to view the audit info and click ‘Audit’. The system displays the
details tracked for that field.

Close

Click to close a screen or a record. When you try to close an
unsaved, modified record, then the system alerts you with an error
message. You can click ‘Yes’ to continue and ‘No’ to save the
record.

Basic Actions

Most of the screens contain buttons to perform all or few of the basic actions.

All or few of these actions are enabled when you select any of the Basic Operations.

E Save and Add

E Save and Stay

E Sawve and Return

{3 Return

The table below gives a snapshot of them:

Basic Actions

Description

Save And Add

Click to save and add a new record. This button is displayed when
you click ‘Add’ button.

Save and Stay

Click to save and remain in the same page. This button is displayed
when you click 'Add/Edit' button.

Save And Return

Click to save and return to main screen. This button is displayed
when you click ‘Add’ or ‘Edit’ buttons.

Return

Click to return to main screen without modifications. This button is
displayed when you click ‘Add’, ‘Edit’ or ‘View’ buttons.

The Payment maintenance screens consist of the following actions.

Post and Stay

B Post and Return

{‘l_j Return
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The table below gives a snapshot of them:

Basic Actions Description

Post and Stay Click to post the transaction and remain in the same section. This
button is displayed when you click 'Modify Payment/Modify
Payment Transaction' button.

Post and Return Click to save and return to main section. This button is displayed
when you click ‘Modify Payment/Modify Payment Transaction’
buttons.

Return Click to return to main section without modifications. This button is

displayed when you click ‘Modify Payment/Modify Payment
Transaction’ buttons.

The summary screens consist of the following navigations. The table below gives a snapshot
of them:

Basic Actions Description

Click to navigate to the first record.

Click to navigate to the previous record.

[k

Click to navigate to the next record.

b

Click to navigate the last record.

| M

Along with the basic actions, the following buttons are available for specific actions. The table
below gives a snapshot of them:

Basic Actions Description

Ij Show File - Click to view the details of selected file.

List Files - Click to generate and view the list of files maintained in
the system.

|__|-ﬂr Download File - Click to download the details of selected data.

1.5.3 Personalization Options

You can personalize the data displayed in setup tables. Once personalized, system saves the
settings for that User ID until next personalization.

|'v'iewv Farmat » | Freeze i Detach A Wrap E@l
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The table below gives a snapshot of them:

Options Description

View Click to personalize your view. The drop-down list provides the
following options of customization:

e Customize columns you wish to view
e Sort the order of displayed data
e Reorder columns

Additionally, the drop-down list provides selection of options
adjoining ‘View’.

M Format ~ | [&p Freeze pfiDetach

LI b showal
| Freez= + Product |
Detadh + Description ,
#ork » ¥ StartDt
Reorder Columns... + End Dt
Query By Example + Direct
+ Enabled

+ Collateral Type

+ Collateral Sub Type

+ Credit Bureau Portfolio Type
+ Credit Bureau Account Type

Manage Columns...

Format Click to resize columns or wrap a data in the table cells.
| e
Select the column you need to resize and select Resize Columns
option from the Format drop-down list.

Resize Column = I

Column DESCRIPTION

width | 100 ] [pixels [=]
OK. Cancel

Specify the Width and unit for the selected column. Click OK to
apply changes and Cancel to revert.

Query by Example | Click to query for the data by an example. When this option is
selected, the system displays an empty row above column heads.
You can specify all or any of the details of the record you wish to

query.
View » Format{ Freeze i Detach o1l Wrap o)
¢ | | @) %) i_
Freeze Select the column at which you need to freeze the table and click

Freeze. Function is similar to the freeze option in MS excel.

Detach Click to detach the setup table from the screen. An example of the
detached table is provided below.
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Options Description

Wrap Select the column in which the data needs to be wrapped and click

Wrap.

Lloan  Lne

Jpadd | JEdt | [Fven | o Audt

Product Definition

vew - [ | © | Mrrece gtococr | QM| @ vewrodct st copy
I I I I I Cotateratsub Ty |CredtBureat
prosuct et encoe |orect Fxive Repayment Enabled Jocdateraype  |cotatera subype [hedtBuens |
o+ LOANHOME (R)  p1/01/1800 12/31/4000 ¥ Y 2 HOME COLLATERAL - REAL PROPERTY HON INSTALLMENT
LOAN SECURED
Loans6 12/31/4000 N N v HOUSEHOLD GOODS PERSONAL PROPERT INSTALLMENT
WR)
Loanam oy SR b o1/1500 12/31/4000 v v ¥ UNSECLRED COLLATIUNSECLRED INSTALLMENT
Loanve LOANVEHICLE ()1 b1/01/1800 12731/42000 N v v VEHICLE COLLATERA PERSONAL PROPERT INSTALLMENT
MoP1 wopL 3/08/1863 12/31/4000 v N v VEHICLE COLLATERA PERSONAL PROPERT INSTALLMENT
MURABAHA B povse 031372013 v N v HOME COLLATERAL  REAL PROERTY HON INSTALLMENT
nDs1 NORM DSER 3/11/1853 1273174000 v N ¥ UNSECLRED COLLATIUNSECLRED ISTALLMENT
o1 et 1017201 12/31/4000 v N 2 HOME COLLATERAL REAL PROPERTY HOMMORTGAGE

Click to refresh the data in the table.

Print option in Customer Service screen

The Print button option in Customer Service/Collection screen facilitates you to print the

contents on the screen as is without scroll bars. This button is available along with other

options in the Action block. Clicking on this provides a browser print functionality and a new

tab is opened where the print content is displayed.

Detach

ORACLE
Financial Services Lending and Leasing

&, Welcome, VAVAIDVA »  pccessibilty TSRO

L customer seree ¢

Close
> DashBoard He
> Origination | quest (Pending: 0) .
Servicing
senicing Account(s): 20120200010231: YUTAKA OZAKA / AKANE [El view || <2 audt
Ctboics: Sl Viewv Formatw [5 Freeze 5 Detach o wrap W & @ curent O ShowAll C* Group Follow-up
Securtization Company Branch Sub Uit ccount # Product Days Past Due Currency Pay Off At Amount Due Status Oldest Due D
Transaction Authorization usot USRL UNDEFINED 2010200010231 LEASEVEHICLE 0.00 ACTIVE 10015
Post Date Checks
SOy Tadioe Summary | Customer Service | Account Details | Customer Details | Transaction History | PmtHodes || Bankruptcy | RepojForeclosure | Deficency | Collateral | Bureau | GrossUp el Activities
Account Documents
Collateral Management Call Activities  Maintenance Comments Promises ChecKists Tracking Attributes  References Corespondence Letters Document Tracking
Reports
Producers i i
Vendors Transaction Batch Information padd | At || Fview | & Auit
Batch Transactions View~ Formatv [ Freeze 5 Detach Wrap o Frrost [ vod
Advances Date Monet Transaction Status Batch
Payments 021072015 ADD CUSTONER ADDRESS PHONE POSTED "
Fees oot TERMIIATE ERROR N
Interfaces 01062016 TERMINATE voI N “
QusD0LS EXEvIO) von "
Detached Table x
View~| Format v [ Freeze [[EBetadh vap @ ot [5hvoid
Date Wonetary Transaction Status Batch
01of201s " ADD CUSTOMER ADDRESS PHONE POSTED "
03072016 ¥ TERMINATE ERROR N
01/05/2015 ¥ TERMINATE vo N
01/06/2016 Y EXTENSION Vo N
12472015 ¥ PAYOFF QUOTE LEASE POSTED [
Viewv Formatv [ Freeze Bl Detach @
> Collections Transaction Processing Details
swe ||| mE= Diret Record Update, Transaction Postng Successful “*+*%
> Tools
> Setup

Click ‘Add’, ‘Edit’ or ‘View’ button to open a new screen in expanded mode with details.

Drop-down List

The system provides an option to select the required data from LOV, for few fields. You can

either select the record from list or enter first alphabet of the value you want. When you
provide the alphabet, system limits the selection to the values starting with the specified
alphabet. These lists are grouped into two types:

o
list or enter first alphabet of the required value.

Drop-down list — Provides the selection option. You can either select a record from the

ORACLE



e Combo drop-down list — The LOV contains huge data and prov

ides both selection and

search option. These drop-down arrows are smaller in size, when compared to normal

drop-down arrows, thus enabling easy identification.

ORACLE"
Financial Services Lending and Leasing

= Welcome, VAVAIDYA ~  Accessibility o

Casa Recondliation

Conversion Accounts 3 .
Transaction Batch Information

ustomer Service x Close.
> DashBoard Gt Ll
> Origination ~~ Seard gl C 8
Servicing
m—— Account(s): 20151200010012: MADHU BOBBURI B view || & auat
Customer Service Vieww Fomatv B3 [ Freeze i Detsch Wrap & ® curent O showall © Group Follov-up
Securitization Company Branch Sub Unit Account # Days Past Due Currency Pay Off Amt. Amount Due Status. 0ldest Due Dt
Transaction Autharization usot uskg 2015120001012 LOAN VEHICLE (FR) 21 usp 5031881 2,19:30 [T ET AT 01/01/2016.
Summary | Customer Service | Accourt De ory || Pt Modes| | Bonkiuptey | RepojForedos o =
;:EZ“E‘“”‘“”““”‘E“‘ Gall Adtvities | Maintenance | Comments || Promises | Cheekists || Tracking Attributes || References || Correspondence || Letters [ Zsaarch ]
Prod ) . ® Al O any
ven Transaction Batch Information Add |/ Edit ] vi £ Audit
Batch View v Fomatv [ Freeze EfiDetach ¢l wrap W post [ veid
Advances .
ot Date Vonetary Transaction accounTeL e
L o2f10f2016 ¥ Pt arch: Transacti
o= . 03/25/2016 n ACCOUNT SUB UNIT TRANSFER e
Interface: 0y/22/2016 n ACH HAINTENANCE pomdtily . Search e
AP Transactions 03/07/2016 r, 'ACH ONE TIME PHONE PAY e o DAY i @
GLTransactions 12/15/2015 v ADJUSTMENT TO ADVANCE / PRINCIPAL - ADD >

Parameters
View v Format +
> Collections
Parameter
> WP o data to display,
> Tools
> setup

Result

Reset | | AddFields || Reorder

Date 02/10/2016

* Monetary @) 0K || Cancel

&

Freeze i Detach

Value

Required

Click the arrow button available before ‘Search’ to toggle the search options.

Buttons/Menu Do this

Basic Click ‘Basic’ for normal search.

Advanced Click ‘Advanced’ for advanced search. In this mode, you can select
the search option from drop-down list adjoining the search criteria.
Selected record will be highlighted (Hover to select).

Match Select ‘All’ to display results exactly matching the specified
characters. Select ‘Any’ to display results matching any of the
specified characters.

Search Click to search for values based on the specified search criteria.
The search results are displayed below with the details in respective
columns.

Reset Click to reset the search criteria.

Add Fields Click to add additional fields to search criteria.

The search criteria are provided below the ‘Match’ field. These criteria vary based on the Field
for which the search is executed.

Also, the system remembers your recent search options and demarcates them from the actual

ones.
| * Channel | WEB ENTRY = * Producer Name [
NY-02: PR HOLTSVILLE 43125313212
MT-00001 : SGFSADDF RAMEY 23132132
LR} SR e 1
TIF-OUOO L T TEST-00T RTINS T 1
MN-00001 : TERMINATE AGUADA a
MT-00001 : SGFSADDF RAMEY 23132132
NY-02: PR HOLTSVILLE 43125313212
Search...
Comments

In all the user input screens wherever comments are accepted, the system allows an input of
4000 characters of information in the comment(s) field.
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1.6 Keyboard Compatibility

The system facilitates keyboard compatibility. You can perform most of your tasks using
keyboard short cuts also termed as ‘Hot Keys’. These hot keys are single keyboards or a
combination of keyboards. The available options are listed below:

1. Shift + Alt + mnemonic to activate buttons in the screen. For example, to open
‘Accessibility’ screen, press ‘Shift + Alt + y’.

2. Tab for forward navigation in the application. Shift + Tab for backward navigation in the
application. When the required link/tab/button/field is highlighted, press enter on the
keyboard to edit.

Space bar to check or uncheck ‘Check Box'.

4. Arrow Keys to hover within the drop-down list.

1.6.1 Keyboard Compatibility

The application is made compatible with keyboard only-operations. However, there is a
change in key combination based on the browser on which the application is running.

Browser Operating Key Combination Action
System

Google Chrome Linux Alt + mnemonic Click

Google Chrome Mac OS X Control + Option + mne- | Click
monic

Google Chrome Windows Alt +mnemonic Click

Mozilla Firefox Linux Alt + Shift + mnemonic Click

Mozilla Firefox Mac OS X Control + mnemonic Click

Mozilla Firefox Windows Alt + Shift + mnemonic Click

Microsoft Internet Windows Alt + mnemonic Set focus

Explorer 7

Microsoft Internet Windows Alt + mnemonic Click or set focus

Explorer 8

Apple Safari Windows Alt + mnemonic Click

Apple Safari Mac OS X Control + Option + mne- | Click
monic

Also, one can use the following keyboard shortcuts in order to increase or decrease the zoom

level.
Shortcut Action
Ctrl++ To increase zoom level.
Ctrl+- To decrease zoom level.
Ctrl+0 To set zoom level to default level.
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1.7

1.8

1.8.1

1.8.2

1.8.2.1

Tool Tips

The system is facilitated with tool tip option. When the cursor is moved to any of the field in
the screen, a popup is displayed with a tip on the action to be performed.

Accessibility

Application

Understanding Accessibility

Accessibility is making the application usable for multiple user groups, which includes users
with physical challenges. One of the most important reasons to make the application
accessible is to provide them the opportunity to work. The four main categories of disabilities
are visual, hearing, mobility and cognitive.

A person with disability might encounter one or more barriers that can be eliminated or
minimized by making the electronic information user-friendly and approachable.

Application Accessibility Preferences

Oracle Financial Services Lending and Leasing is facilitated with the feature of Accessibility
to make the application more usable for the people who are differently abled. You can set the
accessibility preferences after login. On the landing screen using 'Accessibility’ link on the
right end of the header set the following preferences as required

Screen Reader

Screen reader provides assistance to the visually impaired users. It interprets the screen
elements by reading them aloud.

High Contrast

High contrast feature increases contrast level to make the screen more appealing for the
reader with low vision.

Large Fonts

Large fonts feature increases font size to ensure clear display and appropriate spacing. This
benefits the reader with low vision.

For Visual Challenges

The visual challenges varies widely, however it generally includes, blindness, low vision or
color blindness. To make the application more accessible, following features are provided.

Blindness:

In order to interpret the visual display information in the audible form, Screen reader
compatibility is provided.
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1.8.2.2

1.8.2.3

1.8.3
1.8.3.1

In places where Screen reader technology cannot obtain information from images, text
equivalents for images are provided.

For Users with difficulty in using mouse, since it requires hand and eye coordination,
Keyboard navigation is provided. Details of keyboard navigation is provided in ‘Section 1.8.3.2
Keyboard Compatibility’.

Low vision:

For Users who cannot view the content that has small font size and cannot be enlarged,
Software magnifier is provided to enlarge text and images beyond normal font enlargement.

Also, there is no information presented using attributes such as depth, size, location, font etc.

For high contrast requirements Screen setting can be adjusted.

Color blindness:

Oracle Accessibility guidelines have been followed and hence accessibility issues relating to
color blindness are addressed.

Also, high contrast colors have been used to address difficulty in identifying shades of colors.
For example, Black text in white background.

For Hearing Challenges

People with hearing challenges or hard of hearing might encounter problems accessing the
information presented using sounds. Some application features minimize their concerns.

Visual representations of audible information is provided so that Users with this challenge do
not miss information presented using audio.

For Age-related Challenges

Apart from the above, there can be aging issues like week eye-sight or hearing.

Issues related to weak eyesight can be addressed through Application features for Visual
Challenges provided in ‘Section 1.8.2.1 For Visual Challenges’.

Issues related to hearing can be addressed through Application features for hearing
challenges provided in ‘Section 1.8.2.2 For Hearing Challenges’.

For Users who are less familiar with computers, the simplified user interface with easy
navigation options, uniform layout and design and commonly used terminology in the
application is of great advantage.

To address issues relating to understanding complex information, User manuals are provided
for online help and tool tips at all required places are provided. In addition, system messages
like error, warning or information helps you through.

Other Accessibility Considerations

Documentation Accessibility

Apart from assigning the logical sequence and organizing topics, the following techniques are
used to enhance the accessibility of documentation.

e Addition of text equivalent to all graphics
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e Usage of standard fonts and avoiding shadow or reversed text

e Usage of strong foreground and background color contrast

e Color usages as per Oracle Accessibility guidelines have been ensured
e Usage of styles and formatting elements

e Documentation in simple language to ensure easy understanding

e Including accurate and effective navigational features, such as cross-reference, tables
of content and bookmarks as appropriate

Setting up Accessibility Preferences

You can setup or change the accessibility preferences.

To edit accessibility settings

1. Click Accessibility in the header part of application. The system displays the following
screen:

Oracle Financial Services Lending and Leasing *
| Accessibility Preferences
Edit Accessibility Settings

Any setting made is saved until changed here again.' : 'Any setting must
be made for each browser session,

[[]5ereen reader
[ High contrast
[[Large fonts

E[g Submit $2 Cancel

2. Select any or all of the required options to edit or change the accessibility settings.

3. Click Submit.

Note

You need to define the required Settings for each browser session and defined settings
are saved until next modification.
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2. Administration System

In Administration > System, you can record setup data related to the application’s overall
functionality and performance. This data affects;

e The mechanics of the system
e The processes of the system
e The search for Location of files to complete the tasks.

Navigating to Administration System

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > System

The System drop-down link records the following data:

e System Parameters
e Lookups

e User Defined Tables
e Audit Tables

e User Defined Defaults
e Transaction Codes
e Data Files

e Events

e Batch Jobs

e Producer Cycles

e Vendors

e Collection Cycles

e Reports

e Error Messages

e Translations

e Seed Data

Using these parameters, you can control the behavior of the system from a technical

perspective. For example, determine parameter values, define what information is audited,
and record default values. The product provides default values for all these screens.

System Parameters

System parameters define information or values used throughout the system. They act as
switches that control the manner in which a function is implemented, or whether or not the
system performs a particular task. Parameters are used throughout the system to control
everything from user access to what information is stored on any given form. Parameters also
define configuration data, such as the location of the system files, the URLSs for the report and
image servers, and other administration controlled data. Some of the system parameters are
setup when the system is installed, but the values associated with the parameters need to be
reviewed and maintained.
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There are three types of parameters in the system, grouped by what part of the system they
affect:

Parameter Type: Parameter Range:

System parameters These parameters apply to the entire system.

Examples: batch processes, archiving, aging.

Organization parameters These parameters apply to the organization, division,
and user responsibility.

Examples: User login control, password expiration.

Company parameters These parameters apply to the company and branch.

Examples: decision fax control, scoring model.

Hence, the System Parameters screen contains the following three tabs:

e System Parameters
e Organization Parameters
e Company Parameters

System Parameters Setup

The System Parameters Setup screen displays and records each system wide parameter,
along with its current value and whether or not it is enabled. These parameters relate to the
overall processing of the system, such as application server file locations and data purging
configuration.

To set up the System Parameters

1. Click Setup > Setup > Administration > System > System Parameters > System. The
system displays the System Parameter screen
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2. In the System Parameters section, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE

Financial Services Lending and Leasing

DashBoard
> Origination
> Servicing
> Collections
> WEP
> Tools
setup
Setup
Administration
System
System Paramett
Lookups
User Defined Tat
Audit Tables
User Defined Def.
Transaction Code
Data Files.
Dedupe
Securitization

scer Cycles
Vendors
Gollection Cycles
Reports
Error Messages
Translations

User

Organization
Companies
Access
Users
Credit Bureau
Correspondence
General Ledger
Queuss
Printers
Bank Details
Chack Details
Standard Payees
Currencies
Zip Codes

Products

< >

System Parameter y;

System | Organization | Company

System Parameters

View v Format~ | [
Parameter Paramater
AAIPRC_B]_100_0... AAIPRC_B) :
ACAPRC_BJ 100_.. A
ACA_DLQ_AMT_E
ACA_PAYMENT_A

OTE_D.

'S BEFORE DRAFT DAY FOR ACCOUNT ACH PROCESS
AYS BEFORE DEEIT DAY FOR ACH PROCESS IN FIRST TIME/ONE-TIME CASE

ACCDMP_BY_100_
ACCVAL BI 111__ A
ACCVAL B 112 A
ACCVAL B] 121_
ACHPRC_BJ 100_

ACH_PAYEE_PREN... NI
ACMPRC_BI_112_
ACPPRC_B1_100_
ACVPRC_BJ 100 .
ACK(PRC_EM_100_... /
anmmv cFRvER

System Parameters

Parameter
* Parameter Des

* Parameter Value

2 Welcome, PRAKRRAQ ~  Accessibility o
(3] Close
dadd | Fedit | [Eview || & audit
Parameter Valus Enabled
2
2 N ~
N ¥
¥ ¥
7 03
2 12
32.00 3
> N
7 N
7 N
> N
2 ¥
2 N
N
0.00 ¥
2 N
2 N
2 N
2 N v
bt Huhfanare i rememnnien ¥

Save and Add || [ Save and Stay || [ Save and Retun || (3 Retum

* Enabled []

A brief description of the fields is given below:

Field Do this

Parameter System parameter of the specified parameter description is
displayed here.

Parameter Select the description of system parameter from the drop-down list.

Description

Parameter Specify the value for the system parameter (required).

Value

Enabled Check this box to enable the parameter.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

For a detailed list of available parameters, refer to Appendix “System Parameters” chapter.

FCUBS Integration

Oracle Financial Services Lending and Leasing (OFSLL) is integrated with Oracle
FLEXCUBE Universal Banking System (FCUBS) with the capability to integrate the
centralized CIF (Customer Information Files), ELCM (Enterprise Limits and Collateral
Management) and CASA (Current Account and Savings Account) modules.

To work with the integrated environment functionalities, you need to enable the following core
banking indicator.

Parameter

Parameter Description

CMN_CORE_BANK

CORE BANKING INTERFACE INDICATOR
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Note

Re-qualification is pending for Core and Direct Banking Integration.

For detailed information about integration changes, you can refer to ‘FCUBS Integration
Documents’ section at OTN library (http://docs.oracle.com/cd/E59770_01/homepage.htm).

Organization Parameters

The Organization parameters control the system functions related to user log in, such as
passwords and expiration dates, responsibility levels and the ability to access the system
features. Individual parameters can be created with different values for uniquely defined
organizations, divisions, and responsibility combinations.

When determining which parameter to use, the system selects the best match based on a
hierarchical sort by the Organization, Division, and Responsibility fields, with values of ALL
being a lower order match than an exact match.

For example:

Assume the organization parameter UIX_APP_VIEW_ALL_APPS (VIEW ALL
APPLICATIONS) is as follows:

e If auser belongs to an organization as ‘DMC’ with a responsibility of SUPERUSER and
is using the Underwriting screen of Lending menu, the system will return with a value N,
and the system will not allow the user to view all applications.

e If the user belongs to any organization with a responsibility of SUPERUSER, and is
using the Underwriting screen of Lending menu, the system will return with a value Y,
and the system will allow the user to view all applications.

Note

Be aware that while the system allows for Organization parameters to be defined at all
three hierarchical (organization, division, and responsibility) levels, not all will be applica-
ble to each parameter. For example, while you can define the UIX SMTP_SERVER
(EMAIL SERVER FOR USER) for a responsibility, you would normally want only to define
this parameter based on organization or division.

To set up the Organization Parameters

1. Click Setup > Setup > Administration > System > System Parameters >
Organization tab.
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2. Inthe Organization Parameters section, perform any of the Basic Operations mentioned

in Navigation chapter.

ORACLE

Financial Services Lending and Leasing

P System Parameter x
> Origination System | Organization  Company
> Servicing
> Collections Organization Parameters Fadd | edt | [Eview || of audit
 WFP View v Formate [ Freeze ¢ Detach Wrap W
Parameter Parameter Description Parameter Value Organization Division Responsibility Enabled
P . SET THE NUMEER TO RESTRICT PASSWORD REPETL... 0.00 AL AL ¥
setup DAYS TO CONSIDER FOR GROUP FOLLOW-UP, WHE... 10 AL AL AL ¥
oy REVIEW QUEUE ALLOWED WITHOUT ENTERING CAL.. N AL ALL AL ¥
i S ~ ... VIEW ALL APPLICATIONS ¥ AL AL AL b
System HIDE RESTRICTED DATE (FOR EXAMPLE 551%) ¥ AL AL AL Y
- — /ER  EMAIL SERVER FOR USER INTERFACE internal-mail-router.oraclecorp.com AL ALL AL ¥
i R... VIEW SECURED ACCOUNTS Y AL AL AL ¥
ey VIEW SECURED APPLICATION ¥ AL AL AL ¥
iy USER LOGIN DAY END HOUR 24 AL AL AL ¥
i ULG DAY START  USERLOGINDAYSTARTHOLR 0 AL AL AL ¥
5 ULG_FAILED_LOG... USER LOGIN MAXIMUM FAILED LOGIN TRIALS BEFO... 853999999999 AL ALL AL ¥
[Eegtion Code 1 JSER LOGIN MAXIMUM INA Y DAYS BEFORE D. AL ALL AL ¥
33: s s AL AL AL ¥
edupe ;
Securitization : i ::t ::t :
Events A AL
i i i ax ;
Producer Cycles Fria S iy o
Yendy AL ALL AL ¥
Collection Cycles an a an v
Reports
Error Messages
Translations
User
Organization
Companies
Access
Users
Credit Burcau
Correspondence
General Ledger
Queuss
Printers
Bank Details
Chark Detalls
Standard Peyees
Currencies
Zip Codes
Products
< >

A brief description of the fields is given below:

Field

Do this:

Parameter Parameter of the specified parameter description is displayed here.

Parameter Select the description of system parameter from the drop-down list.

Description

Parameter Value Specify the value for the system parameter.

Organization Select the organization for which the parameter will be valid from
the drop-down list.

Division Select the department for which the parameter will be valid from

the drop-down list.

Responsibility

Select the responsibility for which the parameter will be valid from
the drop-down list.

IMPORTANT: In selecting which organization parameter to use,
the system searches for a best match using the following attributes:

1. Organization
2. Division
3. Responsibility

Hence, Oracle Financial Services Software recommends creating
a version of each organization parameter, where ALL is these
fields.

Enabled

Check this box to enable the parameter.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

For a detailed list of available parameters, refer to Appendix “System Parameters” chapter.

Company Parameters

The Company parameters control the system processes associated with functions that may
vary for different companies or branches. These parameters address credit scoring, credit
bureau interfaces, fax services, and fax generation. Individual parameters may be set up with
different values for uniquely defined company and branch combinations.

When these parameters values are requested by the system, the system responds with the
“best” match based on a hierarchical sort ordered on company and branch fields, with values
of ALL being a lower order match than an exact match. For example, assume the company
parameter UIX RUN_AAI ACT (ONLINE ACCOUNT CREATION AND ACTIVATION) has
been defined as:

The system uses these two parameters to determine whether to create and activate an
account online.

e When processing items for the company US01, the system will return a value N and not
create and activate an account online.

e When processing items for the company other than US01 and within the value ALL, the
system will return with a value Y and create and activate an account online.

To set up the Company Parameters

1. Click Setup > Setup > Administration > System > System Parameters > Company
tab.

2. Onthe Company Parameters screen, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE’ & Welcome, PRAKRRAQ = Accessibility O
Financial Services Lending and Leasing
DashBoard System Parameter x [3€] Close:
> Origination System  Organization =~ Company
> Servicing
5 Collertions Company Parameters dadd | SEdt | Elvew | of audt
P View v Fomaty [Ep Freeze i Detach o] Wrap o]
Farameter Parameter Description Parameter Valus Company Division Enabled
> Tools ™
Setup AUD_ADV_REASO... AUTO DECISION ADVERSE ACTION REASON MODEL FICO AL AL ¥ ~
prers AUD_SCORING_M... APPLICATION SCORING METHOD PRIM AL AL ¥
Amiriration ~ AUD_SCORING_M (CATION SCORING METHOD WITH IN ALL BUREAU MAX_SCORE AL AL ¥
System SELECTION CRITERIA MONTHLY AL AL ¥
; E SELECTION CRITERIA MONTHLY usoL usHQ N
System Paramete &
e METRO 2 FILE FORMAT 850 AL AL ¥
o VALIDATE ASSET MAKE MODEL DURING DATA ENTRY N AL ALL ¥
d_( 3_I J.. DEFAULT PRINTER NAME UNDEFINED AL ALL Y
S tnbles CMN_WEEKLY_NO... WEEKLY NON-BUSINESS DAYS UNDEFINED ALL AL ¥
He Dol ey COR_STORAGE_D... ORACLE DIRECTORY OBIECT NAME FOR CORRESPONDENCE DOC STORAGE COR_DIR_QA143REL_HQ AL ALL ¥
ranaition Codd DBR_JOINT_INC_.. COMBINE INCOME AND DEBT WITH SPOUSE AND 2NDRY N AL AL ¥
Gpnides 3 .. COMBINE INCOME AND DEBT N AL AL ¥
Dedupe ... DEDUPING CREDIT BUREAU EXPIRATION DAYS E= AL AL ¥
Sectintstion DEDUP CREDIT BUREAU LIABI WITH SPOUSE AND SECONDARY N ALL AL ¥
DEDUP CREDIT BUREAU LIABILITIES WITH SPOUSE N AL AL Y
B: o Jobs f 7 - D ORACLE DIRECTORY OBJECT NAME FOR ACCOUNT DOCUMENT LOADING ~ DOT_DIR_QA143REL_HQ AL ALL Y
Producer Cycles ECB_EDIT_FAIL_A... CREDIT BUREAU EDIT WILL FAIL IF ANY BUREAU FOR Al WILLNO.. N AL AL ¥
Vendars ECB_USE_APL_CU... RUN CREDIT BUREAU EDITS ONLY ON CURRENT SCORED APPLICANT BU.. Y A AL ¥ v
Callection Cycles FIN TMBGE STAT  NEFAINT TMAGE STATIIS FONF ENR FAY TN SERVICE n s an v
Reports
Error Messages Company Parameters
u;;rans‘a“ms saveand add | [ save and stay || [ Save and Retum | ¢ Retum
Organization
Companies Parameter * Company AL v
Access Parameter Description L2 ﬂ
Users . T i
e Parameter Value * Enabled []
Correspondence
General Ledger
Queues
Printers
Bank Details
Check Detals
Standard Payees
Currencies
Zip Codes
Products o
< >
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A brief description of the fields is given below:

Field Do this:

Parameter The system displays the parameter, when you select parameter
description.

Parameter Select the description of system parameter from the drop-down list.

Description

Parameter Value | Specify the value for the system parameter.

Company Select the portfolio company for which the parameter will be valid
from drop-down list.

Branch Select the portfolio branch for which the parameter will be valid from
the drop-down list (required).

IMPORTANT: In selecting which company parameter to use, the
system searches for a best match using the following attributes:

1. Company
2. Branch

For this reason, the Software recommends creating a version of
each company parameter where ALL is the value in these fields.

Enabled Check this box to enable the parameter.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

For a detailed list of available parameters, refer to Appendix “System Parameters” chapter.

Lookups Setup screen

The Lookup Setups screen defines the contents in many drop-down fields used throughout
the system. Fields that make use of drop-down field will accept only entries that are stored on
this screen.

The Lookups screen contains two sections: Lookup Types and Lookup Codes. Lookup
types and codes can be system-defined or user-defined. The lookup types describe the
function of the related lookup codes.

For system-defined lookup types, only the Description field may be changed.

A system-defined lookup type (Lookup Types block, System Defined is selected) is one that
is critical to the system and cannot be changed. However, you can still modify the lookup type
description and Record indicator (Enabled/Disabled).

A user-defined lookup type (Lookup Types block, System Defined is not selected) is one
that can be modified, depending on a user's business needs. You can modify the description,
system indicator and record indicator. If a lookup type is user-defined, the lookup code
belonging to that lookup type can either be system-defined or user-defined.

A system-defined lookup code (Lookups screen, System Defined is selected) is one on

which the system processing is dependent. Without this lookup code, the process produces
incorrect results or fails.
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A user-defined lookup code (Lookups screen, System Defined is not selected) is one that
can be defined or altered by a user.

WARNING: System-defined lookup types are those that are required by the system. Their
related lookup codes will also be system defined. If you update and save a user-defined
lookup type as a system-defined-lookup type (that is, change the System Defined button from
No to Yes in the Lookup Type sub screen), the system will not allow you to change the lookup
type back to user-defined in the future.

Note

Lookup codes cannot be deleted, as they may have been used in the past, and the display
and processing of that data is still dependent on the existing setup.

Typically, the system Administrator would modify the descriptions of lookup codes and add
new lookup codes to the existing lookup types as needed.

To set up the Lookups

1. Click Setup > Setup > Administration > System > Lookups. The system displays the
Lookups screen. The details are grouped into two:

e Lookup Types
e Lookup Codes

2. Inthe Lookup Types section, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE" . . Welcome, PRAKRRAQ +  Accessibility o
Financial Services Lending and Leasing

o
DashBoard el v E

> Origination
Lookup Type 4 add | 7 Edit View | < Audit

> Servicil =
% View » Formatw [Ep Freeze i Detach Wirap (5]

> Collections
> WEP
> Tools

Lookup Type Description System Defined Enabled

1098_POINTS_DISCOUNTS_ITM_CD 1098 ITEMIZATION TYPES
Setup
Setup
Admiristration
System
System Paramete
Lookups ACCRUED_TXN_TYPE_CD ACCRUED TXN BALANCE TYPE CODES
User Defined Tat
Auclit Tables
User Defined Def
Transaction Code ACH_ACCOUNT_TYPE_CD ACH ACOOUNT TYPE CODES
Data Files
Dedupe Lookup Type
Securitization
Events
Batch Jobs «
Producer Cycles
Vendors * Description
Callection Cycles * System Defined Yes/No () Yes®) No
Reports
.f:;:sl:fges Lookup Code Fadd | ZEdt || 5 view | o Audt
User View v Format- [P Freeze  Ef Detach 1 Wrap 5]

ACCESS GRID TYPE CODES
ACCRUAL BASE METHOD CODES
ACCRUAL CALCULATION METHOD CODES

ACCRUAL_START_DT_BASIS_CD ACCRUAL START DT BASIS CODES

ACC_CONDITION_CD ACCOUNT CONDITIONS / ACCOUNT QUEUE TYPES (SUB OODE USED FOR DEFAULT QUEUE)
ACC_STATUS_CD ACOOUNT STATUS CODES

[ saveand add | [ save and stay Save and Return | 3 Return

= Lookup Type = Enabled []

Organization 5
g System Defined Frobled|

Lookup Code: Description Sort Sub Code Ve

Companies
Access No data to display.
Users
Credit Bureau
Correspondente
General Ledger
Queues
Printers
Bank Details
Check Details
Standard Payees
Currencies
Zip Codes
Products
< >

A brief description of the fields is given below:

Field Do this:

Lookup Type Specify the lookup type.
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Field Do this:

Description Specify the description for the lookup type .

System Defined | Select ‘Yes', if you wish to maintain the lookup type as system defined
Yes/No and ‘No’, if you wish to maintain lookup type as User defined.
Enabled Check this box to enable the lookup type.

Perform any of the Basic Actions mentioned in Navigation chapter.

4. Inthe Lookup Codes section, you can setup individual codes that a field or process using
the related lookup type can have. Perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Lookup Code Specify the lookup code. These are solely dependent on the
function of the Lookup Type.

Description Specify the lookup code description. This may be changed as per
your business requirement.

Sort Specify the sort order for the lookup code. This determines the
order these lookup codes are displayed or processed.

Sub Code Specify the sub code for the lookup code.

System Defined | Select ‘Yes', if you wish to maintain the lookup code as system
Yes/No defined and ‘No’, if you do not want to maintain it as system
defined. System defined lookup codes cannot be modified,
except for changing the Description or Sorting fields. If the lookup
type is not system defined, then the code can be modified.

Enabled Check this box to enable the lookup code.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

User Defined Tables

In User Defined Tables you can maintain user-defined tables, such as the data attributes the
system uses on its Search screens.

In the following example, the list of attributes in the Criteria column are computed from the
User Defined Tables screen.

To set up a user-defined table, you must:

1. Define the fields on the table.
2. Join the related tables.

3. Assign the table a lookup type.
You can create tables for different products, funding, and collateral types.

After creating the user-defined tables, the system sorts the attributes to make the system
usage more efficient. These details are used with different functions of the system, including:
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e Searching applications and accounts

e Tracking follow-up items

e Creating details in bankruptcy, foreclosure/repossession, and deficiency

Note

Many of these tables, (ASSET TRACKING ATTRIBUTES for example) may be configured
during the initial setup of the application to provide for your specific business needs. Oth-
ers, such as APPLICATION SEARCH, may be changed whenever your business needs
change. Still others should not be changed without consulting Oracle Financial Services
Software, as changing them would require changes to existing code for the expected re-
sults to be implemented. As a thumb rule, it is better to add or disable information on the

User Defined Tables screen than to edit existing entries.

To set up the User Defined Tables

1. Click Setup > Setup > Administration > System > User Defined Tables. The system
displays the User Defined Tables screen. The details are grouped into two:

e User Defined Tables
e User Defined Table Attributes

2.

Navigation chapter.

In the User Defined Tables section, perform any of the Basic Operations mentioned in

ORACLE’ " " " & Welcome, PRAKRRAO v  Accessibility (&)
Financial Services Lending and Leasing
e User Defined Tables 5, [ Close:
> Origination
it User Defined Tables 4 add | S Ed =] vi 7 Aud
> Ser
rvicing =
View v Format- B Freeze o Detach Wrap 5]
> Collections =
D Table Usertable Type  Description 3{;};’2 Lk Enablad Product Type Funding Type Collateral Type View Name SQL Statement
Yes ® No N UNDEFINED
> Tools - L ; A
— SEARCH_WFP_PR... SEARCH : WFP PR... WFP PRODUCER'S ¥ AL AL ALL UNDEFINED SELECT /*+ FIRS
L2 SEARCH_UPD_AC... SEARCH : POSTD... POST DATED CHE ¥ AL AL AL UNDEFINED SELECT /*+ FIRS
‘e‘:‘z - N DLR_TRACK_MAP... MAPPING: INTERF... DLR_TRACK MAPP. ¥ AL AL AL UNDEFINED SELECT 1 FROM [
iministration
— SEARCH_UBT_AD... SEARCH : ACCOU... BATCH ENTRY AC A AL AL AL UNDEFINED SELECT /*+ FIRS
Systm Paramel SEARCH_UBT_FEE... SEARCH : ACCOU.. BATCH ENTRY AC ¥ AL AL AL UNDEFINED SELECT /*+ FIRS
Lookups SEARCH_UTA_TXN SEARCH: TRANSA.. TRANSACTION HI ¥ ALl AL AL UNDEFINED SELECT f*+ FIRS
Usex Deifed 1o SEARCH_UBT_PM.. SEARCH : ACCOU.. BATCH ENTRY AC ¥ AL AL AL UNDEFINED SELECT f*+ FIRS
Pudit Tabl
el CHGOFF_TYPE_D... TABLEATTRIBUT.. DEFICIENCY DETA. ¥ AL AL AL UNDEFINED SELECT 1 FROM [
User Defined De. v
Trancaxtion Cod CPY_APP_SETUP  SETUP: APPLICAT. . APPLICATION CO. es ¥ AL ALL AL UNDEFINED SELECT 1 FROM [
Data Files
User Defined Tables
k3 Saveand Add || [ Saveand Stay || [ Save and Return || Ga Retum
atch Jobs ‘4
Producer Cycles
Vendars *Table *View Name | UNDEFINED
Collection Cycle: = User table Type ~ [v] * SO Statement
Report
s * System Defined Yes/No () ves @ No = Collateral Type ALL ~
User
Organization
Companies ot 0
Access
Users. >
Credlt Burean User Defined Table Attributes e add | Ew <7 Audit
Correspondence View - Format~ [ 2= i Detach Wrap o)
‘\;”W‘ LR Aattribute Description Data Type Length Sort Operator 5‘;};: Ot Enabled Sub Attribute LOV Type
ueues
Printers No data ta display.
Bank Details >
Check Details
Standard Payee
Currencies
Zip Codes v
Products
< >

A brief description of the fields is given below:

Field

Do this:

Table

Specify the user-defined table name.

User Table Type

Select the user-defined table type from the drop-down list. This
determines where and how the related data is being used.
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Field

Do this:

Description

Specify the description for user-defined table.

System Defined
Yes/NO

Select ‘Yes', if you wish to maintain the User table type as system
defined and ‘No’, if you do not want to maintain it as system
defined. System defined entries cannot be modified. If the entry is
not system defined, then it can be modified.

Enabled

Check this box to enable the user-defined table (optional).

Product Type

Select the product typefrom the drop-down list.

Funding Type

Select the funding type associated with the user-defined table from
the drop-down list.

Collateral Type

Select the collateral type associated with the user-defined table
from the drop-down list.

View Name

Specify the view name.

SQL Statement

Specify the SQL version of the statement.

For Example: For SEARCH_ACC_ACCOUNTS table, the SQL is as
follows:

SELECT /*+ FIRST_ROWS */ ACC_AAD_ID FROM ACCOUNTS
WHERE

Note: For the above SQL, the where criteria is part of the User
Defined Table Attributes

Sort

Specify the sort order for the user-defined table relative to other
tables of the same type.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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4.

In the User Defined Table Attributes section, perform any of the Basic Operations

mentioned in Navigation chapter.

ORACLE" . . . 2 Welcome, PRAKRRAD v  Accessibility o
Financial Services Lending and Leasing
Close
e User Defined Tables 5, 3]
> Origination
T User Defined Tables Bl wew | o audit
rvicing
View » Format- [P Freeze £ Detach
7 Collections
e Table Usertable Type  Description Enabled Product Type Funding Type Collateral Type  View Name SQL Statement
> Tools SEARCH_WFP_PR.. SEARCH : WFP PR.. WFP PRODUCER 5. B AL AL ALL UNDEFINED SELECT /*+ FIR
= SEARCH_UPD_AC... SEARCH : POST D... POST DATED CHE... Y AL AL AL UNDEFINED SELECT /*+ FIR:
-2 DLR_TRACK_MAP_. MAPPING: INTERF... DLR_TRACK MAPP. Y AL AL ALL UNDEFINED SELECT 1 FROM
Se
;Z et A SEARCH_UBT_AD... SEARCH : ACCOU.. BATCH ENTRY AC. Y AL AL AL UNDEFINED SELECT /*+ FIR:
imiristration
System SEARCH_UBT_FEE... SEARCH : AOCOU... BATCH ENTRY AC Y AL AL ALL UNDEFINED SELECT /*+ FIR:
System Paramete SEARCH_UTA_TXN  SEARCH: TRANSA... TRANSACTION HI Y AL AL ALL UNDEFINED SELECT /*+ FIR
Lookups SEARCH_UBT_PM... SEARCH : ACCOU... BATCH ENTRY AC. ¥ AL AL AL UNDEFINED SELECT /*+ FIR
“Sef Defined Tat PE_D.. TABLE ATTRIBUT. EFICIENCY DETA Y ALL AL ALL UNDEFINED SELECT 1 FROM
A s UP  SETUP: APPLICAT... APPLICATION CO... ¥ AL AL AL UNDEFINED SELECT 1 FROM
User Defined Def v
Transacion Cocd SEARCH_ACC_AC.. SEARCH : ACCOUNT ACCOUNT SEARCH Y AL AL ALL UNDEFINED SELECT /*+ FIR
Data Files
Dedupe
Securitization
Events user Defined Table Attributes Hadd | FEd || Sl view | o audit
Batch Jabs * Veww Fomatv B Freeze EfiDetach | ol Wrap W
Producer Cycles
Vendors Aattribute Description Data Type Length Sort Operator i‘g:,;’: et Enabled Sub Attributs LOV Type
Collection Cydles
] ] Yes ® No
Reports
Error Messages PRO_NAME PRODUCER NAME CHARACTER 80 1 UKE ¥ NO LOV
Translations WPR_STATUS_CD PRODUCER STATUS  CHARACTER 30 2 LKE Y O LOV
User WPR_TOT_CREDIT L . TOTAL CREDIT LIMIT  NUMBER 30 3 EQUAL ¥ NO LOV
Organization < >
Companies
Access -
r— User Defined Table Attributes
Credit Bureau [ save and Add saveand Stay | [ Ssve and Retun || {3 Retum
Correspondence
General Ledger * Attribute * Operator [~ = LOV Validation Ind []
Queues O T JNo ) yee @ Lookup Type
A Description System Defined Yes/No O Yes®) No ke
Bank Details = Data Type [~] = Enabled (] Default Value
Check Details *Length 0 Sub Attribute
Standard Payees
*sort 0 LOV Type v
Currencies SHtG ® &
Zip Codes ol
Products
< mimiiam >

A brief description of the fields is given below:

Field

Do this:

Attribute

Specify the user-defined table attribute.

Description

Specify the description for the user-defined table attribute.

Data Type

Select the data type for the attribute (CHARACTER, NUMBER, or
DATE) from drop-down list.

Length

Specify the maximum length of the user-defined table attribute.

Sort

Specify the sort order of the user-defined table attribute. If the sort
order is changed it will only affect new instances of the User Defined
Table, and will not affect existing data.

Operator

Select the operator for the user-defined table attribute from the drop-
down list.

System
Defined Yes/No

Select ‘Yes', if you wish to maintain the User table attribute as system
defined and ‘No’, if you do not want to maintain it as system defined.

System defined entries cannot be modified. If the entry is not system

defined, then it can be modified.

Enabled

Check this box to enable the user-defined table attribute so that the
attribute will be considered when creating new instances of the User
Defined Table.

Sub Attribute

Specify the sub-attribute for the attribute (sub attributes are used to
associate related attributes).
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Field Do this:

LOV Type Select the list of value (LOV) type for the user-defined table attribute
from the drop-down list.

LOV Validation Check this box to enable LOV validation of the user-defined table
Ind attribute. This indicates whether the data must come from the LOV.

Lookup Types Specify the lookup type of the LOV associated with the user-defined
table attribute.

Default Value Specify the default value for the user-defined table attribute.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Audit Tables

The system allows you to track changes in the database during loan origination. This includes
the tracking of:

e Account status history
e Audit history of specified fields

The Audit Tables Setup screen records the tables and columns requiring an audit. the system
stores the following details for the fields you want to audit for changes:

e Current value in field

e New value field

e User who changed the field’s content

e Date and time when the value was changed

IMPORTANT: The system recommends that only a database administrator perform the
following steps.

To set up the Audit Tables

1. Click Setup > Setup > Administration > System > Audit Tables. The system displays
the Audit Tables screen. The details are grouped into two:

e Audit Tables
e Audit Columns
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2. Inthe Audit Tables section, perform any of the Basic Operations mentioned in Navigation

chapter.
ORACLE 2 Welcome, PRAKRRAD v  Accessibility o
Financial Services Lending and Leasing
TR Audit Tables » [ Close.
> Origination —
= Audit Tables [ Zedt || B view | o audi
T‘g Viewv Formate (B Freeze i Detach Wirap ) 8% Generate
FHL S Table Description Display Description  Display Column Reset RowID Enabled Primary Ky 1 Primary Key 2 Primary Key 3 Primary Key 4
> WP INDEX_RATES INDEX RATE DETA IRT_INDEX_TYPE . N ¥ IRT_INDEX_TYPE... IRT_START_DT
» Tools INSURANCES INSURANCES DET... INSURANCE TYPE  INS_INSURANCE_.. N Y INS_AAD_ID INS_ID A
1085 JOB DETALLS DESCRIPTION J0B_DESC N Y JOB_JBS_CODE JOB_CODE
Setup 0B BUCKETS ~ JOB BUCKET DET... I J8B.ID N ¥ 188D
Setup J0B_HOLIDAYS  JOB HOLIDAY DET... DESCRIPTION JBH_DESC N ¥ BHDT
i —— A J0B_SETS JOB SET DETAILS ~ DESCRIPTION JBS_DESC N Y JBS_CODE
System JOB_THREADS JOB THREAD DET.. CODE JBT_JOB_CODE N Y JBT_JBS_CODE JBT_JOB_CODE JBT_THREAD
System Paramets LOOKUPS LOOKUP DETAILS  DESCRIPTION LKC_DESC N ¥ LKC_IKT_TYPE  LKC_CODE
tokins LOOKUP_TYPES LOOKUP TYPE DE..  DESCRIPTION LKT_DESC N Y LKT_TYPE
Pl — MESSAGES MESSAGE DETAILS MSG_TEXT N Y MSG_CODE MSG_PTC_COMPA_ MSG_PCB_BRANCH MSG_SUPER_PR
Audit Tables < 2
User Defined Def
Transaction Cod Audit Tables
Data Files G Retum
Dedupe
Securitization Table INDEX_RATES Primary Key 2 IRT_START_DT
Description  INDEX RATE DETAILS Primary Key 3
Display Description TYPE Primary Key 4
B Display Column  IRT_INDEX_TYPE_CD Primary Key 5
e Primary Key 6 Primary Key 13
Callection Cydes
it Resat RowID _ Primary Key 7 Primary Key 14
Primary Key 1 IRT_INDEX_TYPE_CD Primary Key 8 Primary Key 15
Error Messages
e Audit Columns o | Peon || Elvew || o avi
Organization View~ Format~ (5 Frecze L Detach 1l wrap (o]
Companies Column Description Data Typs Enabled
Access No data to display
Users
Credit Bureau
Correspondence
General Ledger
Queues
Printers
Bank Details
Check Details
Standard Payees
Currencies
Zip Codes
Products
< >

A brief description of the fields is given below:

Field

Do this:

Table

The table name on which audit trigger needs to be
created is displayed here (the system table being
audited).

Description

Specify the table description.

Display Description

Specify the column description to be displayed on audit
screen.

Display Column

Select the table column to be displayed on audit screen
from the drop-down list.

Enabled

Check this box to enable the audit table so that it will be
considered while generating the database triggers.

Reset Row ID

Check this box to allow resetting the row identifier.

Primary Key 1 (unlabeled)

The table primary key column 1 is displayed here.
(These columns define how to access the data in the
table.)

Primary Key 2 (unlabeled)

The table primary key column 2 is displayed here.

Primary Key 3 (unlabeled)

The table primary key column 3 is displayed here.

Primary Key 4 (unlabeled)

The table primary key column 4 is displayed here.

Primary Key 5 (unlabeled)

Table primary key column 5 is displayed here .

2-14 ORACLE



2.5

Field Do this:

Primary Key 6 (unlabeled) Table primary key column 6 is displayed here.

Primary Key 7 (unlabeled) The table primary key column 7 is displayed here.

Primary Key 8 (unlabeled) The table primary key column 8 is displayed here.

Primary Key 9 (unlabeled) The table primary key column 9 is displayed here.

Primary Key 10 (unlabeled) | The table primary key column 10 is displayed here.

Primary Key 11 (unlabeled) The table primary key column 11 is displayed here.

Primary Key 12 (unlabeled) | The table primary key column 12 is displayed here.

Primary Key 13 (unlabeled) | The table primary key column 13 is displayed here.

Primary Key 14 (unlabeled) | The table primary key column 14 is displayed here.

Primary Key 15 (unlabeled) | The table primary key column 15 is displayed here.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Inthe Audit Tables Columns section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Column Specify the column name on which the audit needs to be created from
drop-down list (column in the table that is being audited)

Description Specify the column description (description of the data contained in the
column).

Data Type The data type for the attribute is displayed here.

Enabled Check this box to enable the audit column.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Transaction Codes

The system uses transaction codes to define the actions and tasks it can perform; for
example, activating an account, changing a due date, applying a late fee, and charging off an
account.

The Transaction Codes Setup screen catalogs and defines these core system actions.
The system organizes transaction codes in ‘Super Groups’. All transaction codes within a

particular super group are processed in a similar manner. The transaction super groups in the
system are as follows:

Super Group Type: Description:

ACCOUNT CONDITION TXN | These transaction codes control a user’s ability to
open and close account conditions.
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Super Group Type:

Description:

ACCOUNT MONETARY TXN

These transaction codes affect the monetary value of
accounts in the system; for example, activating accrual
of interest, the assessment of fees, and closing the
account.

ACCOUNT NON MONETARY | These transaction codes do not have a direct affect on

TXN the monetary value of the account, but are used in
maintaining account information. This includes chang-
ing a customer’s driving license, or adding information
for automated clearing house (ACH).

AMORTIZATION TXN These transaction codes affect the amortized balances
of the accounts in the system.

CORRESPONDENCES These transaction codes relate to the system corre-
spondences.

ESCROW ANALYSIS AND These transaction codes allow for reviewing and

DISBURSEMENTS approving escrow analysis, stopping an escrow over-
ride, and posting escrow disbursement.

ESCROW MONETARY These transaction codes affect the monetary value of

TRANSACTIONS escrow accounts in the system; for example, disburs-

ing escrow to a customer and insurance, and receiving
payment.

ESCROW NON MONETARY
TRANSACTIONS

These transaction codes do not have a direct affect on
the monetary value of an escrow account, but are used
in maintaining account information, such as changing
insurance maturity date and adding new escrow tax
details.

FEE ASSESSMENTS

These transaction codes determine if fees such as
nonsufficient funds fees or membership fees are to be
applied.

FUNDING TXN

These transaction codes affect the funding of applica-
tions and accounts within the system.

ITEMIZATION TXN

These transaction codes affect the itemization of appli-
cations and accounts within the system.

MENU TXN

These transaction codes affect the menus within the
system.

PRODUCER MONETARY TXN

These transaction codes relate to the monetary trans-
actions that apply to the the system producers (or
“dealers”).

REPORTS

These transaction codes are related to generating the
system reports.

SECURITIZATION TXN

These transaction codes affect the pools of securitized
loans or accounts within a pool of securitized loans.
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Super Group Type:

Description:

SETUP LOCK/UNLOCK

These transaction codes limit a user’s ability to change
the existing setup data, even if they are allowed
access to the form, by restricting access to the Lock/
Unlock Record icon on the the system tool bar.

Three sub screens, Transaction Parameters, Access Grid, and Transaction Product
Definition, record any additional information required to perform a transaction, the user types
that can perform the transaction, and the product type to which the transaction codes apply.

Note

The Software recommends that you restrict the access to the seed data once you are in

production.

To set up the Transaction Codes

1.

displays the Transaction Codes screen.

2.

ORACLE
Financial Services Lending and Leasing

Click Setup > Setup > Administration > System > Transaction Codes. The system

In Transaction Super Group section, you can view the following information

& Welcome, PRAKRRAO ~  Accessibility

S Transaction Codes
> Origination 3
- Transaction Super Group
» Servicing o
View  Formatv B Freeze ffi Detach &
> Collections
Super Group
> WFP ACCOUNT MONETARY TXN
> Tools ACCOUNT NON MONETARY TXN
AMORTIZATION TXN
Setup
Setup
Administration A Transaction Codes
System e T
View v Format = Freeze (i Detach
System Parameter & L @
Lookups Ton Code Description Group Action Monetary 3‘;;;’;‘ Detted
User Defined Tables
EADV ESCROW ADVANCE  ESCROW POST ¥
Audit Tables
User Defined Defaults EADV_AD]_MINUS ADJUSTMENT TO... ESCROW ADIUST MINUS v
Transaction Codes EADV_AD]_MINUS_ REV  REVERSE ADJUST.. ESCROW REVERSE Y
Data Files: EADV_AD]_PLUS ADJUSTMENT TO... ESCROW ADIUST PLUS ¥
Dedupe EADV_AD] PLUS REV ~ REVERSE ADJUST.. ESCROW REVERSE ¥
Securitization
. EADV_BILL ESCROW ADVANC... ESCROW BILL Y
§  EADV.BIL REV REVERSE ESCRO...  ESCROW REVERSE Y
Producer Cycles EADV_CHGOFF CHGOFF ESCROW... ESCROW CHARGE OFF/WRITE.. Y
Vendors <
Collection Cydles
Reports
Parameters | Access Grd | Froducts
Error Messages
Translations
User Transaction Parameters
Organization 2 2
View v Format = Freeze Detach ra
Companies & & 2 L
Actn Parameter code Defauit
Deere No data to display.
Credit Bureau
Comespondence
General Ledger
Queues
Printers
Bank Details
Check Details
Standard Payees
Currencies
Zip Codes
Products o
Asset Types

[ Close
~
v
Fpadd | Zede | [Fview || o aude
Enabled Txn/Bal Type Statement Txn Type Batch
R 7 ESCROW ADVANCE ESCROW ADVANCE N
Y ESCROW ADVANCE ADIUSTMENT TO ESCROW. N 2
Y ESCROW ADVANCE REVERSE ADJUSTMENT TO. N
¥ ESCROW ADVANCE ADIUSTMENT TO ESCROW__. N
Y ESCROW ADVANCE REVERSE ADJUSTMENT TO. N
Y ESCROW ADVANCE ESCROW ADVANCE BILLED N
Y ESCROW ADVANCE REVERSE ESCROW ADVANC... N ¥
Y ESCROW ADVANCE CHGOFF ESCROW ADVANCE N
>
dpadd || Zedt || Elvew | o audic
Sort Displayed? Yes/No Required? Yes/No

A brief description of the fields is given below:

Field Do this:

Super Group
Codes screen.

Select the Super Group you want to work with in the Transaction

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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4. Inthe Transaction Codes section, perform any of the Basic Operations mentioned in

Navigation chapter

ORACLE" . . 2 Welcome, PRAKRRAO »  Accessibility o
Financial Services Lending and Leasing
i Close:
DashBoard Transaction Codes [@d
» Origination )
~ Transaction Super Group A~
> Servicing 7
View v Format~ [ Fresze i Detach irap ®
» Collections
Super Group
> WEP ACCOUNT MONETARY TXN ~
> Tools ACCOUNT NON MONETARY TXN v
AMORTIZATION TXN
Setup
Setup
Administration A Transaction Codes dradd | AE 5w 2 hud
Sysem View~ Format | Fresze A Detach Wi
System Paramets & s i D | @
Lookups [v] 52
Ueer Defier Tl Txn Code Description Group Action Monetary f,"“im Defmed | o T Bal Tjpe Statement T Type Batch M
Audit Tables esfNo
User Defined Def N Yes® Noo N N N
4 ~
Transaction Code ESCROW ADVANCE ESCROW POST Y Y ESCROW ADVANCE ESCROW ADVANCE NN
Dat; Files ADIUSTMENT TO.. ESCROW ADIUST MINUS ¥ ¥ ESCROW ADVANCE ADIUSTMENT TOESCROW.. N ¥
D
ri::: s REVERSE ADJUST... ESCROW REVERSE ¥ Y ESCROW ADVANCE REVERSE ADIUSTMENTTO.. N ¥
ADIUSTMENT TO... ESCROW ADIUST PLUS Y Y ESCROW ADVANCE ADJUSTMENT TOESCROW... N Y
‘< REVERSE ADJUST... ESCROW REVERSE ¥ Yes® No Y ESCROW ADVANCE REVERSE ADJUSTMENT TO. N Y
ESCROW ADVANC... ESCROW BILL ¥ o Y ESCROW ADVANCE ESCROW ADVANCEBILLED N N,
EADV_BILL_REV REVERSE ESCRO... ESCROW REVERSE Y ESCROW ADVANCE REVERSE ESCROW ADVANC.. N N
Collection Cycles
Reports
Error Messages
Translations Transaction Codes
User System [ save and add || [ Save and Stay || [ Save and Retum || {aRetum
Organization Indicator
Companies T + System Defi *Manual (]
fecess *Statement Print []
. . Statement P
Users Descrintiony = Enabled [] e
:}edlt Bureau * Group v I )] GL
Correspondence e =
Genersl Ledger Lol ¥+ spatement T Type -
Queuss *monetary [ P—
Printers
Bank Details Parameters | AccessGnd | Products
Cherk Details
ftj::::;ayees Transaction Parameters Fradd | A Edit w 87 Audit
Zip Cades Vieww Formatv P Freeze i Detach rap (e
Products Paramater code Default Sort Displayed? Yes/No Required? Yes/No
< mmimmii - No data to display.

A brief description of the fields is given below:

Field

Do this:

Txn Code

Specify the transaction code (required).

Description

Specify the description for the transaction.

Group

Select the transaction group (the group within the Transaction Super
Group that the transaction code belongs to) from the drop-down list.

Action Select the action type code for the transaction (what action will take
place when the transaction occurs) from the drop-down list.
Monetary Check this box to maintain the transaction as a monetary transaction. If

unchecked, then the transaction is nonmonetary.

System
Defined Yes/
No

Select ‘Yes’, if you wish to maintain the transaction code as system
defined and ‘No’, if you do not want to maintain it as system defined.
System defined entries cannot be modified. If entry is not system
defined, then it can be modified.

Enabled

Check this box to enable the transaction.

Txn/Bal Type

Select the transaction / balance type affected by the Transaction from
the drop-down list.

Statement
Txn Type

Select the statement transaction type (how the transaction should
appear on the customer statement) from the drop-down list.

Batch

Check this box to perform the transaction in a batch process.
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Field Do this:

Manual Check this box, if the transaction is a manual transaction. If you define a
transaction as manual, the system recommends that the transaction
that reverses it also be defined as manual.

Stmt Print Check this box to print the transaction on customer statements.

GL Check this box, if the transaction is a general ledger transaction.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

251 Transaction Codes sub screens

The Transaction Codes screen contains three sub screens:

e Parameters

e Access Grid

e Products

Note

Please contact your System Administrator / Implementation Manager before making any
changes in these sub screens.

2.5.1.1 Parameters

Here, you can define the parameter information for the associated transaction.

Note

Treat the Transaction Parameters sub screen as containing view-only information. This is
very sensitive data and you should not change it without consulting Oracle Financial Ser-
vices Lending and Leasing.

To set up the Parameters

1. Click Setup > Setup > Administration > System > Transaction Codes > Parameters.

2. Inthe Transaction Parameters section, perform any of the Basic Operations mentioned
in Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Parameter Select the parameter code associated with the transaction code, from

Code the drop-down list.

Default Specify the default value for the transaction parameter (value to initially
populate, or used if no value is supplied).

Sort Specify the sort order for the transaction parameter.

Displayed? Select ‘Yes’ to display the parameter and ‘No’ if you do not want to

Yes/No display in current use.
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Field Do this:

Required? Select ‘Yes’ if the parameter is required and ‘No’ if you do not require the
Yes/No parameter. (You must select Required as empty values are not allowed.)

3. Perform any of the Basic Actions mentioned in Navigation chapter.
Access Grid

The Access Grid sub screen allows you to control access to each transaction according to
user responsibility, account status, and account condition. It allows the administrator to
control when these transactions may be conducted. Normally, you would create or modify the
access based on either the user responsibility or account condition. Account status access is
left unchanged.

To set up the Access Grid sub screen

1. Click Setup > Setup > Administration > System > Transaction Codes > Access Grid.

2. Inthe Transaction User Access Definition section, perform any of the Basic Operations
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Access Type | Select the access grid function type (ACCOUNT CONDITION AND
ACCOUNT STATUS) that is being used to control the creation of the
associated transaction, from the drop-down list.

Access Select the access function grid value from the drop-down list (based on a
Value lookup associated with the Access Type. Multiple entries for each access
type may be created as long as each has a different access value).

Allowed? Select ‘Yes' if the access is allowed and ‘No’ if the access is not allowed
Yes/No (indicates whether the current Access Type / Access Value may create
the associated transaction).

System Select ‘Yes’, if you wish to maintain access type as system defined and

Defined Yes/ | ‘No’, if you do not want to maintain it as system defined. System defined

No entries cannot be modified. If entry is not system defined, then it can be
modified.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.5.1.3 Products

The Products sub screen allows you to define the products to which the transaction codes
apply. It allows the administrator to control if the associated transaction code will be available
for use for specific product types and or funding types.

Normally, an Access Value of ALL is defined for one or more Access Types with a given

Allowed value. Additional Access Values are then defined for the same Access Types with the
opposite Allowed value. This controls access to the associated transaction.

To set up the Products sub screen

1. Click Setup > Setup > Administration > System > Transaction Codes > Products.
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2.6.1

2.6.1.1

2. Inthe Transaction Product Definition section, perform any of the Basic Operations
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Product Type Select the product type associated with the transaction code from
the drop-down list.

Funding Type Select the funding type associated with the transaction code from
the drop-down list.

Allowed? Yes/No | Select ‘Yes’ if the transaction is allowed and ‘No’ if the transaction is
not allowed (indicates whether the current Access Type / Access
Value may create the associated transaction).

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Data Files

The Data Files Setup screen organizes information pertaining to the various input/output data
files that the system can generate. The system uses the Data Files Setup screen to outline
the file layouts of each data file produced/received within the system, including the length and
data type of each column name.

These files are typically produced during the nightly process.
One major advantage for the system-defined data files is the format mask of each column
name within each data file. A format mask is like a stencil that forces data input to be of the

same format before accepting the data.

You can change the order in which the fields are displayed in the file.

Note

Any addition or removal of a field or change in the data type length requires the Software
involvement.

Data Files screen consists of the following two tabs:

e Output
e Input

Output tab

The Output tab in the Data Files screen allows you to define the structure of output data file
through the following sections:

e Data File Definitions
e Record Definitions
e Column Definitions

Data File Definitions

The Data File Definitions section defines specific data files. Each is associated with a specific
Output Data Definition (ODD) batch job that gathers the data that the file will contain. While
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new data file definitions may be created they will have no use unless a batch job is also
created to populate the data.

To set up Data File Definitions

1. Click Setup > Setup > Administration > System > Data Files > Outpout tab.

2. Inthe Data Files Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE 1 Welcome, ABSHEKAR Accessbiity 1@ Sonout &
Financial Services Lending and Leasing

@8 Barkuptcy x || Data Files x [3€] Close
Output | Irput.

* DashBoard

- 4 Add # Edit View o Audit
> Origination Data File Definitions & Z & ERL o
o Sexticing View + Format ~ [ Freeze EliDetach | o Wrap 5]
%BANKO% o
? Collections ¢ =
= Name Description File Name Directory Path System Defined Yes/ho
MR UNDEFINED s O]
Ve BANKO_INTERFACE LMY BANKO INTERFACE L _banko_output_S(COMPANY_CODE... UNDEFINED
Setup
Setup
Administration Data File Definitions
System L [ save an dadd || [ saveandstay || [ seveandRetum || GaRetn
System Parameter B
Lot *Name * Directory Path | UNDEFINED
User Defined Tables " 3
- System Defined Yeso () Yes(® No
Audit Tables st e P
User Defined Defaults *File tame s Bl
Transaction Codes
Record Definitions o Add & A
vien > Formatv Freere L Detach tirap 50

Record Type Desaription Record Format. Delimiter Terminator
No data to display.

Column Definitions ok add || 7 Edit
View v Formatv [ Freeze i Detach Wrap @
Seq Column Name Data Type Format Mask Length Data Coumn  Output Column
No data to display.

A brief description of the fields is given below:

Field Do this:

Name Specify data file type (name of data file definition).

Description Specify data file description.

File Name Specify data file name. Prefix used for files generated for this Data

File. This is the only field on the Data File Definitions screen that can
or should be modified by your Administrator. The generated file name
will be in the form of <FILE NAME> <COMPANY ID> <BRANCH
ID> <MMDDYYYY> <PROCESS ID>.DAT. The inclusion of
_<COMPANY ID>and <BRANCH ID> depends entirely on the
associated batch process.

Directory Path Specify the directory path.

System Defined | Select ‘Yes', if you wish to maintain the data file definition as system
Yes/No defined and ‘No’, if you do not want to maintain it as system defined.
System defined entries cannot be modified. If the entry is not system
defined, then it can be modified.

Enabled Check this box to enable the data file definition.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.6.1.2 Record Definitions

Each data file definition is made up of one or more record definitions. These define
organization of the data. The associated batch file determines how these records are used.
The order in which the data is populated determines the order in which those records will
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appear in the output file. This is generally related to the order the records appear in the Data
File Definition section.

1. In the Record Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field

Do this:

Record Type

Specify the type of record being defined.

Description

Specify record description.

Record Format

Select the format of output data (FIXED, VARIABLE) from the drop-

down list.

Delimiter Specify the delimiter (column separator used with VARIABLE
format).

Terminator Select the record terminator code (how the end of each record is

CARRIAGE RETURN AND LINE FEED) from the drop-down list.

indicated within the file -- CARRIAGE RETURN, LINE FEED, or

2. Perform any of the Basic Actions mentioned in Navigation chapter.

Column Definitions

Each record definition is made up of one or more column definitions. These define the output
of the data. Much of this data is informational; it indicates what data is being provided by the
associated batch job. Unless otherwise noted, the data should not be changed without
changing the associated batch job.

1. In the Column Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field

Do this:

Seq

Specify the order in which the output data dump will process the
column information.

Column Name

Specify name/description of the column (informational only).

Data Type

Specify the data type. This describes the type of data the column is
expected to contain (CHARACTER, DATE, or NUMBER). This effects
how the ODD process handles the data, and should not be changed

Format Mask

Select the format mask for the column from the drop-down list. For
DATE or NUMBER columns, this field defines the output format of
the data. For example; Date fields may be entered using the MM/DD/
YYYY format, Number fields may be entered as decimal numbers
with varying degrees of precision. Other formats for each data type
are available.
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Field Do this:

Length Specify the column length (the maximum number of characters of the
output data to be included in the output file). Each output data details
column may contain up to 240 characters of data. If the output data
details column contains more data than the length value the data will
be truncated. For VARIABLE records the length should be set to “-1”
or a Delimited file will be created with FIXED LENGTH columns.

Data Column Specify the data column sequence. This is the column that will be
used to select the data that is being output. This should not be
changed.

Output Column Specify the output column sequence. This is the column that will
appear in Output File. The Output Data Dump process allows for the
output of 250 columns of data per record. No output column should
be repeated in the setup for a record.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

Input tab

Oracle Financial Services Lending and Leasing facilitates processing of a input data file
received from external interface into the system through an automated batch job
(IDDPRC_BJ_000_01) triggered on regular intervals.

The Input tab in the Data Files screen allows you to define the input data file through the
following sections:

e Input Data File Definitions
e Column Definitions

Input Data File Definitions

In the Input Data File Definitions section, you can define and maintain the structure of input
data file to populate data from external system.

To set up Input Data File Definitions

1. Click Setup > Setup > Administration > System > Data Files > Input tab.

2. In the Input Data Files Definitions section, perform any of the Basic Operations
mentioned in Navigation chapter.

ORACLE i # Welcome, ABSHEKAR ~  Accessbilty i Sgnout &
Financial Services Lending and Leasing

§@ Barkriptty x  Data Files [ Close
Cutput | Tnput

> DashBoard
* Origination Input Data File Definitions o add || 2 Edit ] Yiew o Audit
view v Format v [ Freeze g Detach Vrap ®

> Servicing
> Collections

Name Description Directory Path Delmiter RecordFormat
Y
> WFP BANKO_NEW NEW BANKO FILE BN ! VARIABLE Y
~ Tools BANKO_UPDATE UPDATE BANKO FILE BU : VARIABLE Y
CURE_LTR CURE LETTER UPLOAD 1 ; VARIABLE Y
Setup
Setup
Administration
System
System Parameter

4 Input Data File Definitions
£ Saveand Add | [ Save an dstay | [ SaveandRetun | CaRetun

ke * Name * Delimiter

User Defined Tables * Description Record Format VARIABLE
Audit Tables *Directory Path * Enabled [¢]
User Defined Defaults
Transaction Cades - — e - —
Column Definitions 4 add | 7 Edit | Yiew || o Audit
Data Fies ~

o View = Format v [ Freeze i Detach wrap @

Sl Seq Column Name Column Description DataType  FormatMask  Length Sort Enabled

- No data to display.

Batch Jobs
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A brief description of the fields is given below:

Field Do this:
Name Specify a unique name for the input data file.
Description Specify data file description.

Directory Path Specify the directory path configured within OFSLL Database server
to process the input data file.

Delimiter Specify the delimiter used to separate column data. (Ex: Comma).

Record Format | System defaults the record format as ‘VARIABLE'.

Enabled Check this box to enable the input data file definition.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.6.2.2 Column Definitions

Each input data file definition is made up of one or more column definitions. These define the
structure of data to be loaded from external system.

1. In the Column Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Seq Specify the order in which the input data dump will process the
column information.

Column Name Specify name of the column.

Column Specify description of the column.

Description

Data Type Select the data type from the drop-down list. The selected data type

describes the type of data the column is expected to contain such as
INTEGER/DATE/NUMBER/CHARACTER. This effects how the input
data file processing handles the data, and should not be changed.

Format Mask Select the format mask for the column from the drop-down list. The
list displays the format depending on the Data Type selected.

For example; Date fields may be entered using the MM/DD/YYYY
format, Number fields may be entered as decimal numbers with
varying degrees of precision. Other formats for each data type are
available.

Length Specify the column length (the maximum number of characters of the
data to be included in the input file).

Each input data details column may contain up to 240 characters of
data. If the output data details column contains more data than the
length value the data will be truncated. For VARTABLE records the
length should be set to “-1” or a Delimited file will be created with
FIXED LENGTH columns.
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Field Do this:

Sort Specify the order in which the column definitions are to be sorted for
display in the external interface screen (Customer Service > External
Interfaces). There can be a maximum of 61 column definitions.

Enabled Default selected. If not, you can check this box to enable the column
definition.

2. Perform any of the Basic Actions mentioned in Navigation chapter.
Events

During account processing, when an account moves from one status/sub status to another,
or changes condition, the system can trigger an event and perform the associated event
actions. This can occur either online or in batch mode.

Note

Only predefined events and actions can be set up on the Events Setup screen. You cannot
create new event types or action types.

As processing events and associated actions require additional processing at the server level,
the performance of the transactions, for which the events are setup, may be adversely
affected dependent upon your specific configuration.

Events

In the Events screen you can setup “trigger events” with associated actions which the system
performs during account processing. The fields on this form are both system and user
defined. There are four sub screens on the Events screen to set up and maintain these
events:

e Events Types

e Event Action Types
e Online

e Batch

Event Types and Action Types sections of this screen provide a master table for setting up
the online and batch events. This setup triggers the event, which in turn triggers the actions
associated with the events, during account processing.

Navigating to Events

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Events.

Event Types

1. Click Setup > Setup > Administration > System > Events > Lease > Events Types.
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2. Inthe Events Type section, perform any of the Basic Operations mentioned in Navigation

ORACLE’
Financial Services Lending and Leasing
Events [® lose
» DashBoard il
» Origination loan Lz Lease
» Servicing Event Types | EventActonTypes | Ornlne | Batch
»» Collections
> WFP Event Types G add | AEdt | EVen | < Audt
7 Tools View ~ Formatv 5 Freeze gl Detach Wrap (5]
Setup EventType Code  Description Process Type Entity Type Engine Type Enzbled Sys
EVEDL ACCOUNT LEVEL BATCH EVENT #01 BATCH ACCOUNTS MONETRARY TRANSACTIONS PROCESSING v ) -
Setuy =
© AZrmmstl aten EVEDL APPLICATION LEVEL BATCH EVENT #01 BATCH APPLICATIONS  CREDIT BUREAU PROCESSING ¥ E
System EVED2 ACCOUNT LEVEL BATCH EVENT #02 BATCH ACCOUNTS MONETRARY TRANSACTIONS PROCESSING Y i
System Parameter EVED2 APPLICATION LEVEL BATCH EVENT #02 BATCH APPLICATIONS  CORRESPONDENCE ¥
Lookups EVEO3 ACCOUNT LEVEL BATCH EVENT #03 BATCH ACCOUNTS CONDITION/ASSIGNVENT PROCESSING v
User Defined Tables EVED3 APPLICATION LEVEL BATCH EVENT #03 BATCH APPLICATIONS  APPLICATION STATUS CHANGE ¥
Avdit Tables EVEO4 ACCOUNT LEVEL BATCH EVENT #04 BATCH ACCOUNTS CCONDITION/ASSIGNMENT PROCESSING v
User Defined Defaults
EVED4 APPLICATION LEVEL BATCH EVENT #04 BATCH APPLICATIONS Y
Transacton Codes |2
Data Flles EVEDS ACCOUNT LEVEL BATCH EVENT 05 BATCH ACCOUNTS CONDITION/ASSIGNVENT PROCESSING ¥
Dedupe EVEDS APPLICATION LEVEL BATCH EVENT #05 BATCH APPLICATIONS v -
Securitization b L T ] )
Events
Batch Job:
W Event Types
Producer Cydes
gk e saveand Stay | [ save andRetun | CaRetwmn
Collection Cydes : )
Reports Event Type Code EVEDL Entity Type ACCOUNTS System Defined @) Yes ) No
Error Messages * Description ACCOUNT LEVEL BATCH EVENT #01 Engine Type  MONETRARY TRANSACTIONS PROCESSING
Translations Process Type BATCH % Enabled ¥
User
Orgarization
Comparies
Access
Users
Credit Bureau
Correspondence
General Ledger
Queues
Printers
Bark Details
Check Details
Standard Payees
Currendes 5

A brief description of the fields is given below:

Field: Do this:

Event Type Code Specify the event type code.

Description Specify the event description.

Process Type Specify the process type (BATCH or ONLINE) from the drop-
down list.

Entity Type Specify the entity type (ACCOUNTS or APPLICATIONS) from
the drop-down list.

Engine Type Specify the engine type (MONETARY TRANSACTIONS PRO-
CESSING, NON-MONETARY TRANSACTION PROCESSING,
CONDITION/ASSIGNMENT PROCESSING, APPLICATION STA-
TUS CHANGE, CREDIT BUREAU PROCESSING, LETTERS
PROCESSING or CORRESPONDENCE) from the drop-down list.

Enabled Check this box to activate the event type.

System Defined Select ‘Yes’ to indicate that the event type is system define.
Select ‘No’ to indicate that the event type is user defined.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.7.1.2 Event Action Type

The Event Action Types section is system defined and lists the action codes supported in
the system.
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Types.

Click Setup > Setup > Administration > System > Events > Lease > Event Action

In the Events Action Types section, perform any of the Basic Operations mentioned in

Navigation chapter.

Financial Services Lending and Leasing
> DashBoard il
> Origination loan |Line  Lease
2 Servicing EventTypes  EventAction Types Cnine  Batch
» Collections
> WFP Event Action Types
S Tooks View v Formatw B Freeze EfiDetach | o Wirap e}
e Action Code Description Process Type Entity Type
POST_CONDITION_TRANSACTION_ACC_ONLINE ~ POST CONDITION TRANSACTION ONLINE ACCOUNTS
Setuy -
- Azmmm - POST_MONETARY_TRANSACTION_ACC_ONLINE  POST MONETARY TRANSACTION ONLINE ACCOUNTS
System POST_NON_MONETARY_TRANSACTION_ACC_ON... POST NON MONETARY TRANSACTION ONLINE ACCOUNTS
System Parameter SEND_CRB_REQ_ACC_ONLINE SEND CREDIT BUREAL REQUEST ONLINE ACCOUNTS
Lookups SEND_CRB_REQ_APP_ONLINE SEND CREDIT BLREAU REQUEST ONLINE APPLICATIONS
User Defined Tables SEND_LETTER_ACC_BATCH SEND LETTER BATCH ACCOUNTS
B vebies SEND_LETTER_ACC_ONLINE SEND LETTER ONLINE ACCOUNTS
User Defined Defaults
SEND_LETTER_APP_BATCH SEND LETTER BATCH APPLICATIONS
Transacton Codes |z
Data Files SEND_LETTER_APP_ONLINE SEND LETTER. ONLINE APPLICATIONS
Dedupe 4 I
Securitization Columns Hidden 1
ety Event Action T
Batch Jobs e
Producer Cydes
Vendors
Coliection Cyces Action Code POST_CONDITION_TRANSACTION_ACC_ONLINE Entity Type ACCOUNTS
F— * Description | POST CONDITION TRANSACTION Engine Type  CONDITION/ASSIGNVENT PROCESSING
Error Messages Process OMLINE Enabled ¥
Translations Type
User
Organization
Companies
Access
Users
Credit Bureau
Correspondence
General Ledger
Queues
Printers
Bank Details
Check Detals
Standard Payess

Currencies

o Add

Engine Type

CONDITION [ASSIGNMENT PROCESSING
MONETRARY TRANSACTIONS PROCESSING
NON-MONETRAY TRANSACTION PROCESSING
CREDIT BUREAL PROCESSING

CREDIT BLREAU PROCESSING

LETTERS PROCESSING
LETTERS PROCESSING
LETTERS PROCESSING
LETTERS PROCESSING

[ saveandstay | [ saveandRetum | {aRetum

System Defined @ Tes ) No

[ Close.

AEdt | Huew | L a

Enabled

¥

v

v

v

v

v

v

v

v

A brief description of the fields is given below:

Field:

Do this:

Action Code

Specify the action code.

Description

Specify the action description.

Process Type

down list.

Select the process type (BATCH or ONLINE) from the drop-

Entity Type

Select the entity type from the drop-down list.

Engine Type

Select the engine type from the drop-down list.

Enabled

Check this box to activate the action.

System Defined

Select ‘Yes'’ to indicate that the event type is system define.
Select ‘No’ to indicate that the event type is user defined.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Online

The Online screen allows you to set up the online events by defining all online events and the
event criteria actions. The system supports the following online events:

1.

e Account status of ACTIVE is reversed

e Account status is changed to PAID
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Account status change to PAID is reversed
Account status is changed to CHARGE OFF
Account status change to CHARGE OFF is reversed.

2. The opening or closing of an accounts conditions. The system processes the event’s

actions when the:

Account condition DELINQUENT is opened

Account condition DELINQUENT is closed

CHG OFF Reversal

Paid Off Reversal

BKRP is closed

BKRP Is Opened

When Queue is Closed

When status/ Sub status changed to 'Approved- Rehashed'
Account condition SCHG is closed

Account condition SCHG is Opened

3. The posting of a non-monetary transaction to the account.

The events that can be performed online after each of the events listed above are as follows:

Send correspondence for an account
Generate correspondence for an account
Send a credit bureau request for an account
Post a monetary transaction for an account
Post a condition transaction for an account

To setup Online Event

1.

Click Setup > Setup > Administration > System > Events > Lease > Online.
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2. In the Events section, perform any of the Basic Operations mentioned in Navigation
chapter.

ORACLE’ 3 | APKELKAR ~
Financial Services Lending and Leasing

> DashBoard i o

> Origination Loan | Line | Lease

 Servicing Event Types || Event Action Types || Onfine | Batch
> Collections
> WFP Events qeadd | AEdt | [FVew | o Audt

> Tools View = Format~ | & Freeze i Detach Virap [53]
setup Event Code Event Type Frequency Synchronous Enabled
EVE_TCN_ONLINE_OPEN_SCHGOFF ALWAYS 8 2
setup o TEST DAILY N N
Administration o i ] '
System
System Parameter
(bl Events
User Defined Tables [ saveandstay | [ saveandRetum | (aRetum
Audit Tables N
User Defined Defaults Event Code EVE_TCN_ONLINE_OPEN_SCHGOFF * Synchronous [F]
Transaction Codes = * Event Type EVENT TO PROCESS ACTIONS WHEN=] *Enabled [¥]
Data Files
Dedupe
Securitization
Events Event Criteria dp add | A Edit | view || o Audit
Baich Jobs View Format+ | B Freeze {fiDetach wep | @) o Chedkcrieria
Producer Cydes
Query Name: Description Enabled

Vendors
EVE_TCN_ONLINE_CO1 EVE_TCN_ONLINE_CO1 ¥
Collection Cydles R — I a

Reports
Error Messages Criteria Details | Action
Translations

*Frequency ALWAYS [=]

User
o Criteria shadd || FEdt | [Huew || o Audt
Companies View~ Formatv Freeze G Detach Wirap 5]

Access Seq ( Parameter Comparison Operator Criteria Value ) Logical Expression  Enabled
Users 1 PRODUCT CODE EQUAL LOAN-VE

Credit Bureau 2 ACCOUNT STATUS EQUAL OPEN v

Correspondence

General Ledger

Queues

Frinters

Bank Detais

Check Detals

Standard Payees

Currencies

A brief description of the fields is given below:

Field: Do this:

Event Code Specify the event code.

Event Type Specify the event type from the drop-down list.

Frequency Specify the event frequency from the drop-down list.

Synchronous | Check this box to set the event as synchronous (any failure in trigger-
ing the event will fail to trigger the entire transaction). If unchecked,
then the event is asynchronous (any failure in the event will not affect
the transaction, which will be successfully completed).

Enabled Check this box to activate the event type.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
The Event Criteria section allows you to name and describe the query for an event, as well
as enable or disable the query.

4. In the Event Criteria section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Query Name | Specify the query name.

Description Specify the query description.
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Field: Do this:

Enabled Check this box to activate the event criteria.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Criteria Details

The Criteria Details sub screen allows you to define the selection criteria for the event. The
event engine uses these criteria to determine which account to include in the event action.

6. Inthe Setup > Setup > Administration > System > Events > Lease > Online > Criteria
section, you can define the event selection criteria. Perform any of the Basic Operations
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Seq Specify sequence numbers.

( Specify left bracket.

Parameter Select the parameter from the drop-down list.

Comparison Operator | Select comparison operator from the drop-down list.

Criteria Value Specify criteria value.
) Specify right bracket.
Logical Expression Specify logical operator from the drop-down list.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

Actions

The Actions section records the actions the system performs after the event is triggered.
8. Inthe Setup > Setup > Administration > System > Events > Lease > Online > Action
section, define the action you want the system to perform for the event by entering the

following information. (You can set up more than one event action for a particular event,
then use the Seq field to define the order in which the events will occur)

A brief description of the fields is given below:

Field: Do this:

Description Select the event action description from the drop-down list.
Seq specify sequence number.

Enabled Check this box to activate the event action.

9. Perform any of the Basic Actions mentioned in Navigation chapter.

10. For each event action, use the Action Parameters section to set up the required action
parameters and values. Perform any of the Basic Operations mentioned in Navigation
chapter.
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A brief description of the fields is given below:

Field: Do this:

Description Specify the parameter description from the drop-down list.

Value Specify parameter value.

11. Perform any of the Basic Actions mentioned in Navigation chapter.
Batch

The Batch screen allows you to set up the events performed as a batch transaction by the
system. The system supports the following predefined batch events for account processing.
(These batch events are listed in the Events Types section on the Setup screen):

e ACCOUNT LEVEL BATCH EVENT #01
e ACCOUNT LEVEL BATCH EVENT #02
e ACCOUNT LEVEL BATCH EVENT #03
e ACCOUNT LEVEL BATCH EVENT #04
e ACCOUNT LEVEL BATCH EVENT #05
e ACCOUNT LEVEL BATCH EVENT #06
e ACCOUNT LEVEL BATCH EVENT #07
e ACCOUNT LEVEL BATCH EVENT #08
e ACCOUNT LEVEL BATCH EVENT #09
e ACCOUNT LEVEL BATCH EVENT #10

To setup the Batch Event
1. Click Setup > Setup > Administration > System > Events > Lease > Batch.

2. In the Events section, perform any of the Basic Operations mentioned in Navigation
chapter.

ORACLE' & Welcome, APKELKAR ¥ Accessibiity o
Financial Services Lending and Leasing

Close
> DashBoard Events s e

> Origination Loan | Line || Lease:

> Servicing Event Types || Event Action Types || Online | Batch

> Collections
> WP Events dpadd | ZEdt || E]vew || o Audt
> Tools View v Format > | Fee pHendh | dwer | @)

Setup Event Code Event Type Frequency Synchronous Enabled
TESTS ALWAYS N N
Setup -
Administration

System

System Parameter Event Criteria qpadd | AEdt | B vew | o it

View = Format v | Freeze pliDetach o wrap T o Chedkcriteria

Query Name: Description Enabled

TESTS TESTS N
Criteria Details  Action
Criteria Apadd | AEdt | Fven | o Auit

View v Formatv [ eeze fiDetach 5]

Seq ( Parameter Comparison Operator Criteria Value ) Logical Expression  Enabled
0 SECURED ACCOUNT EQUAL TEST v
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A brief description of the fields is given below:

Field: Do this:

Event Code Specify the event code.

Event Type Specify the event type from the drop-down list.

Frequency Specify the event frequency from the drop-down list.

Synchronous | Check this box to set the event as synchronous (any failure in triggering

the event will fail to trigger the entire transaction). If unchecked, then the
event is asynchronous (any failure in the event will not affect the transac-
tion, which will be successfully completed).

Enabled Check this box to activate the event type.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
The Events Criteria section allows you to name and describe the query for an event, as well
as enable or disable the query.

4. In the Events Criteria section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Query Name | Specify the query name.

Description Specify the query description.

Enabled Check this box to activate the event criteria.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Criteria Details
The Criteria Details sub screen allows you to define the selection criteria for the event. The
event engine uses these criteria to determine which account to include in the event action.

6. Inthe click Setup > Setup > Administration > System > Events > Lease > Batch >
Criteria section, you can define the event selection criteria. Perform any of the Basic
Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Seq Specify sequence numbers.

( Specify left bracket.

Parameter Select the parameter from the drop-down list.
Comparison Operator Select comparison operator from the drop-down list.
Criteria Value Specify criteria value.

) Specify right bracket.
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Field: Do this:

Logical Expression Specify logical operator from the drop-down list.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

Action

The Action sub screen allows you to define the actions performed in the batch event. The
system supports the following batch event actions:

e Send letter for an account
e Generate correspondence for an account
8. Click Setup > Setup > Administration > System > Events > Lease > Batch > Action.

9. Inthe Actions section, define the action you want the system to perform for the event by
entering the following information. (You can set up more than one event action for a
particular event, then use the Seq field to define the order in which the events will occur.)
Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Description Select the event action from the drop-down list.
Seq Specify sequence numbers (required).
Enabled Check this box to activate the event action.

10. Perform any of the Basic Actions mentioned in Navigation chapter.

11. For each event action, use the Action Parameters section to set up the required action
parameters and values. Perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:
Description Select the event action from the drop-down list.
Value Specify sequence numbers (required).

12. Perform any of the Basic Actions mentioned in Navigation chapter.

Monitoring Events

You can verify the status of events and event actions on the Monitor Jobs screen of the
Utilities form.
To monitor events

1. On the Oracle Financial Services Lending and Leasing home screen, clickDashboard >
Dashboard > System Monitor > Jobs > Back Ground.

The system displays the status for all asynchronous events that have been completed
or failed for an account.

For further details, on monitoring events refer Dashboard Chapter of this Guide.
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2.8

2.8.1

2.8.11

Batch Jobs

“Batch jobs” refer to the back-end processes that automatically run at a certain time. There
are two types of batch jobs:

e Business processes (such as billing and delinquency processing)
e Housekeeping tasks (such as application aging and application purging)

Batch Jobs

The Batch Job screen allows you to set up, monitor, and maintain batch jobs in the system.

Batch jobs can be set up to be performed on a daily, weekly, monthly, and ad-hoc basis. Batch
jobs can also be configured to trigger an e-mail or phone message if a batch job fails.

Critical batch jobs control job flow and system date rollover to allow recovery during errors.
Errors are instances where a process did not successfully complete. Failures indicate that a
particular job encountered errors that require remedial action. The number of errors allowed
before failure is defined for each job. Some errors automatically result in a failure.

Navigating to Batch Jobs:

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > System > Batch Jobs. The Batch Jobs details are further grouped
into two tabs:

e Batch Jobs tab
e Job Holidays tab

Batch Jobs

In the Batch Job Setup screen, you can track and maintain all batch processes within the
system. Using this form, the system administrator can configure the frequency and start time
of each batch process, as well as set the number of threads to improve performance.

“Threading” allows a specific job to be separated into smaller units that are processed at the
same time. This allows Oracle Financial Services Lending and Leasing to complete the job in
less time.

You can set up multiple batch jobs within a batch set. In the Batch Job Sets section, each
process is listed with the last run date (Last Run Dt field) and the next scheduled process date
(Next Run Dt field). In the Freq Code and Freq Value fields, you can determine the frequency
of each batch set, such as daily, weekly and monthly. You can also set up batch sets to
incorporate a dependency on another batch set. This way, if the initial batch fails, the
dependent set will not be processed.

In the Batch Jobs section, you can configure the process to run on weekends and holidays
using the respective option boxes.

CAUTION: As the batch job setup widely affects the Oracle Financial Services Lending and
Leasing system, Oracle Financial Services Software suggests that the system administrator
has a clear understanding of the various functionalities within Oracle Financial Services
Lending and Leasing before creating and updating the batch processes.

For the standard job set please review the Visio document,
dbk_std_detail_design_job_sets.vsd

To setup a Batch job
1. Click Setup > Setup > Administration > System > Batch Jobs.
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In the Batch Job Sets section, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE’

Financial Services Lending and Leasing

% Welcome, PRAKRRAQ ~  Accessibility o

Close:
DashBoard i ®e
> Origination Batch Jobs | Job Holidays
> Servicing
> Collections Batch Job Sets Fpadd | AEdit | B view | o Audit
- WEP View v Formatw [ Freeze G Detach Wirap. 50
Set Code Job Set Description Frequency Frequency value  Start Time Gritical Enabled
> Tools N N
Setup SET-AAL ACCOUNT CREATION DALY DAILY 10:00 AM N N
= ACCRUALS AND DELINQUENCY DALY DAILY 10:30 M i3 N
adh A E UPDATE AUDIT TABLE (AFTER TABLE EXPORT-IMPORT)  SPECIFIC DAY SPECIFIC DAY 10:00 AM N N
iministration =
oo E AGING DAILY DAILY 12:00 AM N N
: E SALE LEAD AGING DAILY DAILY 10:30PM ¥ N
System Parameter = 4 1
i SET- AP SPECIFIC DAY SPECTFIC DAY 2:00 PM N N
R — SET-8LK BULK UPLOAD SPECIFIC DAY SPECIFIC DAY 10:00 AM [ [ o
it SET-BMT1 BATCH TXNS (MONETARY} DAILY DAILY 800 P ¥ [ 08/03/20C W
et ET-8MT2 BATCH TXNS (NGNMONETARY) DAILY DALY 801PM N N 08/09/200
User Defined Default < 3
Transaction Codes
Data Files
Dedupe Batch Job Sets
Securitization & soveand add || [ save and Stay | [l Save and Return || <3 Return
Events
Batch Jobs 1 * set Code: * start Time * Next Run Dt 12/31/1969 12:30:00 PM )
Producer Cycles
Ay SEES * Job Set Description = ritial [ * parent &
Collection Cycles * Frequency [¥] * Enabled [] Dependency [v]
Reparts Lest Run Dt 01/01/1800
Frequency value =
Error Messages
Translations
User Batch Jobs Gadd | Sedt || Elview | o audic
Orgarizstion View v Formatv | [ B Detach i (5]
Gimperiies Job Type Job Code Job Description Threads ‘Commit Count rrors Allowed we
aing No data to display.
Users < >
Credit Burcau
Correspondence
e Batch Job Threads Frodd | P | Elview | £ pusi
Prinkers View~ Formatv | B Fresze  Efff Detach ol Wrap (0]
Bark Details Thread Trace Level Encbled
Check Details No data to display.
Standard Payees
Currencies
Zip Codes .
Products
< >

A brief description of the fields is given below:

Field:

Do this:

Set Code

Specify the code for the batch job set.

Job Set Description

Specify the description for the batch job set.

Frequency

Select the frequency at which the job set is to be executed
from the drop-down list.

Frequency Value

Select the frequency value from the drop-down list. The fre-
quency value will be displayed based on the frequency code
selected.

Start Time

Specify the start time for the job set.

Critical

Check this box to set job as critical. A “critical” job is one that
prevents the General Ledger (GL) post date from rolling for-
ward, should the job fail.

Enabled

Check this box to enable the job set.

Last Run Dt

The system displays the last run date of the job set.

Next Run Dt

Specify the next run date for job set. You can select the data
from adjoining calendar icon.

Parent

Select the parent job set from drop-down list.

Dependency

Select the type of dependency on the parent from drop-down
list.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.

chapter.

In the Batch Job section, perform any of the Basic Operations mentioned in Navigation

A brief description of the fields is given below:

Field: Do this:

Seq Specify the batch job sequence number.
Note: Within a job set, jobs are executed sequentially based on the
sequence number assigned.

Job Type Select the batch job request type from the drop-down list.

Job Code Specify the batch job request code.

Job Description

Specify the batch job description.

Threads

The system displays the number of threads used by the job.

Commit Count

Specify the number of rows after which auto-commit is triggered.

Errors Allowed

Specify the number of errors allowed.

Weekend Check this box to perform batch jobs on weekend.

Holiday Check this box to perform batch jobs on a holiday. (Holidays are
defined on the Job Holidays screen.)

Enabled Check this box to enable the batch job.

Parent Select the parent batch job from the drop-down list.

Dependency ISelect the dependency clause of the batch job from the drop-down
ist.

Command Specify the command line for the job (required).

RollbackSegment | If you choose, use this field to specify the rollback segment for job.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6.

In the Batch Job Thread section, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Thread Specify the name of thread.

Trace Specify the SQL trace level (0, 1, 4, 8, 12). The higher the number, the
more activities the system can trace.

Enabled Check this box to enable the thread.

7. Perform any of the Basic Actions mentioned in Navigation chapter.
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2.8.1.2 Job Holidays

The system allows you to define holidays within the company on Job Holidays screen. You
can then use the Batch jobs screen to set up whether you want the system to perform batch
jobs on these days or not, using the Holiday box of Batch Jobs section .

To define job holidays

1. Click Setup > Setup > Administration > System > Batch Jobs > Job Holidays.

2. Inthe Job Holidays section, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE’ 1 & Welcome, PRAKRRAO v Accessiblity @
Financial Services Lending and Leasing

Close
DashBoard BrEy e

> Origination Baich Jobs  Job Holidays
» Servicing
> Collections Job Holidays Fadd | Lede | [Hyvew | o audic
> WEP View v Fomatv [y Freeze i Detach o wrap 5]

e Holiday Dt Description Enabled
> Tools 02/11/2016 UNDEFINED
Setup 12/08/2015 TESTL

Setup 12/25/2002 CHRISTMAS

THANKS GIVING DAY

N

N

-

Administration o
INDEPENDENCE DAY Y
-

Y

Y

Y

System
System Parameter
Lookups
User Defined Tables
Mudit Tables

CHRISTMAS
THANKS GIVING DAY

INDEPENDENCE DAY
12/25/2000 CHRISTMAS

User Defined Default -

Transaction Codes Job Holidays

Data Files Save and add || [ save and stay | [ Save and Return | G Retumn
Dedupe

Securitization *Holiday Dt 02/11/2016 (B
* Desaription  UNDEFINED
* Enatled [

Callection Cycles
Reports
Error Messages
Translations
User
Organization
Companies
Access
Users
Credit Bureau
Correspondznce
General Ledger
Quauss
Printers
Bark Details
Check Details
Standard Payees
Currencies
Zip Codes
Froducts
< >

A brief description of the fields is given below:

Field: Do this:

Holiday Dt Specify the date of the job holiday. You can select the date from the
adjoining calendar icon.

Description Specify the job holiday description (required).

Enabled Check this box to enable the holiday.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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2.8.2 Batch Jobs Available
The below table provides a list of Batch Jobs maintained in the system and a brief description
to each:
& 5 c
L o
Ea Description ?:ktfh Description E :E '% § Comment
=) D 2| =73
c = 0| O| =
w Olwm|O|a
AAE | Application aaiprc_b- | APPLICA- N Y | N | C | This process peri-
Account j_100_01 | TIONTO o | e | o | o | odically picks up
Interface ACCOUNT s m | applications in
INTERFACE m | 'Approved-Veri-
o | fied' status and
n | creates accounts.
ACH | ACH acaprc_b | ACCOUNT N |Y | N| C | This process pro-
Accounts j_100_01 | ACH PRO- 0 | e | o | o | ducesthe ACH file
CESSING s m | for the eligible cus-
m | tomer payments.
o}
n
ACH | ACH Produc- | acp- PRO- Y | Y | N| C | This process pro-
ers prc_b- DUCER e | e | o | o | ducesthe ACH file
j_100_01 | ACH PRO- s |s m | for the eligible pro-
CESSING m | ducer payments.
o]
n
ACH | ACH Ven- acvprc_b | VENDOR N |Y | N| C | This process pro-
dors j_100_01 | ACH PRO- o0 | e | o | o | ducesthe ACH file
CESSING S m | for the eligible ven-
m | dor payments.
o}
n
ACH | ACH Pro- acx- ACH Pro- Y | Y | N| C | This process pro-
ducer/Ven- prc_b- ducer/Ven- e | e | o | o | ducersthe ACH
dors/ j_100_01 | dors/ s |s m | file for the eligible
Customer/ Customer/ m | Producer/Vendors/
Third Party Third Party 0 | Customer/Third
n | Party
AGE | Aging Appli- | agaap- APPLICA- Y | N | N | C | This process puts
cations p_b- TION e | o | o | o | applications into
j_100_01 | AGING s m | 'Aged-Application’
PROCESS m | substatus.
o]
n
AGE | Aging Con- agcco- CON- Y | N | N | C | This process puts
tracts n_b- TRACT e | o | o | o | contracts into
j_100_01 | AGING S m | 'Aged-Contract'
PROCESS m | substatus.
o}
n
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& 5| o €
Ea Description ?:ktfh Description E :E '% § Comment
=) D 2| =73
c = 0| O| =
w Olwm|O|a
ALT- | ALLOT- PFSEFT- | BACKUP N [Y | N | C | This process cre-
PFS MENT PRC B- | EFT o | e |0 | o | atesthe Backup
EXTRACT J_ 110 s m | EFT file
FILE DUMP 1 m
o}
n
ALT- | ALLOT- PFSL- POSTING N | Y | N | C | This process posts
PFS MENT BAPRC_ | ALLOT- o | e | o | o | thepaymentsfrom
EXTRACT BJ_100_ | MENT PAY- S m | the allotment file
FILE DUMP 01 MENTS m | received from the
o | bank
n
ALT- | ALLOT- PFSOD- | ALLOT- N |Y | N| C | This process
PFS MENT DALT_B- | MENT o | e | 0o | 0| sends the allot-
EXTRACT J_100_0 | EXTRACT S m | mentdraft notice to
FILE DUMP 1 FILE DUMP m | the bank
o]
n
ALT- | ALLOT- PFSNS- | NSFBATCH | N | Y | N | C | This process posts
PFS MENT FPRC_B o | e | o | o |theNSFfile
EXTRACT J 100 0 s m | received from the
FILE DUMP 1 m | bank
o}
n
API API Accounts | accaa- API AAI N |[Y | N | C | This process cre-
ib- o0 | e |0 | o | atesaccountsfrom
j_100_01 s m | validated conver-
m | sion applications/
o | contracts
n
API API Accounts | accd- MOVE N | Y | N | C | This process cop-
mp_b- API_ XX TO o | e | o | o | iesdatafrom con-
j_100_01 | ITABS S m | version API tables
m | to conversion
o | applications table
n
API API Accounts | accval_bj | VALIDATE N |Y | N|L | This process vali-
_111_01 ITABS o | e | o | o | dateall conver-
(LOAN) s a | sion applications
n | loan accounts by
running the edits
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& 5| o €
Ea Description ?:ktfh Description E :E '% § Comment
=) D 2| =73
c - O O =
w Olw| O| o
API API Accounts | accval_bj | VALIDATE N |Y | N|L | This process vali-
_12_01 ITABS o |e | o |i | dateall conver-
(LINE) s n | sion applications
e | line of credit
accounts by run-
ning the edits
API API Accounts | acm- LOAD N [Y | N | C | This process cre-
prc_b- API_COM- o | e |0 | o | atesaccountcom-
j_100_01 | MENTS S m | ments from
m | conversion appli-
0 | cations/contracts
n
COL | Appointment | cap- APPPOINT- | N | Y | Y | C | This process can-
Cancellation | prc_b- MENT CAN- | o | e | e | o | cels all the expired
j_100_01 | CEL s | s | m| appointments.
PROCESS- m
ING o]
n
COL Payment cppprc_b | BROKEN N |Y | N| C | This process
Promise Pro- | j_100_01 | PROMISE o | e |0 | o | updatesany bro-
cessing PROCESS- S m | ken promises as of
ING m | the run time.
o}
n
CRB | Credit cbuutl_b- | CREATE N |Y | N| C | This process cre-
Bureau j_100_01 | METRO2 o|e |0 | o | atesthe METRO2
Reporting FILE S m | file for Credit
m | Bureau reporting
o | for the specified
n | date.
DOT | Document dolprc_b- | ACCOUNT N |[Y | Y | C | Thisprocessreads
Tracking j_000_01 | DOCU- o |e |e | o | acct doc load
Load MENT s | s | m | directory. Attach
LOAD m | the documents to
o0 | specified accounts
n | and move docu-
ments to appropri-
ate directory
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& 5| o €
Ea Description ?:ktfh Description § :E '% § Comment
=] o 2| 2|3
c = 0| O| =
w Olwm|O|a
DLX | Accounts ODX- ACCOUNTS | N | Y | Y | C | This process gen-
Dialer Exclu- | PRC_B- | DIALER o0 | erates a dialer
sion J _100_0 | EXCLU- m | exclusion file with
1 SION m | account details
o | and checks if the
n | maintained call
action result entry
is made on any
account during the
specified time
interval.
GLP GL Interface | gliprc_ b- | GLSUMMA- | N | Y | N | C | This process sum-
j_100_01 | RIZATION o |e |0 | o | marizes GL trans-
s m | actions for the day.
m
o}
n
GOV | Debt Report- | gdraap_ | IRS1099-A | N | Y | N | C | This process gen-
ing IRS bj_100_0 | PROCESS- |0 | e | o | o | eratesthe 1099-A
1099A / 1 ING S m | flat file for govern-
1099C m | ment reporting.
o]
n
GOV | Debt Report- | gdrcad_b | IRS 1099-C N [Y | N | C | This process gen-
ing IRS j_100_01 | PROCESS- | o0 | e | o | o | eratesthe 1099-C
1099A / ING S m | flat file for govern-
1099C m | ment reporting.
o}
n
GOV | HMDA ghr- IRS HMDA Y | N | N | C | This process gen-
Reporting prc_b- PROCESS- | e |o | o | o | erates the HMDA
j_100_01 | ING S m | flat file for govern-
m | ment reporting.
o}
n
GOV | Interest girprc_b- | IRS 1098 N [Y | N | C | This process gen-
Reporting j_100_01 | PROCESS- |0 | e | o | o | eratesthe 1098 flat
IRS 1098 ING S m | file for government
m | reporting.
o]
n
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Ea Description ?:ktfh Description § :E '% § Comment
=] o 2|23
c = 0| O| =
w Olwm|O|a
JOB Scheduler jsctst_b- | Scheduler Y | Y | Y| C | This process test
j_000_01 e | e | e | o| thejob scheduler
s |s|s |m
m
o}
n
LBP Lockbox Ibxprc_b- | LOAD N | Y | N| C | This process loads
j_100_01 | LOCKBOX o | e |0 | o | anylockbox files
PROCESS- s m | available. This pro-
ING m | cess can be set to
0 | run periodically
n | throughout the day.
LNT Lien Tracking | OFD- OUTPUT N |Y | N| C | This process gen-
PRC_B- | LIEN 0 | erates output file
J 111 0 | TRACKING m | with changes in
3 FOR DATA m | customer informa-
CHANGE o | tion such as
n | Address/Phone
no./Borrower/Co-
borrower name.
LNT Lien Tracking | OFD- OUTPUT N [Y | N | C | This process gen-
PRC _B- | LIEN o | erates output file
J 111 _0 | TRACKING m | for '"Void Accounts'
4 FOR VOID m | to be sent to dealer
ACCOUNT o | track.
n
LTR Collections Icolt1_b- | GENERATE | N | N | Y | C | This process gen-
Letter j_100 01 | FIRSTCOL- | o | o | e | 0 | erates the first col-
LECTION s | m | lection letter for
LETTER m | eligible accounts.
o]
n
LTR Collections Icolt2_b- | GENERATE | N | N | Y | C | This process gen-
Letter j_100_01 | SECOND o | o |e | o | eratesthe second
COLLEC- s | m | collection letter for
TION LET- m | eligible accounts.
TER o]
n
LTR Collections Icolt3_ b- | GENERATE | N | N | Y | C | This process gen-
Letter j 100 01 | THIRDCOL- | 0o | 0o | e | o | erates the third col-
LECTION s | m | lection letter for
LETTER m | eligible accounts.
o}
n
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Ea Description ?:ktfh Description E :E '% § Comment
=) D 2| =73
c = 0| O| =
w Olwm|O|a
LTR Customer Icspdf_b- | PAID IN N |[Y | N|L | This process gen-
Service Let- | j 111_01 | FULL LET- 0 | e | o | o | erates the paid-in-
ter TER s a | full letter for the
n | relevant accounts.
LTR Customer Icspo- PAYOFF N Y | N | C | This process gen-
Service Let- q_b- QUOTE o | e |0 | o | eratesthe payoff
ter j_111_01 | LETTER s m | quote letter for the
m | requested
o | accounts.
n
LTR Customer Icsst- CuUs- N Y | N | C | This process gen-
Service Let- m_b- TOMER o | e |0 | o | eratesthe cus-
ter j_100_01 | STATE- S m | tomer statement
MENT LET- m | letter for requested
TER 0 | accounts.
n
LTR Customer Icswel b- | WELCOME N |[Y | N|L | This process gen-
Service Let- | j_111_01 | LETTER o | e | o | o | eratesthe wel-
ter S a | come letter for the
n | newly funded
accounts.
LTR Origination loraco_b- | Origination Y | N | N | L | This process gen-
Letter j_111_01 | Adverse e | o | o | o | eratesthe adverse
Action Let- S a | action letter for rel-
ter(Condi- n | evant applications.
tional)
(Loan)
LTR Origination loradv_b- | Origination Y | N| N | L | This process gen-
Letter j_111_01 | Adverse e | o | o | o | eratesthe adverse
Action Let- S a | action letter for rel-
ter (Loan) n | evant applications.
ODD | Coupon och- CUS- N Y | N | C | This process gen-
Book Dump prc_b- TOMER o | e | o | o | erates coupon
File j_100_01 | COUPON s m | books, if appropri-
BOOK GEN- m | ate.
ERATION o}
n
ODD | Output Data | odd- CREATE Y | Y |Y | C | This process cre-
Dump File prc_b- OUTPUT e | e | e | o | ates any defined
j_000 01 | DATADUMP | s | s | s | m | output data dump
FILES m | files set in the sys-
o | tem.
n
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Ea Description ?:ktfh Description E :E '% § Comment
=) D 2| =73
c = 0| O| =
w Olwm|O|a
ODD | Collections olclt1_b- | COLLEC- N [N | Y | C| This process gen-
Letter j_100_01 | TION LET- o | o |e | o | erates the first col-
TER 1 FILE s | m | lection letter for
CREATION m | eligible accounts.
o}
n
ODD | Collections olclt2_b- | COLLEC- N [N | Y | C | This process gen-
Letter j_100_01 | TION LET- 0 |0 | e | o | eratesthe second
TER 2 FILE s | m | collection letter for
CREATION m | eligible accounts.
o]
n
ODD | Collections olclt3_b- | COLLEC- N [N | Y | C | This process gen-
Letter j_100_01 | TION LET- o0 | o | e | o | erates the third col-
TER 3 FILE s | m | lection letter for
CREATION m | eligible accounts.
o]
n
ODD | Origination olo- ADVERSE Y | N | N | C | This process gen-
Letter aco_b- ACTION e | 0 | o | o | eratesthe adverse
j_100_01 | CONDI- s m | action letter for rel-
TIONAL m | evant applications.
LETTER o}
FILE CRE- n
ATION
ODD | Origination oload- ADVERSE Y | N | N | C | This process gen-
Letter v_b- ACTION e | 0 | o | o | eratesthe adverse
j_100 01 | LETTER s m | action letter for rel-
FILE CRE- m | evant applications.
ATION o]
n
ODD | Customer olspdf b- | PAID IN N Y | N | C | This process gen-
Service Let- | j_100_01 | FULL FILE o |e |0 | o | eratesthe paid-in-
ter CREATION S m | full letter for the
m | relevant accounts.
o
n
ODD | Customer olspo- PAY OFF N | Y | N| C | This process gen-
Service Let- q_b- QUOTE o | e |0 | o | eratesthe payoff
ter j_100_01 | FILE CRE- s m | quote letter for the
ATION m | requested
o | accounts.
n
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Ea Description ?:ktfh Description E :E '% § Comment
=) D 2| =73
c = 0| O| =
w Olwm|O|a
ODD | Customer ols- WELCOME N [Y | N | C | This process gen-
Service Let- wel_b- LETTER O | e | o | o | eratesthe wel-
ter j_100_01 | FILE CRE- s m | come letter for the
ATION m | newly funded
o | accounts.
n
ODD | Producer opsprc_b | DEALER N Y | N | C | This process gen-
Statement j_100_01 | STATE- o0 | e |0 | o | eratesthe dealer/
Dump File MENTS S m | producer state-
GENERA- m | ments at the speci-
TION o | fied frequency.
n
ODD | Customer ostprc_b- | CUS- N Y | N | C | This process gen-
Statement j_100_01 | TOMER o |e |0 | o | eratesthe cus-
Dump File STATE- S m | tomer statement
MENTS m | for eligible
GENERA- 0 | accounts.
TION n
PRQ | Payable pcu- CUsS- N |Y | N| C | This process cre-
Requistion prc_b- TOMER o | e | o | o | atesrequisitions
Customer j_100_01 | REFUND s m | for customer over-
PAYMENT m | payment refunds.
REQUISI- o}
TIONS n
PRQ | Payable ppores b | MONTH N [Y | N | C | This process cre-
Requisition j_100_01 | END o | e | 0o | 0 | atesrequisitions
Producer DEALER S m | for dealer compen-
RESERVE m | sation payments
PAYMENT 0 | on month-end.
REQUISI- n
TIONS
PRQ | Payable pvn- VENDOR N |Y | N| C | This process cre-
Requisition prc_b- INVOICE o0 | e | o | o | atesrequisitions
Vendor j_100_01 | PAYMENT S m | for vendor invoice
REQUISI- m | payments
TIONS o]
n
PUR | Archive pacarc_b | ARCHIVE N|Y |Y | C| This process
Accounts j_100_01 | ACCOUNT o | e | e | o | archives account
DATA TO s | s | m| data from
OTABLES m | ACCOUNTS table
o | to OACCOUNTS
n | table.
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Ea Description ?:ktfh Description E :E '% § Comment
=) D 2| =73
c = 0| O| =
w Olwm|O|a
PUR | Archive pacarc_b | ARCHIVE N |Y | Y | C | This process
Accounts j_100_02 | ACCOUNT o | e | e | o | archives account
DATA TO s | s | m| data from OAC-
OOTABLES m | COUNTS table to
o | OOACCOUNTS
n | table.
PUR | Archive paparc_b | ARCHIVE Y | N| N | C | This process
Applications | j_100_01 | APPLICA- e | o | o | o | archives applica-
TION DATA | s m | tion-related data
TO m | from APPLICA-
OTABLES o | TIONS to OAPPLI-
n | CATIONS table.
PUR | Archive paparc_b | ARCHIVE Y | N | N | C | This process
Applications | j_100_02 | APPLICA- e | o | o | o | archives applica-
TION DATA | s m | tion-related data
TO OOT- m | from OAPPLICA-
ABLES 0 | TIONS to OOAP-
n | PLICATIONS
table.
PUR | Archive GL pglarc_b- | ARCHIVE N |Y |Y | C| This process
j_100_01 | GLDATATO | o | e | e | o | archives General
OTABLES s | s | m| Ledger data from
m | GL tables to OGL
o | tables.
n
PUR | Archive GL pglarc_b- | ARCHIVE N |Y |Y | C | This process
j_100 02 | GLDATATO | o | e | e | o | archives General
OOTABLES s | s | m | Ledger data from
m | OGL tables to
o | OOGL tables.
n
PUR | Purge Job pjrirq_b- | Purge Job Y |Y | Y| C | This process
Requests j_100_01 | Requests e |e |e | o | purgesjob
s | s | s | m| requests from the
m | system.
o]
n
PUR | PurgeOutput | pododh_ | PURGE N |Y | Y | C | This process
Data Dump bj_100_0 | OUTPUT o |e |e | o | purges Output
1 DATA s | s | m | Data Headers from
HEADERS m | the system.
o}
n
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=) D 2| =73
c - O O =
w Olw| O| o
PUR | Archive ppaarc_b | ARCHIVE N |Y | N| C | This process
Securitiza- j_100_01 | POOLDATA |0 | e | o | o | archives securiti-
tion TO s m | zation data from
OTABLES m | TABLE to corre-
o | sponding OTABLE.
n
PUR | Archive ppaarc_b | ARCHIVE N |Y | N| C | This process
Securitiza- j_100 02 | POOLDATA | o | e | o | o | archives securiti-
tion TO OOT- s m | zation data from
ABLES m | OTABLE to corre-
o | sponding OOT-
n | ABLE.
PUR | Archive Pro- | pprarc_bj | ARCHIVE Y |Y | Y| C | This process
ducers 100 01 | PRO- e | e | e | o | archives producer
DUCER s | s | s | m| datafrom PRO-
DATATO m | DUCERS table to
OTABLES o | OPRODUCERS
n | table.
PUR | Archive Pro- | pprarc_bj | ARCHIVE Y | Y |Y | C | This process
ducers _100_02 | PRO- e | e | e | o | archives producer
DUCER s | s | s | m| data from OPRO-
DATATO m | DUCERS table to
OOTABLES o | OOPRODUCERS
n | table.
PUR | Archive Pro- | ppx- ARCHIVE N |Y | N| C | This process
ducers Txns | arc_b- PRO- o | e |0 | o | archives producer
j_100_01 | DUCER s m | transaction data
TXNS DATA m | from PRODUC-
TO o | ERS table to
OTABLES n | OPRODUCERS
table.
PUR | Archive Pro- | ppx- ARCHIVE N |Y | N| C | This process
ducers Txns | arc_b- PRO- o | e | o | o | archives producer
j_100_02 | DUCER s m | transaction data
TXNS DATA m | from OPRODUC-
TO OOT- o | ERS table to
ABLES n | OOPRODUCERS
table.
PUR | Archive pstarc_b- | ARCHIVE N |Y | N| C | This process
Statements j_100_01 | ACCOUNT o | e | o | o | archives account
STATE- s m | statement and
MENT AND m | transaction data
TXNS DATA o | from TABLE to cor-
TO n | responding
OTABLES OTABLE.
2-48 ORACLE




& 5| o €
Ea Description ?:ktfh Description E :E '% § Comment
=) D 2| =73
c = 0| O| =
w Olwm|O|a
PUR | Archive pstarc_b- | ARCHIVE N |Y | N| C | This process
Statements j_100_02 | ACCOUNT o | e | o | o | archives account
STATE- s m | statement and
MENT AND m | transaction data
TXNS DATA o | from OTABLE to
TO OOT- n | OOTABLE.
ABLES
PUR | Terminate ptuus- Terminate Y | Y| Y| C| This process termi-
User r_b- User e | e | e | o | nates user satisfy-
j_100_01 s | s | s | m| ingthe selection
m | criteria.
o]
n
PUR | Archive Txns | ptxarc_b- | ARCHIVE N |Y | N | C | This process
(To O tables) | j_100_01 | TXNS DATA | o | e | o | o | archives data from
TO S m | TXNS table to
OTABLES m | OTXNS table.
o]
n
PUR | Archive Txns | ptxarc_b- | ARCHIVE N |Y | N| C | This process
(To OO j_100_02 | TXNS DATA | o | e | o | o | archives data from
tables) TO OOT- S m | OTXNS table to
ABLES m | OOTXNS table.
o}
n
PUR | Purge User pululg_b- | Purge User Y| Y |Y | C| This process
Logins j_100_01 | Logins e | e | e | 0 | purges user login
s | s | s | m| datafrom the sys-
m | tem.
o]
n
PUR | Archive Ven- | pvaarc_b | ARCHIVE N|Y |Y | C | This process
dor Assign- j_100_01 | VENDOR o | e |e | o | archives vendor
ments ASSIGN- s | s | m | assignment data
MENTS m | from TABLE to
DATATO o | OTABLE.
OTABLES n
PUR | Archive Ven- | pvaarc_b | ARCHIVE N|Y |Y | C| This process
dor Assign- j_100_02 | VENDOR o | e |e | o | archives vendor
ments ASSIGN- s | s | m | assignment data
MENTS m | from OTABLE to
DATATO o | OOTABLE.
OOTABLES n
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PUR | Archive Ven- | pviarc_b- | ARCHIVE N |Y | Y | C | This process
dor Invoices | j 100_01 | VENDOR o | e | e | o | archives vendor
INVOICES s | s | m| invoice data from
DATATO m | TABLEs to
OTABLES o | OTABLEs.
n
PUR | Archive Ven- | pviarc_b- | ARCHIVE N |Y |Y | C | This process
dor Invoices | j 100_02 | VENDOR o | e |e | o | archives vendor
INVOICES s | s | m| invoice data from
DATATO m | OTABLEs to OOT-
OOTABLES o | ABLEs.
n
QUE | Queue Cus- qgcsprc_b | CUS- N |Y |Y | C| This process cre-
tomer Ser- j_100_01 | TOMER o | e |e | o | atesthe customer
vice SERVICE s | s | m| service/collections
QUEUE m | queues
PROCESS- o]
ING n
RDB RDB1 racd- Data Dump N |Y | Y | C| This process trans-
1 Accounts mp_b- Accounts o | e | e | o | fersthe account
j_100_01 s | s | m| data from (OLTP)
m | Regular tables to
o | Temporary T tables
n
RDB | RDB1 Appli- | rapd- LOAD Y | N | N | C | This process trans-
1 cations mp_b- APPLICA- e | o | o | o | fersthe applica-
j_100_01 | TION s m | tion data from
RELATED m | (OLTP) Regular
DATA INTO o | tables to Tempo-
T TABLES n | rary T tables
RDB RDB1 Asset ratd- LOAD N |Y | N| C | This process trans-
1 Tracking mp_b- ASSET o | e | o | o | fersthe account
j_100_01 | RELATED s m | asset data from
DATA INTO m | (OLTP) Regular
T TABLES o | tables to Tempo-
n | rary T tables
RDB | RDB1 Bank- | rbkd- LOAD N | N |Y | C | This process trans-
1 ruptcy mp_b- BANK- o | o | e | o | fersthe account
j_100_01 | RUPTCY s | m | bankruptcy data
DATATO T m | from (OLTP) Regu-
TABLES o | lar tables to Tem-
n | porary T tables
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RDB | RDB1 Call rcad- LOAD CALL | N | N | Y | C | This process trans-
1 Activities mp_b- ACTIVITIES | o | o | e | o | fers the account
j_100_01 | DATA INTO s | m | call activity data
T TABLES m | from (OLTP) Regu-
o | lar tables to Tem-
n | porary T tables
RDB | RDB1 Defi- rchd- LOAD DEFI- | N | N | Y | C | This process trans-
1 ciency mp_b- CIENCY o | o |e | o | fersthe account
j_100_01 | DATA INTO s | m | deficiency data
T TABLES m | from (OLTP) Regu-
o | lar tables to Tem-
n | porary T tables
RDB | RDB1 Con- rcod- LOADCON- | Y |Y | N | C | This process trans-
1 tracts mp_b- TRACT e | e | o | o | fersthe account
j_100_01 | DATA INTO s |s m | contracts data from
T TABLES m | (OLTP) Regular
o | tables to Tempo-
n | rary T tables
RDB | RDB1 rfod- LOAD N | N|Y | C | This process trans-
1 Reposses- mp_b- REPO o | o | e | o | fersthe account
sions j_100_01 | FORECLO- s | m | bankruptcy data
SURE DATA m | from (OLTP) Regu-
INTOT o | lar tables to Tem-
TABLES n | porary T tables
RDB | RDB1 Pro- rprd- LOAD PRO- | N | Y | N | C | This process trans-
1 ducers mp_b- DUCER o | e | o | o | fersthe producer
j_100_01 | ANDITS s m | and producer
TXNS DATA m | transactions data
INTOT o | from (OLTP) Regu-
TABLES n | lar tables to Tem-
porary T tables
RDB | RDB1 Setup | rstd- LOAD Y | Y | Y| C | This process trans-
1 mp_b- SETUP e | e | e | o | fersthe setup data
j_100_01 | RELATED s |s |s | m| from(OLTP) Regu-
DATA INTO m | lar tables to Tem-
T TABLES 0 | porary T tables
n
RDB | RDB1 Txns rtxd- LOAD TXN N | Y | N | C | This process trans-
1 mp_b- DATA INTO o | e | o | o | fersthe account
j_100_01 | T TABLES s m | transactions data
m | from (OLTP) Regu-
o | lar tables to Tem-
n | porary T tables
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RDB | RDB2 racac- Load N |Y | Y | C | This process trans-
2 Accounts c_b- Reporting o | e |e | o | fersthe account
j_100_01 | Tables s | s | m| datafrom T tables
Accounts m | to RDB tables
o}
n
RDB | RDB2 rac- Update N |Y |Y | C | This process
2 Accounts drv_b- Reporting 0 | e | e | o | updates the codes
(Derived j_100_01 | Tables s | s | m | with description for
Fields) Accounts m | account RDB
o | tables
n
RDB | RDB2 Appli- | rapap- Load Y | N | N | C | This process trans-
2 cations p_b- Reporting e | o | o | o | fersthe applica-
j_100_01 | Tables Appli- | s m | tion data from T
cations m | tables to RDB
o | tables
n
RDB RDB2 Appli- | rap- Update Y | N | N | C | This process
2 cations drv_b- Reporting e | 0 | o | o | updates the codes
(Derived j_100_01 | Tables Appli- | s m | with description for
Fields) cations m | application RDB
(Derived o | tables
Fields) n
RDB | RDB2 Asset | ratase_bj | Load N |Y | N | C | This process trans-
2 Tracking _100_01 | Reporting o | e | o | o | ferstheaccount
Tables Asset s m | asset tracking data
Tracking m | from T tables to
o | RDB tables
n
RDB | RDB2 Asset | ratdrv_b- | Update N |Y | N | C | This process
2 Tracking j_100_01 | Reporting 0 | e | 0 | 0 | updates the codes
(Derived Tables Asset S m | with description for
Fields) Tracking m | account asset
(Derived o | tracking RDB
Fields) n | tables
RDB | RDB2 Bank- | rbkab- Load N | N | Y | C | This process trans-
2 ruptcy d_b- Reporting o | o | e | o | fersthe account
j_100_01 | Tables s | m | bankruptcy data
Bankruptcy m | from T tables to
o | RDB tables
n
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RDB | RDB2 Call rca- Load N [N | Y | C | This process trans-
2 Activities cac_b- Reporting o | o |e | o | fersthe account
j_100_01 | Tables Call s | m | call activities data
Activities m | from T tables to
o | RDB tables
n
RDB | RDB2 Defi- rchaof_bj | Load N | N|Y | C | This process trans-
2 ciency _100_01 | Reporting o | o | e | o | ferstheaccount
Tables Defi- s | m | deficiency data
ciency m | from T tables to
o | RDB tables
n
RDB | RDB2 Con- rco- Load Y | Y | N| C | This process trans-
2 tracts con_b- Reporting e | e | o | o | fersthe account
j_100_01 | TablesCon- |s | s m | contract data from
tracts m | T tables to RDB
o | tables
n
RDB | RDB2 Con- rcodrv_bj | Update Y | Y | N | C | This process
2 tracts _100_01 | Reporting e | e | o | o | updates the codes
(Derived Tables Con- | s | s m | with description for
Fields) tracts m | account contract
(Derived o | RDB tables
Fields) n
RDB | RDB2 rfoafr_b- | Load N | N|Y | C | This process trans-
2 Reposses- j_100_01 | Reporting o | o | e | o | ferstheaccount
sions Tables s | m | repossession data
Reposses- m | from T tables to
sions o | RDB tables
n
RDB | RDB2 Pro- rprdrv_b- | Update N |Y | N| C | This process
2 ducers j_100_01 | Reporting 0 | e | 0 | 0 | updates the codes
(Derived Tables Pro- S m | with description for
Fields) ducers m | producer and pro-
(Derived 0 | ducer transactions
Fields) n | RDB tables
RDB | RDB2 Pro- rprpro_b- | Load N |Y | N | C | This process trans-
2 ducers j_100_01 | Reporting o | e | o | o | fersthe producer
Tables Pro- s m | and producer
ducers m | transactions data
o | from T tables to
n | RDB tables
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RDB | RDB2 Setup | rststp_b- | Load Y | Y | Y| C | This process trans-
2 j_100_01 | Reporting e | e | e | o | fersthe setup data
Tables s | s |s | m|fromT tablesto
Setup m | RDB tables
o}
n
RDB | RDB2 Txns rixdrv_b- | Load N |Y |Y | C | This process trans-
2 j_100_01 | Reporting o | e | e | o | ferstheaccount
Tables Txns s | s | m | transaction data
m | from T tables to
o | RDB tables
n
RDB | RDB2 Txns rixtxn_b- | Update N |Y |Y | C | This process
2 (Derived j_100_01 | Reporting 0 | e | e | o | updates the codes
Fields) Tables Txns s | s | m | with description for
(Derived m | account transac-
Fields) o | tions RDB tables
n
SEC Pool Sum- ssm- POOL SUM- | N | Y | N | C | This process popu-
mary prc_b- MARY o|e |o | o | lates summary
j_100_01 | TABLE s m | tables for all pools
POPULA- m
TION o}
n
SET- | OVERPAY- PFSTX- OVERPAY- N |Y | N| C | This process han-
OVR | MENT NOVR_B | MENT o | e |0 | o | dlesthe overpay-
REALLOCA- | J_100_0 | REALLOCA- S m | ments/overages
TIONS 1 TIONS m | existing on an
o | account
n
TPE Earning/ tam- AMORTIZA- | N | Y | N | C | This process cre-
Amortization | prc_b- TION o | e | o | o | atesthe month-
j_100_01 | TRANSAC- S m | end interest
TIONS m | accrual transac-
PROCESS- 0 | tions on month-
ING n | end.
TPE Earning/ tam- MONTH N |[Y | N|L | This process cre-
Amortization | prc_b- END AMOR- | 0 | e | 0 | 0o | ates the month-
j_111_01 | TIZATION s a | end interest
TRANSAC- n | accrual transac-
TIONS tions on month-
end.
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TPE Escrow Non tenbmt b | EscrowNon | N | Y | Y | C | This process posts
Monetary j_100_01 | Monetary O | e | e | o | escrownonmone-
Transactions Batch Trans- s | s | m | tary transactions in

actions m | the background at
o | the specified time
n | interval.

TPE Escrow Anal- | tesanl_b- | Escrow N | Y | N | C | This process posts
ysis & Dis- j_100_01 | Analysis o|e |o | o | allapproved
bursements Posting S m | escrow analysis to

m | the account
o]
n

TPE Escrow Anal- | tesanl_b- | Create N |[Y | N | C | This process cre-
ysis & Dis- j_100_02 | batches for o |e |0 | o | atescompany
bursements Customer s m | branch wise

Refund m | batches for cus-
Requests o | tomer refund
n | requests.

TPE Escrow Anal- | tesanl_b- | Create N |Y | N| C | This process popu-
ysis & Dis- j_100_03 | Transaction | o | e | o | o | late customer
bursements of Customer s m | refund request in

Refund m | respective batch
Requests 0 | created above
n

TPE Escrow Anal- | tesanl_b- | Compute N |Y | N | C | This process popu-
ysis & Dis- j_100_04 | controltotals | o | e | o | o | lates control totals
bursements for cus- S m | for the bathes cre-

tomerrefund m | ated for customer
request o | refund requests.
batches n

TPE Escrow Anal- | tesanl_b- | Escrow N |Y | N| C | This process
ysis & Dis- j_100_05 | compliance o0 | e | o | o | checks escrow-
bursements checking s m | able account for

m | compliance
o
n

TPE Escrow Anal- | tesds- Escrow dis- N | Y | N | C | This process posts
ysis & Dis- b_b- bursement O | e | o | o | processed escrow
bursements j_100_05 | posting & s m | disbursement and

requisition m | creates requisi-
creation o | tions.

n
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TPE Non Mone- tnmb- NONMON- | N |Y | Y | C | Thisprocess posts
tary Transac- | mt_b- ETARY o | e | e | o | non monetary
tions j_100_01 | TRANSAC- s | s | m| transactions in the
TIONS m | background at the
POSTING o | specified time
n | interval.
TPE Compensa- tpr- Compensa- N |Y | N|L | This process cre-
tion com_Db- tion o | e | 0 | 0| atestransaction for
j_111_01 S a | month-end pro-
n | ducer compensa-
tion
TPE Statement tprps- Producer N |Y | N|L | This process cre-
g_b- Statement o |e |0 | o | atesthe month-
j_111_01 s a | end interest
n | accrual transac-
tions on month-
end.
TPE Monetary txnacr_b- | INTEREST N | Y | N | C | This process posts
Transactions | j_100_01 | ACCRUAL o |e |0 | o |anypayment
AND DELIN- s m | batches open in
QUENCY m | the system. This
PROCESS- 0 | process can be set
ING n | to run periodically.
TPE Monetary txnact_b- | ACCOUNT N |Y | N| C | Thisjob activates
Transactions | j 100_01 | ACTIVA- o |e |0 | o0 | newaccountsi.e.
TION s m | changes status
m | from PENDING to
o | ACTIVE.
n
TPE Monetary txnad- Advance N | Y | N|L | This process posts
Transactions | v_b- Posting o|e |o |i |anyadvance
j_112_01 s n | batches open in
e | the system. This
process can be set
to run periodically.
TPE Monetary txnan- ANNIVER- N [Y | N | C | This process car-
Transactions | n_b- SARY PRO- | o | e | o | 0 | ries out the anni-
j_100_01 | CESSING S m | versary processing
m | for eligible
o | accounts
n
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TPE Monetary txnbmt_b | MONE- N | Y | N | C | This process posts
Transactions | j_100_01 | TARY 0 | e | o | o | monetary transac-
TRANSAC- s m | tions in the back-
TIONS m | ground at the
POSTING o | specified time
n | interval.
TPE Monetary txnch- Chargeoff N |Y | N| C | This process
Transactions | g_b- Processing o | e | o | o | charges off eligi-
j_100_01 s m | ble or scheduled
m | for chargeoff
o | accounts .
n
TPE Monetary txncls_b- | VOID/PAID N |Y | N| C | This process
Transactions | j 100_01 | ACCOUNT o |e | o | o | closes void and
CLOSE s m | paid off accounts.
PROCESS- m
ING o]
n
TPE Monetary txnddt_b- | BILLING/ N |Y | N|C | This process cre-
Transactions | j_100_01 | DUEDATES | o | e | o | o | ates/updates the
PROCESS- S m | due dates for the
ING m | accounts in the
o | system.
n
TPE Monetary txnfpd_b- | FIRSTPMT | N | Y | N | C | This process posts
Transactions | j 100_01 | DEDUC- o | e |0 | o | thefirst payment
TION PRO- s m | deduction pay-
CESSING m | ment to the eligi-
o | ble accounts.
n
TPE Monetary txnfpr_b- | FIRSTPMT | N |Y | N | L | This process posts
Transactions | j_111_01 | REFUND o |e |0 | o | thefirst payment
PROCESS- s a | deduction pay-
ING n | ment to the eligi-
ble accounts.
TPE Monetary txnitc_b- | LATE N |Y | N| C | This process
Transactions | j_100_01 | CHARGE O | e | o | o | assesses late
PROCESS- S m | charge depending
ING m | on the rules, for all
o | accounts in the
n | system.
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TPE Monetary txnmt- MONTH N |Y | N | C | This process popu-
Transactions | d_b- END PRO- o | e | o | o | latesthe month
j_100_01 | CESSING s m | end balances and
m | carries over the
o | balances to next
n | month.
TPE Monetary txnp- Payment N |Y | N| C | This process does
Transactions | mt_b- Posting o | e | o | o | thedaily accrual
j_100_01 s m | and delinquency
m | processing.
o]
n
TPE Monetary txn- PROMO- N |Y | N| C | Thisprocess'ends'
Transactions | prm_b- TION END o | e | o | o | thepromotionon
j_100_01 | PROCESS- s m | the account.
ING m
o]
n
TPE Monetary txn- TLP PRO- N |Y | N | C | This process 'can-
Transactions | prm_b- MOTION o |e | o | o | cels'the promo-
j_100_03 | CANCEL s m | tion on the
PROCESS- m | account.
ING o}
n
TPE Monetary txnrat_b- | RATE N |Y | N| C | This process
Transactions | j 100_01 | CHANGE o0 | e | o | o | changes the prev-
PROCESS- s m | alent rate on an
ING m | account.
o}
n
TPE Monetary txn- SCHEDULE | N | Y | N | C | This process puts
Transactions | sch_b- FOR o | e | o | o | the'Schedule for
j_100_01 | CHARGED s m | Charge Off' condi-
OFF PRO- m | tion on eligible
CESSING 0 | accounts.
n
TPE Monetary txntip_b- | TERMINA- N | Y | N | C | This process puts
Transactions | j 100_01 | TIONPRO- | o |e | o | o | the"Paid" status
CESSING S m | on eligible
m | accounts
o}
n
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TPE Monetary txnytd_b- | YEAR END N |Y | N | C | This process popu-
Transactions | j 100 01 | PROCESS- | o | e | o | o | lates the year end
ING S m | balances and car-
m | ries over the bal-
0 | ances to next year.
n
LTR CONDI- LORAC CONDI- Y | N| N | L | This process gen-
TIONAL O_B- TIONAL e | o | o | o | eratesthe adverse
ADVERSE J_100_0 | ADVERSE S a | action letter for rel-
ACTION 1 ACTION n | evant applications.
LETTER LETTER
GENERA-
TION
LTR ADVERSE LORAD- | ADVERSE Y | N | N | L | This process gen-
ACTION V_B- ACTION e | o | o | o | eratesthe adverse
LETTER J_100_0 | LETTER S a | action letter for rel-
1 GENERA- n | evant applications.
TION
RPT | ACCOUNT ROPAC- | ACCOUNT N|Y|N|C
LIST C_EM_1 | LIST ole|o|o
00_01 s m
m
o}
n
RPT | ADVANCE ROPAD- | ADVANCE N|Y | N|C
POSTING V_EM_1 | POSTING o|le|o|o
LIST 00_01 LIST s m
m
o}
n
RPT | ASSET ROPAT- | ASSET NIY | N|C
TRACKING KEM 1 | TRACKING |o |e |0 |0
DETAILS 00_01 DETAILS s m
m
o]
n
RPT | BANK- ROPBN BANK- N|Y|N|C
RUPTCY K_EM_1 | RUPTCY olel|o|o
ACCOUNT 00_01 ACCOUNT s m
LIST LIST m
o}
n
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RPT | COLLEC- ROP- COLLEC- N|Y|N|C
TOR ACTIV- | COL_EM | TORACTIV- |0 |e |0 | O
ITY DETAILS | _100_01 | ITY s m
DETAILS m
o}
n
RPT DEFI- ROP- DEFI- N|Y | N|C
CIENCY DEF_EM | CIENCY o|le|o|o
ACCOUNT _100_01 | ACCOUNT s m
LIST LIST m
o]
n
RPT DELIN- ROP- DELIN- N|Y | N|C
QUENT DLQ_EM | QUENT o|le|o|o
ACCOUNT _100_01 | ACCOUNT s m
LIST LIST m
o]
n
RPT FUNDING ROP- FUNDING N|Y|N|C
CONTRACT | FUN_EM | CON- ole|o|o
LIST _100_01 | TRACT LIST s m
m
o}
n
RPT | GL TXN ROP- GL TXN NlY | N|C
DETAILS GLI_EM | DETAILS o|le|o|o
LIST _100_01 | LIST s m
m
o}
n
RPT | APPLICA- ROPOR | APPLICA- NlY | N|C
TIONSLIST | G_.EM_1 | TIONSLIST o |e |0 | O
00_01 s m
m
o]
n
RPT PAYMENT ROP- PAYMENT N|Y|N|C
ALLOCA- PAL_EM | ALLOCA- ole|o|o
TION POST- | _100_01 | TION POST- s m
ING ING m
DETAILS| DETAILS| o}
n
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RPT | PAYMENT ROP- PAYMENT N|Y|N|C
POSTING PMT_EM | POSTING ole|o|o
LIST _100_01 | LIST s m
m
o}
n
RPT | PAYABLE ROP- PAYABLE NlY | N|C
REQUISI- PRQ_E REQUISI- ole|o|o
TION LIST M_100_0 | TION LIST s m
1 m
o]
n
RPT | REPOSSSE- | ROPRE REPOS- NlY | N|C
SION/FORE- | P_EM_1 | SSESION/ ole|o|o
CLOSURE 00_01 FORECLO- s m
ACCOUNT SURE m
LIST ACCOUNT o]
LIST n
RPT | SCHEDULE | ROP- SCHEDULE |[N|Y |N|C
TO CHAR- SCH_EM | TO CHAR- ole|o|o
GEOFF LIST | _100_01 | GEOFF s m
LIST m
o}
n
RPT | TERMINA- ROP- TERMINA- NlY | N|C
TION IN TIP_EM_ | TION IN ole|o|o
PROGRESS | 100_01 PROG- S m
LIST RESS LIST m
o]
n
RPT | NON MON- ROPTN- | NONMON- | N|Y |N|C
TETARY M_EM_1 | TETARY ole|o|o
TXN POST- 00_01] TXN POST- s m
ING LIST ING LIST m
o
n
RPT | MON- ROPTX- | MON- N|Y|N|C
TETARY N_EM_1 | TETARY olel|o|o
TXN POST- 00_01 TXN POST- s m
ING LIST ING LIST m
o}
n
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RPT | BATCH JOB | CMN- BATCHJOB [N |Y [N |C

SETUP BJB_EM | SETUP ole|o|o
_100_01 s m

m

o}

n

RPT | BATCH JOB | CMN- BATCHJOB |[N|Y [N |C

LOG BJB_EM | LOG ole|o|o
_100_02 s m

m

o]

n

RPT | NUMBER OUN- NUMBER NlY | N|C
OF CREDIT | ADE_EM | OFCREDIT (o |e |0 | O
APPLICA- _100_01 | APPLICA- s m
TIONS TIONS m
ENTERED ENTERED 0
BY USER BY USER n

RPT | CREDIT OUN- CREDIT N|Y|N|C
APPLICA- ADE_EM | APPLICA- olel|o|o
TIONS _100_02 | TIONS s m
IMAGES BY IMAGES BY m
STATUS STATUS o}

n

RPT | UNDER- OUNUN | UNDER- NlY | N|C
WRITING D EM_1 | WRITING ole|o|o
STATUS BY | 11_11 STATUS BY s m
MONTH MONTH m
AND PRO- AND PRO- o}
DUCER DUCER n
(LOAN) (LOAN)

RPT | UNDER- OUNUN | UNDER- NIY | N|C
WRITING D_EM_1 | WRITING ole|o|o
STATUS BY | 11_12 STATUS BY s m
MONTH MONTH m
AND AND o
UNDER- UNDER- n
WRITER WRITER
(LOAN) (LOAN)

RPT | UNDER- OUNUN | UNDER- N|Y|N|C
WRITING D _EM_1 | WRITING olel|o|o
STATUS BY | 11_13 STATUS BY s m
MONTH MONTH m
(LOAN) (LOAN) o}

n
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RPT UNDER- OUNUN | UNDER- N|Y|N|C
WRITING D_EM_1 | WRITING o|le|o|o
STATUS BY 11_14 STATUS BY S m
UNDER- UNDER- m
WRITER WRITER o]
(LOAN) (LOAN) n

RPT UNDER- OUNUN | UNDER- N|Y | N|C
WRITING D EM_1 | WRITING ole|o|o
STATUS BY 12_11 STATUS BY s m
MONTH MONTH m
AND PRO- AND PRO- o}
DUCER DUCER n
(LINE) (LINE)

RPT UNDER- OUNUN | UNDER- NlY | N|C
WRITING D_EM_1 | WRITING ole|o|o
STATUS BY 12_12 STATUS BY s m
MONTH MONTH m
AND AND 0
UNDER- UNDER- n
WRITER WRITER
(LINE) (LINE)

RPT UNDER- OUNUN | UNDER- NIY | N|C
WRITING D_EM_1 | WRITING o|le|o|oO
STATUS BY 12_13 STATUS BY S m
MONTH MONTH m
(LINE) (LINE) o]

n

RPT UNDER- OUNUN | UNDER- N|Y | N|C
WRITING D EM_1 | WRITING ole|o|o
STATUS BY 12_14 STATUS BY s m
UNDER- UNDER- m
WRITER WRITER o}
(LINE) (LINE) n

RPT UNDER- OUNUN | UNDER- NIY | N|C
WRITING D_EM_1 | WRITING ole|o|o
STATUSBY |21 M1 STATUS BY s m
MONTH MONTH m
AND PRO- AND PRO- 0
DUCER DUCER n
(LEASE) (LEASE)
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RPT | UNDER- OUNUN | UNDER- N|Y|N|C
WRITING D_EM_1 | WRITING olel|o|o
STATUS BY | 21_12 STATUS BY s m
MONTH MONTH m
AND AND o}
UNDER- UNDER- n
WRITER WRITER
(LEASE) (LEASE)

RPT | UNDER- OUNUN | UNDER- NlY | N|C
WRITING D EM_1 | WRITING ole|o|o
STATUS BY | 21 _13 STATUS BY s m
MONTH MONTH m
(LEASE) (LEASE) o]

n

RPT | UNDER- OUNUN | UNDER- Y| N|N|L
WRITING D _EM_1 | WRITING e|o|o|e
STATUS BY | 21_14 STATUSBY | s a
UNDER- UNDER- s
WRITER WRITER e
(LOAN) (LOAN)

RPT | ACCOUNT OFNA- ACCOUNT Y|N|N|C
PAYABLE PY_EM_ | PAYABLE elo|o|o
(ORIGINA- 100_01 (ORIGINA- s m
TION) TION) m

o}
n

RPT | ACCOUNT OFNA- ACCOUNT NlY | N|C
PAYABLE PY_EM_ | PAYABLE olel|o|o
(SERVIC- 100_02 (SERVIC- s m
ING) ING) m

o}
n

RPT | PRE-FUND- | OFNF- PRE-FUND- | Y [N | N |L
ING CON- ND_EM_ | ING CON- e|o|o|o
TRACTS 111_01 TRACTS S a
(LOAN) (LOAN) n

RPT | FUNDED OFNF- FUNDED Y| N|N]JI
CON- ND _EM_ | CON- e|o|o|o
TRACTS 111_02 TRACTS s a
(LOAN) (LOAN) n

RPT | PRE-FUND- | OFNF- PRE-FUND- | Y [N | N |L
ING CON- ND_EM_ | ING CON- elo|o|o
TRACTS 112_01 TRACTS s a
(LINE) (LINE) n
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RPT | FUNDED OFNF- FUNDED Y| N|N|C
CON- ND _EM_ | CON- e|o|o|o
TRACTS 112_02 TRACTS s m
(LINE) (LINE) m
o}
n
RPT | PRE-FUND- | OFNF- PRE-FUND- [ Y [N | N |C
ING CON- ND_EM_ | ING CON- elo|o|o
TRACTS 121_01 TRACTS s m
(LEASE) (LEASE) m
o}
n
RPT | FUNDED OFNF- FUNDED Y| N|N|L
CON- ND_EM_ | CON- e|lo|o|o
TRACTS 121_02 TRACTS S a
(LEASE) (LEASE) n
RPT | ACCOUNT OCSAP- | ACCOUNT Y| N|N|L
PAYABLE P_EM_1 | PAYABLE elo|o|o
LOG BY 00_01 LOG BY s a
PRODUCER PRODUCER n
RPT | ACCOUNT OCSAPV | ACCOUNT Y| N|N|L
PAYABLE _EM_10 | PAYABLE elo|o|o
LOG BY 001 LOG BY S a
VENDOR VENDOR n
RPT | COLLAT- OCSAS- | COLLAT- Y|N|N|C
ERAL T EM_1 | ERAL elo|o|o
TRACKING 00_01 TRACKING | s m
LOG LOG m
o]
n
RPT | GL POST- 0OCSs- GL POST- Y| N|N|C
ING LOG GLI_EM ING LOG e|o|o|o
_100_01 s m
m
o}
n
RPT | PAYMENT OCSP- PAYMENT Y|N|N|C
POSTING MT_EM_ | POSTING elo|o|o
(DAILY 100 _01 (DAILY s m
CASH) LOG CASH) LOG m
o}
n
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RPT | PAYMENT OCSP- PAYMENT Y| N|N|C
POSTING MT_EM_ | POSTING elo|o|o
ERROR 100_02 ERROR s m
LOG LOG m

o}
n

RPT | ACCOUNT OCSAC- | ACCOUNT Y|N|NJ|L
LISTING C_EM_1 | LISTING elo|o|o
(LOAN) 11_01 (LOAN) s a

n

RPT | EXCESS OCSP- EXCESS Y|N|NJ|L
PAYMENT MT_EM_ | PAYMENT elo|o|o
(REFUND) 111_03 (REFUND) S a
LOG (LOAN) LOG n

(LOAN)

RPT | PAYMENT OCSP- PAYMENT Y| N|N|L
HISTORY MT_EM_ | HISTORY elo|o|o
(LOAN) 111_04 (LOAN) s a

n

RPT | PAYMENT OCSP- PAYMENT Y|N|NJ|L
ALLOCA- MT_EM_ | ALLOCA- elo|o|o
TIONS LOG | 111_05 TIONS LOG | s a
(LOAN) (LOAN) n

RPT | PAYMENT OCSP- PAYMENT Y|N|NJ|L
ALLOCA- MT_EM_ | ALLOCA- elo|o|o
TIONS LOG | 111_06 TIONS LOG | s a
BY GLPOST BY GL n
DT (LOAN) POST DT

(LOAN)

RPT | PRO- OCSPS- | PRO- Y| N|N|L
DUCER M_EM_1 | DUCER elo|o|o
STATE- 11_01 STATE- s a
MENT MENT n
(LOAN) (LOAN)

RPT | PRO- OCSPTX | PRO- Y|N|NJ|L
DUCER _EM_111 | DUCER elo|o|o
MONETARY | 01 MONE- s a
TXNS LOG TARY TXNS n
BY GLPOST LOG BY GL
DT (LOAN) POST DT

(LOAN)
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RPT | SCHED- OCSS- SCHED- Y| N|N|L
ULED FOR CH_EM_ | ULED FOR elo|o|o
CHAR- 111_01 CHAR- s a
GEOFF GEOFF n
ACCOUNTS ACCOUNTS
LOG (LOAN) LOG

(LOAN)

RPT | AMOR- OCSTA AMOR- Y|N|NJ|L
TIZEDTXNS | M_EM 1 | TIZED elo|o|o
LOG BY GL 11_01 TXNS LOG S a
POST DT BY GL n
(LOAN) POST DT

(LOAN)

RPT | SCHED- OCSTER | SCHED- Y|N|NJ|L
ULED FOR _EM_111 | ULED FOR elo|o|o
TERMINA- _01 TERMINA- s a
TION TION n
ACCOUNTS ACCOUNTS
LOG (LOAN) LOG

(LOAN)

RPT | MONETARY | OCSTX- | MONE- Y| N|N|L
TXNS LOG N_EM 1 | TARYTXNS |e |o |0 | O
BY GLPOST | 11_01 LOGBYGL |s a
DT (LOAN) POST DT n

(LOAN)

RPT | ACCOUNT OCSAC- | ACCOUNT Y|N|NJ|L
LISTING C_EM_1 | LISTING elo|o|o
(LINE) 12 01 (LINE) S a

n

RPT | ADVANCE OCSAD- | ADVANCE Y|N|NJ|L
POSTING V_EM_1 | POSTING elo|o|o
LOG (LINE) 12_01 LOG (LINE) | s a

n

RPT | ADVANCE OCSAD- | ADVANCE Y| N|N|L
POSTING V_EM_1 | POSTING elo|o|o
ERROR 12_02 ERROR s a
LOG (LINE) LOG (LINE) n

RPT | PAYMENT OCSP- PAYMENT Y| N|NJ|L
HISTORY MT_EM_ | HISTORY elo|o|o
(LINE) 112_04 (LINE) S a

n
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RPT PAYMENT OCSP- PAYMENT Y| N|N|C
ALLOCA- MT_EM_ | ALLOCA- e|o|o|oO
TIONS LOG 112_05 TIONS LOG | s m
(LINE) (LINE) m
o]
n
RPT PAYMENT OCSP- PAYMENT Y|N|N|C
ALLOCA- MT_EM_ | ALLOCA- elo|o|o
TIONS LOG 112_06 TIONS LOG | s m
BY GLPOST BY GL m
DT (LINE) POST DT o}
(LINE) n
RPT | SCHED- OCSS- SCHED- Y|N|N|C
ULED FOR CH_EM_ | ULED FOR elo|o|o
CHAR- 112_01 CHAR- s m
GEOFF GEOFF m
ACCOUNTS ACCOUNTS o]
LOG (LINE) LOG (LINE) n
RPT | AMOR- OCSTA AMOR- Y|N|N|C
TIZEDTXNS | M_EM_1 | TIZED e|o|o|oO
LOG BY GL 12_01 TXNS LOG S m
POST DT BY GL m
(LINE) POST DT o]
(LINE) n
RPT | SCHED- OCSTER | SCHED- Y|N|N|C
ULED FOR _EM_11 ULED FOR elo|o|o
TERMINA- 2 01 TERMINA- s m
TION TION m
ACCOUNTS ACCOUNTS o]
LOG (LINE) LOG (LINE) n
RPT MONETARY | OCSTX- | MONE- Y|N|N|C
TXNS LOG N EM 1 | TARYTXNS |e |o |0 |0
BY GLPOST | 12_01 LOGBYGL |s m
DT (LINE) POST DT m
(LINE) o
n
RPT | ACCOUNT OCSAC- | ACCOUNT Y| N|N|C
LISTING C_EM_1 | LISTING e|o|o|oO
(LEASE) 21_01 (LEASE) S m
m
o]
n
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RPT PAYMENT OCSP- PAYMENT Y| N|N|C
HISTORY MT_EM_ | HISTORY e|o|o|oO
(LEASE) 121_04 (LEASE) S m
m
o]
n
RPT PAYMENT OCSP- PAYMENT Y|N|N|C
ALLOCA- MT_EM_ | ALLOCA- elo|o|o
TIONS LOG 121_05 TIONS LOG | s m
(LEASE) (LEASE) m
o]
n
RPT PAYMENT OCSP- PAYMENT Y|N|N|C
ALLOCA- MT_EM_ | ALLOCA- elo|o|o
TIONS LOG 121_06 TIONS LOG | s m
BY GLPOST BY GL m
DT (LEASE) POST DT o]
(LEASE) n
RPT | SCHED- 0OCSS- SCHED- Y|N|N|C
ULED FOR CH_EM_ | ULED FOR e|o|o|oO
CHAR- 121_01 CHAR- S m
GEOFF GEOFF m
ACCOUNTS ACCOUNTS o]
LOG LOG n
(LEASE) (LEASE)
RPT | AMOR- OCSTA AMOR- Y|N|N|C
TIZEDTXNS | M_EM 1 | TIZED elo|o|o
LOG BY GL 21_01 TXNS LOG s m
POST DT BY GL m
(LEASE) POST DT 0
(LEASE) n
RPT | SCHED- OCSTER | SCHED- Y|N|N|C
ULED FOR _EM_12 | ULED FOR elo|o|o
TERMINA- 101 TERMINA- s m
TION TION m
ACCOUNTS ACCOUNTS o]
LOG LOG n
(LEASE) (LEASE)
RPT MONETARY | OCSTX- | MONE- Y|N|N|C
TXNS LOG N_EM 1 | TARYTXNS |e |o |0 | O
BY GLPOST | 21_01 LOGBYGL |s m
DT (LEASE) POST DT m
(LEASE) o]
n
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RPT | BANK- OCOBN | BANK- Y| N|N|C
RUPTCY K_EM_1 | RUPTCY elo|o|o
LOG 00_01 LOG s m
m
o}
n
RPT | COLLEC- OCO- COLLEC- N{N|Y | C
TOR ACTIV- | COL_EM | TORACTIV- |o |o | e |0
ITY _100_01 | ITY s |m
(DETAILED) (DETAILED) m
LOG LOG o]
n
RPT | COLLEC- OCO- COLLEC- NI{N|Y | C
TOR PRO- COL_EM | TOR PRO- o|ol|e|o
DUCTIVITY | _100_02 | DUCTIVITY s | m
BY QUEUE BY QUEUE m
o]
n
RPT | DELIN- OCO- DELIN- NIN|Y|C
QUENCY COL_EM | QUENCY o|lole|o
ANALYSIS _100_03 | ANALYSIS s |m
BY PRO- BY PRO- m
DUCER DUCER o}
n
RPT | DELIN- OCO- DELIN- N{N|Y | C
QUENCY COL_EM | QUENCY o|lo|e|o
ANALYSIS _100_04 | ANALYSIS s |m
BY CREDIT BY CREDIT m
GRADE GRADE 0
n
RPT | DELIN- OCO- DELIN- NI{N|Y |C
QUENCY COL_EM | QUENCY o|lol|e|o
ANALYSIS _100_05 | ANALYSIS s |m
BY STATE BY STATE m
o]
n
RPT | PAYMENT OCO- PAYMENT NIN|Y|C
PROMISE COL_EM | PROMISE o|lol|e|o
LOG _100_06 | LOG s |m
m
o}
n
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RPT | COLLEC- OCO- COLLEC- NIN|Y |C
TOR ACTIV- | COL_EM | TORACTIV- |[o |0 | e | O
ITY LOG _100_07 | ITYLOG s |m
m
o}
n
RPT | DEFI- OCODE- | DEFI- N{N|Y | C
CIENCY F_EM_1 | CIENCY o|lol|e|o
LOG 00_01 LOG s |m
m
o]
n
RPT | DELIN- OCODL DELIN- N{N|Y | C
QUENCY Q_EM_1 | QUENCY o|lo|le|o
LOG 00_01 LOG s |m
m
o]
n
RPT | REPOSSES- | OCORE | REPOS- NIN|Y|C
SION/FORE- | P_EM_1 | SESSION/ o|lol|e|o
CLOSURE 00_01 FORECLO- s |m
LOG SURE LOG m
o}
n
RPT | NON MONE- | OCOTN- | NONMON- [N|N|Y |C
TARY TXNS | M_EM 1 | ETARY o|lol|e|o
LOG 00_01 TXNS LOG s |m
m
o]
n
RPT | VENDOR OCOVIN | VENDOR NI{N|Y | C
INVOICE _EM_10 | INVOICE o|ol|e|o
LOG 0_01 LOG s |m
m
o
n
RPT | VENDOR OCOVN | VENDOR NIN|Y|C
WORK A_EM_1 | WORK o|lol|e|o
ORDER 00_01 ORDER s |m
LOG LOG m
o}
n
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RPT POOL 0OCS- POOL N|Y|N|C
DELIN- SEC_EM | DELIN- olel|o|o
QUENCY _111_01 QUENCY s m
SUMMARY SUMMARY m
(LOAN) (LOAN) o}
n
RPT POOL OCSs- POOL N|Y | N|C
DEFAULTS SEC_EM | DEFAULTS o|le|o|o
(NON LIQUI- | _111_02 | (NON LIQ- S m
DATED) UIDATED) m
(LOAN) (LOAN) o}
n
RPT POOL PAY- OCS- POOL PAY- NlY | N|C
OFFS SEC EM | OFFS o|le|o|o
(LOAN) _111_03 | (LOAN) s m
m
o]
n
RPT POOL 0OCSs- POOL N|Y|N|C
RECOVERY | SEC_EM | RECOV- olel|o|o
(LOAN) _111_04 | ERY (LOAN) s m
m
o}
n
RPT POOL OCSs- POOL NlY | N|C
DELIN- SEC_EM | DELIN- o|le|o|o
QUENCY _111_05 | QUENCY s m
(LOAN) (LOAN) m
o}
n
RPT POOL OCS- POOL NlY | N|C
REPUR- SEC_EM | REPUR- ole|o|o
CHASED _111_06 | CHASED s m
ACCOUNTS ACCOUNTS m
(LOAN) (LOAN) 0
n
RPT POOL 0OCSs- POOL N|Y|N|C
MONTHLY SEC_EM | MONTHLY ole|o|o
ACTIVITY _111_07 | ACTIVITY s m
(LOAN) (LOAN) m
o}
n
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RPT | POOL LIQ- 0OCS- POOL LIQ- N|Y|N|C
UIDATED SEC_EM | UIDATED olel|o|o
CON- _111_08 | CON- s m
TRACTS TRACTS m
(LOAN) (LOAN) o}
n
RPT | POOLTXNS | OCS- POOLTXNS [N|Y [N |C
LOGBYGL | SEC_ EM | LOGBYGL |o |e |0 |0
POST DT _111._09 | POST DT s m
(LOAN) (LOAN) m
o}
n
SET- | Real time QCSPR Real time N |[Y | Y | C | This batch job pro-
QRT | Queues pro- | C_B- Queuespro- | 0 | e | e | 0 | cesses queues
cessing J_100_0 | cessing s | s | m| marked as real
2 m | time based on
o | refresh frequency
n | setup in the job
set.
TAM | MONTH TPR- MONTH N|Y|N|C
END COM- COM_B- | END COM- ole|o|o
PENSATION | J_100_0 | PENSA- s m
DISBURSE- | 1 TION m
MENT PRO- DISBURSE- o}
CESSING MENT PRO- n
CESSING
TAM | PRO- TPRPS- | PRO- N|Y|N|C
DUCER G_B- DUCER ole|o|o
STATE- J 100 0 | STATE- s m
MENTS 1 MENTS m
o]
n
TAM | PRO- TPRSTA | PRO- N|Y|N|C
DUCER _BJ_100 | DUCER o|le|o|o
STATUS _01 STATUS s m
CHANGE CHANGE m
o]
n
TPE Escrow Anal- | TXNCH- | CHAR- N | Y | N| C | This package con-
ysis & Dis- G _B- GEOFF o | e | o | o | tains procedures
bursements J 100 0 | PROCESS- s m | related to Batch
2 ING FOR m | Job for chargeoff
ACTIVE 0 | processing
ACCOUNTS n
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ESC | ESCROW TESAN- | ESCROW N Y | N | C | This package con-
ANALYSIS L B- ANALYSIS o | e |0 | o | tains procedures
POSTING J _100_0 | POSTING s m | related to Batch
1 m | Job for escrow
0 | analysis process-
n | ing
ESC | CREATE TESAN- | CREATE N | Y | N| C | This package con-
BATCHES L_B- BATCHES o | e |0 | o | tains procedures
FOR CUS- J _100_0 | FOR CUS- s m | related to Batch
TOMER 2 TOMER m | Job for escrow
REFUND REFUND o0 | analysis process-
REQUESTS REQUESTS n | ing
ESC | COMPUTE TESAN- | COMPUTE N|Y|N|C
CONTROLS | L_B- CON- o|le|o|o
FOR CUS- J_100_0 | TROLSFOR s m
TOMER 4 CuUs- m
REFUND TOMER 0
REQUEST REFUND n
BATCHES REQUEST
BATCHES
ESC | ESCROW TESAN- | ESCROW N|Y|N|C
COMPLI- L_B- COMPLI- olel|o|o
ANCE J_100_0 | ANCE s m
CHECKING 5 CHECKING m
o}
n
ESC | CREATE TESDS- | CREATE N|Y|N|C
PAYABLE B _B- PAYABLE ole|o|o
REQUISI- J_100_0 | REQUISI- s m
TIONS 1 TIONS m
FROM FROM o]
APPROVED APPROVED n
DISBURSE- DISBURSE-
MENT MENT
REQUESTS REQUESTS
PUR | ARCHIVE PACARC | ARCHIVE N|Y|N|C
ACCOUNT _BJ_100 | ACCOUNT ole|o|o
DATATO _01 DATATO s m
OTABLES OTABLES m
o}
n
EVE BATCH EVBAC- | BATCH Y
EVENTS C_B- EVENTS e
FOR J_100_0 | FOR s
ACCOUNTS | 1 ACCOUNTS
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EVE BATCH EVBAP- | BATCH Y
EVENTS P_B- EVENTS e
FORAPPLI- | J 100 0 | FORAPPLI- | s
CATIONS 1 CATIONS
EVE MAIN EVB- MAIN Y
BATCH JOB | PRC_B- | BATCHJOB e
FORBATCH | J 100 0 | FORBATCH s
EVENTS 1 EVENTS
PROCESS- PROCESS-
ING ING
ODD | BATCHJOB | CBUUT- | BATCHJOB |Y
2 TO GENER- | L B- TO GENER- | e
ATE METRO | J 100 0 | ATEMETRO | s
2 DATA 2 2 DATA
ODD | BATCHJOB | CBUUT- | BATCHJOB |Y
2 FOR CRE- L B- FOR CRE- e
ATING J_100_0 | ATING s
METRO 2 3 METRO 2
DATA FILE DATA FILE
ODD | THIRD ACT- THIRD Y
2 PARTY ACH | PRC_B- | PARTY ACH e
PROCESS- J_100_0 | PROCESS- s
ING 1 ING
ODD | THIRD OBI- CREATE Y This process pulls
2 PARTY OUT- | PRC_B- | THIRD e the customer
PUT DATA J 100 0 | PARTY s account details
DUMP SER- | 1 CUS- shared in input
VICING TOMER data files for pro-
FILE cessing.
ESC | JOBTO OED- JOB TO Y
GENERATE PRC_B- | GENERATE e
ESCROW J 100 0 | ESCROW s
DISCLO- 1 DISCLO-
SURE SURE
STATEMENT STATE-
MENT
EDF | ADRFILE EDFADR | ADR FILE Y
_BJ_100 e
_01 s
EDF IVR FILE EDFIVR | IVRFILE Y
_BJ_100 e
01 s
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TPE CONTRAC- TXN- CONTRAC- Y
TUAL PRO- PRM_B- | TUAL PRO- e
MOTION J_100_0 | MOTION S
CANCEL 4 CANCEL _
PROCESS- PROCESS- _
ING ING
TPE RATE TXN- RATE Y
CHANGE RAT_B- CHANGE e
PROCESS- J_100_0 | PROCESS- S
ING FOR 2 ING FOR
BACK- BACK-
DATED DATED
INDEXES INDEXES
RDB | LOAD RACD- LOAD Y
1 ACCOUNT MP_B- ACCOUNT e
RELATED J_100_0 | RELATED s
DATA INTO 1 DATA INTO
T TABLES T TABLES
TPE EXPIRED TXNINS | EXPIRED Y
INSUR- _BJ_100 | INSUR- e
ANCE PRO- | _01 ANCE PRO- S
CESSING CESSING
ADT UPDATE ADT- UPDATE Y
ROWID IN PRC_B- | ROWID IN e
AUDIT J_100_0 | AUDIT S
TABLE (RUN | 1 TABLE
THIS JOB (RUN THIS
AFTER JOB AFTER
EXPORT- EXPORT-
IMPORT OF IMPORT OF
TABLES) TABLES)
RDB | LOAD RIND- LOAD Y
1 INSUR- MP_B- INSUR- e
ANCE DATA | J_100_0 | ANCE DATA s
TO T- 1 TO T-
TABLES TABLES
AGS | SALE LEAD | AGS- SALE LEAD | Y
AGING SAL_B- AGING e
J_100_0 S
1
BOD | PROCESS JOB- PROCESS Y
PARKED BOD _B- | PARKED e
TRANSAC- J_000_0 | TRANSAC- S
TIONS 2 TIONS
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BOD | MARK SYS- | JOB- MARK SYS- Y
TEM FOR BOD_B- | TEM FOR e
BEGINING J_000_0 | BEGINING S
OF DAY 1 OF DAY
EOD | SET SYS- JOBEOD | SET SYS- Y
TEM MODE | BJ 000 | TEM MODE e
TO END-OF- | 01 TO END- s
DAY OF-DAY
ACR | DAILYTRIAL | TABAC- DAILY Y
BALANCE C_B- TRIAL BAL- e
DATA J_100_0 | ANCE DATA s
1 GENERA-
TION
LTR2 | RATE LCS- RATE Y
CHANGE RAT_B- CHANGE e
PRE-INTI- J_100_0 | PRE-INTI- S
MATION 1 MATION
LETTER LETTER
BLK BULK BLK- BULK Y
UPLOAD PRP_B- UPLOAD e
FOR PRIC- J_100_0 | FOR PRIC- s
ING SETUP 1 ING SETUP
BLK BULK BLK- BULK c
UPLOAD GLS B- UPLOAD 0
FOR GL J_100_ 0 | FORGL m
ATTRI- 1 ATTRI- m
BUTES BUTES o]
n
BLK BULK BLK- BULK c
UPLOAD GLS_B- UPLOAD o]
FOR GL J_100_0 | FORGL m
TRANSLA- 2 TRANSLA- m
TION TION DEFI- o]
NITION n
BLK BULK BLK- BULK c
UPLOAD GLS B- UPLOAD 0
FOR GL J 100 0 | FORGL m
TRANSAC- 3 TRANSAC- m
TIONTYPES TION o]
TYPES n
DETAILS
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BLK BULK BLK- BULK c
UPLOAD GLS_B- UPLOAD o]
FOR GL J_100_0 | FORGL m
TRANSAC- 4 TRANSAC- m
TION LINKS TION LINKS o]
n
ODD | RATE OLSRAT | RATE Y
2 CHANGE _BJ 100 | CHANGE e
LETTER _01 LETTER s
FILE FILE CRE-
ATION
TPE EXPIRED TXN- EXPIRED Y
DRAW DRW_B- | DRAW e
PERIOD J_111_0 | PERIOD s
PROCESS- 1 PROCESS-
ING (STAGE ING (STAGE
FUNDED FUNDED
LOANS) LOANS)
ODD | DEALER OPSSB- | DEALER c
2 SUBVEN- V_B- SUBVEN- 0
TION J_100_0 | TION m
STATE- 1 STATE- m
MENTS MENTS o]
GENERA- n
TION
TAM | SUBVEN- TPRSB- | SUBVEN- c
TION V_B- TION 0
RECEIV- J_100_0 | RECEIV- m
ABLE PRO- 1 ABLE PRO- m
CESSING CESSING o}
(PAY AS GO) (PAY AS n
GO)
ODD | PRO- OPCPR PRO- c
2 DUCER C_B- DUCER o]
CHECK J_100_0 | CHECK m
PRINT 1 PRINT m
GENERA- o]
TION n
BSR | BEHAV- BSR- BEHAV- y
IORAL PRC_B- | IORAL e
SCORING J_100_0 | SCORING S
1
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Ea Description ?:ktfh Description E :E '% § Comment
=) D 2| =73
c = 0| O| =
w Olwm|O|a
AGE | TRANSAC- TXNAGE | TRANSAC- y
TION IN _BJ_100 | TIONIN e
WAITING _01 WAITING S
FOR FOR
APPROVAL APPROVAL
AGING AGING
PROCESS
ACR | PREPARE TXNA- PREPARE y
BATCH CR_B- BATCH e
DATA FOR J _100_0 | DATAFOR s
INTEREST 2 INTEREST
ACCRUAL ACCRUAL
AND DELIN- AND DELIN-
QUENCY QUENCY
PROCESS-
ING
PDC | POST PDCPR POST y
DATED C_B- DATED e
CHECKS J_100_0 | CHECKS S
1
PDC | PENDING PDCPN PENDING y
PDC D_B- PDC PRO- e
J_100_0 | CESSING S
1
LTR2 | PDC LCSPD- | PDC y
RENEWAL C _B- RENEWAL e
LETTER J 100 0 | LETTER s
1 GENERA-
TION
DOT | APPLICA- DOL- APPLICA- Y
TION DOCU- | PRC_B- | TION DOC- | e
MENT LOAD | J 000 0 | UMENT S
2 LOAD
ODD | ONE TIME OLSPD- | ONE TIME Y
2 ACH POST P_B- ACH POST e
DATED PAY- | J_100_0 | DATED S
MENT LET- 1 PAYMENT
TER LETTER
PROCESS-
ING
WFP | BILLING WTX- BILLING Y
BIL_B- PROCESS- e
J 132 0 | ING S
1
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WFP | DELIN- WTX- DELIN- Y
QUENCY DLQ_B- | QUENCY e
J_132_0 | PROCESS- S
1 ING
WFP | LATE WTX- LATE Y
CHARGE LTC B- CHARGE e
J_132_0 | ASSESS- s
1 MENT
WFP | STATEMENT | WTXPS- | STATE- Y
G _B- MENT GEN- e
J_132_0 | ERATION s
1
WFP | RATE WTX- RATE Y
CHANGE RAT_B- CHANGE e
J_132_0 | PROCESS- S
1 ING
WFP | TERMINA- WTX- TERMINA- Y
TION TIP_B- TION PRO- e
J 132 0 | CESSING S
1
TPE PERIODIC TXNPM- | PERIODIC
MAIN- F_B- MAIN-
TAINENCE J_100_0 | TAINENCE
FEE 1 FEE PRO-
CESSING
WFP | UNIT WUP- UNIT c
UPLOAD PRC_B- | UPLOAD o]
J_132.0 m
1 m
o]
n
ODD | BATCHJOB | CBUUT- | BATCH JOB
2 FOR L_B- FOR
MONTHLY J_100_0 | MONTHLY
HANDSOFF | 4 HAND-
FILE FOR SOFF FILE
SIMAH FOR SIMAH
PUR | PURGE ALL | PTTPRC | PURGE ALL c
PTT TABLES | _BJ 100 | PTT o]
_01 TABLES m
o
n
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c = 0| O| =
w Olwm|O|a
TPE BATCH JOB | TXN- BATCH JOB y
FOR SET- MAC_B- | FOR SET- e
TING J_100_0 | TING S
MATURED 1 MATURED
ACCOUNT ACCOUNT
CONDITION CONDITION
TPE NON TXNRF- | NON c
REFUND GL | D_B- REFUND 0
J _100_0 | GL PRO- m
1 CESSING m
o]
n
TPE PAYMENT TXNPA- PAYMENT y
ARRANGE- P_B- ARRANGE- e
MENT J_100_0 | MENT PRO- s
1 CESSING
TPE DELAY FEE | TXND- DELAY FEE y
LY _B- PROCESS- e
J_100_0 | ING S
1
TPE STATE- TXNST- STATE- y
MENT PAST | M_B- MENT PAST e
MATURITY J_100_0 | MATURITY s
1 PROCESS-
ING
TPE BLACK VEVBB- | BLACK c
BOOK K_B- BOOK o]
INTERFACE | J 100_0 | INTERFACE m
1 m
o
n
LBT BULK NSF TXNNS- | BULK NSF
PAYMENT F_B- PAYMENT
REVER- J_100_0 | REVER-
SALS 1 SALS
ACR | STOP TXNA- STOP y
INTEREST CR_B- INTEREST e
ACCRUAL J_100_0 | ACCRUAL s
3 PROCESS-
ING
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c = 0| O| =
w Olwm|O|a
QRT | CUSTOMER | QCSPR CUS- y
SERVICE C_B- TOMER e
REAL TIME J_100_0 | SERVICE s
QUEUE 2 REAL TIME
QUEUE
PROCESS-
ING
ODD | OUT- OCP- OuUT- y
2 BOUND PRC _B- | BOUND e
CUSTOMER | J_100_0 | CUS- S
EXTRACTS 1 TOMER
TO PAY- EXTRACTS
MENT TO PAY-
AGENCIES MENT
AGENCIES
IFP OFFLINE ICAPRC | OFFLINE y
CALL _BJ_100 | CALL e
ACTIVITY _01 ACTIVITY s
POSTING POSTING
ACR | RE-START TXNA- RE-START y
INTEREST CR_B- INTEREST e
ACCRUAL J_100_0 | ACCRUAL s
4
IFP UPLOAD ITUPRC | UPLOAD y
TRANSAC- _BJ 100 | TRANSAC- e
TIONS _01 TIONS s
IFP POST ITUPRC | POST y
UPLOADED | BJ 100 | UPLOADED e
TRANSAC- _02 TRANSAC- s
TIONS TIONS
IFP INPUT FILE ICE- CUR- Y | Y| Y| C| This process
PROCESS- PRC B- | RENCY e | e | e | o | extracts currency
ING - CUR- J_100_0 | EXCHANGE |s |s | s | m | exchange rates
RENCY 1 RATE FILE m | from desired
EXCHANGE UPLOAD o | source at sched-
RATE FILE n | uled intervals.
UPLOAD
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& 5 c

= I Batch . S| 2 8|

@ Description Job Description g S *g 9 Comment

=) D 2| =73

c = 0| O| =

w Olwm|O|a

IFP INPUT FILE IDDPRC | INPUT Y This process

PROCESS- _BJ_000 | DATA e updates customer
ING - INPUT | 01 INSERTION s account informa-
DATA tion corresponding
INSERTION to the details

received from
external system.
Ex: Bankruptcy
details in External
Interface screen or
Cure Letter details
in Account Infor-
mation screen.

Producer Cycles

The Producer setup screen enables you to define the dealer or producer status cycle. This
tells the system which status a producer can cycle through. (This information is recorded in

the Status field on the Producers section of the Producer setup screen.

For example,

(0

| TEMPORARY |

[INACTIVE]

The Producer Setup screen also defines the user responsibilities capable of changing the

prod

ucer status.

Note
The system enables only producers/dealers with a status of ACTIVE to fund contracts.

To set up Producer Cycles
On the Oracle Financial Services Lending and Leasing home screen, clickSetup >

1.

Setup > Administration > System > Producer Cycles.

The system displays the Producer Cycles screen. The producer cycle screen contains

three section:
Cycle Definition

Current/Next Status
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e Status Change Responsibilities

ORACLE’
Financial Services Lending and Leasing
Close
e Producer Cycles =
> Origination -
X Cycle Definition
Aeng View > Format~ [ Fresze [fiDetach wee @
» Collections Cyde Type
© WEP FRO PRODUCER CYCLE
> Tools
Setup Current/ Next Status dpadd || [Fvew || o audt
Setup = View v Formatv Freeze EfiDetach | ¢l Wrap 5]
Adminztraton Current Code: Next Code
System ACTIVE ACTIVE
System Parameter PR TEETIE
Lookups ACTIVE TEMPORARY
User Defined Tables NACTIVE ACTIE
Audit Tables NACTIVE INACTIVE
User Defined Defaults NACTIVE TEMPORARY
Transaction Codes |z TEMPORARY ACTIVE
Dats Fies TEMPORARY INACTIVE
Dedupe TEMPORARY Revporsay
Securitzation g
Events
Ramhimbs Status Change Responsibilities dpadd | ZEdt || [Even | 2 audt
Producer Cydes
ki Vew~ Fomate [ [|Freere [fiDetsch wep @
Collection Cydes Responsbilty A5 lowed Ind
Reports ALl Y
Error Messages
Translati ey
u;erra”” e Status Change Responsibifities
Organization [ ssveandstay | [ saveandRetum | {aRetim
Comparies
Access *Responshility ALL [=]
teers * Allowed ind [7]
Credit Bureau
Correspondence
General Ledger
Queues
Printers
Bark Detals
Check Details
Standard Payees
Currendies =

3. Inthe Cycle Definitions section, you can view the following information.

Field: View This:
Cycle Displays the cycle name.
Type Displays the cycle type.

4. In the Cycle/Next Status section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Current Code Select the current code from which you need to perform transition,
from the drop-down list.

Next Code Select the code to which you need to perform transition, from the
drop-down list.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Inthe Status Change Responsibilities section, perform any of the Basic Operations
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Responsibility Code Select the responsibility that will be capable of executing this
transition, from the drop-down list.
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Field: Do this:

Allowed Indicator Check this box to enable the responsibility to execute the
transition.

2.10 Vendors

During the life of an account, a financial institution might require the use of specialized
services of a vendor for various purposes; for example, repossessing a vehicle, retaining an
attorney for bankruptcy court proceedings, or making field calls. With the system’s Vendors
screen, you can define the following:

e Cycles
e Vendor Services
e Vendor Fees

2101 Cycles Tab

The Cycle link allows you to define the various vendor cycles and the responsibilities that can
gain access to the various transactions in each cycle. The different categories are:

e You can define vendor status cycle and restrict the status change based on
responsibility.

|&cTrvE £——NACTIVE

e You can define vendor invoice status cycle and restrict the status change based on
responsibility.

MEw ——={0PEN —=lclosE

LID

e You can define vendor assignment status cycle and restrict the status change based on
responsibility.

=D ——{OPEN ——COMPLETED ———>{CLOSE

WOID

e You can define vendor invoice payment status cycle and restrict the status change
based on responsibility.

MER CIRER CLOSE

*oID

1. Click Setup > Setup > Administration > System > Vendors > Cycles. The screen
contains three sections:

To set up the vendor cycles

e Status Cycle
e Current/Next Status
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e Status Change Responsibilities

ORACLE
Financial Services Lending and Leasing
@@ Vendors [ Close:
Status Cycle o add || P Edit Wi 7 Audit =
View = Formatv (& Freeze  pfiDetach rap oh)
> DashBoard
Cyde Type Order Type
> Origination 7
> Servicing VEN_REPO_ALL VENDOR ASSIGNMENT STATUS CYCLE ALL 2
* Collections VEN_COLLECTION VENDOR ASSIGNMENT STATUS CYCLE COLLECTION
VEN_CYC_2 VENDOR ASSIGNMENT STATUS CYCLE IMPOUND INVOLUNTARY REPOSSESSION
v WFP VEN_REPQ VENDOR ASSIGNMENT STATUS CYCLE REPOSSESSION -
 Tools
Setup Status Cycle
System [ saveandadd || [ saveandstay | [ saveandRetun || {aRetum
System Parameter
ke 4 *Cyde Type VENDOR ASSIGNMENT STATUS CYCLE = Order Type | ALL = ||}
User Defined Tables i
Audit Tables Current/ Next Status e add || it | S At
e Defined De faulks View ~ Format~ (B Freeze ffiDetach Wrap 7]
T E”s"‘d’”“ oS Current Code: Next Code Action Code Result Code
Lolasds No data to display.
Dedupe
Securitization
ks Status Change Responsibilities e 7 Audi
Batch Jobs : Lo = 2 T @
- v Freeze  HiDetad rep
Producer Cycles e &
B Responsbilty Alowed
Collection Cyeles .|| MNodata todisplay. I

2. Inthe Status Cycle section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields are given below:

Field: View this:

Cycle Specify the status cycle for the vendor.

Type Displays the type of vendor assignment status cycle.

Order Type Select the work order type for the vendor from the drop-down
list.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Current/Next Status section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Current Code Select the current code from which you need to transition,

from the drop-down list

Next Code Select the Next status code to which you need to transition,
from the drop-down list
Action Code Select the call activity action code from the drop down list.
Result Code Depending on the call activity action code, you can select the
result code from the drop down list.
Note

When there is a change in status from ‘Current’ to ‘Next’, system posts respective call ac-
tivity on the account based on selected Action and Result code.

5. Perform any of the Basic Actions mentioned in Navigation chapter.
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2.10.2

6. Inthe Status Change Responsibilities section, perform any of the Basic Operations
mentioned in Navigation chapter:

A brief description of the fields is given below:

Field: Do this:

Allowed Select ‘Yes’ to enable the responsibility to execute the transition and
‘No’ to disable

Responsibility Select the responsibility that will be capable of executing this transition
(from current code to the next code), from the drop-down list.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

Vendor Services Tab

The Vendor Service screen enables you to establish the links between the service type,
vendor group, and the work order type. It records which vendor groups can provide which type
of services and which service type belongs to which work order types.

For each service type (Service Type field), there can be multiple vendor groups and/or
multiple work order type(s).Each vendor (Group field) can belong to one or multiple vendor

group(s).
1. Click Setup > Setup > Administration > System > Vendors > Vendor Services. The
screen contains three sections:
e Services
e Vendor Groups
e Work Order Types

opace

Financial Services Lending and Leasing

) DashBoard e & e
 Origination Cycles  Vendor Services
 Servicing
> Collections Seniics
Views Fomatv [ [ Freeze i Detach wep @)
» WFP
Senice Type Enabled
> Tools ATTORNEY FEE ¥
Setup TRANSPORT OF UNIT Y
AUCTION/SALE CHARGES Y
Setup SEARCH BI/DHV RECORDS Y
Adniristation B0ND CHARGES " -
System
System Parameter
Lodus Vendor Groups PAdd [ View | Audt
User Defined Tables
Audit Tables Vien Fomat v [ Freee Hidetach  dwmp @)
User Defined Defaults Gioup
Transaction Codes
DataFies | | ATTOREY
Dedupe BANKRUPTCY TRUSTEE
Securitization
Events Vendor Groups
Eatch Jobs [ saeandadd | [ saveand stay | [ smve andRetum | Gapetum
Producer Cycles
Vendors “Grap v
Collection Cydles
Reports
Error Messages Work Order Types aid || Lt | [Fview | o auit
Translations Views Fomatv B [Freeze  Detach wep @
User ‘Work Order Type Transaction
Ofhenezation BANKRLPTCY LEGAL BANKRUPTCY EXPENGES
Companies COLLECTION REPDSSESSION EXPENSES
Access RECOVERY REPOSSESSION EXPENSES
Users
Credit Bureau
Correspondence
General Ledger o
Aueise
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2. Inthe Services section, you can view the following information:

Field: View this:
Service Type | Displays the service type.
Enabled Displays if the service is enabled or not.

3. Inthe Vendor Groups section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Group

Select the vendor group from the drop-down list.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. In the Work Order Types section, perform any of the Basic Operations mentioned in
Navigation chapter:

A brief description of the fields is given below:

Field:

Do this:

Work Order Type Select the work order type from the drop-down list.

Transaction

Select the associated transaction for the service type from the
drop-down list.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

Vendor Fees Tab

The Vendor Fees tab allows you to define fee structure (with specific amount) for each service
offered by specific vendor. The defined fees is auto populated as the estimated cost of the
assignment when a specific vendor and service is selected during work order creation.
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To define vendor fees

1. Click Setup > Setup > Administration > System > Vendors > Vendor Fees. The

screen consists of Vendor Service Fee Definition section with option to define vendor

fees.
ORACLE’

Financial Services Lending and Leasing

ility

g sonout &

> DashBoard

'+ Origination

» Servicing

»» Collections

> WFP

 Tools

Setup

System

System Parameter
Lookups
User Defined Tables
Audit Tables
User Defined Defaults
Transaction Codes
Data Files
Dedupe
Securitization
Events
Batch Jobs
Producer Cydes
Vendors

Vendors .

Cydes = Vendor Services  Vendor Fees

Vendor Service Fee Definition o Add

=
End Dt
12/31/4000
12{31/4000
12{31/4000
12/31/4000
12/31/4000

S Edit ] view

Freeze

o]

View ¥ Format ¥ L Detach o1l Wrap

Start Dt Enabled
08/05/2016
01/01/2000
08/01/2016
01/01/2000
08/04/2000
f

Amt
0.00
10.00
7.00
9.00
200.00

Vendor Group vendor Services
ATTORNEY
ATTORNEY
REPO AGENCY

ATTORNEY

PA-02001-MAC VENDOR
PR-03002-TEST_VENDOR.
ALL

ALL

ATTORNEY FEE
ATTORNEY FEE
REPOSSESSION
ATTORNEY FEE

| =< < < < B

T

Vendor Service Fee Definition

[ save and Add | [ Save and Stay. Save sndReturn | (g Return

Selection Criteria

&
&

*StartDt 08/05/2015 * Company
*End Dt 12/31/4000

* Enabled (]

.
T Branch

Group

[=]
* Vendor hd

[=]

* Vendor
+amt 0.00 Channel

.
*Services o

4 m

Brcic

2.

In the Vendor Service Fee Definition section, perform any of the Basic Operations

mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Start Dt System defaults the current date as the start date. You can modify the
same to a future date using the adjoining calendar.

End Dt Specify the end date from the adjoining Calendar.

Enabled Select the check box to enable the fee structure.

Amt Specify the amount charged by the vendor for a specific service.

Selection Criteria

Vendor Select the vendor group from the drop-down list. You can also select

Group ‘ALL’ (default option) if the fee structure is applicable across vendor
groups.

Vendor Select the vendor from the drop-down list. You can also select ‘ALL’ if
you have selected the ‘Vendor Group’ as ‘ALL’. The list is sorted
depending on the vendor group selected.

Services Select the service from the drop-down list. The list is sorted depending
on the services offered by the selected Vendor.

Company System defaults this value based on the vendor selected. You can
also select the required company from the drop-down list.

Branch System defaults this value based on the vendor selected. You can

also select the required branch from the drop-down list.
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Field: Do this:

Vendor System defaults this value based on the vendor selected. You can
Channel also select the required vendor channel from the drop-down list.
State System defaults the state in which the vendor operates. You can also

select the state from the drop-down list.

3. Perform any of the Basic Actions mentioned in Navigation chapter

2.10.4 Invoice Rules tab

The Invoice Rules tab allows you to define state specific rules with a combination of service
and work order status. This helps to decide if a particular service fees in a work order is
‘Collectable or Not’ from the customer.

When the same combination of service, work order status and state is detected during auto
invoice validation, the ‘Collectible’ check box in Vendors > Invoice tab > Invoice Details
section is selected. Further, the collectible amount is posted as an expense on the customer
account.

To define invoice rules

1. Click Setup > Setup > Administration > System > Vendors > Invoice Rules.

2. Inthe Invoice Rules section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Service Select the service from the drop-down list. The list consists of services
offered by Vendors which can be associated with a work order.

Work Order Select the work order status from the drop-down list.

Status

Close Rea- Select the close reason from the drop-down list. This field is enabled

son only if the work order status is selected as ‘CLOSE’.

State Select the state from the drop-down list. The selection here indicates
that the state rules allow to collect the service fee for selected service
from the customer.

Enabled Select the check box to enable the invoice rule.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.11 Reports

The Reports screen allows you to setup reports in the system.

To set up the Reports

1. Click Setup > Setup > Administration > System > Reports link. The system displays
the Report screen. The details are grouped into two:

e Reports
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e Report Parameters

2. In the Reports section, perform any of the Basic Operations mentioned in Navigation
chapter.

ORACLE’ j & Welcome, PRAKRRAO v  Accessiilty o
Financial Services Lending and Leasing

Close.
DashBoard Bt x e

> Origination

Reports e add | AEdit | [Eview | 2 Audit
View + | Formet | [ Fresze [fiDetach <l Wrap 5]

> Collections ¢ il

> WFP Code Description Package Module

> Tools UNDEFINED

Setup ACCESS_BY_RESPPONSIBILITY  ACCESS BY RESPPONSIBILITY OUSRAC_EM_100_01 ORIGINATION
Setup ACCOUNT_WISE_PDC ACOOUNT WISE PDC LIST OCSPDC_EM_100_03 SERVICING

Administration A ACC_LIST_LEASE ACCOUNTS AND LISTING - LEASE QCSACC_EM_121 01 COLLECTIONS

System ACC_LIST_LINE ‘ACOQUNTS AND LISTING - LINE OCSACC_EM_112 01 COLLECTIONS
System Paramete
Lookups
User Defined Tat Reports
Audit Tables EH saveand add || [ Save and stay Save and Retum | 3 Retum

> Servicing

Enabled
N

v
7
¥
=

User Defined Def
Transaction Code. *Code = Module [¥]
Dats Files
Dedupe
Securitization * Package |UNDEFINED * Enabled []
Events
Batch Jobs )  Report Parameters dradd | Fedie | [Eview | oF audit
5;:1:? o View v Format~ | [0 Freeze % Detach wap | BR
Collection Cycles| | &
Reparts Parameter Description Parameter Type Parameter Sub Type Default Sort Enzbled
Error Messages No data to display.
Translations
User
Organization
Companies
Access
Users
Credit Bureau
Correspondence
General Ledger
Queues
Printers
Bank Details
Check Details
Standard Payess
Curencies
Zip Codes
Products
< >

* Description * System Defined () Yes @ No

A brief description of the fields is given below:

Field Do this:

Code Specify the code of the report.

Description Specify the description of the report.

Package Specify the package .

Module Select the code of the report from the drop-down list.

System Select ‘Yes’, if you wish to maintain the Report as system defined
Defined Yes/ | and ‘No’, if you do not want to maintain it as system defined.

No System defined entries cannot be modified. If the entry is not
system defined, then it can be modified.

Enabled Check this box to enable the report definition.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Report Parameters section,perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Parameter Specify the parameter code of the report.

Description Specify the description of the parameter.
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Field Do this:

Parameter Type Select the parameter type of the report from the drop-down list.

Parameter Sub Type Select the parameter sub type of the report from the drop-down
list.

Default Specify the default value for the report parameter (value to
initially populate, or used if no value is supplied) (optional).

Sort Specify the sort order for the lookup code. This determines the
order these report parameters are displayed or processed.

Enabled Check this box to enable the report definition.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

2.12 Error Messages

In the Error Messages Setup screen, you can translate or modify the text of error messages.
the system displays all messages as they appear to the system users in the Error Message
section’s Message field.

New messages created with the Error Messages screen can then be translated with the
Setup > Setup > Administration > System > Translation > Message Translation screen.

To set up the Error Messages Setup screen
1. Click Setup > Setup > Administration > System > Error Messages. The system
displays the Error Message screen.

2. Onthe Error Messages Setup screen’s Error Type section, use the Error Type field to
select the error type. These are the categories of error messages available for creating or
editing.

3. The error messages associated with the error type you selected appear in the Error
Message section.
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4. Inthe Error Messages section, perform any of the Basic Operations mentioned in
Navigation chapter.

Financial Services Lending and Leasing
Close
DachBoard Error Messages x [E3fe
> Origination
o Error Message
rvicing
View  Formatw [ Freeze & Detach Il wrap 5]
> Collections
Error Type
> WFP SERVER MESSAGE
IENT ERROS )
o] CLEENT ERROR
CLIENT MESSAGE
Setup CLIENT QUESTION v
Setup SERVER ERROR
Admiristration ()
System
System Parametc Error Message qpadd | Fedt | Hw <7 Aud
Lok - View~ Format~ [ Fracze B Detach I wrap e
User Defined Tal
S Region Country Customer Engine Error Code Error Message Enobled
(e Dol e UNDEFINED UNDEFINED UNDEFINED UNDEFINED. UNDEFINED N H
Transaction Code svs sv5 515 ™ 000001 Trensaction Locked, Transaction Posting Failed ¥
Datz Files svs svs svs ™~ ooosoz 0 === Transaction Posting Successful *=*== ¥
Dedupz sYs sYs sYs ™N Transaction Posting will occur on Txn Dt Y
Securitization -
i Invalid Account Number - ~ACC_NER~ , Transaction
Events BH =5 svs ™ Posting Failed ¥
Batch Jobs M srs svs svs N Transaction Posting Failed ¥
P"“d“m o svs svs s ™™ Transaction Locked, Transaction Posting Faled v
Vendors
Collection Cycles svs s1s svs ™M =*=*= Transaction Posting Successful *+*+* 1
Reports s¥s svs svs ™M Transaction Posting will accur on Txn Dt Y
Error Messages - - - - P— Invalid Account Number - ~ACC_NER-~ , Transaction - v
Translations Posting Failed
User
Organkzstion Error Message
;cm"a"“’g El ssveand 2dd || [l ssve and stay || [ save and Retum || (3 Retum
coess
Users _ . ——
— Region  UNDEFINED Engine UNDEFINED Enable
Correspondence *Country UNDEFINED *Error Code | UNDEFINED * Error Message
Generel | ey = Customer # UNDEFINED * System Defined () ves(®) No
Queues
Printers
Bank Details
Chack Details
Standard Payees
Currencies
Zip Codes
Products
< >

A brief description of the fields is given below:

Field

Do this:

Region

Specify the region code.

Country

Specify the country code.

Customer

Specify the customer code.

Engine

Specify the engine code.

Error Code

Specify the error code.

System Defined Displays whether the record is system defined or not.

Enabled Check this box to enable the data error message.

Error Message Specify the error message.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

2.13 Translation

You can setup translation properties.

Navigating to Translation

1. Click Setup > Setup > Administration > System > Translation. The system displays
the Translation screen. On this screen you can,

e Setup Translation
e Translate Error Messages
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2131

Setup Translation

In the Setup Translation tab, you can translate the contents of a predefined list of setup
description fields into a different language.

After you translate an entry in the Translation Data section, the system adds the new data to
the setup form.

To set up the Translation Setup

1. Click Setup > Setup > Administration > System > Translation > Setup Translation.

2. In the Language section, you can select the language for which you need to setup the

translation.
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Note

For more information, refer Language setup at the end of this chapter.

3. Inthe Source Type section, you can select the source (or location in the system) of the
item you want to translate.

4. Click Populate All in the Source Type section and the system loads the setup data
descriptions in the Translation section screen for the selected source type.
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If you have new entries and are unsure as to which setup items have been updated
since the last translation, click Populate All, the system loads the additional data for all
items with no impact to the previously translated data for any of the entries.

5. In the Translation Data section, Select:

e All-to view all the records (both translated and un-translated) in the Translation Data
section.

e Translated — to view all the translated records in the Translation Data section.
e Un Translated — to view all the un-translated records in the Translation Data section.

6. Inthe Translation Data section, perform any of the Basic Operations mentioned in
Navigation chapter.

Note

You cannot add a new record.

A brief description of the fields is given below:

Field Do this:

Key 1 Displays the first reference key value.

Key 2 Displays the second reference key value.

Key 3 Displays the third reference key value.

Key 4 Displays the fourth reference key value.

Key 5 Displays the fifth reference key value.

Key 6 Displays the sixth reference key value.

System Defined Select ‘Yes’, if you wish to maintain the data as system defined

and ‘No’, if you do not want to maintain it as system defined.

Enabled Check this box to indicate that the record is active.

Desc 1 Translation 1 | Specify the first translated description.

Desc 2 Translation 2 | Specify the second translated description.

Desc 3 Translation 3 | Specify the third translated description.

Desc 4 Translation 4 | Specify the fourth translated description.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

2.13.2 Message Translation Setup

In the Message Translation tab, you can translate the contents of a predefined list of error
messages into a different language.

After you translate an entry in the Error Message section, the system adds the new data to
the error message.
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To set up the Message Translation Setup

1. Click Setup > Setup > Administration > System > Translation > Message
Translation.

2. Inthe Language section, you can select the language for which the translation needs to
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For more information, refer Language setup at the end of this chapter.

3. Inthe Error Type, you can select the type of error message you want to translate.

4. Click Populate All in the Error Type section and the system loads the error messages
in the Error Message section for the selected error type.

If you have new entries and are unsure as to which error messages have been updated
since the last translation, click Populate All, the system loads the additional data for all
items with no impact to the previously translated data for any of the entries.

5. Inthe Error Message section, select:

e All —to view all the records (both translated and un-translated) in the Error Message
section.

e Translated — to view all the translated records in the Error Message section.
e Untranslated — to view all the un-translated records in the Error Message section.

6. Inthe Error Message section, perform any of the Basic Operations mentioned in
Navigation chapter.

Note

You cannot add a new record.
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A brief description of the fields is given below:

Field Do this:

Region Displays the region code.

Country Displays the country code.

Customer Displays the customer code.

Engine Displays the engine name.

Error Code Displays the error code.

System Defined Check this box to indicate that the record is system defined.
Enabled Check this box to indicate that the record is active.
Message Specify the error message.

English Translation Specify the English translated description.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

Language setup

On the Lookup master tab’s Lookup Types screen, you can add other languages to the
TRD_LANGUAGE_CD lookup type and perform translations for those languages.

However, translated data only appears in one language, which is defined by the User
Language parameter. This parameter can be defined in the system configuration file, typically
named DBKWEB.CFG, which defines the parameter as:

Parameter: otherparams=0ORA_USER=<schema_name> USR_LANG=<native language>

Note

<native language> should match lookup codes in the TRD LANGUAGE_CD lookup type
on the Administration form’s Lookups screen.

The system supports the following pre-defined list of setup items for translation:

9.

© N o g~ w DN =

Asset Sub Types

Asset Types
Assignments

Audit Table Columns
Audit Tables

Call Action Result Types
Call Action Types
Checklist Action Types
Checklist Types

10. Commission Plans

1

1. Companies
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12.
13.
14.
15.
16.
17.
18.
19.
20.
21.
22.
23.
24.
25.
26.
27.
28.
20.
30.
31.
32.
33.
34.
35.
36.
37.
38.
39.
40.
41.
42.
43.
44,

Company Branch Departments
Company Branches
Compensation Plans

Credit Bureau Score Reasons
Credit Models

Credit Scoring Parameters
Edits

Escrow Disburse Rules
Escrow Sub Types

Flex Table Attributes

Flex Tables

GL Transaction Types

GL Translators

Job Sets

Jobs

Lookup Codes

Lookup Types

Portfolio Companies

Portfolio Company Branches
Producers

Product Instruments

Product Insurances

Product Pricings

Products

Promotions

Spreads

Standard Correspondences
Standard Document Definitions
Standard Element Definitions
Standard Function Definitions
Transaction Codes

Error Messages

Org. Fees

Seed Data

Seed data in general is referred to as any data delivered with the standard product installation
and is required to be present in the production environment for application to work properly.
Seed data basically consists of Table with its associated data that are uploaded into the

system through DAT files.
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Seed Data screen in Oracle Financial Services Lending and Leasing displays the existing
seed data details maintained in the system and allows you to compare and selectively merge
only the required differences in each record.

Seed data difference arise when there are new tables and/or its associated data are updated
on base installation during subsequent patch updates and customizations done to existing
seed data during implementation. Manual merging of seed data difference ensures to have
minimal impact on the existing seed data configuration.

Navigating to Seed Data screen

1. Click Setup > Setup > Administration > System > Seed Data. The system displays the
Seed Data screen.

2. On this screen you can do the following:

e View and update the seed data differences between factory shipped data and current
data in ‘Factory Data’ tab.

e View the current system seed data details in ‘Current Data’ tab.
e View the differences between Factory data and Current data in ‘Comparison Data’ tab.

Factory Data

The Factory Data tab displays the consolidated list of seed data which include the initially
shipped seed data and subsequent additions done though upgrades and patch installations.

In the Factory Data tab you can selectively merge the required seed data differences into the
respective seed data tables. Merging involves adding new seed data or updating the latest
changes into existing seed data. Accordingly, you can sort the view in Factory Data tab by
selecting ‘Insert’, ‘Update’ or ‘All' options to display the list of corresponding seed data.

In the ‘Patch # drop-down list, you can further sort the list to display ‘ALL’ the seed data or
only the additions or updates available as part of latest patch which has seed data changes.

To View Factory Data

Click Setup > Setup > Administration > System > Seed Data > Factory Data tab.
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The ‘Factory Data’ section displays the list of seed data (table definitions) available in the
system with the following details:

Field View this:
Table Displays the seed data table name.
Type Displays the category of seed data as either System or

Combination Data.

Key Column Displays the unique identifier columns.

Key Column Type Displays the unique identifier column data types.

Other Columns Displays the non unique identifier column names.

Other Column Types Displays the non unique identifier column data types.
Count Displays the total count of records in the seed data table.

The ‘Factory Data Details’ section displays the associated data of the selected seed data
table along with the following details:

Field View this:

Key Column Data Displays the unique identifier column names.

Other Column Data Displays the non unique identifier column names.

Patch # Displays the patch number with which the seed data changes

are identified.

Status Displays the current status of seed data as Updated, Posted,
Skipped or Deprecated.

In the ‘Factory Data’ tab, you can click (refresh) to fetch the latest details and click ‘View’
to display the detailed information of the selected record.

Insert/Update Data

The ‘Insert’ and ‘Update’ options in the Factory Data tab allows you to ‘Insert’ (add new setup
data) and/or ‘Update’ (modify existing setup data). However, ensure to double check the
details before using ‘Insert’ or ‘Update’ operations since the same can have significant impact
on system behaviour.

To Insert/Update Data

1. In the Factory Data’ tab,

— Select ‘Insert Data’. System displays those records which are to be added into the
seed data tables.

— Select ‘Update Data’. System displays those records which are to be updated to the
existing seed data tables.

2. Inspect the required record in Factory Data section with the Factory Data Details in
subsequent section.

3. Select the required record to be updated by clicking on the adjacent check box. You can
also click ‘Select All' to select all the records.
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4. Based on the option selected in step 1, do one of the following:

— Click ‘Insert’. This action appends the new seed data on to the current Data, which
are received as a part of the patch or release.

— Click ‘Update Data’. This action updates the current data which are modified during
implementation as part of the current release.

5. Click ‘Yes’ in confirmation dialog to confirm the setup data changes.

On successful update, system does the following:

e When individual records are selected and inserted/updated, the same is removed from
Factory Data Details section and the ‘Insert Count’ column in Factory Data section is
updated with the remaining number of records.

e In case of Bulk update, the record is removed from Factory Data tab.

Current Data

The Current data tab displays the seed data which are currently available in the system.

To View Current Data

Click Setup > Setup > Administration > System > Seed Data > Current Data tab.
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The ‘Current Data’ section displays the following details:

Field View this:

Table Displays the current seed data table name.

Type Displays the category of seed data as either System or
Combination Data.

Key Column Displays the unique identifier columns.

Key Column Type Displays the unique identifier column data types.

Other Columns Displays the non unique identifier column names.

Other Column Types Displays the non unique identifier column data types.
Count Displays the total count of records in the seed data table.
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Field View this:

Last Refreshed Dt Displays the date and time when seed data for the selected
table was last updated in the system.

The subsequent ‘Current Data Details’ section displays the associated data of the selected
seed data table along with the following details:

Field View this:

Key Column Data Displays the unique identifier column names.

Other Column Data Displays the non unique identifier column names.

In the ‘Current Data’ tab, you can click (refresh) to fetch the latest details and click ‘View’
to display the detailed information of the selected record.

Additionally you can click “Refresh Data’ to pull the seed data details from the system and
update the current seed data tables.

Comparison Data

The ‘Comparison Data’ tab displays the seed data differences between Factory Data and
Current Data. These differences arise when the seed data of base installation is updated with
changes as part of patch installation or other specific customizations.

In the Comparison Data tab, you can sort the list of seed data by selecting ‘Insert’ or ‘Update’
options to display either new or updated seed data respectively.

To View Comparison Data
Click Setup > Setup > Administration > System > Seed Data > Comparison Data tab.

The Comparison Data’ tab by default displays the differences in Factory data.
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The ‘Comparison Data’ section displays the list of records which are added/updated in the
system with the following details:

Field View this:

Table Displays the seed data table name to be inserted or updated.
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Field View this:

Type Displays the category of seed data as either System or
Combination Data.

Key Column Displays the unique identifier columns.

Key Column Type

Displays the unique identifier column data types.

Other Columns

Displays the non unique identifier column names.

Other Column Types

Displays the non unique identifier column data types.

Count

Displays the total count of records in the seed data table.

The subsequent ‘Comparison Data Details’ section displays the associated data of the
selected seed data table along with the following details:

Field

View this:

Key Column Data

Displays the unique identifier column names.

Other Column Data

Displays the non unique identifier column names.

Patch #

Displays the patch release version with which the seed data
was inserted/updated.

In the ‘Comparison Data’ tab, you can click (refresh) to fetch the latest details and click
‘View’ to display the detailed information of the selected record.
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3. Administration User

In the Administration > User, you can record setup data that define your organization
structure and its users. Information in this link is more “data” related, whereas the information
stored on the System drop-down link functions more like switches that control system
behavior.

Navigating to Administration System

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User.

The User drop-down link records the following data:

e Organization

e Companies

e Access

e Users

e Credit Bureau

e Correspondence
e General Ledger
e Queues

e Printers

e Bank Details

e Check Details

e Standard Payees
e Currencies

e ZipCodes

Organization

The Organization screen records the operational hierarchy of your business in terms of
people. It groups the human resources of your business in three categories: organization,
division, and department. The system uses this data to control access of users to applications
and accounts.(The Companies screen allows you to setup the location of these applications
and accounts.)

Note

You can have only one active organization, so use the Organization field to define your
organization at its highest level.

Divisions are groups within your organization that will have access to the same
applicationsand accounts. Larger organizations often define their divisions by region. Smaller
organizations may define division as branch offices or even departments, and might only have
one division defined.
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Departments are smaller units within a division. They expand on who is in the corresponding
Division field. The system uses this sub screen, for example, when setting up the Services
screen on the Utility form. At least one department must be defined for each division.

I—Qrganization —‘ '
I—.. Division A —l | I— Divisioln .B —I

' Deptl Dept2 Dept 3 Deptl Dept2 . Dept 3
{PEOPLE)

As an example of an organization setup, Oracle Corp. might be defined as:
Organization: O-00010racle Corp.ORA

Division: OD-001Central RegionC01

Department. ODD-010riginationORG

Department. ODD-02FundingFUN

Department. ODD-03ServicingSER

Division: OD-002Eastern RegionE01

Department. ODD-11ServicingSER

Department. ODD-12CollectionCOL

™ ]

I—Central Region (C01) —I Eastern Region (E0L)
Crigination Funding Servicing Servicing .Collcctions
(ORG) {FUN) (SERV) (SER) (coL)

Note

The Short Name field on the Organization screen allows you to create the ID that Oracle
Financial Services Lending and Leasing will use when referring to the organization, divi-
sion, and department throughout the system.

To setup the Organization screen
1. Click Setup > Setup > Administration > User > Organization.
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2. In the Organization Definition section, there can be only one active entry, so use this
screen to define your organization at its highest level. Perform any of the Basic
Operations mentioned in Navigation chapter.
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A brief description of the fields is given below:

Field:

Do this:

Organization

Specify the organization ID (the ID is the unique identifier used
internally by Oracle Financial Services Lending and Leasing to
represent your organization).

Note: Do not edit this field.

Organization Name

Specify the organization name.

Short Name

Specify the short name for the organization.

Note: This ID represents this organization throughout the sys-
tem.

Enabled

Check this box to enable the organization.

Note: Only one enabled organization is currently allowed by
Oracle Financial Services Lending and Leasing.

Country

Select the country where the organization is located from the
drop-down list.

City

Specify the city where the organization is located.

State

Select the state where the organization is located from the
drop-down list.

Address Line 1

Specify the address line 1 for the organization.

Address Line 2

Specify the address line 2 for the organization.
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Field: Do this:

Zip Select the zip code of the location where the organization is
located from the drop-down list.

Extn Specify the extension of the selected zip code.

Phone 1 Specify the primary phone number for the organization.

Extn 1 Specify the phone extension for the primary phone number.

Phone 2 Specify the alternate phone number for the organization .

Extn 2 Specify the phone extension for the alternate phone number, if
specified.

Fax 1 Specify the primary fax number for the organization.

Fax 2 Specify the alternate fax number for the organization.

Perform any of the Basic Actions mentioned in Navigation chapter.

In the Division Definition section, you can setup the information for the groups within
your organization that will have access to the same applications and accounts. Perform

any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Division

Specify the division ID. The ID is the unique identifier used inter-
nally by the system to represent the division within the organiza-
tion.

Note: Once specified, do not edit this field.

Division Name

Specify the division name.

Short Name Specify the short name for the division.
Note: This ID represents this division throughout the system
(required).

Enabled Check this box to enable the division.

Country Select the country where the division is located from the drop-
down list.

City Specify the city where the division is located.

State Select the state where the division is located from the drop-down

list.

Address Line 1

Specify the address line 1 for the division.

Address Line 2
(unlabeled)

Specify the address line 2 for the division.

Zip

Select the zip code of the location where the division is located
from the drop-down list.
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Field: Do this:

Extn Specify the extension of the selected zip code.

Phone 1 Specify the primary phone number for the division.
Extn 1 Specify the extension for the primary phone number.
Phone 2 Specify the alternate phone number for the division.
Extn 2 Specify the extension for the alternate phone number .
Fax 1 Specify the primary fax number for the division.

Fax 2 Specify the alternate fax number for the division.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Click Setup > Setup > Administration > User > Organization > Department
Definition.

7. On the Department Definition section, perform any of the Basic Operations mentioned
in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Department Specify the department ID.

Note: The ID is the unique identifier used internally by the sys-
tem to represent the department within the division.

Department Name Specify the department name.

Short Name Specify the short name for the department.

Note: This is the ID that appears throughout the system to repre-
sent this department.

Enabled Check this box to enable the department.

Country Select the country where the department is located from the
drop-down list.

City Specify the city where the department is located.

State Select the state where the department is located from the drop-
down list.

Address Line 1 Specify the address line 1 for the department.

Address Line 2 Specify the address line 2 for the department.

Zip Select the zip code where the department is located from the

drop-down list.

Extn Specify the zip extension where the department is located.
Phone 1 Specify the primary phone number for the department.
Extn 1 Specify the phone extension for the primary phone number.
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3.2

Field: Do this:

Phone 2 Specify the alternate phone number for the department.
Extn 2 Specify the phone extension for the alternate phone number.
Fax 1 Specify the primary fax number for the department.

Fax 2 Specify the alternate fax number for the department.

8. Perform any of the Basic Actions mentioned in Navigation chapter.

9. Click Setup > Setup > Administration > User > Organization > Display Format.

10. On the Display Format section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Format Type Select the type of format from the drop-down list.

Format Sub Type Select the sub type of the format from the drop-down list. The format
sub type will be displayed based on the format type selected.

Format Specify or select the format based on the format type and format sub

type selected. For Date and Time Zone format, select the required
option from the drop-down list.

Format Mask

Specify the format mask.

Format Filler

Specify the format filler.

Special Data

Specify the special data, if any.

Enabled

Check this box to enable the display format.

11. Perform any of the Basic Actions mentioned in Navigation chapter.

Companies

The Companies screen records the hierarchical structure of your portfolio companies and

their branches. Just as Oracle Financial Services Lending and Leasing uses the Organization
screen to determine the location of people, it uses the information on the Companies screen
to determine the location of applications and accounts. In completing the Companies screen,
there can be more than one company, and each company can have more than one branch.

Accounting is performed at the company level. Accounts and applicationscan be sorted down
to the branch level. For this reason, branches are set up to reflect different business practices.
You would set up different branches if, for example:

e The General Ledger (GL) differs between branches
e The branches work with different accounts
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e There is a difference between branches in terms of the tasks they perform (loan
origination, servicing, collections, and so on)

= Cempany A Company B
I | [ 1 ]
Branch 1 Branch 2 Branch 3 Branch 1 Branch 2 Branch 3
(APPLICATIONS/ACCOUNTS)

As an example of the companies setup, Oracle Corp. might have the following companies and
branches defined as:

Company: C-0001TrustOne Financial CorpTOFC
Branch: CB-01TOFC - HeadquartersHQ

Branch: CB-02Kennedy Plaza KP

Company: C-0002Credtyme Credit CorpCCC
Branch: CB-11CCC - HeadquartersHQ

Branch: CB-12CCC - MissoulaMT

— The system does not limit the number of companies or associated branches with
the company you can enter.

— The Short Name field on the Companies screen allows you to create the ID that the
system will use while referring to the company and branch.

KEY CONCEPT: Note the difference between the Company screen and the Organization
screen:

e On the Organization screen, Oracle Financial Services Lending and Leasing users
belong to an organization and division.

e Onthe Companies screen, creditapplications and accounts belong to a company and
branch.

As you can see in the following Access screen section, the information on the Organization
and Companies screens define the operational hierarchy of your companies in terms of which
Oracle Financial Services Lending and Leasing users will have access to which applications
and accounts

To setup the Companies

1. Click Setup > Setup > Administration > User > Companies. The Companies screen
defines entities within your organization that originate and/or service Loans.
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2.

Navigation chapter.

ORACLE’

Financial Services Lending and Leasing

In the Company Definition section, perform any of the Basic Operations mentioned in
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A brief description of the fields is given below:

Field:

Do this:

Company Specify the portfolio company ID. (This ID is the unique identifier
used internally by the system to represent the company).
Name Specify the name of the portfolio company (required).

Short Name

Specify the short name for the portfolio company (ID displayed to
represent the company).

Currency

Select the currency of the portfolio company from the drop-down
list. The system displays the default value as ‘US DOLLAR’.

Enabled

Check this box to enable the portfolio company.

Country

Select the country where the portfolio company is located from the
drop-down list. The system displays the default value as ‘UNITED
STATES'.

City

Specify the city where the portfolio company is located .

State

Select the state where the portfolio company is located from the
drop-down list.

Address Line 1

Specify the address line 1 for the portfolio company.

Address Line 2

Specify the address line 2 for the portfolio company.

Zip

Select the zip code of the location where the portfolio company is
located from the drop-down list.
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Field:

Do this:

Extn Specify the extension of the zip code where the portfolio company is
located.

Phone 1 Specify the primary phone number for the portfolio company.

Extn 1 Specify the phone extension for the primary phone number.

Phone 2 Specify the alternate phone number for the portfolio company.

Extn 2 Specify the phone extension for the alternate phone number.

Fax 1 Specify the primary fax number for the portfolio company.

Fax 2 Specify the alternate fax number for the portfolio company.

Tax ID # Specify the tax identification number for the portfolio company.

TCC Specify the transmitter control code for the portfolio company (1098
Electronic Filing).

Contact Specify the contact information about the portfolio company.

Coupon Order
Code

If you are using coupons, Specify the coupon order code to be used
by a third party printing the coupons for billing statements.

HMDA

Select the HMDA agency (Home Mortgage Disclosure Act reporting
agency for the company).

Remittance Address section

Country Select the remittance address country from the drop-down list. The
system displays the default value as ‘UNITED STATES'.

City Specify the remittance address city.

State Select the remittance address state from the drop-down list.

Remittance Specify the remittance address line 1, if it is different from the com-

Address 1 pany address. This address is included as the remittance address
on statements.

Remittance Specify the remittance address line 2.

Address 2

Zip Select the zip code of the remittance address line 1 from the drop-
down list.

Extn Specify the extension of the remittance address zip code.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. On the Branch Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
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3.3

A brief description of the fields is given below:

Field: Do this:

Branch Specify the portfolio branch ID. (This ID is the unique identifier used
internally by the system to represent the branch within your company).

Name Specify the name of the portfolio branch (required).

Short Name Specify the short name for the portfolio branch (ID displayed to repre-
sent the branch) (required).

Enabled Check this box to enable the portfolio branch.

Sub Unit Select the Sub Unit from the drop-down list.
Sub Unit refers the entity which is the source of funds for the credit
application/Account.
System associates the selected sub unit with the particular company/
branch combination and displays by default when the same is selected
during an application/Account creation.

Country Select the country from the drop-down list. The system displays the
default value as ‘UNITED STATES'.

City Specify the city where the portfolio branch is located.

State Select the state from the drop-down list.

Address Line 1

Specify the address line 1 for the portfolio branch.

Address Line 2

Specify the address line 2 for the portfolio branch.

Zip Select the zip code of the location where the portfolio branch is located.

Zip Extn Specify the extension of the zip code, where the portfolio branch is
located.

Phone 1 Specify the primary phone number for the portfolio branch.

Extn 1 Specify the phone extension for the primary phone number.

Phone 2 Specify the alternate phone number for the portfolio branch.

Extn 2 Specify the phone extension for the alternate phone number.

Fax 1 Specify the primary fax number for the portfolio branch.

Fax 2 Specify the alternate fax number for the portfolio branch.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Access

Using the organizations, divisions, companies, and branches created on the Organization and
Companies screens, you can control the access privileges of applications and accounts. On
the Access screen, you define which organization/division (users) can gain access to which
company/branch (applications and accounts) locations.
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3.3.1

Normally, for each division within an organization, you would define a record with Company
value of ALL and a Branch value of ALL, then select the Allowed box. You then define other
records for the same Organization and Division for other Company and Branch combinations
with the Allowed box cleared to restrict access.

Dept 2
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.;xtrv\ang
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To setup the Access

1. Click Setup > Setup > Administration > User > Access. The system displays the
Access screen. In this screen, you can control the access privileges of the user for the

following categories:

e Data
e Screen
e Reports

e Correspondence
e Transaction

Data

The Data screen allows you to restrict access to different data.

To setup the Data

1. Click Setup > Setup > Administration > User > Access > Data.
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2. Inthe Access Grid section, perform any of the Basic Operations mentioned in Navigation
chapter.

ORACLE’ 2 Welcome, PRAKRRAO v Accessibiity o
Financial Services Lending and Leasing
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A brief description of the fields is given below:

Field: Do this:

Organization Select the organization for which you are defining access privileges
from the drop-down list.

Division Select the division within the organization for which you are defining
Access privileges from the drop-down list.

Company Select the portfolio company to which you are defining access privi-
leges for the organization and division specified from the drop-down
list.

Branch Select the portfolio branch of the company to which you are defining

access privileges for the organization and division specified from the
drop-down list.

Allowed Check this box to provide access to the data pertaining to the com-
pany and branch, for the organization and division specified.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
3.3.2 Screen
In the screen, you can control the access to the following:

1. Menu — Control access at the application menu level. For example, for Setup menu you
can provide access only to an Administrator.
2. Screens — Control access to the screens available in the application

3. Buttons — Control access based on the stage.
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For example, Add and Edit buttons can be disabled once an application is funded.

If you want to restrict updating the Applicant details, then edit button has to be disabled
for the stage.

The screen allows you to restrict access to different screens.
To set the Screen Security
1. Click Setup > Setup > Administration > User > Access > Screen.

2. In the Security Super Group section, you can view the details of the super group you
want to work with.

ORACLE"
Financial Services Lending and Leasing
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3. Inthe Security Access Definition section, perform any of the Basic Operations
mentioned in Navigation chapter.

Note

You can not add a new record

A brief description of the fields is given below:

Field: Do this:

Access Code The system displays the selected access code.

Description Modify the description of the access code.

Type The system displays the type of security access definition.

If ‘Yes’ is selected, the security access definition entry is system
defined.

System Defined

If ‘No’ is selected, the security access definition entry is manually
defined.
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3.3.3

Field: Do this:

Enabled Check this box to enable the security access definition entry is
enabled.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. Inthe Security User Access Details section, perform any of the Basic Operations
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Access Type Select the access type of the user who will have access to this
screen from the drop-down list.

Active Value Select the active value of the user who will have access to this
screen from the drop-down list.

Allowed Select ‘Yes'’ to allow access to this screen or ‘No’ to deny access to
this screen.

System Select ‘Yes', if the screen user access definition entry is system

Defined defined.

Select ‘No’, if the screen user access definition entry is manually
defined.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

Reports

In the Reports screen you can control access to generate certain reports.

To set up Reports
1. Click Setup > Setup > Administration > User > Access > Reports.
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2. In the Reports section, you can view the following information:
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A brief description of the fields is given below:

Field

View this:

Code

Displays the code of the report.

Module

Displays the code of the report from the drop-down list.

Description

Displays the description of the report.

Enabled

Displays whether the report definition is enabled or not.

3. Inthe Reports User Access Definition section, you can set the access rights for the
report selected in the Reports section. Perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Access Type

Select the access grid function type from the drop-down list.

Access Value

Select the access function grid value from the drop-down list.

Allowed

Select ‘Yes'’ to allow access or ‘No’ to restrict access to the entry
based on the access type and value.

Yes/No

System Defined

defined.

defined.

Select ‘Yes', if the report user access definition entry is system

Select ‘No’, If the report user access definition entry is manually
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3.34

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Correspondence

The Correspondence screen allows you to restrict access to different correspondence
commands on the Letters menu, thus restricting your ability to generate certain
correspondence.

If you do not have the responsibility to create a type of correspondence, the corresponding
command on the Letters menu is unavailable (dimmed).

To setup the Correspondence
1. Click Setup > Setup > Administration > User > Access > Correspondence.

2. Inthe Correspondence Codes section, perform any of the Basic Operations mentioned
in Navigation chapter.
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A brief description of the fields is given below:

Field: Do this:

Code The system displays the correspondence code name you want to work
with.

Description The system displays the description for the correspondence code (dis-
play only).

Enabled Check this box to enable the selected correspondence code entry.

3. Inthe Correspondence User Access Definition section, perform any of the Basic
Operations mentioned in Navigation chapter.
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A brief description of the fields is given below:

Field: Do this:

Access Type Select the access grid function type from the drop-down list.
Access Value Select the access function grid value from the drop-down list.
Allowed Select ‘Yes’ to allow access or ‘N0’ to restrict access to the entry

based on the access type and value.

System Defined | Select ‘Yes', if the correspondence user access definition entry is
Yes/No system defined.

Select ‘No’, If the correspondence user access definition entry is
manually defined.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Transaction

The transaction screen allows you to view and restrict access to the following account
transactions maintained in the system.

ACCOUNT MONETARY TXN

ACCOUNT NON MONETARY TXN
PRODUCER MONETARY TXN

ACCOUNT CONDITION TXN
SECURITIZATION TXN

ESCROW MONETARY TRANSACTIONS
ESCROW NON MONETARY TRANSACTIONS
FEE ASSESSMENTS

ESCROW ANALYSIS AND DISBURSEMENTS

Along with restricting access, you can also define authorization permissions for monetary
transactions. While defining authorization permissions, you can allow transactions to
Authorize through assigned Maker/Check responsibilities with/without having specific
authorization criteria defined. However, authorization criteria can be defined only for
monetary transactions which needs authorization.

To define access/authorization rights for Transaction

1.

Click Setup > Setup > Administration > User > Access > Transaction.
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2. Inthe Transaction Super Group section, select the super group you want to work with.
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3. Inthe Transaction Codes section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Code The system displays the transaction code you want to work with.

Description Specify/Edit the description for the transaction.

Authorize Check this box to enable authorization by another user. Such transac-
tions can be authorized on the Authorization tab of Transaction Authori-
zation screen in Servicing Module.

Note: For monetary transactions, system allows you to define both
Maker and Checker authorization in the Maker and Checker Responsi-
bility tabs respectively. For non-monetary transactions, you can define
maker responsibility for authorization.

When the Authorization check box is not selected, any new transactions
posted will not go for authorization.

For more information, please refer the Transaction Authorization
(Maker-Checker) chapter in the Oracle Financial Services Lending
and Leasing User Guide.

Enabled Select this box to enable the transaction.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

You can define the authorization restrictions using the following sub tab:

e Maker Responsibility
e Checker Responsibility
e Authorization Criteria
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Note

‘Checker Responsibility’ and ‘Authorization Criteria’ tabs are available only for monetary
transactions (i.e. Authorize flag set to ‘Y’).

To define Maker Responsibility

1. Click Setup > Setup > Administration > User > Access > Transaction.
2. Inthe Transaction Super Group section, select the super group you want to work with.

3. Inthe Maker Responsibility section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Access Type Select ‘RESPONSIBILITY’ as the access type from the drop-down
list.

Access Value Select the user responsibility from the drop-down list.

Allowed Select “Yes'’ to allow access or ‘No’ to restrict access to the entry in
the Transaction Codes section, based on the access type and
value.

System Defined Select “Yes/, if the transaction user access definition entry is sys-
tem defined.

Select ‘No’, if the transaction user access definition entry is manu-
ally defined.

Perform any of the Basic Actions mentioned in Navigation chapter.

To define Checker Responsibility

When a particular monetary transaction needs checker authorization you can define the same
in ‘Checker Responsibility’ tab and also specify the Authorization Criteria for the transaction.
1. Click Setup > Setup > Administration > User > Access > Transaction.

2. In the Transaction Super Group section, select the super group you want to work with.

In the Transaction Codes section, select the monetary transaction with the Authorize
flag as ‘Y.

4. Inthe Checker Responsibility section, perform any of the Basic Operations mentioned
in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Access Type Select ‘CHECKER RESPONSIBILITY’ as the access type from the
drop-down list.

Access Value Select the user responsibility from the drop-down list.
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Field: Do this:

Allowed Select ‘Yes’ to allow access or ‘N0’ to restrict access to the entry in
the Transaction Codes section, based on the access type and
value.

System Defined Select ‘Yes', if the transaction user access definition entry is sys-
tem defined.

Select ‘No’, if the transaction user access definition entry is manu-
ally defined.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

To define Authorization Criteria

You can define conditional authorization by creating a sql statement based on required
criteria. For example, you can define a condition to allow transaction authorization in an
account for amount greater than 500.

1. Click Setup > Setup > Administration > User > Access > Transaction.

2. Inthe Transaction Super Group section, select the super group you want to work with.

In the Transaction Codes section, select the monetary transaction with the Authorize
flag as ‘Y.

4. Inthe Authorization Criteria section, you can add/edit the following details in the ‘Criteria
Name’ and ‘Criteria Details’ section.

5. In the Criteria Name section perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:
Name Specify a name for the criteria.
Description Specify a description for the criteria.

Authorization Level | Specify the level of authorization responsibility in numeric value.

Note: You will need to specify the same value as defined for each
user within ‘Checker Responsibility’ Lookup Type (CHECK-
ER_RESPONSIBILITY_CD) in Setup > Administration > System
> Lookups screen.

Enabled Select this box to enable the criteria.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

7. In the Criteria Details section perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Seq Specify a sequence number.
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Field: Do this:

( Specify the open/entry criteria.

Parameter Select the transaction parameter from the drop-down list.

The list displays transaction parameters for the selected transac-
tion and the parameters in user defined table INP_BMP_ACC’.

Comparison Opera- | Select the comparison operator from the drop-down list.
tor

Criteria Value Specify the required criteria value for validation.

) Specify the close/exit criteria.

Logical Expression | Select the logical operator from drop-down list.

Enabled Select this box to enable the criteria.

8. Perform any of the Basic Actions mentioned in Navigation chapter.

9. Click Check Criteria to validate the correctness of the statement and to resolve errors, if
any.

You can add multiple checker responsibility and define multiple selection criteria for each
checker responsibility.

Users

The Users screen allows you to create and set up an user. In the User Definition section, you
can assign a user an identification name and password to log on to the system. You can also
assign the organization, division, and department where each user is located. Additional fields
allow you to record information for contacting the user. You can also define the time frame
within which a user has access to the system to ensure compliance to the company’s
schedule. This is a very useful feature to prevent logins during scheduled maintenance.

The Responsibility field records the job function of the user and defines the level of access
that user has within the system; in particular:

e What menu items does the user have access to?

e What transactions can the user perform on the Maintenance screen on the Customer
Service screen?

e What edits can the user perform on the Verification link during origination?

Note

The system’s SUPERUSER responsibility grants access to the entire system. Give careful
consideration to the number and type of users who receive this responsibility.

To set up the Users screen

1. Click Setup > Setup > Administration > User > Users. The system displays the Users
screen.
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2. In the User Definition section, perform any of the Basic Operations mentioned in

Navigation chapter.

ORACLE"
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A brief description of t

he fields is given below:

Field:

Do this:

User

Specify the user ID.

Note: This field is a unique indicator and cannot be updated,
edited, or deleted once saved.

Organization

Select the organization to which the user belongs, from the drop-
down list.

Division

Select the division to which the user belongs, from the drop-down
list.

Department

Select the department to which the user belongs, from the drop-
down list.

Start Dt

Specify the start date for the user. You can also select from the
adjoining calender icon.

End Dt

Specify the end date for the user. You can also select from the
adjoining calender icon.

System Defined

Select ‘Yes', if the entry is system defined. System defined entries
cannot be modified.

Select ‘No’, if the entry is not system defined and it can be modified.

Enabled

Check this box to enable the user.

First Name

Specify the first name of the user.
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Field: Do this:

Ml Specify the middle initial of the user.
Last Name Specify the last name of the user.
Responsibility Select the responsibility for the user from the drop-down list.

Note: The users mapped to the role ‘Responsibility’ can only view
the screens.

Phone 1 Specify the user’s primary phone number.

Extn 1 Specify the phone extension for the primary phone number.

Phone 2 Specify the user’s alternate phone number.

Extn 2 Specify the phone extension for the alternate phone number.

Fax 1 Specify the user’s primary fax number.

Fax 2 Specify the user’s alternate fax number.

Replacement Select the user ID of the replacement user from the drop-down list.
User

Dt Specify the date from when the replacement is effective. You can

also select from the adjoining calender icon.

Note: These two fields allow you to create a replacement user for
the current user. This is particularly useful when a new employee
assumes the duties of a former. By completing the Replacement
User and Replacement Dt field, the system recognizes the replace-
ment user as the current user on the effective date. For more infor-
mation, refer the section, ‘Replacement Users’.

Type Select the user type from the drop-down list.
Reference # Specify the reference number for the user from the drop-down list.
Email Specify user’s email address.

Default language | Select the default language from the drop-down list.

Time Zone Select the required Time Zone from the drop-down list, The speci-
fied time zone would be applicable at company level.

Time Zone Level | Select the time zone level (Organization, Company or User) that
would apply by default, when specific time zone is not specified at
Company and User level.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Replacement users

By completing the Replacement User and Dt fields on the Users screen, you can replace an
existing user with a new user. The system assigns all responsibilities of the original user to
the new user as of the date of the replacement.

The Replacement User and Dt fields allow you to designate a replacement for the current
user in the User ID field. When you complete the Replacement User and Dt fields, save your
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entry, and then enable the record, the system replaces the original user. The system changes
the End Dt field to the date when the original user was replaced (the same date in the Dt field).

The system assigns the queues of the original user to only those replacement users who have
the same user responsibilities (or Super User responsibility) as set in the system.

The system updates the following when replacing users:

1. Assigns all applications in the replaced user’s underwriting queue with the status NEW to
the replacement user’s queue.

2. Assigns all applications in the replaced user’s funding queue with a status other than
FUNDED to the replacement user’s queue. The system currently stores the collector
name in the back end tables, which are updated with the replacement users ID in the case
of the replacement of any user.

3. Also updates the Producer Management screen with the replacement user in the
Underwriter and Collector fields. The system assigns all applications routed to the
original user to the replacement user. This also includes any future applications for the
replaced user.

4. The system automatically updates the Collector ID field in all accounts to the
replacement user and routes all accounts assigned to the original user to the replacement
user.

Note

The system will not update the replacement user ID for accounts that are closed.

5. Onthe queue setup of Customer Service screen’s Responsibilities sub screen, the record
for the original user will be disabled and a new record will be created for the replacement
user. If the replacement user already exists in the setup, The system will not create a new
record. It updates the user ID and routes all accounts that were assigned to the original
user, based on the account condition, to the replacement user.

Application and Oracle Identity Manager Synchronization

Oracle Identity Manager is for user administration. Oracle Financial Services Lending and
Leasing has been developed in such a way that it can be implemented with or without Oracle
Identity Manager. In case OID has been employed, the user definition is done in OID and then
synchronized to the Oracle Financial Services Lending and Leasing Users table using a utility
JAR called OID Synchronization JAR. In OID, users are defined across various groups
belonging to a realm which is nothing but the directory structure in OID. A user can be
configured to belong to multiple groups in a realm. Every time the user tries to login to Oracle
Financial Services Lending and Leasing or OBIEE, the system validates the login ID and the
password with OID and provides access to those applications.

Credit Bureau

In the system, an important part of the origination process is pulling a credit report from a
credit bureau and scoring that information against a user-defined risk model. These credit
reports can be pulled both automatically and manually.

After you enter an application, the system compares its contents against pre-screen criteria.

If the application passes a pre-screen edits check, the system advances the status of the
application and automatically pulls a credit report.
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3.5.1.1

You can manually request a credit report for an applicant or any other party included on the
application, such as co-signers and spouses by selecting the bureau from which you want to
pull the report. If more than one report type is defined for the selected bureau, then you can
indicate the type of report you want to pull.

The following are few additional Credit Bureau Setup details:

e The credit bureau from which the report is pulled is determined by the applicant’s zip
code. The credit bureau interface searches the information in the Credit Bureau Zip
Matrix tab and matches the applicant’s zip code to determine the bureau(s) from which
to request a report.

e The number of credit reports automatically pulled per applicant is controlled through the
credit request parameter CRB. MAX BUREAU_ PULL. If this parameter is setto 1, a
credit bureau request will be made for the Bureau credit bureau from the zip code
matrix. Likewise, if this parameter is set to 2, a credit bureau request will be made for
the Bureau1 and the Bureau2 credit bureaus from the zip code matrix.

e The system automatically pulls credit reports for only the primary applicant and the
primary applicant's spouse (for joint applications) unless the
CRB_ALL_APL BUREAU PULL credit request parameter is set to Y. However, if the
parameter is set to Y, the system pulls credit reports for all of the applicants on the
Lease, regardless of their relationship to the primary borrower.

e Passwords, default report formats, and other required information from the credit
bureaus are set up in the Report Formats screen.

Member codes and passwords when switching credit bureau access methods (moving from
dial-up to Net Connect). The member codes and passwords are not dependent on the
connection method used to access the bureau.

Frame relay access is from the database server to the Experian host though a TCP/IP socket
connection. The connection is outbound only and it is to a specific port (699 or 700) on the
Experian host.

The credit bureau service will be accessing Experian Net Connect service through HTTP to
the ECALS URL supplied by Experian as well as by the HTTPS to the URL returned as a
response to the ECALS URL inquiry (the credit request URL). This access is from the
database server access.

Credit Bureau

The setup for Credit Bureau spans across the following links:
e Report Formats
e Connections
e Zip Matrix
e Parameters
e Score Reasons
e Reporting

Navigating to Credit Bureau

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Credit Bureau.

Report Formats

The Reports Formats screen captures and tracks the attributes related to the multiple types
of reports offered by the credit bureau agencies. When a company enlists the service of a
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credit bureau, the credit bureau provides a membership code and password. This information
needs to be entered on the Reports Formats screen before you can request a credit report.
You must define at least one report for each credit bureau from which you want to pull reports.

The information on the Report Formats screen is location-specific. If the business requires
different membership codes for each location, be it a company or branch, then individual
records must be set up.

The Score Type, Additional Product, and Inquiry Limit fields on the Credit Report Setup
section are optional. They may not apply to all credit bureau types and even if they do apply,
you may want to leave them blank and rely on a default value set up at the credit bureau.

Note

For more information, refer to the the application Installation Guides.

To setup Report Formats
1. Click Setup > Setup > Administration > User > Credit Bureau > Report Formats

2. In the Credit Bureau section, perform any of the Basic Operations mentioned in
Navigation chapter.:

ORACLE . . 2 Welcome, PRAKRRAO »  Accessibiity o
Financial Services Lending and Leasing
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System >
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Bank Details
Check Details
Standard Payees
‘Currencies
Zip Codes
Products >
< I >
A brief description of the fields is given below:
Field: Do this:
Bureau Name Specify the name of the credit bureau company.
Short Name Specify the abbreviated or short name for the bureau.
Source Select the credit bureau source from the drop-down list.
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Field:

Do this:

Country Select the country of the credit bureau address from the drop-down
list.

City Specify the city for the credit bureau address.

State Select the state of the credit bureau address from the drop-down list.

Address Line 1

Specify the address line 1 for the credit bureau.

Address Line 2

Specify the address line 2 for the credit bureau.

Zip Select the zip code for the credit bureau address from the drop-
down list.

Extn Specify the extension of the zip code for the credit bureau address.

Phone 1 Specify the primary phone number for the credit bureau.

Extn 1 Specify the extension for the primary phone number.

Phone 2 Specify the secondary phone number for the credit bureau.

Extn 2 Specify the extension for the secondary phone number.

Fax 1 Specify the primary fax number for the credit bureau.

Fax 2 Specify the alternative fax number for the credit bureau.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Inthe Credit Bureau Report Formats section, perform any of the Basic Operations
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Company Select the portfolio company that will be using the above credit
bureau from the drop-down list.

Branch Select the portfolio branch from the company that will be using the
above credit bureau from the drop-down list.

Description Specify the credit report format description.

Member Code Specify the credit bureau member code (assigned by bureau).

Password Specify the credit bureau password.

Customer Code Specify the customer code.
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Field

Do this:

Auth Password
Change Dt

Display the last authorization password change date. The Experian
Net Connect product requires that the Auth Password (or SSP
Password in Experian jargon) be changed every 90 days (or
sooner). Equifax may have similar requirements, but they were not
known at the time of this writing. Use the date displayed in this field
to identify when the password needs to be changed.

Note: The password needs to be changed both in the system and at
the credit bureau. Changing the password does not initiate or per-
form a change at the bureau. Changing the password at the bureau
must be done outside the system. Contact the credit bureau for the
procedure for changing the password (display only).

Auth User ID

Displays the authorization user ID (display only).

Auth Password

Displays the authorization password (display only).

Note: This field is not displayed to the user and is also encrypted
before being stored in the database (display only).

Change Authorization User Id/Password section

New Auth User Id

Specify the authorization user ID.

New Auth User
Password

Specify the authorization user password.

TransUnion Details section

(Note: This is only applicable for TransUnion.)

Market Specify the TransUnion market id.
Sub Market Specify the TransUnion Sub Market id.
Industry Specify the TransUnion Industry code.

Experian Details section

(Note: This is only applicable for Experian.)

Preamble Specify the Experian preamble code.
Host Code Specify the Experian host ID.
uiC Specify the Experian UIC.

Equifax Details section

(Note: This is only applicable for Equifax.)

Service Name

Specify the equifax service name. The service name will be pro-
vided to you by Equifax when your company's Internet System to
System account is created. Possible values for pulling credit reports
are acrotest (for access to the test system) and acro (for access to
the production system).

5. Perform any of the Basic Actions mentioned in Navigation chapter.
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6. Inthe Report Format Details section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Report Specify the report name to be accessed from the credit bureau.

Report Type | Select the report type of the credit bureau report from the drop-down list.

Score Type Select the credit score type from the drop-down list.

Addl Product | Select the product code from the drop-down list.

Inquiry Limit | Select the inquiry limit for the credit report from the drop-down list.

Enabled Check this box to enable the report as default.

7. Perform any of the Basic Actions mentioned in Navigation chapter.
Connections

The Connections screen records and supports various connections to the credit bureau to
receive reports from the agencies. The system supports connections to the bureaus through
one or more modems attached to the database server, network accessed modem server, or
direct network connection (usually frame relay).

For modem-based connections, multiple credit bureaus can be accessed over the same
modem. If there are multiple requests in the queue, the order in which the bureaus are listed
determines the order in which the requests are processed.

For example,

If the credit bureau service checks the submitted credit requests and finds three Experian, one
Equifax, and two TransUnion credit requests and the connections setup is Bureau1=TUC,
Bureau2=EFX, and Bureau3=EXP, the two TransUnion requests will be processed first, the
Equifax request next, and then the three Experian requests.

Note

For this above example, adding two more modems and assigning a specific bureau to
each one would help to avoid the delay caused by queuing all requests through a single
modem.

IMPORTANT: Direct network connections must be set up for only one bureau.
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Like the Credit Bureau section on the Report Formats screen, the data fields used on the
Connections screen are generic and not all fields are used for all access methods. The
following table summarizes the data needed for each access method:

Methaod Name Bureau 1 | Bureau Bureau Device Device Speed
2 3
Dial-up Required Required Optional Optional Required (can be either | Required for
(can he (catn be (cat e alocal seral port device | locally attached
EXP, EXP, EXF, ot arnIP address and modems
TUC, or TUC, or TUC, or port number of a
EFZD) EFX) EFZ) tetwrark mode m)
Experian Required | Must be Leave Leawe Dlust be the IP address | ot applicable
Frame-relay EXP blatilc blank and post number of
Experian host
Eguifax Required Must be Leave Leawe Dlust be the P address Mot applicable
Frame-relay EFX blank blatk and pott number of
Equifax host
Translnion Required | Must be Leave Leawe Lilust be the IP addtess | Mot applicable
Frame-relay TUC blarik blank and pott number of
TransUnion host
Experian et Required Mast be Leave Leawe NIust be the ECALS Mot applicable
Connect EXP blank hlank URL provided by
Experian
Eguifax Heguired | Musthe Leave Leawe Lust be the URL Mot applicabls
[nternet EFX blarie blark provided by Equifax for
System to connecting to the
System Internet System to
System service
C3C Internet Required Ilust be Leave Leawe Ilust be the URL Mot applicable
zac blank blank provided by C3C
CredcoConnect | Requited | Mustbe Leave Leawe Dulust be the URL Mot applicable
CRD blarile blank provided by Credco

For frame relay access, specify the IP address provided by the bureau followed by a space
and then the port number (for example, 192.168.36.2.700).

Experian Net Connect

At the time of this writing, the Experian product ECALS URL is:
http://www.experian.com/lookupServletl?lookupService
Name=AccessPoint&lookupServiceVersion=1.0&serviceName=Net

Connecté&serviceVersion=2.0&responseType=text/plain

Note

The URL given above is one continuous string. This can be verified by entering the URL
with a browser. The displayed value will be an HTTPS URL.

Enter the entire ECALS URL provided by Experian into the Device field. Notice that this URL
does not start with https. The ECALS URL is a URL used by the credit bureau service to
request the HTTPS URL. The HTTPS URL is not displayed on any setup screen and is only
known to the credit bureau interface at runtime.

Equifax Internet System to System

At the time of this writing, the Equifax Internet System to System URL is:

https://transportb.ec.equifax.com/servlet/stspost
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CSC Tri-Merge
At the time of this writing, the CSC URL is:

https://www.emortgage.Equifax.com/cgi-bin/emspop.exe

To setup the Connections

1. Click Setup > Setup > Administration > User > Credit Bureau > Connections.

2. In the Credit Bureau Connections section, perform any of the Basi

¢ Operations

mentioned in Navigation chapter.

ORACLE" ; . & Welcome, PRAKRRAC +  Accessibility o
Financial Services Lending and Leasing
o Credit Bureau [ Close
> Origination Report Formats  Connections  Zip Matrix = Parameters  Score Reasons  Reporting
»» Servicing
> Collections Credit Bureau Connections dkadd | Edit S view | o Audit
- View v Format~ B Freezz B Detach Wrap o)
> Tool Name Bureau 1 Bureau 2 Bureau 3 Device Device Speed Enabled
ools
N
Setup EFX TEST FILES EFX hitps:/ftransports. . NA Y
Setup EXPTESTFILES  BXP hittps:/jdm Lexper.. NA ¥
administration ~ TUCTESTFILES  TUC https://netaccess-.. NA Y
System
System Parameter Credit Bureau Connections
Lockups Saveand Add | [ saveand Stay || [ Saveand Retum | {3 Retum
User Defined Tables
::z‘rt;:!\rid Defauit e Bureau 3 ~] = Enabled []
Transaction Codes *Bureau 1 v = e
Data Files Bureau 2 [v] * Device Spesd
Dedups
Securitization
Events

B

Jobs “
Producer Cycles
Vendors
Collection Cycles
Reports
Ermror Messages
Translations

User
‘Organization
‘Companies
Access
Users
Credit Bureau
Correspondence
‘General Ledger
Queues
Printers.
Bank Details
Check Details
Standard Payees
‘Currencies
Zip Codes
Products
« i >

A brief description of the fields is given below:

Field: Do this:

Name Specify connection name.

Bureau 1 Select first credit bureau from the drop-down list.
Bureau 2 Select 2nd credit bureau from the drop-down list.
Bureau 3 Select 3rd credit bureau from the drop-down list.

Note: The Bureau1, Bureau2, and Bureaus3 fields in t

the connection.

Connections section specify which bureau types can be accessed over

he Credit Bureau

connection.

Device Specify the connection device name. The Device field lists the physical
device name for a modem, or the IP address for a network accessed

Device Speed | Select the connection device speed. The Device Speed field is only
applicable to server-attached modems. It is used to specify the com-
munications speed between the server and the modem.
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3.5.1.3

Field:

Do this:

Enabled

Check this box to enable the connection.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Zip Matrix

The system uses the zip code of the applicant’s current home address to determine which

credit bureau to use when automatically pulling a report. The Zip Matrix screen allows you to
record the credit bureau from which a report is pulled based on a range of zip codes, as well
as the company, branch and country of the account.

When searching for a zip code match, the system:

1. Reads the first credit bureau defined in the matrix

2. Reads the credit report format to get the appropriate membership code and password for
the user’s location

3. Requests a credit report.

If the system cannot pull a report from the first bureau, it pulls one from the second. If the zip
code you entered does not fall in the matrix setup, then the system uses a default zip matrix
(0000000000 to 0000000000) to select the required bureau.

To set up the Zip Matrix

1. Click Setup > Setup > Administration > User > Credit Bureau > Zip Matrix

2. Inthe Credit Bureau Zip Code Matrix section, perform any of the Basic Operations

mentioned in Navigation chapter.

ORACLE’

Financial Services Lending and Leasing

» DashBoard
> Origination
> Serviding
7 Collections
> WFP
» Tools
Setup
Setup -
Admiristration j
System
System Parameter
Lookups
User Defined Tables
Audit Tables
User Defined Defaults
Transaction Codes |
Data Files
Dedupe
Securitization
Events
Batch Jobs
Producer Cycles
Vendors
Collection Cydes
Reports
Errar Messages
Transations
User
Organization
Companies
Access
Users
Credit Bureau
Correspondence
General Ledger
Queues
Printers
Bark Details
Check Details
Standard Payees
Currendies

Credit Bureau

Report Formats | Connections | Zip Matrix | Parameters | Score Reasons | Reporting

Credit Bureau Zip Code Matrix

View ~ Farmat ~

Company
AL

AL
ALL
ALL
AL
AL
AL
AL
ALL
ALL
AL
AL
AL
ALL
ALL

=] Freeze i Detach
Branch
AL
AL
AL
AL
AL
AL
AL
AL
AL
AL
AL
AL
AL
AL
AL

Credit Bureau Zip Code Matrix

* Company | ALL

*Branch ALL

* Country  UNITED STATES

)
Country
UNITED STATES
UNITED STATES
UNITED STATES
UNITED STATES
UNITED STATES
UNITED STATES
UNITED STATES
UNITED STATES
UNITED STATES
UNITED STATES
UNITED STATES
UNITED STATES
UNITED STATES
UNITED STATES
UNITED STATES

ERRERRCE|

From Zp
0000000000
0000000000
0000000500
0000001400
0000003000
0000007000
0000015000
0000017800
0000020000
0000025300
0000025500
0000025500
0000025700
0000025800
0000026100

*From Zp 0000000000
*ToZip 0000000000
*Bureau1 TUC

ToZp
0000000000
0000000539
0000001333
0000002933
0000006993
0000014963
0000017799
0000013933
0000025233
0000025499
0000025599
0000025633
0000025739
0000025033
0000026299

[ Close
I A 7 Edit i 7 Audit

Bureau 1 Bureau 2 Bureau 3

e EXF EFX -

Tue EFX EXP E|

EXp EFX Tuc

Tue BXP EFX

T X =]

Tue B EFX

Tue EFX EXp

EFX Tuc EXp

EFX Tuc Exp

EFX = Tuc

EFX Tuc =]

Tue EFX EXP

EFX Tue EXp

EFX EXP Tuc

EFX Tuc EXP -

E\%

[ saveandstay | [ saveandRetum | CaRetum

Bureau 2 EXP =
Bureau 3 EFX [=
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A brief description of the fields is given below:

Field: Do this:
Company Select the portfolio company from the drop-down list.
Branch Select the portfolio branch from the drop-down list. The branch will be

displayed based on the company selected.

Country Select the country from the drop-down list.

From Zip Specify the starting zip code (From).

To Zip Specify the ending zip code (To).

Bureau 1 Select the preferred bureau #1 (first bureau pulled), from the drop-down

list. You must enter at least one credit bureau in the Bureau 1 field for
each zip code range. The bureau entered in the Bureau 1 field for each
range is the primary bureau. For any given range, do not list the same
credit bureau in more than one field.

Bureau 2 Select the preferred bureau #2 (second bureau pulled) from the drop-
down list.

Bureau 3 Select the preferred bureau 3 (third bureau pulled) from the drop-down
list.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
3.5.1.4 Parameters

The Parameters screen records parameters specifically dealing with credit bureau
information. These parameters are divided into three groups:

e Parsing parameters
e Request parameters
e Configuration parameters

Parameters can be defined at the company or branch level. The following credit bureau
parameters are configured during the installation:

PARSING PARAMETERS FOR CREDIT BUREAU SERVICE

CONFIGURATION PARAMETERS FOR CREDIT BUREAU SERVICE

The following credit bureau parameters are configured during implementation:
REQUEST PARAMETERS FOR CREDIT BUREAU SERVICE

Request Parameters for Credit bureau Service

To setup the Parameters
1. Click Setup > Setup > Administration > User > Credit Bureau > Parameters.
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2. Inthe Credit Bureau Parameters section, perform any of the Basic Operations
mentioned in Navigation chapter.

ORACLE" | ] ) j & Wielcome, PRAKRRAO v Accesciilty o
Financial Services Lending and Leasing
DashBoard R e Qo2
> Origination Report Formats | Connections | Zip Matrix | Parameters | Score Reasons | Reporting
> Servicing
> Collections Credit Bureau Parameter Fadd | FEdt | [Evew | F audit
S WP View » Fomatw [Ep Freeze (2! Detach [ Wrap W
Company Branch Parameter Group Parameter Parameter Value Enabled
> Tools N
Setup ALL AL PARSING PARAME... ALLOW REVOLVIN... N Y A
Setup ALL ALL PARSING PARAME . A CORE E. Y Y
Administration ~ ALL. ALL PARSING PARAME . MAXIMUM AMOUN. 2 Y
e alL AL PARSING PARAVE . MINIMUM AMOUN. 2 ¥
System Parameter AL AL PARSING PARAME. MAXIMUM AMOUN__ -2 ¥
Lnn;c = E2 AL AL PARSING PARAME... MINIMUM AMOUN, 2 L4
bSE[EZﬁHEd e AL AL PARSING PARAME... ACCOUNTS WITH.. Y Y
e ALL AL PARSING PARAME... COLLECTIONITE.. N Y
il AL AL PARSING PARAME . COLLECTIONTTE . N ¥
L i CRE AL AL PARSING PARAME . CSCQLOSEDSTA. 8,9 ¥
et Cares ALL ALL PARSING PARAME. . DAYS OLD THAT. 1 ¥
Dok e AL AL PARSING PARAME . DELETE THE EXPE. N Y
Dedupe AL AL PARSING PARAME... DERIVE MISSING... Y Y v
Securitization ALL ALL. PARSING PARAME . EOQUIFAX NARRAT. b
Events
Beichlobs *  Credit Bureau Parameter
Producer Cycles
Vandirs [ soveand add | [ Sove and Sty || [ Save and Return | a Retum
Collection Cydles
Reports * Company ALL [v] * parameter M
_E(::’s‘:"i‘fi“s = Branch ALL v *Enabled [
A = Parameter Group
Organization
Companies
Access
Users:
Credit Bureau
Correspondence
General Ledger
Queues
Printers
Bank Details
Check Details
Standard Payees
Currencies
Zip Codes
Products ™
< >
A brief description of the fields is given below:
Field: Do this:
Company Select the portfolio company from the drop-down list.
Branch Select the portfolio branch from the drop-down list. The branch will

be displayed based on the company selected.

Parameter Group Select the credit bureau parameter group from the drop-down list.

Parameter Select the credit bureau parameter from the drop-down list

Parameter Value Specify the credit bureau parameter value.

Enabled Check this box to enable the credit bureau parameter.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.5.1.5 Score Reasons

The Score Reasons screen allows you to define or modify the scoring reason codes and
descriptions for the predefined scoring models used by the credit bureau agencies.

Note

This information is not associated with the user-defined scores determined by the internal
Oracle Financial Services Lending and Leasing model during product setup.

To setup the Score Reasons
1. Click Setup > Setup > Administration > User > Credit Bureau > Score Reasons.
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2. Inthe Score Models section, you can view the following information.

OQACLE. I APKELKAR v
Financial Services Lending and Leasing
» DashBoard Skt [ Cose
» Origination Report Formats ~ Connections ~ Zip Matrix  Parameters  Score Reasons  Reporting
» Servicing
e pollacions, Score Models
WD View v Formatv [ Freeze ifiDetach | ¢ Wrap )]
Score Model Enabled
> Tools % NEW NATIONALRI... ¥ %
Setup EQUIVALENCY MO... ¥
EXPERIAN/FICO [ : §
Setup 2 EXPERIANFICO A Y
Administration EXPERIANFICOP ¥ -
System
System Parameter
Lookups Adt Edit View Audi
User Defined Tables Score Reasong add || Aeit | Eview || of Audt
Audit Tables View v Formatvy = [ Freeze i Detach Wrap 5]
User Defined Defaults Reason Code Description
Transaction Codes | i Too few accounts now current *
Data Files 10 Revalving accounts with high balance to limit ratios [
Dedupe 1 Presence of non-satisfactory ratings on revolving bank accounts or lack of revolving bank accounts 3
Seauritization 12 Number of revalving bank accounts
Events Ll 13 Number of recently opened retail accounts
Batch Jobs 4 Number of Service and Professional accounts (collections agency, medical, and utility)
Producer Cydes 15 Lack of martgage accounts
Venders 16 Presence of non-satisfactory ratings on mortgage accounts or lack of mortgage accounts
Collection Cycles 17 Lack of open retail accounts
Reports 18 MNumberr of recent delinquendies -
Frrir Messages ColmnsHdden 1
Translations Score Reasons
Les Hssveandstay | [ saveandrenm | (aRetun
Organization
e Reason Code 1
Access
Users *Description  TOO FEW ACCOUNTS NOW CUR!
Credit Bureau
Correspondence
General Ledger
Queues
Printers
Bank Details
Check Details
Standard Payees
Currencies =
A brief description of the fields is given below:
Field: Do this:
Score Model Displays the credit bureau score model (display only).
Enabled Displays if the credit bureau score model is enabled or not.

3. Onthe Score Reasons sub screen, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Reason Code Specify the reason code.

Description Specify the description.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

3.5.1.6 Reporting

The system reports to the credit bureau agencies in the Metro 2 format with the payment and
account status information of each account holder. The Credit Bureau Reporting screen
contains the program identifier to be reported to the bureaus.

To setup the Reporting
1. Click Setup > Setup > Administration > User > Credit Bureau > Reporting.
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3.5.2

2. Inthe Credit Bureau Reporting section, perform any of the Basic Operations mentioned
in Navigation chapter.

ORACLE’ % Welcome, PRAKRRAC ~ Accessibiity RGO
Financial Services Lending and Leasing R = R =
e Credit Bureatr y, [ Close:
 Origination Report Formats  Connections  Zip Matrix  Parameters  Score Reasons  Reporting
- Servicing
> Collections Credit Bureau Reporting 2kadd | S Edt ] View || o Audit
S WEP View v Formats Ep Freeze it Detach ol wrap o)
5 Tools Company Bureau Program Identifier Enah\ad
Setup
Setup Credit Bureau Reporting
Ad“’r‘;”;f;“"” & [ saveandadd | Bl savesndsmy | [ save and Retum || G2 Retum
i:jz::srsnets' Y = * Enabled []
User Defined Tables * Bureau 2]
A Tt * Program Identifier
User Defined Default
Transaction Codes
Data Files
Dedupe
Securitization
Events
Batch Jobs 4
Producer Cycles
Vendors
Collection Cycles
:&Tlﬂureau
Correspondence.
General Ledger
QLE‘Jef
Check Details
Standard Payess
Procu}f"sgd(;? ¥
¢ I >
A brief description of the fields is given below:

Field Do this:

Company Select the portfolio company from the drop-down list.

Bureau Select the bureau from the drop-down list.

Program Identifier Specify the program identifier. The customer receives this from
the bureau and uses it to identify itself to that bureau. You will
need to update this information.

Enabled Check this box to enable the program.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Special Metro Il Code reporting

The system allows you to report the following special Metro Il segments to the credit bureau
output file:

e Consumer Information Indicator Code (CIIC)

e Compliance Condition Code (CCCD)

e Special Comment Code (SPCC).

The system users will need to use call Action/Results and Reason fields on the Call Activities
sub screen of the Customer Service form (Lending > Customer Service > Customer Service
(2) master tab > Account Details tab > Call Activities sub tab) to place specific account
conditions where these Metro Il segments are to be reported. The specific segment reported
for a given condition will be based on the account condition and call activity reason codes.
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Note

Itis the responsibility of the Administrator or individual user to setup Special Metro Il Code
reporting functionality.

When users open one of the following conditions:

Code Description

CIIC CONSUMER INFORMATION INDICATOR CODE (METRO?2 - FCRA)

CCCD COMPLIANCE CONDITION CODE (METRO2)

SPCC SPECIAL COMMENT CODE (METRO?2)

The system recognizes the condition, processes the selected Metro Il reporting call activity
reason code, and generates the Metro Il reporting segment in the Metro |l reporting output file.

Note

— You are responsible for selecting the correct Metro Il reporting segment reason
code to be reported. If you do not select a Metro Il reporting segment reason code,
the system will not generate information to Metro Il output file. If you select an
incorrect Metro Il reporting segment reason code, the system will report the
selected Metro Il reporting segment. the system does not validate the contents of
the Reason field with the contents of the Condition field.

— To end the reported Special Metro Il Special Code, close the open Special Metro I
Condition (no reason code needed). The system recognizes the closing of the open
Special Metro Il Condition and will not create a Metro Il reporting segment in the
output file.

— The CBU_FILE FREQUENCY (METRO 2 FILE FREQUENCY) Company system pa-
rameter determines if output file is generated and created daily or output file is writ-
ten with daily data and output monthly.

To setup Metro Il Code reporting

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Queues > Call Action Results to open and close the
following system defined condition codes:

Action Code | Description

CIIC CONSUMER INFORMATION INDICATOR CODE (METRO?2 - FCRA)
CCCD COMPLIANCE CONDITION CODE (METRO2)
SPCC SPECIAL COMMENT CODE (METRO2)

When setup is completed, you can open and close Special Metro Il code conditions.

Note

Opening and closing Special Metro 1l Code reporting is a manual process.
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3.5.3

The CBU_FILE_FREQUENCY (METRO 2 FILE FREQUENCY) Company system parameter
determines, if output file is generated and created daily or output file is written with daily data
and output monthly.

Oracle Wallet Manager setup

The Experian Net Connect, Equifax Internet System to System, and CSC interfaces within the
the system credit bureau service use functionality provided by the Oracle Wallet feature. Use
the Oracle Wallet Manager on the database server to create and export a wallet for use by
the credit bureau service.

Note

All of the above mentioned interfaces use the same Oracle wallet. If a wallet already exists
and is in use by one of the credit bureau interfaces, there is no need to create another wal-
let. Due to differing certificate requirements, there may be a need to import additional trust-
ed certificates into the wallet, but there will not be a need to create a new one. The credit
bureau parameter ORA_ WALLET PATH contains the location of the Oracle Wallet used
by the credit bureau service.

To create and export a wallet suitable for use by the credit bureau

Refer to the Oracle documentation for more detailed instructions on how to use the Oracle
Wallet Manager to create and manage a wallet:

1. If a wallet does not already exist, create one somewhere on the database server. The
location must be readable and writable by the Oracle user. Make a note of the full path
where the wallet is stored (for example, /etc/ORACLE/WALLETS/oracle or
C:\oracle\WALLETS).

e For Transunion credit bureau, a separate wallet file is needed under transunion folder
inside the main wallet path (for example: /etc/ORACLE/WALLETS/oracle/transunion or
C:\oracle\WALLETS\transunion).

2. The wallet needs to contain the public key for the certificate authority that issued the
server certificate for each HTTPS web site that will be connected to by the credit bureau
interface. At the time of this document, those sites are:

https://ssl.experian.com Experian

https://transport5.ec.equifax.com Equifax

https://www.emortgage.Equifax.com CSC

This list may change. Use the URL provided to you by the credit bureau when they set up your
service. To get the proper Experian HTTPS URL, enter the ECALS URL that was provided by
Experian into a web browser. The response returned to the browser is the HTTPS URL that
will be used to communicate with Experian.

1. Import the necessary certificate authority’s certificate files into the Oracle wallet that was
created in Step 1. See the appendix of this chapter for detailed instructions of how to
download and install a trusted certificate.

2. Test the wallet by connecting to each web site with a simple command issued from
SQLPlus.

SQL> select utl http.request('https://ssl.experian.com', NULL,
'file:/etc/ORACLE/WALLETS/oracle', 'password') from dual;
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3.5.5

Replace the URL in the above command with each HTTPS URL given to you for use by
the credit bureaus. Also replace the wallet path with the path to your wallet and your
wallet password. The output from the command is not important, what is important is
that it runs without displaying an Oracle error. If there is an Oracle error, then something
is wrong with the contents of the wallet, the path to the wallet, and/or the wallet
password.

3. When the wallet contains all of the required trusted certificates, export the wallet to a text
file. On the Operations menu of the Oracle Wallet Manager, choose Export All Trusted
Certificates. The text file MUST be located in the same directory as the wallet and the
filename MUST be default.txt. Anytime a change is made to the trusted certificates in the
wallet, the wallet must be re-exported to the same text file.

4. Inthe Setup > Setup > Credit Bureau > Parameters set the ORA WALLET PATH and
ORA WALLET PASSWORD parameters.

Oracle JVM Security setup

The Experian Net Connect interface within the credit bureau service requires the use of the
Oracle Java Virtual Machine (JVM) that is resident in the Oracle database. Furthermore,
specific permissions must be granted to the Java classes used by the credit bureau service.
These permissions have been added to the set_java_perms.sql script that is part of the
distribution. This script (as well as many other useful SQL scripts) is available from the Oracle
Financial Services Software technical support Oracle Financial Services Lending and Leasing
patches web site.

The set_java_perms.sql script needs to run as the SYS user (or a user with SYS privileges).
The script will prompt for SYS user id and password. Be prepared to provide it when
prompted. Also, the script will select the value of the ORA_ WALLET PATH parameter from
the credit bureau parameters table. Make sure that it has been updated with the proper wallet
path before running the set_java_perms.sql script (although the script can be safely run again
if necessary).

Credit Bureau Service operation

The basic operation of the credit bureau service has not changed. Once setup, there is no
operational difference between accessing the credit bureaus via dial-up, frame relay, or the
Internet.

Importing a trusted certificate into an Oracle Wallet

The HTTPS servers used by Experian, Equifax, and CSC for their Internet based credit report
services (as well as all HTTPS servers) contain a site certificate signed by a trusted Certificate
Authority (CA). The CA is an entity that guarantees the identity of the HTTPS server. If the
client trusts the CA, and the CA says that the HTTPS server is who they say they are, then
the clientinherently trusts the HTTPS server. Normally, a client tool such as Microsoft Internet
Explorer has a large store of trusted CA certificates which makes secure communication
between a client and a trusted HTTPS server relatively seamless and uneventful.
Unfortunately, the store of CA certificates in the default Oracle wallet is rather small and it is
likely that it will not contain the certificate of the CA that is certifying one or more of the credit
bureau web sites. This means that the CA certificate must be imported into the wallet. To do
this, the certificates must first be exported from a browser and then imported into the Oracle
wallet using the Oracle Wallet Manager.

Using Microsoft Internet Explorer to Export a Certificate

1. Use Microsoft Internet Explorer and connect to one of the HTTPS URLSs referenced in the
Oracle Wallet Manager Setup section of this document.
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If the web site asks for a user id and password, cancel the dialog box and remain on the
top-level HTTPS screen.

Once connected, from the browser’s File menu, choose Properties.
Click the Certificates button.

Click the Certification Path tab. The bottom-most certificate is the one generated by the
host itself. The one or more certificates above the bottom-most one are of greater
importance to this task. The screen shot below displays a web site with two CAs (an
intermediate, and a primary). Whether it is an intermediate CA or a primary one, the steps
are the same for saving the certificate as a text file.

Certificate

General | Detale  Certification Path l

— Cettification path

VeriSign Clags 3 Public Prinnany T
v venizign. cordCPS Incorp. by Bef, LIABILITY LTD ()97 4

----- 331 ewperian.cam

4 |
Wiew Certificate... |

Certificate status:
This certificate is OK.

Click the first certificate above the bottom-most certificate (it may be the only certificate
above the bottom-most certificate).

Click the View Certificate button.
Click the Details tab.

Click the Copy to File button.
Click the Next button.

. Choose the Base 64 encoded format.

. Click the Next button.

. Enter a filename and location for the file.
13.
14.
15.

Click the Next button.
Click the Finish button.

Repeat steps 5 through 14 for the next certificate in the certification path, if any.

Importing the Certificates into an Oracle Wallet

1.

Copy the certificates exported and saved during the process described above onto the

database server (not the iAS server).

2. As the Oracle user (or Administrator on Windows), start the Oracle Wallet Manager.
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3. Open the wallet that will be used by the credit bureau service. Create a new wallet if one

does not already exist.

4. View the list of Trusted Certificates in the wallet.

Check the list of certificates against the list of certificates that are in use on the HTTPS
servers used by the credit bureaus (and that were exported and saved during the export
process described above).

6. Click the Trusted Certificates heading in the left list box of the Oracle Wallet Manager.

Yallel Operations Help
S Wallet
Cedificate:Emphi
Tiusled Cerlificate
3 Class 1 Publlc
-3 Class 2 Public

- TREnustnet Ce
3 Entrustnet Se

-3 Class 3 Public
—'ﬁm.verisign.cl

Cerficates

Key Size

: =lupng
ORACLE
Expire Date

ﬁ‘ Class 1 Public Primary Certification Authority
i Class 2 Public Primary Certification Authority
?' Clags 3 Public Primary Certification Authority
3, Secure Berver Certification Authority

T3 OTE CyberTrust Root

53 6TE CyberTrust Glabal Root

53 Entrustnel Secure Semver Cettication Authorly
53 Entrustnet Cerlification Authorly (2046)

=3 Entrustnet Secure Server Cartfication Authorlty
&3 Class 3Pyblic Primary Certfication Authority
3 wewviarisian comiCeS Incorp by Ref. LIABILIT,

1024
1024
1024
1000
1024
1024
1024
2048
1024
1024
1024

January 7, 2020
January T, 2004
January 7, 2004
January 7, 2010
February 23, 2006
August 13,2018
May 25, 2018
December 24, 2019
February 4, 2020
August1, 2028
Ortober 24, 2011

7. Use Microsoft Internet Explorer to view the certificate details for the HTTPS web sites
(File > Properties > Certificates > Certification Path > View Certificate > General)
that will be contacted by the credit bureau service. Look through the list of certificates
shown in the right panel of the Oracle Wallet Manager and look for a match between the
Issued To and Valid To dates shown in the Internet Explorer View Certificate screen.
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The screen shot below shows a certificate that is already in the wallet’s list of trusted
certificates (see the last entry for the www.verisign.com/CPS certificate).

Certificate

General | Detale  Certification Path I

— Certificahon path

Yerizign Class 3 Public Prinary Cé
srizign. com/CFS [ncorp.by Fef. LIABILITY LTD [c]97 W

q |
Wiew Certificate... |

Certificate status:
This certificate is Ok

8. Onthe Operations menu, choose Import Trusted Certificate and follow the prompts for
locating and loading the files that were copied onto the database server in step 1 for any
certificate not already stored in the wallet.

9. On the Wallet menu, choose Save when finished loading certificates.

3.5.7 De-duping Credit Bureau data

Oracle Financial Services Lending and Leasing allows you to remove duplicate (“de-dupe”)
liabilities data from the credit bureau information.

De-duping logic

The de-duping logic is based on a number of parameters that the system compares among
tradelines (only) to determine if they are duplicates. The following fields are used to
determine if two tradelines are duplicates:

Field: Description:

Account # The account number of the consumer with the lender for the particular
account.

Open Date The date the account was opened.

Member Code | The subscriber code of the lender with the respective credit bureau.

Note: Since member codes for the same lender differ across bureaus,
this field is used only for tradelines reported by the same bureau. Since
reports obtained from CSC can have tradelines from different bureaus,
this field is only for reports pulled from the credit bureaus.

All available bureau reports pulled later than DEDUP_CRB_EXPIRATION DAY days old will
be used.
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The following system parameters will be set up to provide switches to allow the functionality
to be turned on and off:

Parameter Description Valid Setup
Values value
JOINT_DEQUP_SPOUSE_LIABILITIES | De-deup the tradelines with spouss YoM v
JOINT_DEDUP_ALLAPL_LIABILITIES De-deup the tradelines with spouse | ', b W
and secondary applicant=s(=z).
DECUP_CRE_EXPIRATION _DAYS Credit report expiration days Mumber ag

Whenever two (or more) items are identified as duplicates, Oracle Financial Services Lending
and Leasing uses the following hierarchy to pick one of the items as the “correct” one:
1. Last Reported Date: The row that has been reported most recently is used.

2. Owner: In case of a tie on the last reported date, one of the tradelines is picked in the
descending order of priority depending on who the tradeline belongs to: Primary, Spouse,
then Secondary.

Debt Ratio combination

Oracle Financial Services Lending and Leasing uses the system parameter

DBR _JOINT INC DEBT WITH_SPOUSE to decide whether to combine debt ratios of the
spouse with the primary applicant. The DBR JOINT INC DEBT WITH COAPP parameter
decides whether to do the same on a non-spousal joint application.

When this indicator is checked, all liabilities in the Liability section on the Summary sub screen
of the Applicant (2) master tab with the Include box selected will be used in the debt ratio
calculation.

The following system parameter will be set up to provide switches to allow the functionality to
be turned on and off:

De-duping process

The de-duping logic will be integrated into the system decision-making process in the
following manner:

Initial credit pulls on new applications

e Ifthe JOINT DEDUP _SPOUSE LIABILITIES/ JOINT DEDUP ALLAPL LIABILITIES
system parameters are set to Y, uses the de-duping logic described above to uncheck
the duplicate liabilities in the spouse's/co-applicant’s liabilities.

e Ifthe DBR_JOINT INC DEBT WITH SPOUSE/
DBR _JOINT INC DEBT WITH ALLAPL parameters are setto Y, the system includes
the liabilities of the spouse/ co-applicant while calculating the debt ratio of the primary
applicant.

e The system will use all available credit reports at the time.

Subsequent credit pulls (manual)

e Toremove duplicate liabilities from the calculation, choose the Dedup Liabilities button
on the Underwriting form (Applicants master tab > Summary sub screen > Liability
section). (Potential record locking situations force the action to remain manual versus
the system automatically doing it).

e Ifthe Populate Debt and Include Debt boxes are selected in the Applicant/Customer
Detail section on the Bureau master tab on the Underwriting form for the credit
request and the JOINT DEDUP_SPOUSE LIABILITIES/

JOINT DEDUP_ALLAPL_LIABILITIES system parameters are setto Y, the system will
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3.6

use the de-duping logic described above to uncheck the duplicate liabilities in the
spouse's/co-applicant's liabilities.

e Ifthe DBR_JOINT INC DEBT WITH SPOUSE/
DBR JOINT INC DEBT WITH COAPL parameters are settoY, the system will include
the liabilities of the spouse/ co-applicant while calculating the debt ratio of the primary
applicant.

e The system will use all available credit reports at the time of the request that have been
requested within the number of days specified in the DEDUP_CRB_EXPIRATION DAYS
parameter.

Restrictions

The de-duping logic will be limited based upon the discussion above. If the system cannot
identify two tradelines as duplicates based upon the logic mentioned above, the individual
tradelines will be retained. In such circumstances, both tradelines will be used in the debt ratio
calculation and it will be the user’s responsibility to disregard one of them by clearing the
Include check box.

Correspondence

The Correspondence screen enables you to setup the system'’s correspondence.

The system provides two types of correspondence: predefined and ad hoc. The following
chart provides a quick summary of both:

TYPE OF CORRESFONDENCE AD HOC [ PREDEFINED
Created automatically

Created manually

Generated for accounts

Generated for applications

Set up with the Correspondence link

H =

bt
b
s
h
X

Set up with the Letters link on the Product link

This chapter explains how to setup ad hoc correspondence with the Correspondence form.

The Correspondence screens provide a cost-effective and easy to use method to build
custom documents that draw information from the system’s database without additional
programming. You can choose what to include in a letter, create a template, and then use this
template to produce a letter.

The core of the Correspondence module is the document element -- the information stored in
the database merged into the correspondence. The system has document elements defined
for commonly used data elements in correspondence, such as account numbers, account
balances, customer addresses, telephone numbers, and due dates.

Correspondence consists of a document file with text of your choice and the document
elements from the system’s database.

You can create a correspondence set that consists of one or more documents. If a
correspondence set consists of more than one document, such as the account details letter
and a payment overdue letter, it prints both documents every time the system generates
correspondence for a customer.

The Correspondence module creates the following standard ad hoc correspondence:

e Microsoft Word (RTF)
e Adobe Acrobat (PDF/XFDF)
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3.6.1

3.6.1.1

Note

In this document and in the system, the term BANKERS SYSTEM is synonymous with
Adobe Acrobat.

Correspondence

The Correspondence screen contains the following sub screens:

e System Functions
e Elements

e E-Form Elements
e Documents

e Correspondence

Navigating to Correspondence

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Correspondence.

System Functions

The System Functions screen enables you to view the predefined functions for the
appropriate Lease product in the system. These are attributes from the database.

Functions define how the system retrieves data to include in correspondence. The data is
retrieved as elements which are either specific database columns or calculated values.
Elements are recorded on the Elements screen.

To view the predefined system functions
1. Click Setup > Setup > Correspondence > Lease > System Functions.

2. In the Function Definition section, you can view the following information.

ORACLE
Financial Services Lending and Leasing

% Welcome, PRAKRRAQ ~  Accessibility o

User Defined Default

Producer Cycles

Vendors
Collection Cycles
Reports

Error Messages

Translations
User

Organization

Comparies

Access

Users

Credit Bureau

Correspondence

General Ledger

Queues

Printers

Bark Details

Check Details

Standard Payess

Currencies

Zip Codes
Products

< >

Function Parameters

Transaction Codes View~ Format~ [ Freeze £ Detach 1) wrap 2]
Datz Files Position Parameter Description
Dedupe 1iv 10 AcC id Account 1D
Securitization 2 iv_name_ar Paramster Name
3 iv_value_ar Parameter value

Close
DashBoard Carrespondence EIls
* Origination Common || Loan | Line Lease
> Serviding System Functions  Elements | E-Form Elements | Documents | Correspondance
> Collections
> WEP Function Definition
> Tools Vieww Formatw [ Freeze i Detach ) Wrap [0
Setup Function Name: Description Function Type Source Program
rrom GET_ACC_121 DTLS Get Account Details (Leass CE) COR_ELM_PROC CGNACC_EL 121 01
- GET_ACC_CON_121 DTLS  Get Account Contract Details (Lasss CE) COR_ELM_PROC CGNCON_EL 121 01
e GET oTLS Get Application case CE) COR_ELM_PROC CONAPP_EL.
2l . . GET_APP_ADC_121_DTLS  Get Application Decisions (Lease Close Ended) ‘COR_ELM_PROC CGNADC_EL_121_01
::s‘k" e GET_8PP_CON_121_DTLS  Get Application Contract Details (Lease CE) (COR_ELM_PROC CGNACO_EL_121_01
okups
User Defined Tables
Audit Tables

3-45

ORACLE



A brief description of the fields is given below:

Field: View this:

Function Name Displays the function name.
Description Displays the function description.
Function Type Displays the function type.
Source Program Displays the source program.

3. Inthe Functions Parameters section, you can view the following information.

A brief description of the fields is given below::

Field: View this:

Position Displays the parameter position.

Parameter Displays the function parameter.
Description Displays the function parameter description.

3.6.1.2 Elements

The Elements screen displays the predefined document elements retrieved from the
database when the correspondence is generated.

In the Element Definitions section, you can update or edit only the Description field.

To view the Elements
1. Click Setup > Setup > Administration > User > Correspondence > Lease > Elements
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3.6.1.3

2. On the Element Definitions screen, perform any of the Basic Operations mentioned in
Navigation chapter. You cannot add a new record.

2

lement Type Description
ACCOUNT ADS LIFE

ACCOUNT DEPRECIATION METHOD CODE
ACCOUNT DEPRECIATION START DATE
ACCOUNT DEPRECIATION VALUE

ACCOUNT EOT VALUE

ACCOUNT FIRST LAST YEAR CONV CODE
ACCOUNT LEASE TAX BOOK TYPE CODE
ACCOUNT LEASE TERMINATION TYPE CODE
ACCOUNT TAX LIFE

ACCOUNT TAX SALVAGE VALUE

ACCOUNT TERM PD

APPLICATION DECISIO!
APPLICATION ADS LIFE
APPIICATION APPROX CASH PRC

AUV ML N D A e A e @

B save and sy | [ Save and Retum

* Description | ACCOUNT ADS LIFE
ype NUMBER
Source Function GET_ACC_121_DTLS

ORACLE
Financial Services Lending and Leasing
R Correspondence y
- Origination Common | loan | kine Lease
> Senvicing System Functions  Elements | E-Form Elements | Documents  Comespondance
> Collections
> Wep Elements
> Tools Vieww Fomat [ Fréeze & Detach ) wrap
Setup Levelo Type Element Name
ety acc ACC_ADS_LIFE_ 121
A A ACC ACG_DEPREGIATION_METHOD_CD_121
e acc ACC_DEPRECIATION_START_DT_121
- Acc ACC_DEPRECIATION_VALUE 121
:Z:;’:S it acc ACC_EOT_VALUE 121
Y AcC ACC_FIRST_LAST_YEAR_CONV_€D_121
Ueer: Definec] Toblesy ACcC ACC_LEASE_TAX_BOOK_TYPE_CD_121
Audit Tables acc ACC_LEASE_TERMINATION_TYPE_CD_121
User Defined Default: ACC ACC_TAX_LIFE_121
Trensaction Codes AcC ACC_TAX_SALVAGE_VALUE_121
Datz Files ACC ACC_TERM_PD_121
Dedupe PP ADC_CAP_COST_121
Seciizin app ADC_DOWN_PMT_AMT_121
7 ADC_DOWN_PMT_PER_121
14 APP ADC_PMT_AMT_121
app ADC_RENT_FACTOR_121
v PP ADC_RESIDUAL_PER_121
Collection Cycles aep
Reports APP APP_ADS_LIFE_121
Error Messages avp APP APPROX CASH PRE 121
Trenslations
User
Organization Elements
Comparies
Access
Users Levelo Type ACC
Credit Bureau ~ .
Al Element Name AQC_ADS_LIFE_121
& Element Type S
General Ledger
Queues
Printers
Bank Details
Check Detalls
Standard Payees
Currencies
7ip Codes
Products ™,
< >

Data Type
NUMBER
VARCHAR2
DATE
NUMBER
NUMBER
VARCHARZ
VARCHARZ
VARCHAR2
NUMBER
NUMBER
NUMBER
NUMBER
NUMBER
NUMBER
NUMBER
NUMBER
NUMBER
NUMBER
NUMBER
NUMRFR

S Betum

Enabled ¥

Default Value

A brief description of the fields is given below:

Field:

Do this:

Level0 Type

Displays the element LevelO type.

Element Name

Displays the element name.

Element Type

Displays the element type.

Description

Specify the element description.

Data Type

Displays the element data type.

Source Function

Displays the element function.

Enabled

Displays if the element is enabled or not.

Default Value

Displays the default value.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

E-Form Elements

The E-forms Elements screen defines elements included when the system generates online
correspondence with a browser. The E-forms screen is set up only for PDF elements using

the XFDF format. These definitions translate the external element required by the vendor to
a systems correspondence element.
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For example,

Type

Details

Vendor Element

AlIBorrowers.FullNameStreetCityStateZip

(Contains names of all borrowers with address of
primary customer)

The system’s Elements

PRIM_APL NAME

SPOUSE_APL _NAME

PRIM_APA_ADDRESS!
PRIM_APA_ADDRESS2
PRIM_APA_ADDRESS3

Translation:

PRIM_APL NAME|',' || SPOUSE_APL NAME]|","||
PRIM_APA_ADDRESSI ||';'|[PRIM_APA_AD-
DRESS2 || ;' || PRIM_APA_ADDRESS3

To setup the E-forms Elements

1. Click Setup > Setup > Administration > User > Correspondence > Lease > E-Form

Elements

2. In the E-form Elements Definitions section, perform any of the Basic Operations

mentioned in Navigation chapter.

ORACLE'
Financial Services Lending and Leasing

DashBoard Corespndencé x

 Origination Common Loan Line Lease
> Servicing
> Collections

> WEP E-Form Elements
> Tools View = Format- [ Frezze i Detach

Setup
Admiristration

System

A <
System Parameter E-Form Elements
Lookups

User Definad Tables
Audit Tables

User Definad Default
Transaction Codes = Source Code
Data Files

Dedupe

Securitization

Evants

Batch Jobs «
Producer Cycles

‘Vendors

Collection Cycles

Reports

= Leveld Type

* Element Name

Error Messages
Translations
User
Organization
Companies
Access
Users
Credit Bureau
Comespondence
Genersl Ledger
Queues

Bank Details
Check Details
Standard Payess
Cumenci =

Zip Codes

System Functions | Elements ~E-Form Elements | Documents | Correspondence

dwes | W@

Setup Levelo Type Source Code: Element Name

[v] *Description

] *DetaType
Code

= Transiation

Description

Data Type Code

A seve and add | [ save and stay || [ save and Retun || Ga Retum

[v]

& Welcome, PRAKRRAD +  Accessiilty =)
3 Cose
dd | Edit || 5 view || <2 audit
Enabled
N
>

=Enabled [

A brief description of the fields is given below:

Field: Do this:

LevelO Type

Select the element LevelO type from the drop-down list.
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Field: Do this:

Source Code Select the element e-form source code from the drop-down list.
Element Name Specify the element name (the name used in the external form).
Description Specify the element description.

Data Type Code Select the element data type code from the drop-down list.

Translation Select the translation for the e-form element (SQL statement frag-
ment defining the element data), from the drop-down list.

Enabled Check this box to enable the e-form element.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
3.6.1.4 Documents
The Documents screen enables you to set up the various documents and the data fields that

the system compiles together when creating a correspondence. The system provides two
different document formats: Word or XFDF: XML-based form.

Note

Oracle Financial Services Software assumes that the user is familiar with Word and the
Merge Document command. If the user is creating e-form documents with XFDF, then
Oracle Financial Services Software assumes that person is familiar with Adobe forms.

To setup documents to be compiled in correspondence

1. Click Setup > Setup > Administration > User > Correspondence > Lease >
Documents.
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2. In the Document Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE’
Financial Services Lending and Leasing

% Welcome, PRAKRRAQ = Acce

DashBoard
> Origination
- Servicing
> Collections
> WFP
> Tools
Setup
Setup
Administration
System
System Parameter
Lookups
User Defined Tables
Audit Tables
User Defined Default
Transaction Codes
Data Files
Dedupe
Securitization
Events
E
Producer Cycles
Vendars
Collection Cycles

A TEST3

Correspondence 5

Common | losn | Line  Lease

System Functions | Elements | E-Form Elements | Documents | Comespondence
Documents Definition

View » Formatw  [Ef
Code

ze Hfivetach | ol wiep

Desription File Name

TEST3 TEST3

Documents Definition

*Code
= Description e

= File Name

Document Elements
‘4 View » Fomat- [Ep

Seq Type
No data to display.

Frocze i Detach wep | @

Element Name

% Gen. Data File

Level0 Type

ACCOUNT

* Level0 Type ACCOUNT

urce | OFSLL

Description

& || Zeoe || Elvew | F aie
Enabled
Y

ORACLE: BI PUBLISHER Y

E-Form Source Froduct Source

OFsLL AL

[ saveand add | [ save and Stay Save and Retum

{2 Retum
]

Source ORACLE: BI PUBLISHER
* Enabled

dpadd | SFedt || B view | o audit

Data Type Format Mask Default Valus Enabled

Reports
Error Messages

A add | e | [E view

Document Templates

Translations

s View~ Format~ [
Organization
Companies
Access
Users
Credit Bureau
Correspandence
General Ledger
Queues
Printers
Bank Details
Check Details
Standard Payees
Currencies
Zip Codes

Products
< >

Jwep | @

Producer State

Freeze i Detach

File Name Product Customer State Enabled

No data to display

App/Acc St New Template

A brief description of the fields is given below:

Field: Do this:

Code Specify the document code to define the name for the new docu-

ment.

Specify the document description for the new document. This entry
appears in the Correspondence section on the Request screen,
when you generate an ad hoc correspondence.

Description

File Name Specify the document file name for the resulting file (Word or XFDF

document).

Level0 Type Select the level0 type from the drop-down list.

E-form Source Select the element e-form source from the drop-down list.

Product Select the document product from the drop-down list.

Source Select the document source type from the drop-down list.

Enabled Check this box to enable the document definition.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Inthe Document Elements section, perform any of the Basic Operations mentioned in
Navigation chapter.
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A brief description of the fields is given below:

Field: Do this:
Seq Specify the sequence number to order the document elements.
Type Select element type from the following from the drop-down list. This

list provides the following options:

System-defined — If you select, the value is supplied by the system
and cannot be changed in the Correspondence Request screen.

Constant.

User Defined Element — If you select, you can choose the value
and change it in the Correspondence Request screen.

User Defined Constant — If you choose, you can choose the value,
but you cannot change it in the Correspondence Request screen.

Translated Element — If a document contains an e-form element
and you do not select this option, then the value will not be trans-

lated.
Element Name Select the element name from the drop-down list.
Description Specify element description.

Notes:

1. Check that the element name does not have blank spaces or
special characters, such as the forward slash “/” or backward slash
"

2. If the element is system-defined, then the system will automati-
cally complete this field.

Data Type Select the element data type from the drop-down list.
Format Mask Select the element format mask from the drop-down list.
Default Value Specify the element default value.

Enabled Check this box to include the element in the document.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Inthe Document Template section, you can set the information about the template which
is attached to the correspondence documents. The template thus saved is similar to the
template functionality available in MS word. Perform any of the Basic Operations
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

File Name Specify the file name to define the name for the new template.

Product Select the product for which the template is valid, from the drop-
down list.

Customer State | Select the customer state for which the product is valid, from the
drop-down list.
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Field: Do this:

Producer State | Select the Producer state for which the product is valid, from the
drop-down list.

App/Acc St Select the Applicant/Account state for which the product is valid,
from the drop-down list.

New Template Check this box to load the template as a new template.

Loaded Check this box to indicate that the template is loaded.

Enabled Check this box to enable the template.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

The Document Elements sub screen records the system'’s application or account information
that appears in the ad hoc correspondence
To generate a data file for a document

1. In the Document Definition section of Setup > Setup > Administration > User >
Correspondence > Lease > Documents, select the record for which you want to
generate a data file.

2. Click Gen. Data File button.
The system displays a new screen with the following options:

Opening CODEL &

You have chosen to open:

*L CODE1

which is a: Adobe Acrobat Document
from: hitps://10.184.132.155:7013

What should Firefox do with this file?

@ Open with | Adobe Acrobat (default) -

=) Save File

[ Do this gutomatically for files like this from now on.

0K Cancel

e Open with — Select to view the data file in the format you want. The adjacent drop-down
list provides a list of formats compatible with the system. The system downloads the file
and displays it.

e Save File — Select to save the data file on your system.

3. Check the box Do this automatically for files like this from now on to apply selected
properties for the files which are similar to the current one.
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3.6.1.5 Correspondence

The Correspondence screen enables you to define who will receive the documents you
created on the Document Definition screen by creating correspondence sets. Each document

must belong to a set, and a set can have more than one document.

To set up a correspondence set

1. Click Setup > Setup > Administration > User > Correspondence > Lease >
Correspondence. The correspondence setup is classified into two:

e Documents

e Functions

2. Inthe Correspondence section, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE’

Financial Services Lending and Leasing

Welcome, PRAKRRAD +  Accessibility (]

DashBoard
> Origination
> Servicing
> Collections
> WFP
> Tools
Setup
Setup
Administration (i
System
System Parameter
Lookups
User Defined Tables
Audit Tables
User Definad Default
Transaction Codes
Data Files
Dedupe
Securitization

tch Jobs Rl
r Cycles

Vendars
Collection Cycles
Reports

Error Messages
Translations
User
Organization
Companies
Access
Users
Credit Bureau
Correspondence:
General Ledger
Queues
Printers
Bank Details
Check Details
Standard Payees
Currencies
Zip Codes
Products
< >

Correspondence

Common | Loan | Line| Lease

System Functions || Elements | E-Form Elements | Documents | Correspondence

Correspondence
Viewv Fomaty  Fp Freeze £ Detach | Wirap

Code Description

TEST10 TEST10

Correspondence

* Code
* Description

* Print Schedule [~]

Documents  Functions
Documents
View v Formatv [ Freeze

Documents
No data to display.

Recipient

A Detach Wrap

[ Close.
o add || 2 Edit | view || o7 Audit
Print Schedule Level Group Company Branch
ONLINE ACCOUNT 01 BANKRUPTCY SET AL AL

>

B saveand add | [l saveand stay | B save and Retum || Cagetum
* Level ACCOUNT [v] *Branch ALL [v]
= Group = 1

= Company ALL [v] = Enabled []

Include

A brief description of the fields is given below:

Field: Do this:

Code Specify the correspondence code.

Description Specify the correspondence description (required).

Print Schedule Select the correspondence output schedule type from the drop-
down list.

Level Select the correspondence level type from the drop-down list.

Group Select correspondence group from the drop-down list.

Company Select the correspondence company from the drop-down list.

Branch Select the correspondence branch from the drop-down list.

Product Select the correspondence product from the drop-down list.
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Field: Do this:

Enabled Check this box to enable the correspondence.

Perform any of the Basic Actions mentioned in Navigation chapter.

4. Click Setup > Setup > Administration > User > Correspondence > Lease >
Correspondence > Documents.

5. Inthe Documents section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Document Select the correspondence document from the drop-down list.
Recipients Select the recipients for the document from the drop-down list.
Enabled Check this box to enable the recipient selected.

6. Perform any of the Basic Actions mentioned in Navigation chapter.
7. Click Setup > Setup > Correspondence > Lease > Correspondence > Functions.

8. Inthe Functions sub screen, you can define the functions that should be executed before
or after correspondence is generated. Perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Function Select the correspondence functions from the drop-down list.
Execute Select when to execute the correspondence function from the
When? drop-down list.

9. Perform any of the Basic Actions mentioned in Navigation chapter.

3.6.2 Creating Correspondence

1. To create a correspondence add a record in the document definition block. For example:
SAMPLE_LOAN_APP

2. Inthe Document Elements section, add the elements required in the correspondence.
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3. Click on Gen.Data File to generate PDF file of the report.

£ SAMPLE_LOAN_APP (1).pdf - Adobe Reader EaRE=x]

File Edit View Window Help

RN N = =] Lla|le@®[=]|HB| e 2|

Tools Sign Commen

ORACLE’
Financial Services Lending and Leasing

<?xml version="1.0" encoding="UTF-8" 7>

<xs:schema xmins:xs="http://www.w3.0org/2001/XMLSchema" version="1.0">
<xs:element name="SAMPLE_LOAN_APP">

<xs:element name="PRIM_APL_BIRTH_DT" type="xs:string"/>
<xs:element name="PRIM_APL_NAME" type="xs:string"/>
<xs:element name="APP_REQ_ADV_AMT_100" type="xs:string"/>
<xs:element name="APP_APPROX_CASH_PRC_111" type="xs:string"/>
<xs:element name="ASE_APP_DESC_100" type="xs:string"/>
<xs:element name="PRIM_APL_SSN" type="xs:string"/>

<xs:element name="APA_ADDRESS1" type="xs:string"/>
<xs:element name="APA_ADDRESS2" type="xs:string"/>
<xs:element name="APA_ADDRESS3" type="xs:string"/>
<xs:element name="APE_NAME" type="xs:string"/>

<xs:element name="APA_PHONE" type="xs:string"/>

<xs:element name="APE_ADDRESS1" type="xs:string"/>
<xs:element name="APE_ADDRESS2" type="xs:string"/>
<xs:element name="APE_ADDRESS3" type="xs:string"/>
<xs:element name="APE_PHONE" type="xs:string"/>

<xs:element name="APL_EMAIL_ADDRESS1" type="xs:string"/>
<xs:element name="APL_NO_OF_DEPENDENTS" type="xs:string"/>
<xs:element name="APE_ACTUAL_MTHLY_AMT" type="xs:string"/>
<xs:element name="APP_PRO_NAME" type="xs:string"/>
</xs:element>

</xs:schema>

4. Copy and save the content in the pdf file as an xml file. The saved xml file should have
the same name as entered in the Code column of Document Definition section. For

Example: SAMPLE_LOAN_APP.xml.
5. Open MS Word.

Note

Oracle Financial Services Software assumes that BIP Desktop Tool is installed and the

user is familiar with the BIP Report Tool.

6. In Bl Publisher Tab in MS Word, click on Sample XML and import the saved xml file. For

Example: SAMPLE_LOAN_APP.xml.
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7. Create the template by inserting required elements tag.

Page lajout  References  Mailings  Review  View  Developer  BIPublisher

— e P )

|B| L U ~abe x, X' Aav|%~

Requested Loan Amount
Dealer

Approx Value of Asset
Description of Asset
Name of Applicant

Date of Birth

SSN

Name & Address of Employer

Employer Phone
Monthly Salary (Gross)
Number of dependants

Residence Address

Address Phone

E-mail

Page:1of1 | Words: 100 | &

8. The template created in MS Word should be saved with .rtf extension. For Example:

SAMPLE_LOAN_APP.rtf

AsBCel AwBbC AaBb( AaBbC AaBh( aspbcer | A4

TNormal | T No Spaci.. Headingl — Heading 2 Title Subtitle 75:;”"“
es

BANK
LOAN APPLICATION FOR PURCHASE OF ASSET

APP_REQ_ADV_AMT_100
APP_PRO_NAME
APP_APPROX_CASH_PRC_111
ASE_APP_DESC_100
PRIM_APL_NAME
PRIM_APL_BIRTH_DT
PRIM_APL_SSN

APE_NAME

APE_ADDRESS1
APE_ADDRESS2
APE_ADDRESS3

APE_PHONE
APE_ACTUAL_MTHLY_AMT
APL_NO_OF DEPENDENTS
APA_ADDRESS1
APA_ADDRESS2
APA_ADDRESS3

APA_PHONE

APL_EMAIL_ADDRESS1

Note

The .xml and .rtf file should be saved with the same name as entered in the ‘Code’ col-
umn of Document Definition section.

9. Upload the rtf template in the BIP and create the data model with SQL query as “select
CDO_XML_DOCUMENT from correspondence_docs where cdo_id = :docld”.

10. After the data model creation, launch the correspondence screen and click
Correspondence tab.

11. You can setup a correspondence with the created doc.

3.6.3 Generating Correspondence

1. Togenerate a correspondence open the application for which the correspondence should
be generated.

2. Click Correspondence tab. In the Correspondence section, click on Add.
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3. Selectthe created Correspondence. Click Save and Add to save and add a new record.
Click to Save and Return save and return to main screen. Click Return to return to main

screen without modifications.
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E::;';;”""“ 3 App# Sub Uit Status Egg;"“”’"m“ Producer Name: ;zammgfu;{nmer E;;}:E:{fnn Contact Sales Agent Branch Pror
Applicaion Retrieval 04J06/2015 0000001050 UNDEFINED NEW - REVIEW REQUIRED  REVIEW PRAO002 : PORSCHEINDL.. .. ¥ ¥ DEMOSALES  USHQ ]
Scenario Analysis )
Applicaton Docunents
Inage Haintenance
Reports
Producers summary| Applicant  Business  Request  Dedsion Bureau | Collteral | Comments Tracking  Document Verification | Correspondence | Tools
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0 02032016
4001 SAHPLE LOAN APPLICATION 1222015
Correspondence
[ saveandads | [ smeand stay | [ soveandRetum | CaRetun
* Comrespondence v Date 02/09/2016
Documents
 Seniicing Views Fomaty B [[Frece Hoead  Jum @
> Collections Document Id Document Redpiert EfomSouce  Soure Type Seledted  Generated
o data to display.
> WFP
> Tools
T
> Setup Document Elements Elvew | it ’
e . lm e . . o

4. Click Generate to generate the selected correspondence and View Correspondence to
view the Correspondence in PDF format.

APPLICATION FOR PURCHASE OF ASSET

LOAN APPLICATION

Requested Loan Amount
Dealer

Approx Value of Asset
Description of Asset
Name of Applicant

Date of Birth

SSN

Name & Address of Employer

Employer Phone
Monthly Salary (Gross)
Number of dependants

Residence Address

Address Phone

E-mail

| declare that the information given in the application

Signature of the Applicant
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20000.00

.00

2005 TOYOTA CAMRY
ANDREW WATT
07/15/1975
HKAXXKX2147

58, EAST 19TH STREET

HOLTSVILLE NY 00544
o

552230.00

o

34, WEST 69TH STN BCHN
NEW YORK MA 01730 US
o

ANDREW.WATT@XYZ.COM

is true to the best of my knowledge and belief
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3.7

3.71

3.711

General Ledger

The application’s General Ledger Setup screen can generate and transfer transactions to the
accounting software your company uses. It is the interface that transfers all financial
transactions to the accounting system. It provides your accounting software with an ASCII
data file containing the GL (general ledger) entries for the process date.

This chapter explains the General Ledger form - the system interface that enables you to:

e Map system transactions to your GL transactions.
e Define the requirements for header and derived segments

The system supports the bulk uploading of general ledger setup data. This enables you to
upload multiple setup data, avoid reentering setup data, and more importantly, reduce data
entry mistakes. The system currently supports uploading using a fixed-length format only,
where each data is at a pre-fixed position only. You can run batch jobs with the Set Code SET-
BLK to upload pricing and GL data.

Accounting Company Definition

The “accounting company” is the entity for which the financial statements are prepared for
legal reporting. You must define your accounting company when implementing Oracle
Financial Services Lending and Leasing GL Interface. The accounting company is based
upon the portfolio company set up in the system. For example, if there are two companies set
up within one organization, the two portfolio companies will be used as accounting
companies. Each of these companies will have its own GL set up.

General Ledger

In Setup > Setup > Administration > User > General Ledger > General Ledger, you can
setup data that needs to be setup in the system to export transactions to the user’s general
ledger application.

The system uses segments to create the complete GL account to which the amount is to be
posted. The defined segments are linked together to create the GL account. One of the
segments is bound to be the natural account. The other segments could be direct values (like
the natural account) or derived values. The segment is grouped into four categories:

1. Translation Definition
2. Attribute Definitions
3. Transaction Definition

4. Transaction Links

Navigating to General Ledger

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > General Ledger > General Ledger.

2. Inthe Company section of the General Ledger screen, select the portfolio company you
want to work with.

Translation Definition

GL segment values are defined on the Translation Definition.

To setup the Translation Definition

1. Click Setup > Setup > Administration > User > General Ledger > General Ledger >
Translation Definition.
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2. In the Segment Definitions section, perform any of the Basic Operations mentioned in

Navigation chapter.

ORACLE’ APKELKAR +
Financial Services Lending and Leasing
St General Ledger y [#] Close
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> WFP & &
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>+ Tools 1esi 1 =3) s
usot DEMO BAK USA
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e = e
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User Defined Tables
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et Gt View = Format- Freeze ffiDetach | ol wrap 5]
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e SEGMENT #1 150010 150010 TAX RECEIVABLES
e SEGVENT #1 200000 200000 LOAN RECEIVABLES
- — SEGVENT #1 1010 201010 LATE FEE RECEIVABLES
o SEGMENT #1 1020 01020 NSF RECETVABLES
Do SEGMENT #1 0101 01031 EXTENSION FEE RECEIVABLES
UE(ESS SEGENT #1 2104 2104 ADVANCE FEE RECEIVABLES -
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CreditBureau
Correspondence Segment Definitions
General Ledger [ saveandstay | [ saveandRetun | GaRetum
Queues &
b ek oL *Description LOAN FLINDING
Barkital Source 100000
Ehieck betali Transiated Value 100000
Standard Fayees
Currendes Il

A brief description of the fields is given below:

Field:

Do this:

Segment #

Select the segment number. the system can support up to 10 seg-
ments, from the drop-down list. Valid values range from 01 to 10.

Source

Specify the Source to record a “direct value” or “translated value”.

Direct Value: In case the segment value is not a derived value (more
on derived segments later), the Source field contains the same value
as the “Translated Value” field. This would contain a list of all the valid
values for each segment (for example, GL account number).

Translated Value: In case the segment value is a derived value, the
Source field is used to store the value of the condition string that will
be applicable for the particular segment. For example, if the value 02
value in the Segment # field is derived using the branch of the cus-
tomer as a source criteria, then the entry would read as:

Segment #: 02

Source: CB-001

Translated Value: HQ
Description: HEADQUARTERS

Therefore, for all accounts in branch CB-001 for segment 02, the
translated value of HQ will be used in the GL account number
(required).
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3.71.2

Field: Do this:

Translated Specify the actual segment value. All valid segment values for all
Value segments are defined here.
Description Specify the description of the segment.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Attribute Definitions

The General Ledger interface uses two types of segments:

e Header segment types
e Detail segment types

Both are recorded on the Attribute Definitions screen in the Segment Type field.

Header segment types

The header segment types are the account attributes used as selection criteria to map a
transaction to GL segments. The system supports 10 header segments. Four of these are
predefined. The four predefined segments are:

# Segment Description

01 PRODUCT TYPE Product Type

02 BACKDATED TXN Backdated Transaction
03 PRODUCT Product Code

04 STATUS Account Status

This means that the system will allow the attributes listed above to be used as criteria for
categorizing the transactions. Segment selections depend on the values in the header
segment fields.

You can define six additional header segments. The Attributes Definitions screen records the
header segments. A header segment must be an account attribute.

Detail segment types

Detail segment types allow you to set up components of the GL account number. A GL
account number can be composed of multiple segments that are combined to create the
composite GL account number. Default detail segments used in the system are:

# Segment Description
01 Account # The natural account number in the GL for the transaction
02 Branch Customer Branch

Eight additional detail segments can be defined. One of the segments is bound to be the
“natural account.” (A natural account is an account from the client’s master listing of all
general ledger accounts, or “chart of accounts.”)
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3.71.3

The detail segments could be direct values (like the natural account) or derived values.

Note

Simply adding a header or detail segment will not be enough. Additional programming is
required before any new header or detail segment can be used. Please consult Oracle Fi-
nancial Services Software, Inc. before adding any segments.

To setup the Attribute Definitions

1. Click Setup > Setup > Administration > User > General Ledger > General Ledger >
Attribute Definitions.

2. In the Attribute Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Segment Type Select the segment type from the drop-down list.
Segment # Select the segment number from the drop-down list.
Description Specify the segment description (required).

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Transaction Definition

The Transaction Definition screen enables you to define GL transactions and to associate the
Debit and Credit segments for each GL Transaction.

In GL Transactions sub screen, the Transaction Code column contains GL transactions
defined by the client team. The Segments section contains a Debt and Credit section. These
are both detail segments.

To setup Transaction Definition

1. Click Setup > Setup > Administration > User > General Ledger > General Ledger >
Transaction Definition.

2. In the GL Transactions section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Transaction Code Specify unique GL transaction code.
Description Specify description for the GL transaction.
Product Type Specify the product type.

Backdated Txn Specify the back dated transactions.
Product Specify the product.

Status Specify the status.
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Field: Do this:

Enabled Check this box to enable the transaction.
Attribute 5 Specify the header attribute 5.

Attribute 6 Specify the header attribute 6.

Attribute 7 Specify the header attribute 7.

Attribute 8 Specify the header attribute 8.

Attribute 9 Specify the header attribute 9.

Attribute 10

Specify the header attribute 10.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
4.

chapter.

A brief description of the fields is given below:

In the Segments section, perform any of the Basic Operations mentioned in Navigation

Field: Do this:
Sort Seq Specify the sort sequence (optional).
Enabled Check this box to enable the segment.

Debit section

Debit ACC # Select the segment value from the drop-down list.
Branch Select the segment value from the drop-down list.
Segment #3 Select the segment value from the drop-down list.
Segment #4 Select the segment value from the drop-down list.
Segment #5 Select the segment value from the drop-down list.
Segment #6 Select the segment value from the drop-down list.
Segment #7 Select the segment value from the drop-down list.
Segment #8 Select the segment value from the drop-down list.
Segment #9 Select the segment value from the drop-down list.
Segment #10 Select the segment value from the drop-down list.

Credit section

Credit ACC # Select the segment value from the drop-down list.
Branch Select the segment value from the drop-down list.
Segment #3 Select the segment value from the drop-down list.
Segment #4 Select the segment value from the drop-down list.
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Field: Do this:

Segment #5 Select the segment value from the drop-down list.
Segment #6 Select the segment value from the drop-down list.
Segment #7 Select the segment value from the drop-down list.
Segment #8 Select the segment value from the drop-down list.
Segment #9 Select the segment value from the drop-down list.
Segment #10 Select the segment value from the drop-down list.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

As mentioned in the Attributes Definitions screen section, the system can support up to 10
header segments.

Each transaction can be mapped to one or more GL accounts using the segment mapping
section. A segment number can be a natural account or can be a derived segment. In case of
a natural account, you need to select the segment value (from the list of predefined
segments).

Entering DERIVED in the Segment Number field instructs the system to look for the derived
value from the segments defined in the Segments Definition section on the Translation
Definition screen.

Let’'s take an example:

Company: ABC BANK

Transaction Code: ADV

Description: ADVANCE

Product Type: FUNDING TRANSACTION

Branch: CB-001

Segment #1: 200000

Segment #2: DERIVED

Let’'s assume segment #2 is derived from the branch where the account belongs. While
calculating the account number, the system interprets segment #2 as follows:

The system will look for a segment value for segment #2 for the account in question using the
branch of the account (CB-001). It will use the segment value it finds, say HQ. This will be
segment value for segment #2.

IMPORTANT: The derived segment logic can be used for all segments except for the one
designated as the natural account segment.

CAUTION: Please note that the logic for calculation of the derived segments is customized

for each client. You will need to contact Oracle Financial Services Software inc. in case you
want to change the logic or add new derived segments.
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3.71.4

“Best Match Feature” for General Ledger (GL) Transactions

The system provides the functionality wherein for each monetary transaction, you can
generate entries in the General Ledger (GL) based on the setup. For a single transaction (for
example, a late charge), the system allows GL entries to be generated based on different
criteria regarding the loan account (for example, product type, product, status, and so on). A
late charge entry for one product type can differ from a late charge entry for a different product

type.
For example,

Assume you have set up the following four late charge fee GL transactions based on product
and status.

GL Transactions section

Transaction Code | Description PRODUCT STATUS
FLC A LATE CHARGE | LOAN AUTO

FLC AA LATE CHARGE | LOAN AUTO | ACTIVE
FLC B LATE CHARGE | LOAN ATV

FLC BB LATE CHARGE | LOAN ATV ACTIVE

For a late fee for an ACTIVE account for a LOAN AUTO, Oracle Financial Services Lending
and Leasing will process the GL Transaction FLC_AA. However, if the late fee is for a
CHARGED OFF account for a LOAN ATV, Oracle Financial Services Lending and Leasing
will process the GL Transaction FLC_B.

Transaction Links

The system enables you to map the various transactions to your General Ledger transaction
types with the Transaction Links screen. The list of transactions available in the Transaction
Code will be derived from the transactions setup on the Transaction Definition screen.

To setup the Transaction Links

1. Click Setup > Setup > Administration > User > General Ledger > General Ledger >
Transaction Links.

2. Inthe Transaction Links section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below::

Field: Do this:
Transaction Code Specify the transaction code.
Description Select the transaction description from the drop-down list.

GL Transaction Code Specify the corresponding GL transaction code.

Description Select the GL transaction description from the drop-down
list.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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3.8

You can have more than one transaction mapped to a user-defined GL transaction. In that
case, the system summarizes all the transactions to the GL transaction. For example, the
system uses separate transaction codes for fees, such as LATE_FEE and SERVICING_FEE.
If a client site would rather have all fees go into one debt and one credit account, they would
define a GL transaction and link all transactions to that defined transaction.

You could also have one transaction linked to more than one GL transaction. The system will
use the setup on the header segments to identify the correct GL transaction setup to use.

For example, if the FLC (Late Charge) transaction is mapped to the CHG_LC and CHGR _LC
transactions, then the system will look at the header segment definitions to identify the correct
GL transaction. Let’s say the header segment used is Account status and that CHG _LC is
used for “active” accounts and CHGR_LC is used for “charged off” accounts. In this case, the
system will identify the correct GL transaction depending on the account status.

Queues

When processing an account, various users might work on the accounts to complete different
tasks.

The account processing workflow facilitates the movement of the account from one person to
another with queues. Queues create a work section of accounts waiting for a particular and
common task to be performed. The system’s powerful queuing module automates this
otherwise manual process.

In the Queues setup screen, you can setup and manage workflow and work assignments on
a daily basis to ensure that the appropriate queues are available for users at all times.

Any time an account’s status is changed, the system checks whether the account is in the
right queue.

The system will sort queues based on an account’s status and condition. A condition is the
state of an account at a particular time, such as a delinquent, which determines the action a
user needs to take.

Queues in the system are distinguished to two types of queues:

1. Origination Queues

2. Customer Service Queues.

Customer service queues

In the Customer Service screen, queues create a work list of accounts waiting for a particular
and common task to be performed, such as collecting on a delinquency. The system’s
powerful queuing module automates this otherwise manual process. The Queue Setup form
allows you to manage workflow and work assignments and ensure that all accounts are in the
queues of the appropriate users at all times.

Customer Service queues distribute and route accounts that require some particular action to
be performed to specific users or departments. The system sorts customer service queues
based on an account’s status and condition.

Accounts become available for queue assignment when an account receives a condition.
Conditions can be applied automatically by the system or manually by users. For example,
during nightly processing, the system recognizes an account as delinquent and automatically
assigns it a condition of DELQ (“Delinquent”). The users can manually change an account’s
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condition using combination of Action and Result field entries on the Servicing > Servicing
> Customer Service > Customer Service > Customer Service > Call Activities.

These Action and Result field entry combinations are set up on Setup > Setup >
Administration > User > Queues > Call Actions Results.

The system associates an account with one or more queues based on multiple parameters,
including user-defined criteria and the follow-up date. For example, customer service queues
might be configured so accounts are parsed to users according to:

e Due date changes
e Deferment requests
e Title and insurance follow-up dates

Collections queues are included in the Customer Service queue. These queues focus on:
e General collections
e Bankruptcy
e Foreclosure
e Repossession
e Deficiency

Customer Service queues can be built online or in a nightly batch job. Within each queue, the
order of the accounts can be sorted based on user-defined criteria.

Note

— Although, the system allows you to define your own selection criteria in creating
queues, the system’s performance depends on how the selection criterion is
defined. The application highly recommends that you get approval from your
database administrator before using any queue selection criteria. Also, avoid using
user-defined tables and columns in the selection criteria.

— You can use these same methods for creating and closing queues in the case of
repossession, foreclosure and deficiency.

The Call Actions Results screen allows you to define the contents of the Action and Result
fields on the Customer Service screen’s Add Call Activities section. The system uses this
information to allow users to manually change the condition of an account, and thus assign or
remove the account to a queue.

Depending on how you set up call action result codes on the Call Actions screen, conditions
and queues are created or closed. You can also restrict the use of certain call activities based
on responsibility.

The lookup type ACC_CONDITION_CD defines which account conditions can be created. The
application’s queuing engine determines, if queues need to be created based on the
information in the Lookups sub screen for this lookup type.

The following table displays the possible combinations of condition and queue.

CONDIMON
QUELE Onen Close VA
Oaen YES D NO
Close NC VES YES
¥ YES 0 NO

1. Condition: Open, Queue: Open
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e Inthis state, both the account condition and queue are created or opened at the same
time.

e The system’s transaction-processing engine automatically creates DELQ, TIP,
SCHGOFF conditions and queues; therefore, you need not setup any call action result
with these conditions.

e CHGOFF is an account status, so no queues are created. To follow-up on charged-off
accounts, create DEFICIENCY condition with this option.

e BKRP (Bankruptcy), REPO (Repossession), FORC (Foreclosure) account conditions
and queues can be opened with this option. Also, account level indicators (for reporting
purpose) are set.

Note

— An account is moved to the condition, when a Call activity is posted; however, the
Queue is moved only when you click Update queue manually or in the EOD batch.

— Accounts are automatically moved based on the system parameter set up.

2. Condition: Open, Queue: NA
e In this state, only the account condition is created or opened.
e This option should be used only if queuing is not necessary on this account condition.

3. Condition: NA, Queue: Close
e In this state, the queue associated to the account condition is closed.

e This option should only be used if an existing queue on this account condition should be
closed. For example, for accounts with bankruptcy condition, delinquency follow-up is
not necessary. In such case, DELQ queue can be closed while the condition is still open.

e DELQ, TIP, SCHGOFF queues can be closed by using this option.

4. Condition: Close, Queue: Close
e Inthis state, both the account condition and queue are closed.

e The system’s transaction-processing engine automatically closes DELQ, TIP,
SCHGOFF conditions and queues; therefore, don’t setup any call action result with these
conditions.

e BKRP (Bankruptcy), REPO (Repossession), FORC (Foreclosure) account conditions
and queues can be closed with this option. Also, account level indicators (for reporting
purposes) are set.

Note

Condition will be removed from the Summary conditions section.

Navigating to Queues screen

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Queues.

2. The system displays the Queue Setup screen. You can setup queues related to:
e Customer Service
e Call Action Results

3.8.1 Customer Service Tab

The Customer Service section allows you to set up the customer service queues. The screen
includes a Hard Assigned box. When selected, the system assigns an equal amount of
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accounts to each individual user working on a that queue. Also, an account that is hard
assigned will remain assigned to the individual who opens that account until that person is no
longer working that queue

Customer Service command buttons

The Customer Service screen contains following three command buttons:

Command
button:

Function:

Update Queue

Queues can be updated whenever selection criteria has been updated.
They may also be updated manually, if the nightly batch fails.

Un-Assigned

Depends on location of the cursor when you choose this button.
Customer Service - “Un-assigns” all accounts in this queue.

Responsibilities and Users > Responsibilities - “Un-assigns” all
accounts in this queue.

Responsibilities and Users > User - “Un-assigns” all accounts
assigned to the specific user. Unassigned accounts may now be
selected by updating the queue and re-assigned.

Check Criteria

Reviews the selection criteria for errors. The system will not allow you
to enable a queue with invalid selection criteria.

To set up the Customer Service queues

1. Onthe Queue Setup screen, click Setup > Setup > Administration > User > Queues >
Customer Service. Queues are further filtered based on the following criteria:

e Selection Criteria

e Sort

e Responsibilities and Users

e Data node assignments

e Group Assignment

2. In the Queue Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE’

Financial Services Lending and Leasing

;@ sgnout O

> DashBoard
> Origination
"+ Servidng
> Collections
> WFP
 Tools
Setup
Setup
Administration
System
System Parameter
Lookups
User Defined Tables
Audit Tables
User Defined Defaults
Transaction Codes
Data Files
Dedupe
Securitization
Events
Batch Jobs
Producer Cydes

i

Queue Definition ok add || A Edit || [ view o Audit
view v Format~ [ Freeze i Detach ol wirap W) P UpdateQuene | 32 Un-Assigned
Queue Name Queue Desc Account Condition
TEST_PHC_QUEUE PHC_TEST_QUELE DELINQUENT EE
TEST_TIME_BAR TEST_TIME_BAR BANKRUPTCY i
DELQ_DAYS_0_15 DELQ_DAYS_LESS THAN 15 DELINQUENT
TEST_QUEUE_L TEST_QUELE PMT HOLD
g TEST_QUELE_2 TEST_QUELE 2 DELINQUENT
PMT_HOLD PMT_HOLD PMT HOLD
1039C_QUELE 1095C QUEUE 1095C SENT -

[ dlose

Queues

Origination ~ Customer Service | Call Action Results | User Groups

< 0

Queue Definition
[ saveand Add | [ 5ave andStay | [ Save andReturn | {3 Return

i * Company = * Near Real-Time ]
Name
i
* Queue Branch [=] ———
Desc * Hard .: al =l
‘_Accsum E| A.ss\gHEd . -

3-68 ORACLE



A brief description of the fields is given below:

Field:

Do this:

Queue Name

Specify queue name.

Queue Desc

Specify queue description.

Account Condition

Select account condition from the drop-down list.

Priority Specify the priority.
Company Select the company from the drop-down list.
Branch Select the branch from the drop-down list.

Hard Assigned

Check this box to assign an equal amount of accounts to each
individual user working on a that queue. Also, an account that is
hard assigned remains assigned to the individual who opens that
account until that person is longer working that queue.

Group Follow-up Ind

Check this box to enable the bank to indicate whether the
accounts belonging to the same customer have to be followed-up
in groups.

Near Real-Time

Check this box to select the queues for the near real time refresh.
You can specify the time interval and frequency to run this queue.
When a batch is run, it picks only customer service queues
marked as “Real Time” queues for re-assignment.

Dialer Extract

Check this box to indicate if the accounts satisfying the selection
criteria should be extracted from the batch process or not. If the
user is hard-assigned, then user gets identified by the dialer
system as ‘Permission to call” user. The extract will also have
data pertaining to customer time zone and privacy opt out
indicator.

Enabled

Check this box to activate the queue.

Perform any of the Basic Actions mentioned in Navigation chapter.

4. Click the Setup > Setup > Administration > User > Queues > Customer Service >

Selection Criteria.

5. In the Selection Criteria section, you can define the account selection criteria with the
following fields. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Seq Specify sequence numbers.

( Specify left bracket.

Parameter Select the parameter from the drop-down list.

Comparison Operator

Select comparison operator from the drop-down list.

Criteria Value

Specify criteria value.
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Field:

Do this:

)

Specify right bracket.

Logical Expression

Specify logical operator from the drop-down list.

Enabled

Check this box to enable the selection criteria.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

7. Click the Setup > Setup > Administration > User > Queues > Customer Service >

Sort.

8. Inthe Sort section, you can define the account selection criteria with the following fields.
Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Seq Specify sequence number.

AssAgpCode | Select sort field from the drop-down list.

Order Select sort order from the drop-down list.

9. Perform any of the Basic Actions mentioned in Navigation chapter.

10. Click Setup > Setup > Administration > User > Queues > Customer Service >
Responsibilities and Users.

11. In the Responsibilities section, you can define the responsibilities that are authorized to
work on the queue. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Responsibility

Select the responsibility from the drop-down list.

Enabled

Check this box to enable the responsibility.

12. Perform any of the Basic Actions mentioned in Navigation chapter.

13. In the Users section, you can define the users who are authorized to work on the queue.
Also, you can hard assign the queues to the user. Perform any of the Basic Operations
mentioned in Navigation chapter.

Note

The system allows the work queue list to be sorted by user-defined criteria.

A brief description of the fields is given below:

Field: Do this:
Name Select user name from the drop-down list.
# Assigned Specify number of accounts assigned.
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Field: Do this:

Hard Assigned Check this box to hard assign. (For more information, see the
following section in this chapter, Using the Hard Assigned
Feature).

Enabled Check this box to enable.

14. Perform any of the Basic Actions mentioned in Navigation chapter.

15. Click Setup > Setup > Administration > User > Queues > Customer Service > Data
Node Assignments. You can enable the administrator to configure the User interface
nodes that should be made available for the applications that are being processed in that
particular origination queue.

16. In the Data Node Assignments section, perform any of the Basic Operations mentioned
in Navigation chapter.

A brief description of the fields is given below::

Field: Do this:
Node Specify the node.
Enabled Check this box to enable the record.

17. Perform any of the Basic Actions mentioned in Navigation chapter.

18. Click Load Queue Nodes on the Node Assignments sub screen to display the respective
Ul nodes in the origination module.

19. Click Setup > Administration > User > Queues > Origination > Group Assignment.
In the Group Assignment sub tab, you can add user groups to Customer Servicing Queue
and also if required, you can un-assign users from the user group.

Note

Modification of user details (adding or disabling users) within a user group which is added
to Group Assignment will implicitly be updated in Responsibilities and Users tab also.

20. In the User Group section, Click Add. You can also perform any of the Basic Operations
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Group Name Select the user group name from the drop-down list. The list
displays the pre-defined user groups available in the system.

Enabled Check this box to enable the user group.

21. Perform any of the Basic Actions mentioned in Navigation chapter.

22. (Optional) Click 'Un-Assigned' button to un-assign all the users of the group in the queue.

Note the following:

e Ifthe queue is 'Hard Assigned', then it implies that all users in the user group(s) attached
to that queue are not 'Hard Assigned'. Hence all those Users should have to be explicitly
marked as hard assigned in the queue added through user group.
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e User added directly to the queue should be disabled manually. For common users
present at Queue and User Group, you need to manually maintain the data in sync.

e Following table indicates various combinations for enabling and disabling Users and
User Group(s) from Queue and User group(s).

Added | Added
Entity | in in User | Enabling and Disabling options
Queue | Groups

User Yes No User should be disabled /enabled only in that particular
Queue.
No Yes User should be disabled / enabled in all the Queues where

the user group is attached.

User Yes No User group should be disabled /enabled only in that
Group particular Queue.
No Yes User group should be disabled / enabled in all the Queues

where the user group is attached.

Group Follow-up

The system enables lending institution to conduct “one time only” follow-up activity on the
Customer Service screen, if the customer has multiple accounts in various conditions or in
various queues. This avoids unnecessary confusions that arise when more than one user is
performing collection tasks on multiple accounts belonging to the same customer.

You can follow-up on multiple accounts in the same condition at the same time using the
group follow-up functionality. The system locks the accounts in the low priority queues and
displays the same in the high priority queues. You can perform the follow-up activity on all the
accounts when the account in the high priority queue becomes due for follow-up.

For example,

Suppose a customer holds three accounts, one that’s 30 days delinquent and in the
0 30 DAYS DEL queue, one that's 60 days delinquent and in the 30 60 DAYS DEL queue
and one that’s 90 days delinquent and in the 90+ DAYS DEL.

a) If each of the queues Group Followup Ind is unchecked on the Customer Service screen,
then no group follow-up will be performed.

b) If each of the queues Group Followup Ind is checked on the Customer Service screen,
while updating the follow-up date for the low priority days queue, then the system will use the
90 days follow-up date

c) If the Group Followup Ind is checked on Customer Service screen for the 0 30 DAYS DEL
and 30_60 DAYS DEL queues and note the 90+ DAYS DEL queue, and the customer has
accounts in each of the queue, then the system will use the follow-up date of 60 days for the
low priority account.

Using the Hard Assigned feature

The system’s “Hard Assigned” queues feature allows companies to evenly distribute accounts
between users. The following example explains how it works:

Let's say there are 40 unassigned accounts in a queue. Three users are assigned to the
queue, Hard Assigned is checked for two.
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3.8.2

When you select Update Queue on the Customer Service screen (or Oracle Financial
Services Lending and Leasing processes the CUSTOMER SERVICE QUEUE PROCESSING
nightly batch) each of the two Hard Assigned users receives 20 accounts, while the one that
isn’t marked as Hard Assigned receives zero.

If users already have accounts assigned to them, the system attempts to balance the
workload when assigning new accounts. For example, let’'s say there are three users in a
queue. The first has 15 accounts, the second has ten and the third has five. If there are ten
new accounts, the system would give the third user the first 5 accounts, thus bringing that
user's total to ten. The system splits the next five between the second and third, bringing their
totals to 13 and 12, respectively.

Note

The system randomly assigns these accounts.

To set up a user as Hard Assigned feature

1. Click Setup > Setup > Administration > User > Queues > Customer Service >
Responsibilities and Users.

2. In the Responsibilities section, select the level responsibility of the users you want to
hard assign in the queue.

3. Inthe Users section, check the Hard Assigned check box for each user you want to hard
assign.

4. On Setup > Setup > Administration > User > Queues > Customer Service, click
Update Queue to distribute the applications in the queue to the hard assigned users.

The system displays an Information section with the message as “Queue creation
submitted in background”.

5. Choose OK beneath the Error Message section box containing the words NO ERROR.

The system distributes and hard assigns the accounts in the queue to the selected users
in the Users section.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

To remove a user
1. In the Responsibilities section, select the responsibility of the user you want to remove.

2. Inthe Users section, select the user you want to work with.

e Ifyou don’t want that user to be hard assigned any longer, uncheck the Hard Assigned
check box.

e If you don’t want that user to be assigned to that queue any longer, uncheck the
Enabled check box.

3. The system updates the number of accounts assigned to a user only after:
e Running the nightly batch job
e Clicking the Update Queue button.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Call Action Results tab

1. Click Setup > Setup > Administration > User > Queues > Call Action Results. The
screen contains two sections:

e Call Actions
e Call Results
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2. Inthe Call Actions section, perform any of the Basic Operations mentioned in Navigation

chapter.

You can either define new Call Action details or specify a new action code in the New
Action field and click Create Copy to create a copy of selected call action with details.

ORACLE’

Financial Services Lending and Leasing

> DashBoard
> Origination
 Servicing
»» Collections
 WFP
> Tools
Setup
Setup
Administration
System
System Parameter
Lookups
User Defined Tables
Audit Tables

Transaction Codes
Data Files

Dedupe
Securitization
Events

Batch Jobs
Producer Cydes

User Defined Defaults

Queues x [Hdose
Origination | Customer Service  Call Action Results  User Groups 2
Call Actions qpadd || SEdt | [Fview | o Audt
View v Format~ [Ep Freeze  fiDetach Vrap 8 New Action I3 Create Copy
Action Code Description Call Type Enabled
AT ATTORNEY /GENERAL TELEPHONED INCOMING CALL ¥ -
csB TELEPHONED COBUYER BUSINESS OUTGOING CALL ¥ £
. cc CUSTOMER CALLED OUTGOING CALL ¥
[ R CHARGE-OFF REQUEST SUBMITTED EXCLUDE FROM REPORTS ¥
E b DEALER CALLED INCOMING CALL ¥ -
4
Call Results qpadd || SEdt | [Fvew | o Audt
View v Formatw (5P Freeze 1 Detach ol Virap ot}
5 Right Person Followup Advance
Result Code Description Report Type P St Value Ensbled
o: CALLBACK OTHERS N DAY S L
HU HUNG LP OTHERS N DAY 3Y
NP NO PROMISE OTHERS N DAY 3Y |
PH PAYMENT IN HAND (STORE) PROMISETOPAY N DAY 3y i
PP PROMISE TO PAY PROMISETOPAY N DAY 3y
Ps PAYMENT SENT BY MALL FROMISETOPAY N DAY 3y
5 RC RETURN CALL OTHERS N DAY 3 -

A brief description of the fields is given below:

Field: Do this:

Action Code | Specify the action type code.

Description Specify the description for the call action type.
Call Type Select the call type from the drop-down list.
Enabled Check this box to enable the call action.

Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Call Results section, you can define call action result codes and corresponding
descriptions. Perform any of the Basic Operations mentioned in Navigation chapter.

5. A brief description of the fields is given below:

A brief description of the fields is given below:

Advance Unit

Field: Do this:

Result Code Specify the result type code for the specified call action type.
Description Specify the description for the result type.

Report Type Select the report type for the result type, from the drop-down list.
Right Person Check this box to indicate that result type is a right person contact.
Contact

Follow-up Select the unit for advancing the follow-up date/time from the drop-

down list.

Value

Specify the value for the follow-up advance unit.

Enabled

Check this box to enable the result.
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3.8.3

6. Perform any of the Basic Actions mentioned in Navigation chapter.

Queues are further filtered based on the following criteria:

e Conditions
e Responsibilities

The Conditions section determines whether the selected action/result will cause the listed
conditions to be opened or closed. It also determines whether the queue will be opened or
closed.

7. Inthe Conditions section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Condition Select the account condition to be open/close for the action from the
drop-down list.

Condition Select ‘Open’ to open the listed condition, ‘Close’ to open the listed
condition, or ‘NA’, if the condition is not applicable.

Queue Select ‘Open’ to open the listed Queue, ‘Close’ to open the Queue, or
‘NA, if the Queue is not applicable.

Enabled Check this box to enable the account condition.

8. Perform any of the Basic Actions mentioned in Navigation chapter.

9. Inthe Responsibilities section, define the responsibilities that are authorized to use the
call action result combination.Perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Responsibility Select the responsibility that can perform the action result from the
drop-down list.

Allowed Select 'Yes' if access is allowed.

Enabled Check this box to enable the responsibility.

10. Perform any of the Basic Actions mentioned in Navigation chapter.

User Groups Tab

The User Groups tab in Queues is a centralized repository which allows you to define user
groups, add and remove users from user groups.
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The User Groups tab consists of User Group Definition section listing the defined User
Groups and User section below listing the associated users of the selected User Group.
ORACLE \ -
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To define a User Group

1.

On the Oracle Financial Services Lending and Leasing home screen, click Setup >

Administration > User > Queues > User Groups.

In the User Groups section, Click Add. You can also perform any of the Basic Operations

mentioned in Navigation chapter.
A brief description of the fields is given below:

Field:

Do this:

Name

Specify user group name.

Description

Specify an appropriate user group description. The same is
used while referring this User Group on other screens.

Responsibility

Select the responsibility of the user group from the drop-down
list. You can later add only those ‘Users’ who have the selected
responsibility into the user group.

Enabled

Check this box to enable the user group.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

To add Users to User Group

1.

On the Oracle Financial Services Lending and Leasing home screen, click Setup >

Administration > User > Queues > User Groups.

In the User Groups section, select the required User Group.

In the Users section, Click Add. You can also perform any of the Basic Operations

mentioned in Navigation chapter.
A brief description of the fields is given below:

Field:

Do this:

Name

Select the user from the drop-down list, The list displays the
available users based on the responsibility defined for the user
group.

Enabled

Check this box to enable the user.
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3.9

4. Perform any of the Basic Actions mentioned in Navigation chapter.
Printers

The Printers screen allows you to set up an unlimited number of network printers and fax
devices to be used with the system server. The system uses the information on this screen
while selecting a printer, when the printing process involves a batch job or uses a job
scheduler. Examples include printing reports and correspondence.

The printers and fax devices can be set up at each organization, division, or department to
promote efficient printing of documents, and reports. The system uses this information during
product setup and on the Letters screen in the Batch Printer field.

Special printer names

The following printer names are predefined and have specific functions within the system:

Name Description

UNDEFINED Indicates that the document to be printed is to be previewed in your
browser instead of actually printing the document.

ARCHIVE Instead of sending an item to the printer, the system generates a
PDF document and saves it in the archive directory on your server.

EMAIL For Loan origination correspondences that can be faxed, the system
e-mails the document as a PDF attachment to the consumer for
direct Loans or to the producer in the case of in-direct Loans.

FAX For Loans origination correspondences that can be faxed, the sys-
tem generates a PDF document and will send to the fax server
defined in System Parameters.

Additionally, you may set up composite entries in the Printer Name field to perform two or
more functions at the same time. This can be done by defining a printer name with the
following format:

PRINTER NAME = <PRINTER NAME1> + <PRINTER NAME2>

For example, if a printer named JET4050 was previously defined, as were the special printer
names listed above, then the following additional printers could be defined:

Name Description

JET4050+ARCHIVE Prints the document with the jet4050 printer and archives the
document.

FAX+ARCHIVE Faxes and archives the document.

EMAIL+ARCHIVE+] | E-mails, archives, and prints the document with the jet4050
ET4050 printer.

To set up the Printers

1. Click Setup > Setup > Administration > User > Printers. The system displays the
Printers screen
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2. In the Printers section, perform any of the Basic Operations mentioned in Navigation
chapter.
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A brief description of the fields is given below:

Field: Do this:

Printer Name Specify the printer name. The name of the printer as defined by the
server. For a UNIX server, the name might be JET4050, while to
access the same printer from a Windows server the name would
be: \\servername\jet4050.

Description Specify the description for the printer.

Organization Select the organization to which the printer belongs, from the drop-
down list.

Division Select the division to which the printer belongs, from the drop-
down list. The division will be displayed based on the organization
selected.

3-78 ORACLE



Field: Do this:

Department Select the department to which the printer belongs, from the drop-
down list. The department will be displayed based on the division
selected.

IMPORTANT: When you select a printer to use, the system
searches for a best match using the following attributes:

1 Organization
2 Division
3 Department

Hence, Oracle recommends creating a version of each edit, where
ALL is the value in these fields.

It is also recommended that, you define a default printer for an
Organization, Division and Department.

Default Check this box to set the printer as a default printer.

Enabled Check this box to enable the printer and that the printer is active.

Note: Never disable the UNDEFINED printer.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.10 Bank Details

The Banks screen defines the banks, a company/branch uses for processing Automatic
Clearing House (ACH) and lock box payments.

Note

This is “behind the scenes” information that the system uses for payments and does not
appear on any other forms.

To set up the Banks

1. Click Setup > Setup > Administration > User > Bank Details link. The system displays
the Bank Details screen.
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2. In the Banks Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
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A brief description of the fields is given below:

Field: Do this:

Code Specify the bank code (ID used internally by Oracle Financial Ser-
vices Lending and Leasing to represent the bank).

Name Specify the name for the bank.

Short Name Specify the short name for the bank (ID displayed to represent the
bank. This may be included in any output files).

Enabled Check this box to enable and indicate this as an active bank

Account # Specify the account number used for banking transactions with the
bank.

Note: If the organizational parameter UIX HIDE RESTRICTED -
DATA is set to Y, this appears as a masked number; for example,
XXXXX1234.

Routing # Specify the routing number of the bank.

BIC Select the Business Identifier Code from the drop-down list. The list
displays the BIC codes defined in the system.
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Field:

Do this:

IBAN

Specify the IBAN (International Bank Account Number). IBAN is used
for identifying bank accounts across national borders with a minimal
of risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation based
on modulo 97. On save, system automatically validates the IBAN
number length based on country code, characters, white spaces, and
checksum. Validation is also done during posting non-monetary
transaction (ACH Maintenance).

You can maintain the IBAN length and other details required as per
the country code in the user defined table (Setup > Administration >
System > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT_NL) is defined by
default with length of IBAN as 18.

Country

Select the country where the bank is located, from the drop-down list.

City

Specify the city where the bank is located.

State

Select the state where the bank is located, from the drop-down list.

Address Line 1

Specify the address line 1 for the bank.

Address Line 2

Specify the address line 2 for the bank.

Zip Specify the zip code where the bank is located, from the drop-down
list.

Extn Specify the extension of the zip code where the bank is located.

Creditor Id Specify the creditor identification details.

Phone 1 Specify the primary phone number of the bank.

Extn 1 Specify the phone extension for the primary phone number.

Phone 2 Specify the alternate phone number for the bank.

Extn 2 Specify the phone extension for the alternate phone number.

Fax 1 Specify the primary fax number for the bank.

Fax 2 Specify the alternate fax number for the bank.

ACH Format Select the ACH format accepted by this bank from the drop-down list.

The list displays the following options:
- NACHA Format
- SEPA Format

Perform any of the Basic Actions mentioned in Navigation chapter.

Click Setup > Setup > Administration > User > Bank Details > ACH.

On the ACH Definition sub screen, you can create ACH files for the bank listed in the
Banks section. Perform any of the Basic Operations mentioned in Navigation chapter.
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A brief description of the fields is given below:

Field: Do this:
Company Select the portfolio company from the drop-down list.
Branch Select the portfolio branch from the drop-down list.

ACH Identifier Specify the lock box ID provided by the bank. This field is used in the
ACH files to identify the bank.

Enabled Check this box to enable the ACH and indicate this as an active ACH
identifier.

6. Perform any of the Basic Actions mentioned in Navigation chapter.
7. Click Setup > Setup > Administration > User > Bank Details > Lock Box.

8. Onthe Lock Box sub screen, you can create lock box files for the bank listed in the Banks
screen. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Lock Box Specify the lock box ID provided by bank. This field is used in the lock
Identifier box files to identify the bank.

Company Select the portfolio company from the drop-down list.

Branch Select the portfolio branch from the drop-down list.

Enabled Check this box to enable the lock box.

9. Perform any of the Basic Actions mentioned in Navigation chapter.

Standard Payees

The Standard Payees screen defines the third parties that are frequent payees for checks
issued within your organization. These payees are then available on the Consumer Lending
screen’s Advance Entry screen. When you select the Payee # in the Advance Allocation
section, the system completes the remaining fields in this screen with information from the
Standard Payees screen.

Note

The Payee # field on the Advance Payment forms is a non-validated field. This allows you
to select an entry or enter one of your own.

To set up the Standard Payees

1. Click Setup > Setup > Administration > User > Standard Payee. The system displays
the Standard Payees screen.
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2.

In the Payee Definition section, perform any of the Basic Operations mentioned in

Navigation chapter.
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A brief description of the fields is given below:

Field: Do this:

Payee # Specify the payee number (Identifier for the payee).

Name Specify the payee name.

Pmt Mode Select the payment method for the payee from the drop-down list.

Enabled Check this box to enabled the payee.

Country Select the country where the payee is located from the drop-down
list.

City Specify the city where the payee is located.

State Select the state where the payee is located from the drop-down list.

Address Line 1

Specify the address line 1 for the payee (optional).

Address Line 2

Specify the address line 2 for the payee (optional).

Zip Select the zip code where the payee is located from the drop-down
list.

Extn Specify the extension of the zip code where the payee is located.

Phone 1 Specify the primary phone number for the payee.

Phone 2 Specify the alternate phone number for the payee.

3-83

ORACLE



Field: Do this:

Bank Name Specify the payee ACH bank name used by the standard payee.

Routing # Specify the payee ACH bank routing number of bank used by the
standard payee.

Account Type Select the payee type of ACH bank account maintained by the Stan-
dard Payee from the drop-down list.

ACH Account# | Specify the payee ACH bank account number.

BIC Select the Business Identifier Code from the drop-down list. The list
displays the BIC codes defined in the system.

IBAN Specify the IBAN (International Bank Account Number). IBAN is used
for identifying bank accounts across national borders with a minimal
of risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation based
on modulo 97. On save, system automatically validates the IBAN
number length based on country code, characters, white spaces, and
checksum. Validation is also done during posting non-monetary
transaction (ACH Maintenance).

You can maintain the IBAN length and other details required as per
the country code in the user defined table (Setup > Administration >
System > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT_NL) is defined by
default with length of IBAN as 18.

Start Dt Specify the payment mode start date, the date the current payment
method was implemented (defaults on Pmt Mode change). you can
also select from the adjoining calendar icon.

Comment Specify a comment for this advance allocations. This is the default
comment to include with payments to this Payee.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.12 Check Details

The Check Details screen allows you to set up check details.

To setup the Check Details

1. Click Setup > Setup > Administration > User > Check Details. The system displays the
Check Details screen.

3-84 ORACLE



2. In the Check Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE’

Financial Services Lending and Leasing

g signout O

# Welcome, DEMOSUPR »  Accessibility

DashBoard
> Origination
» Servicing
» Collections
> WFP
> Tools

Setup
Setup
Administration

System
System Parameter
Lookups
User Defined Tables
Audit Tables
User Defined Defaults
Transaction Codes
Data Files
Dedupe
Securitization
Events
Batch Jabs
Producer Cycles
Vendors
Collection Cycles
Reports
Error Messages
Translations

User
Organization
Companies
Access
Users
Credit Bureau
Correspondence
General Ledger
Queues
Printers
Bark Details
Check Details
Standard Payees
Currencies
Zip Codes

Products
Asset Types

Check Details 3 Close
Check Definition Jadd | Ledt | B view | f v
View~ Fomat~ [ Freere i Detach Wirap o]
Company Branch Payee Type Check # Printer Name Enabled
0 N
AL AL CUSTOMER 112233 PRINT-11 ¥

Check Definition
& save and Add save and Stay || [ Save and Retum || C3Retum

= Company ALL v *Check = 0

*Branch ALL * Printer Name

L

* Payee Type ALL [v] * Enabled (]

A brief description of the fields is given below:

Field: Do this:

Company Select the company from the drop-down list.
Branch Select the branch from the drop-down list.
Payee Type Select the payee type from the drop-down list.
Check # Specify the check number (required).

Printer Name

Specify the printer name (required).

Enabled

Check this box to enable the check details entry.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.13 Currencies

The Currencies link allows you to set up currency details.

Navigating to currencies

1. Click Setup > Setup > Administration > User > Currencies. The system displays the
Currencies screen. In this screen, you can set up:

e  Currency Definition

e Currency Pair Definition
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3.13.1 Currency Definition

The Currency Definition screen allows you to set up currency details.
To set up the currency definition information

1. Click Setup > Setup > Administration > User > Currencies > Currency. The system
opens the Currency Definition tab by default.

2. Inthe Currency section, perform any of the Basic Operations mentioned in Navigation

ORACLE 2 Welcome, PRAKRRAO »  Accessibilty o
Financial Services Lending and Leasing
prren Close.
DashBoard CumeadIes ¥, 5
> Origination Currency  Currency Pair
> Servicing
> Collections Currency Fadd | Aedn | Bvew | A
> WEP View » Fomat~  [Ep Freeze  ff Detach 1l Wrap @
Currency Currency Name Country Enabled
> Tools .
Setup INR INDIAN RUPEE INDIA Y
Translations EUR EURO IRELAND Y
Lser B A »Y JAPANESE YEN JAPAN ¥
p - OMR RIAL SAUDL ARABIA Y
Organization = 2
s usD US DOLLAR UNITED STATES Y
Companies
Access
Users Currency
Credt Bureau saveandAdd || [ saveand stay | [ Save and Retun | (= Retum
Correspondence
General Ledger R v * Enabled (]
Queues
oz Currency Name
Bank Defails * Country ~]
Check Details
Standard Payees ‘
Currencies
Zip Codes
Products
Asset Types
Index: Rates

Currency Exchange
Scoring Parameters
Products

Pricings

Contract

Edits

Cydes

Scoring Models
Fees

Origination Fees
Compensation
Commission
Insurance
Checklists.
Stipulations
Spreads

Statement Messages
Letters

A brief description of the fields is given below:

Field: Do this:

Currency Select the currency you want to define, from the drop-down list.

Currency Name The system displays the currency name based on the currency

selected.

Country Select the country for which the currency is defined, from the drop-
down list.

Enabled Check this box to enable the currency entry.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.13.2 Currency Pair link

The Currency Pair Definition link allows you to set up currency pair details.

To set up the currency pair definition information:

1. Click Setup > Setup > Administration > User > Currencies > Currency Pair. The
system displays the Currency Pair Definition screen

3-86 ORACLE



2. Inthe Currency Pair Definition section, perform any of the Basic Operations mentioned
in Navigation chapter.

ORACLE ) ) 1 Welcome, PRAKRRAO + Accessibity =]
Financial Services Lending and Leasing
e currencies [ Gos=
» Origination Currency  Currency Pair
> Servicing
> Collections Currency Pair Fadd | A Edt | [ view | F audit
- WEP View » Fomatv [Ep Fresze i Detach I Wrap (5]
> Tools Cumency Cumency Pair Code Thiough Curency  T1T0Ush CUTEncy  ggpieq
Setup o o
Translations EURO RIAL OMANI N ¥
 Trensations ~ EURO vEN N ¥
user EURO US DOLLAR N ¥
I’:_)rgamzanar. YEN EURD N ¥
Lo YEN US DOLLAR N id
Reres RIAL OMANI EURO Y US DOLLAR Y
i YEN ¥ US DOLLAR ¥
Credit Bureau US DOLLAR N ¥
Camespondance T R v
General Ledger e i i
Queues US DOLLAR RIAL OMANI H i
et EURO: EURO N EURO N
Bank Details NDIAN RUPEE YEN N N
Check Details
Standard Payees 4 Currency Pair
‘Currencies
Zip Codes [l saveand 2dd | [ Save end Stny | [ Save and Retum | <3 Retum
Products
Asset Types * Currency [v] Through Currency Code [v]
Ixlex foas * Currency pair Code ~ =Enabled []
Currency Exchange
Scoring Parameters * Through Currency [
Products
Pricings
Contract
Edits
Cydes
Scoring Models
Fees
Origination Fees
Compensation
‘Commission
Insurance
Checklists.
Stipulations
Spreads
Statement Messages
Letters L
A brief description of the fields is given below:
Field: View this:
Currency Code Select the currency code from the drop-down list.

Currency Pair Code Select the currency pair code from the drop-down list.

Through Currency Check this box to set the selected currency as a through cur-
rency.
Through Currency Select the through currency code from the drop-down list.

Code

Enabled Check this box to enable the currency pair entry.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.14 Zip Codes

The Zip Codes screen allows you to set up zip code details.

To set up the zip codes information

1. Click Setup > Setup > Administration > User > ZipCodes. The system displays the Zip
Codes screen
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2. Inthe Zip Codes section, perform any of the Basic Operations mentioned in Navigation

chapter.

ORACLE’
Financial Services Lending and Leasing
DashBoard 2P CANE % (3 e
> Origination
— Zip Codes 4k add | Z Edit View | o7 Audit
> Servicing
8 View~ Formatv [ <] wrap
b Golietion Country State Zip city County
> WFP
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UNITED STATES  PUERTO RICO 00771 LAS PIEDRAS LAS PIEDRAS
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PR — UNITED STATES  PUERTO RICO 00780 FONCE PONCE
el UNITED STATES  PUERTO RICO 00782 COMERIO COMERIO
(e et ekl UNITED STATES  PUERTO RICO 00783 COROZAL coROZAL
e o UNITED STATES  PUERTO RICO 00784 GUAYAMA GUAYAMA
Data Files UNITED STATES PUERTO RICO 00785 GUAYAMA GUAYAMA
s UNITED STATES  PUERTO RICO 00786 LA PLATA AIBONITO
St UNITED STATES PUERTQ RICO 00791 HUMACAQ HUMACAQ
UNITED STATES PUERTO RICO 00792 HUMACAOD HUMACAO
Everts UNITED STATES  PUERTO RICO 00734 BARRANQUITAS  BARRANQUITAS
UNITED STATE PUERTO RICO 00795 JUANA DIAZ JUANA DIAZ
PR US VIRGIN ISLANDS 00801 CHARLOTTEAMA  SAINT THOMAS
Vendors US VIRGIN ISLANDS 00801 CHARLOTTE AMAL . SAINT THOMAS
Collection Gides US VIRGIN 1SLANDS 00801 ST THOMAS SAINT THOMAS
Regots UNITED STATES  US VIRGIN ISLANDS 00802 CHARLOTTEAMA  SAINT THOMAS
S Mo UNITED STATES  US VIRGIN ISLANDS 00802 CHARLOTTE AMAL .. SAINT THOMAS ¥/
Translations INTTEN STATES 1S \IDETN TS ANNE noan T THOMAS SATNT THOMAS
User
Organizston Zip Codes
o B seveand add | [ save and stay || [ save and Retum | 3 Betum
Users )
Credit Bursau *Country UNITED STATES [v] = Zipstat=cd [~
Correspondence “7p County
General Ledger i
Queuss &
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Check Detalls
Standard Payees
Currencies
Zip Codes
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< >

A brief description of the fields is given below::

Field:

View this:

Country

Select the country from the drop-down list.

State

Select the state from the drop-down list.

Zip Code

Specify the zip code (required).

City

Specify the city.

County

Specify the county.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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4.1

4. Product

Under the Setup master tab’s drop-down link bar, the product Setup link opens screens that
enable you to configure the basic business guidelines necessary to support one or more
products in the system. This includes defining the types of collateral your company supports,
creating lending instruments, and determining what is included in credit bureau reporting.
Setting up the Products screens requires a thorough understanding of the current rules of
your business and must be completed before you can use Oracle Financial Services Lending
and Leasing. The Products drop-down link opens screens to record data of all the products
supported by the system and contains the following links:

Navigating to Products

In the Setup > Setup > Products link enables you to setup the options related to following
closed ended products your company offers:

e Asset Types
e Index Rates
e Currency Exchange
e Scoring Parameters

e Products
e Pricing

e Contract
e Edits

e Cycles

e Scoring Models

e Fees

e Origination Fees

e Compensation

e Checklists

e Stipulations

e Spreads

e Statement Messages
e Letters

e Subvention

This chapter explains how to setup the screens associated with each one.

Asset Types

In Assets types you can setup the asset types that can serve as an application or account’s
collateral.

The information on the Assets screen is used by the system to automatically display the
appropriate collateral screen (Vehicle, Home, or Other) on the Application Entry screen.

The system recognizes the following four types of collateral:

Collateral Type Description

Home collateral Homes, manufactured housing, or any real estate collateral.
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Collateral Type Description

Vehicle collateral All vehicle types, such as cars, trucks, and motorcycles.

Household goods
and other collateral

All other collateral types not defined as home, vehicle, or
unsecured; for example, household items such as water heaters,
televisions, and vacuums.

Unsecured
collateral

All unsecured lending instruments. (This collateral type makes
the collateral tabs on the system forms unavailable.)

The Asset Sub Type section allows you to further categorize an asset; for example, the asset
type VEHICLE might be categorized as CAR, TRUCK, or VAN.

The Attributes/Addons and Makes and Models sub screens continue to further detail the asset
both in description and value. For example, a VEHICLE asset might include addons such as
LEATHER SEATS and CRUISE CONTROL.

Note

Neither asset types nor asset sub types can be deleted. As they may have been used in
the past, the display and processing of that data is still dependent on the existing setup.

To set up the Asset Types

You can either define new Asset Type or specify a new name in the New Asset Type field
and click Create Copy to create a copy of selected asset with details.

1. Click Setup > Setup > Products > Asset Types.

2. Inthe Asset Type section, perform any of the Basic Operations mentioned in Navigation

chapter.
ORACLE' APKELKAR ¥ Accesshilty [
Financial Services Lending and Leasing
> DashBoard AsscLTypesx [ R
P Asset Type dpadd | ZEdt || Eview | o2 Audit
e View v Formatv b Freere (i Detach B New AssetType Create Copy
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Producer Cydes
Vendors
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Reparts Asset Sub Type ok add | Ed Vew || 7 Audt
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Correspondence Asset Sub Type GEN_EQUIPMENT * Enabled [7]
General Ledger * Desaription GENERAL HOUSEHOLD GOODS / EQUIPY
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Bank Detalls Atributes / Addons  Makes and Models
Check Details
Standard Payees
Currencies Asset Attributes o add | P Edt o Audit
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A brief description of the fields is given below:

Field: Do this:
Asset Type Specify the asset type.
Description Specify the description for the asset. (This is the asset type which will

appear throughout the system).

Collateral Type Select the collateral type (the general category that the asset type
falls within) from the drop-down list.

Note: There is no need to define an asset for UNSECURED
COLLATERAL, as by definition there is no asset on such account.

Company Select the portfolio company to which the asset type belongs, from
the drop-down list. These are the companies within your organization
that can make Leases using this asset type. This may be ALL or a
specific company.

Branch Select the portfolio branch to which the asset type belongs, from the
drop-down list. This is the branch within the selected company that
can make Leases using this asset type. This may be ALL or a
specific branch. This must be ALL if in the Company field you
selected ALL.

IMPORTANT: By selecting which asset type to use, the system
searches for a best match using the following attributes:

1 Company
2 Branch

Hence, the system recommends creating one version of each asset
type where ALL is the value in these fields.

Enabled Check this box to enable the asset type and indicate that the asset
type is currently in use.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Inthe Asset Sub Type section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:
Asset Sub Type Specify the asset sub type.
Description Specify the description for the asset subtype

Asset Property Type | Select the type of property from the drop-down list.

Enabled Check this box to enable the asset sub type.

5. Perform any of the Basic Actions mentioned in Navigation chapter.
6. Click Setup > Setup > Products > Assets > Attributes/Addons.

7. Inthe Attributes/Addons section, perform any of the Basic Operations mentioned in
Navigation chapter.
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4.2

A brief description of the fields is given below:

Field: Do this:

Attribute/Addon Displays the asset attribute or addon name for the selected asset).

Description Select the description for the asset attribute/addon from the drop-
down list.

Default Specify the default text to be copied or displayed when the asset
attributes and addons fields are completed on an application for
this asset.

Value Specify the default monetary value to be copied or displayed when
the asset attributes and addons fields are completed on an
application for this asset.

Enabled Check this box to enable the asset attribute/Addon and indicate
that it is available for this type of asset.

8. Perform any of the Basic Actions mentioned in Navigation chapter.
9. Click the Setup > Setup > Products > Assets > Makes and Models.

10. In the Makes and Models section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Make Specify asset make.
Model Specify asset model.
Style Specify asset style type.

Model Year Specify asset model year.

Enabled Check this box to enable the asset make and model and indicate that it
is included on fields for this asset type.

11. Perform any of the Basic Actions mentioned in Navigation chapter.

Index Rates

The Index Rates screen maintains your organization’s history of periodic changes in index
rates. It allows you to define index rates to support variable rate lines of credit. The index rate
provides the base rate for a credit line where:

interest rate = index rate + margin rate.

The Index section displays the currently defined indexes on the Lookups screen. You may
create additional user-defined lookup codes for this lookup type as needed.

Note

You cannot tie an index rate to a product rate.
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You can also record any index rate change on the Index Rates screen. During nightly batch
processing, all the accounts with that index type are included when posting the RATE
CHANGE transaction. After the system processes the batch, the interest rate of the account
is changed. The system will use this new interest rate when computing all future interest
calculations.

To set up Index Rates
1. Click Setup > Setup > Products > Index Rates.

2. In the Index section, perform any of the Basic Operations mentioned in Navigation

ORACLE' ) ) ) | & Welcome, VAVAIDYA v  pccessibilty o
Financial Services Lending and Leasing
P Index Ratesx [ e
> Origination
Ak Index it | St | Evien | o mudit
—
L viewv Fomat [ [lFewe o dwe @)
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) WEP ]
- PRINERATE PRINERATE PRINERATE Y
7 Toals FLAT RATE FLATRATE FLAT RATE Y
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Setup Index
Administration A smeandadd | B saveand tey | [ Sove andRetum | Gapetum
> System
) User * IndeTpe v *Enaled
Products
st Tipes Short Description
Index Rates * Descripion
Curtency Exchange
;“‘ﬂ‘"ipa‘”'m”  Index Details Pl | At | Even | o it
roducts
Prcngs Viewv Fomat [ [[Freeze i Detach m @
Cortract Start Ot Rate Enabled
its Mo data o display.
Cycles
Scuing Models
Fees
Origination Fees
Compersation
Commission
Insurance
Checists
Stipuations
Spreads
Statement Messages
Letters
Promotions
Subvention
Escrow &
nen

3. A brief description of the fields is given below:

Field: Do this:

Index Type Select the type of index from the drop-down list.

Short Description Specify a short description of the index.

Description Specify the index description.

Enabled Check this box to activate the index type.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

The Index Details section allows you to define multiple index values using the Start Dt and
Rate fields.

Note

The history appears in descending order, with the most current record at the top.

5. In the Index Details section, perform any of the Basic Operations mentioned in
Navigation chapter.
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4.3

A brief description of the fields is given below:

Field: Do this:

Start Dt Specify the effective start date for the index rate. You can even select
the date from the adjoining Calendar icon.

Rate Specify the new index rate effective from above mentioned date as a
percentage.

Note: For the FLAT RATE index there should be only one entry with a
Start Dt. = 01/01/1900 and a RATE = 0.0000.

Enabled Check this box to activate the index rate effective from start date
mentioned above.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

Note

Variable rate functionality is not extended to pre-compute accounts.

Currency Exchange

The Currency Exchange screen maintains currency exchange rates. You can define the
currency exchange details and schedule a batch job (SET-IFP- ICEPRC_BJ 100 01 -
CURRENCY EXCHANGE RATE FILE UPLOAD) which in-turn pulls the currency exchange
rates from desired source at scheduled intervals through input file processing.

To set up the Currency Exchange
1. Click Setup > Setup > Products > Currency Exchange.

2. In the Currency Exchange Rates section, perform any of the Basic Operations
mentioned in Navigation chapter.

ORACLE’
Financial Services Lending and Leasing
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THEEsS 1 EUR usp 08/14/2012 06:12:42 AM 1.2360 ¥
tser PY EUR 08/14/2012 06:12:42 AM 0.0102 Y
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Check Details EUR P 12/24/2015 12:16:26 AM 45000 ¥
Standard Payees EUR »Y 12/24/2015 12:48:25 AM 3,000 ¥
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oo duip Codes Currency Exchange Rates
Asset Types [ 5aveandstay || [ saveandRetumn || GaRetun
Index Rates i
Currency Exchange Currency ELR Rate 0,0000
Seoring Parameters Currency Pair JPY *Enabled [
Products Effective Dtand Time  12/23/2015 05:50:43 AM
Pricings
Contract
Edits
Cydes
Scoring Models
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Origination Fees
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Comission
Insurance
Chedkists
Stipulations I
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4.4

A brief description of the fields is given below:

Field: Do this:

Currency Select the currency being exchanged from the drop-down
list.

Currency Pair Select the currency to be paired with from the drop-down list.

Effective Date and Time Specify date and time of the exchange rate. You can even
select the date from the adjoining Calendar icon.

Rate Specify the exchange rate (required).

Enabled Check this box to activate the currency exchange rate.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Scoring Parameters

With the Scoring Parameters, you can define the scoring parameters of a company'’s credit
scorecard and behavioral scoring.

While the system’s pricing scores apply to applications and are based on information
recorded during origination, behavioral scoring applies to accounts and is based on account
history attributes and performed on a monthly basis.

Behavioral scoring

Behavioral scoring examines the repayment trends during the life of the account and provides
a current analysis of the customer. This logical and systematic method identifies which
accounts are more likely to perform favorably versus accounts where poorer performance is
probable. This is useful when determining which other Lines of credit/loan products a
customer may qualify for. Behavioral scoring applies to all the three products: loans, lines of
credit and leases.

This information appears on the Customer Service form in the Account Details screen’s
Activities section.

Credit Scoring

Parameters define the factors that can be used when scoring an application during
underwriting and generating an initial decision on whether you wish to fund an amount. The
combination of the flexible definition of these parameters, along with the scoring set up on the
Scoring Models screen, allows you to automate much of the initial decision process in
underwriting accounts.

The Formula Definition section on the Scoring Parameters screen allows you to build a
mathematical expression to express the scoring parameter, test its validity, and locate specific
information with the resulting scoring parameters. The system calculates scoring parameters
using application data, credit bureau information, and applicant details.

To set up the Scoring Parameters

You can either define new Scoring Parameters or specify a new name in the New
Parameter field and click Create Copy to create a copy of selected parameter with details.

1. Click Setup > Setup > Products > Scoring Parameters.
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2. Inthe Parameters section, perform any of the Basic Operations mentioned in Navigation

chapter.
ORACLE'

Financial Services Lending and Leasing
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A brief description of the fields is given below:

Field:

Do this:

Parameter

Specify the name of the scoring parameter. The system
recommends entering a name that in some way reflects how the
parameter is used; for example, use FICO_SCORE instead of
PARAMETER 1.

Description

Specify a description of the parameter. Again, Specify a name that
reflects how the parameter is used; for example, use FICO SCORE
and WEIGHTED FICO SCORE instead of FICO SCORE NUMBER 1
and FICO SCORE NUMBER 2.

Data Type

Select the data type of the scoring parameter being defined from the
drop-down list. This determines how the system handles the values.
(While DATE and CHARACTER are available data types, generally
only NUMBER should be used when defining a scoring parameter.

Scoring Type

Select the scoring type from the drop-down list: CREDIT SCORING
or BEHAVIORAL SCORING.

Enabled

Check this box to enable and indicate that the scoring parameter is
available.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

The Formula Definition section allows you to define a mathematical expression of the
scoring parameter you want to define. The expression may consist of one or more sequenced
entries. All arithmetic rules apply to the formula definition. If errors exist in the formula
definition, the system displays an error message in this section when you choose Show

Expression.
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4.5

4. In the Formula Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Seq Specify the sequence number (the order in which the formula definition
variable will be assembled and evaluated).

( Specify a left bracket, if you need to group part of your formula definition.

Variable Select the variable from a validated field based on the user-defined table
SCR_CRED_SUMMARY: SCORING PARAMETERS, from the drop-down
list.

Constant Specify the constant value (optional).

Value

Mathematical | Select the math operator to be used on the adjacent formula definition

Operator rows, from the drop-down list.
) Specify a right bracket, if you are grouping part of your formula definition.
Enabled Check this box to enable the formula and indicate that it is included when

building a definition for the scoring parameter.

5. Perform any of the Basic Actions mentioned in Navigation chapter.
6. Inthe Parameters section, click Show Expression.

The mathematical expression appears in the Formula Expression section (in sequential order)
in the Expression field.

Products

The Product screen defines the closed ended products your organization offers. This screen
is enhanced to support Islamic along with the conventional.
A product is based on the following attributes:

e The collateral type and sub type
e The billing cycle
e Whether the amount is paid directly or indirectly to the customer

The Product Definition section records details about the product, such as the description,
collateral type and sub type, credit bureau reporting attributes, and billing cycle.

The Product ltemization section is used to define itemized entries for a product. This
information is used on the ltemization sub screens of the Application Entry and Application
screens.

To set up the Product

You can either define new Product details or specify a new product code in the New Product
field and click Create Copy to create a copy of selected product with details.

1. On the Oracle Financial Services Lending and Leasing home screen, Setup > Setup >
Administration > User > Products > Products > Lease.
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2. In the Product Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
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A brief description of the fields is given below:

Field:

Do this:

Product

Specify the product code as defined by your organization (in other
words, how you want to differentiate the products). For example,
products can be differentiated according to asset. The product code, or
name, is unique.

Description

Specify the description of the product. (This is the product description as
it appears throughout the system).

Start Dt

Specify the start date for the product. You can even select the date from
the adjoining Calendar icon.

End Dt

Specify the end date for the product. You can even select the date from
the adjoining Calendar icon.

Direct

Check this box, if you need the product to be originated directly to
customer. (In this case, the compliance state is the state listed in the
customer’s current mailing address.) If unchecked, the product is an
indirect lending product; that is, payment is made to the producer. (In this
case, the compliance state is the state listed in the producer’s address.)

Enabled

Check this box to activate the product.

Note: You can check this box only when Rate adjustment schedule is
maintained, i.e., All the products should be variable rate products

Collateral
Type

Select the collateral type for the product, from the drop-down list. This
field identifies what type of collateral is associated with the and assists
the system in identifying the correct screen(s) to display.
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Field: Do this:

Collateral Select the collateral sub type for the product, from the drop-down list.
Sub Type

Credit Select the credit bureau portfolio type for the product, from the drop-
Bureau down list.

Portfolio

Type*

Credit Select the account type for the product, from the drop-down list.
Bureau *Note: The Credit Bureau Portfolio Type and Credit Bureau Account
Account

Type fields determine how the portfolio is reported back to the credit

Type bureaus.

Billing Cycle | Select the billing cycle for the product, from the drop-down list.

Category Select the category as Standard for the conventional product and Islamic
for the Islamic product, from the drop-down list. This serves to group
products for reporting purposes.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

451 Product Itemizations

1. Click Setup > Setup > Administration > User > Products > Products > Lease >
Product Itemizations.

2. Inthe Product Itemization sub screen, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Itemization Select the itemization type for the product selected in product
definition section, from the drop-down list.

Discount Rate Specify the discount rate.
Sort Specify the sort order.
Sign Select +ve for a positive number and -ve for a negative number.

Note: The +ve and -ve buttons determine whether the values will
increase or decrease the itemization total for the product based on
the selected product. Together the contents of the Product
Itemization sub screen, positive and negative, add up to the
amount.

Enabled Check this box to indicate that this product itemization is currently
available.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.6 Pricing

The Pricing screen records pricing information related to your products. the system uses the
information in the Pricing Definition section to identify the correct pricing for an application,
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depending upon the product and the specific application parameters. the system will always
search for a unique match.

When you choose the Select Pricing while making a decision on the Underwriting window,
the system displays the best match and completes the Pricing and Approved sections under
Summary subtab. The information in the Approved section cite the minimum amounts for the
loan, though the user can edit these figures.

The system determines the best match by looking at all enabled pricing strings on the Pricing
screen that meet the following criteria:

e Exactly match the application values for the Promotion and Billing Cycle fields.

e Are less than or equal to the application values for the Term, Amount, Age, and Start
Date fields.

e Match either the application value or ALL for all other criteria.

Exact matches for each field are given a higher weight than matches of ALL. The returned
rows are then ranked based on the weighted values and the hierarchical position of the field
(see above). They are then ranked by start date. The system recognizes the first row returned
as the best match.

Note

— You should set up a default pricing for each billing cycle and pricing that the system
can select to ensure error-free performance. Oracle Financial Services Software
recommends creating a single version of each edit type, where ALL is the value in
the selection criteria fields listed above. If the system cannot find a pricing match, it
will display an error message.

— The system supports the bulk uploading of product pricing setup data. This allows
you to upload multiple setup data, avoid re-entering setup data, and more impor-
tantly, reduce data entry mistakes. The system currently supports uploading using
a fixed-length format only, where each data is at a pre-fixed position. You can run
batch jobs with the Set Code SET-BLK to upload pricing and GL data.

To set up the Pricing

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup >
Setup > Administration > User > Products > Pricings > Lease.
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2.
Navigation chapter

In the Pricing Definition section, perform any of the Basic Operations mentioned in
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A brief description of the fields is given below:

Field:

Do this:

Pricing*

Specify the code for the pricing.

Description*

Specify the description for the pricing.

* Together these two fields define the name of the pricing.

Start Dt

Specify the start date for this pricing. You can even select the
date from the adjoining Calendar icon.

End Dt

Specify the end date for this pricing. You can even select the
date from the adjoining Calendar icon.

Enabled

Check this box to enable the pricing.

Result section

Residual % From

Specify the minimum residual percentage valid with this
pricing.

Residual % To

Specify the maximum residual percentage applicable with this
pricing.

Rate From

Specify the minimum applicable rate.

Rate To

Specify the maximum applicable rate.

Buy Rate

Specify the buying rate.

Rent Factor From

Specify the minimum money factor valid with this pricing.
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Field:

Do this:

Rent Factor To

Specify the maximum money factor valid with this pricing.

Buy Rent Factor

Specify the ratio of buy rent factor.

Maximum Capital Cost

Specify the maximum capital cost valid for this pricing.

Maximum Term

Specify the maximum term financed for this pricing.

Selection Criteria

Select the portfolio company for this pricing, from the drop-

Company down list. This may be ALL or a specific company.

Branch Select the portfolio branch for this pricing. This may be ALL or
a specific branch. (This must be ALL if in the Company field
you selected ALL), from the drop-down list.

Billing Cycle Select the billing cycle for this pricing, from the drop-down list.

Product Select the product for this pricing, from the drop-down list.
This may be ALL or a specific product. The available values
come from a validated field based on the selected billing cycle
and the product setup.

State Select the state for this pricing, from the drop-down list. This
may be ALL or a specific state.

Pro Group Select the producer group for this pricing, from the drop-down
list. This may be ALL or a specific producer group.

Pro Type Select the producer type for this pricing, , from the drop-down

list. This may be ALL or a specific producer type.

Producer Region

Select the region of the producer.

Producer Territory

Select the territory of the producer.

Producer Select the producer from the drop-down list. This may be ALL
or a specific producer. The available values come from a
validated field based on the product group and product type.

Grade Select the credit grade for this pricing, from the drop-down list.
This may be ALL or a specific grade.

Capital Cost Specify the minimum capital cost which is valid for this pricing.

Lease Term Specify the minimum lease term for which this pricing is valid.

Asset Class Select the asset class from the drop-down list. This may be
ALL or a specific asset class. The available values come from
a validated field based on the collateral type. You may create
additional user-defined lookup codes for these lookup types
as needed.

Asset Type Select the asset type from the drop-down list. This may be

ALL or a specific asset type. The available values come from
a validated field based your assets setup.
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4.7

Field:

Do this:

SubType

Select the asset sub type from the drop-down list. This may be
ALL or a specific asset sub type. The available values come
from a validated field based your assets setup, and is linked to
the selected asset type.

Asset Make

Select the asset make from the drop-down list. The available
values come from a validated field based your assets setup
and is restricted based on the selected Asset Type and Asset
Sub Type. For example, If ALL was selected for either Asset
Type or Asset Sub Type, then ALL will be the only available
selection for the asset make.

Asset Model

Select the asset model from the drop-down list. The available
values come from a validated field based your assets setup,
and is restricted based on the selected Asset Type and Asset
Sub Type. If ALL was selected for either Asset Type or Asset
Sub Type, then ALL will be the only available selection for the
asset model.

Age

Specify the asset age (the minimum age for the selected
pricing).

Note: If your entry in this field is based on the number of years
of age of the asset and not the actual year of make, you must
update this entry annually to ensure that the proper pricing is
available.

Trade-In

Specify if there is a trade in of an asset by selecting Yes/No.

Mileage

If there is a Trade-In of an existing asset, then specify its
mileage in km.

Currency

Select the currency for this pricing, from the drop-down list.

Subvention

Select the subvention plan from the drop-down list, if pricing is
specific for any subvention plan.

Down Pmt

Specify the down payment for the pricing.

Asset Value

Specify the asset value.

LTV

Specify the loan to value ratio.

Selection Criteria : Business - allows you to indicate the age of business by
evaluating the total number of years elapsed.

Years In Business

Specify the total number of years in business.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Contract

The Contract screen allows you to define the instruments used within your system. A

instrument is a contract used by a financial organization with specific rules tied to it. When
processing an application, an instrument associated with the application informs the system
of the type of contract being used for the approved loan. This ensures that all parameters tied
to the instrument are setup for the account as it is booked - without requiring you to do it.
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Instruments can be setup at different levels:
e Company
e Branch
e Product
e Application state
e Currency

The following groups of parameters are setup at the instrument level (Each has its own
section on the Contract screen):

e Accrual

e Rebate

e Scheduled dues

e Billing

e Delinquency

e [Extension

e Advance details

e Rate cap and adjustments
e Payment caps

e Other

Items defined in the contract are “locked in” when you choose Select Instrument on the
Funding form’s Contract link.

The Contract screen’s Instrument and Description fields allow you to enter the financial
instrument’s name and description, for example; INS-LOAN: VEHICLE.

To set up the Contract

You can either define new Contract Definition details or specify a new name in the New
Instrument field and click Create Copy to create a copy of selected contract with details.

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > Products > Contract > Lease
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2. On the Contract Definition section, perform any of the Basic Operations mentioned in

Navigation chapter.
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A brief description of the fields is given below:

Field:

Do this:

Contract Definition section

Instrument

Specify the code identifying the instrument.

Description

Specify the description of the instrument being defined.

Start Dt

Specify the start date for the instrument. You can even select the
date from the adjoining Calendar icon.

End Dt

Specify the end date for the instrument. You can even select the
date from the adjoining Calendar icon

Enabled

If you check this box, the system will consider this contract definition
when selecting a instrument for an application.

Note: Once the field is enabled load balances button in balances
sub tab will be disabled

Selection Criteria

section

Company Select the company for the instrument from the drop-down list. This
may be ALL or a specific company.
Branch Select the branch within the company for the instrument from the

drop-down list. This may be ALL or a specific branch. This must be
ALL, if you have selected ‘ALL’ in the Company field.

Billing Cycle

Select the billing cycle selected from the drop-down list.

4-17

ORACLE




Field:

Do this:

Product Select the product for the instrument from the drop-down list. This
may be ALL or a specific product.

State Select the state in which the instrument is used from the drop-down
list. This may be ALL or a specific state.

Currency Select the currency for the instrument from the drop-down list.
IMPORTANT: By selecting which type to use, the system searches
for a best match using the following attributes:

1. Billing Cycle

2. Start Date

3. Company

4. Branch

5. Product

6. State

Hence, Oracle Financial Services Software recommends creating
one version of each type, where ALL is the value in these fields.

Pricing Select the pricing in which the instrument is used from the drop-

down list. This may be ALL or a specific pricing.

Lease Contract section

Lease Type

Select the lease type from the drop-down list.

Rent Accrual

Select the accrual calculation method for rent from the drop-down

Method list.

Tax Book Type ﬁsetlect the lease tax book type for depreciation from the drop-down
Depreciation Select the depreciation method for calculation from the drop-down
Method list.

Depreciation Select the first/last year depreciation convention method to be used
Convention for calculation from the drop-down list.

Scheduled Dues section

Max Due Day
Change Days

Specify the maximum number of days a due date can be moved.

Due Day Min Specify the minimum value allowed for the due day for this
instrument.
Due Day Max Specify the maximum value allowed for the due day for this

instrument.

Note: If billing cycle is selected as weekly, then Due Day Max field
value cannot be greater than 7.
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Field:

Do this:

Max Due Day Specify the maximum number of due day changes allowed within a
Change / Year given year for this instrument.

Max Due Day Specify the maximum number of due day changes allowed over the
Change / Life life of a product funded with this instrument.

Billing section

Billing Type Select the billing type for accounts funded using this instrument from
the drop-down list.

Billing Method Select the billing method for accounts funded using this instrument
from the drop-down list.

Prebill Days Specify the prebill days. This is the number of days, before the first
payment due, that accounts funded with this instrument will be billed
for the first payment. Thereafter, the accounts will be billed on the
same day every month. If an account has a first payment date of 10/
25/2003 and Pre Bill Days is 21, then the account will bill on 10/04/
2003, and then bill on the 4th of every month.

Default Pmt Select the default payment spread from the drop-down list.

Spread

Delinquency sect

ion

Late Charge

Specify the number of grace days allowed for the payment of a due

Grace Days date before a late charge is assessed on the account.
Stop Accrual Specify the number of days a contract can be in delinquent state,
Days after which the interest accrual must stop for an account.

A Batch Job is run daily to select accounts in delinquent status for a
pre-defined number of days and post ‘No Accrual transaction’ for
such accounts on current date. When the account recovers from
Delinquency, the system will then post a ‘Start Accrual Transaction’
on the date the account is recovered from delinquency.

Delq Grace Days

Specify the number of grace days allowed for the payment of a due
date before an account is considered delinquent. This affects DELQ
Queues, the system reporting, and the generation of collection
letters.

Time Bar Years

Specify the total number of years allowed to contact the customer
starting from the first payment date and beyond which the account is
considered delinquent. You can specify any value between 0-999.

Delq Category

Select the delinquency category method to determine how the

Method system populates delinquency counters on the Customer Service
form.
Note: This value does not affect credit bureau reporting.

Tax section

Sales Tax Mode

Select the sales tax mode from the drop-down list.
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Field:

Do this:

Sales Tax
Method

Select the sales tax method from the drop-down list.

Other section

Lease Type

Select lease type from the drop-down list.

Refund Allowed

Check this box to indicate that refunding of customer over payments
are allowed.

Refund
Tolerance Amt

Specify the refund tolerance amount. If the amount owed to the
customer is greater than the refund tolerance, the over payment
amount will be refunded if Refund Allowed box is selected.

Pmt Tolerance
Amt*

Specify the payment tolerance amount. This is the threshold amount
that must be achieved before a due amount is considered PAID or
DELINQUENT. If (Payment Received + Pmt Tolerance: $Value) >=
Standard Monthly Payment, the Due Date will be considered as
satisfied in terms of delinquency. The amount unpaid is still owed.

Pmt Tolerance%*

Specify the payment tolerance percentage. This is the threshold
percentage that must be achieved before a due amount is
considered PAID or DELINQUENT. If Payment Received >=
(Standard Monthly Payment * Pmt Tolerance% / 100), the due date
will be considered satisfied in terms of delinquency. The amount
unpaid is still owed.

The system uses the greater of these two values.

Promise
Tolerance Amt*

Specify the promise tolerance amount. This is the threshold amount
that must be achieved before a due amount is considered KEPT or
BROKEN. If (Payment Received + Promise Tolerance: $Value) >=
Promise Amount, the Due Date will be considered KEPT (satisfied).

Promise
Tolerance %*

Specify the promise tolerance percentage. This is the threshold
percentage that must be achieved before a due amount is
considered KEPT or BROKEN. If Payment Received >= (Promised
Amt * Promise Tolerance%), the due date will be considered KEPT
(satisfied).

The system uses the greater of these two values.

Write Off
Tolerance Amt

Specify the write off tolerance amount. If the remaining outstanding
receivables for accounts funded using this instrument is less or
equal to the write off tolerance amount, the remaining balance on
the account will be waived.

Int Amortization
Freq

Select interest amortization frequency from the drop-down list.

Repmt Currency

Select the designated repayment currency for this contract from the
drop-down list.

PDC Security
Check

Check this box to indicate that post dated checks are the method of
repayment for this contract.
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Field: Do this:

ACH Fee Check this box to indicate that direct debit fee is included.

Note: The ACH Fee/Direct Debit Fee balance will be displayed in
Balances sub tab only when this checkbox is selected.

Stmt Preference | Select the account statement preference mode from the drop-down
Mode list.

The selected preference will be propagated to Application > Contract
screen when the instrument is loaded.

Recourse Check this box if recourse is allowed. This indicates whether the
unpaid balance may be collected from the producer if the consumer
fails to perform on the lease.

Max Recourse% | Specify the maximum percentage of the outstanding receivables that
may be collected from the producer if the Recourse Allowed box was
selected.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Extension of Terms

The system facilitates extension of terms, provided the following conditions are satisfied:

e Specified number or more payments made in the account

e Gap between the previous and current extension provided in the account must be a
specific number of months that could be specified

If the above conditions are not satisfied, then the system displays an appropriate error
message.

A new transaction Force Extension will be available. This transaction will be posted when you
want the system to bypass the extension validations defined at the contract level.

When a backdated transaction with TXN Date exists before the transaction date of extension,
all the transactions are reversed and posted again. If extension transaction is posted again,
then the validation rules are not validated again.

Staged Funding

Staged funding for closed-end loans allows you to disburse funds to customers through
multiple advances or draws up to the approved amount within a specified “draw period.”

To create a multiple disbursement contract for a transaction

1. In the Contract Definition section, click Add and complete the fields following the
instructions above, making sure to complete the following steps:

e Inthe Advance Details section, select the Multiple Disbursement Permitted check box.
When you select a contract instrument that permits staged funding (multiple
disbursements) on the Funding screen, the system copies the information for that
instrument from the Setup Module screen’s Contract screen to the Funding screen’s
Contract screen.
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Note

You cannot clear the Multi Disbursement Allowed box in the Advance section on the Con-
tract screen.

e Complete the fields in the Advance Details section to define the limits for initial and
subsequent advances for staged funding.

Note

This information appears in the Advance section of the Funding screen’s Contract link.

N

If you choose, set the following APPLICATION CONTRACT EDITS as an ERROR or
WARNING on the Setup Module screen’s Edits screen.

Note

For more information, see the Edits link (Edits screen) section in this chapter.

1. REQUIRED: ADV DRAW END DATE
2. XVL: ADV DRAW END DT MUST BE AFTER CONTRACT DT
3. XVL: ADV DRAW END DT MUST BE LESS THAN FIRST PMT DT - PREBILL DAYS

These edits appear on the Funding screen’s Verification screen.

Repayment scheduling for staged funding

When funding a loan, the system computes repayment schedules from the contract date,
irrespective of whether funds have been disbursed or not. The system uses the approved
amount (amount financed) for computing repayment schedules on the contract date.

As the might have been disbursed through multiple draws, or the draws have been less than
the approved amount, or the amount may have been repaid in some amount before the draw
end date, you may need to change the payment amount. In such cases, you can manually
change the payment in the system by posting the monetary transaction CHANGE PAYMENT
AMOUNT on the Customer Service screen’s Maintenance link.

Disbursements for staged funding

The approved amount for staged funding can be disbursed with the Funding screen or at a
later time using the Advances screen. If the first disbursement is requested during funding,
you may enter it on the Itemization sub screen of the Funding screen’s Contract screen.

If the entire approved amount is not disbursed during initial funding, it can be disbursed using
the Advances screen’s Advance Entry screen.

If the initial amount on the Advance Entry screen is not within the minimum or maximum limits
(as entered in the Advance Details section on the Setup Module screen’s Contract screen),
the system displays any of the following error or warning messages in the Advances section’s
Error Reason field:

e ADVANCE AMOUNT IS LESS THAN THE INITIAL ADVANCE AMOUNT MINIMUM
_or-
e ADVANCE AMOUNT IS MORE THAN THE INITIAL ADVANCE AMOUNT MAXIMUM
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The Advance Entry screen also allows you to enter subsequent funding / disbursements. If
subsequent advances are not within the predetermined minimum or maximum amounts, the
system displays any of the following warning or error messages in the Advances section’s
Error Reason field:

e ADVANCE AMOUNT IS LESS THAN THE ALLOWED SUBSEQUENT ADVANCE
AMOUNT

_O r_

e ADVANCE AMOUNT IS MORE THAN THE ALLOWED SUBSEQUENT ADVANCE
AMOUNT

Additional messages in the Error Field regarding Staged Funding

If you attempt to post an advance after the draw end date, then the system displays the
message in the Advances section’s Error Reason field as, "ADVANCE DT IS AFTER DRAW
PERIOD END DATE".

If you attempt to post an advance above the approved amounts, including tolerance, the
system displays the message in the Advances section’s Error Reason field as "ADVANCE
AMOUNT IS MORE THAN THE TOTAL APPROVED AMOUNT INCLUDING TOLERANCE".

Since this is not a revolving loan, if any repayment is made against the approved amount
principal balance, the system will not adjust the disbursed amount allowing for subsequent
additional staged funding or advances.

Note

There is no change to the payoff quote functionality in the system. The system uses the
actual amount of the advance(s) and any interest accrued since the date of the last pay-
ment or credit in the PAYOFF QUOTE VALID UPTO DATE value when the payoff quote is
requested before the draw end date.

Balances

The Balances sub screen lists the balances that will be established when an account is
booked and funded.

CAUTION: Please contact your Implementation Manager for changes to this section.

To set up the Balances

1. Click Setup > Setup > Administration > User > Products > Contract > Lease >
Balances.

2. On the Balances sub screen, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:
Balance Type Displays the balance type.
Chargeoff Method Select the charge off method to determine how the outstanding

amount of this balance type will be handled from the drop-down
list, if the account becomes uncollectable and the product is
charged off.
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Field: Do this:

Writeoff Method Select the write off method to determine how the outstanding
amount of this balance type will be handled from the drop-down
list, if the account is within the write off tolerance of being PAID.

Reschedule Method | Select the reschedule method to determine how the outstanding
amount of this balance type will be handled from the drop-down
list, if the account is rescheduled.

Sort Specify the sort order of how account balances will appear on the
Customer Service form’s Balance screen.

Billed Check this box to indicate that outstanding amounts for this
balance type are considered a part of the billed amount. This also
determines whether payments applied to this balance type are
considered when satisfying outstanding amounts due.

Accrued Check this box to indicate that outstanding amounts for this
balance type will be included when interest is accrued against the
account.

Non Performing Check this box to indicate that “non-performing” is used as an

Rollover intermediary status on your general ledger prior to charge off and

want to create balances for non-performing accounts for this
balance type.

Note: (The Non-Performing Rollover box applies only to Balance
Types of ADVANCE/PRINCIPAL and INTEREST. For all other
Balance Types, this box would be cleared).

Non Performing Select the balance type you want to rollover from drop-down list,

Balance Type if you select the Non-Performing Rollover box (Advance/
Principal).

Enabled Check this box to indicate that this balance type will be created

when the account is booked and funded

3. Perform any of the Basic Actions mentioned in Navigation chapter.
The system loads the currently defined balances for accounts.

If your organization maintains additional balances, contact your Implementation
Manager for information regarding those balances.

Amortized Balances

With the Amortize Balances sub screen, you can select one or more balances to be amortized
over the life of the loan. You can also define the amortization method.
To set up the Amortization Balances

1. Click Setup > Setup > Administration > User > Products > Contract > Lease >
Amortized Balances.

2. In the Amortization Balances section, perform any of the Basic Operations mentioned in
Navigation chapter.
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A brief description of the fields is given below:

Field: Do this:

Amortize Balance Type Select the amortize transaction type from the drop-down
list.

Amortization Method Select the amortization method used to calculate the net
amortization amount from the drop-down list.

Cost/Fee method Select the amortization cost/fee method.

Sort Specify the sort sequence to define the order of the
amortize balances.

Enabled Check this box to enable the amortize balance to be created
when the account is booked and funded.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
Itemizations

On the ltemizations sub screen, you can define the itemized components for each type of
contract, indicate if it is required, and determine whether it has a positive or negative bearing
on the contract itemization math. You can establish the following groups of itemization
transactions:

Advance Total amount of the product that is not a part of financed fees; in other
words, the total amount the customer requested to be advanced.

Financed Fees rolled into the principal balance of the product. Financed fees are
Fees also considered to be a part of the finance charge.

Pre-Paid Fees that are paid by the consumer prior to the funding of the loan.
Fees These fees are not rolled into the balance of the product but are

considered as part of the finance charge and are included in the
calculation of the APR.

Producer Fees that are paid to or by the producer of the loan; for example, a fee
that is being charged to the producer. These transactions will affect
proceeds.

Escrow Allows you to connect the actual escrow itemization with the escrow type

and the funding transaction.

To set up the Itemizations

1. Click Setup > Setup > Administration > User > Products > Contract > Lease >
Itemizations.

2. On the Itemization sub screen select the option button to indicate the type of itemization
you are working with: Advance, Financed Fees, Pre-Paid Fees, Producer, or Escrow.

3. On the Itemization sub screen, perform any of the Basic Operations mentioned in
Navigation chapter.
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A brief description of the fields is given below:

Field: Do this:

Itemization Select the itemization from the drop-down list.
Disbursement Select the disbursement type from the drop-down list.
Type

Transaction Select the funding transaction type from the drop-down list.

Itemization Type | Select the itemization type from the drop-down list.
Notes:

1. On selecting the "Prefunding Txns" as itemization type, it
indicates that this particular itemization expects a payment from the
customer prior to funding.

2. The itemization type "Prefunding Txns" is available only for loans.

Sort Specify the sort order to define the order of the itemization
transactions.

Sign If the itemized transaction increases the group balance, click +ve.
-Or-

If the itemized transaction decreases the group balance, click -ve.

Enabled Check this box to enable the itemization and indicate that this
itemization transaction will be created when the account is booked
and funded.

Amortize Select the amortize balance affected by this itemization transaction

Balance from the drop-down list. Note: Advance itemizations do not affect

amortize balances.

Refund Select the refund calculation method from the drop-down list
Calculation

Method

Taxable Check this box, if the itemization type is taxable.

Seller Pmt Check this box to enable seller payment

Escrow Select the escrow from the drop-down list.

Itemization Select the itemization formula description from the drop-down list.
Formula

Refund Check this box to enable Refund calculation Method.
Calculation

Method

Escrow If this is an escrow account, check this box to indicate that an
Required escrow is required during the application process (though at that

time the user can choose Opt Out to decline.)

Discount. Rate Specify the discount rate for the itemization.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
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Fees

Any fees that are defined in the contract are set up on the Fees sub screen. The system
currently supports the following contract fees:

e Late charges

e Non sufficient funds

e Extensions

e Prepayment penalties
e Delay Fee

e ACH Fee

The Fees sub screen allows you to define those fees whose value and method of calculation
are set at the time of the loan. As these amounts cannot be changed after the product is
booked and funded, you should only set up fees here that will not change over the life of the
loan. Individual contract fee types may be defined multiple times in order to create graduated
fees.

Note

Certain fees, like late fees, can be set up at contract, as well as state level. In such cases,
the contract fee, if present, is used first.

To set up the Fees
1. Click Setup > Setup > Administration > User > Products > Contract > Lease > Fees.

2. Inthe Fees section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Type Select the fee type from the drop-down list.

Txn Amt From Specify the lowest transaction amount or balance amount against
which this contract fee definition may be applied.

Gross Specify the minimum value of gross capitalization cost.

Capitalized

Cost From

Method Select the method of calculating the fee to be assessed from the drop-
down list.

Frequency Select the frequency of calculating the fee to be assessed from the

drop-down list.

Min Amt Specify the minimum fee amount to be assessed.

Max Amt Specify the maximum fee amount to be assessed. If you selected
FLAT in the Method field, then this field is not used and is normally
populated as $0.00.

Percent Specify the fee percentage of the outstanding transaction amount to
be assessed as a fee. This amount will be adjusted to fall within the
Min Amount and the Max Amount.
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Field: Do this:

Enabled Check this box to create the selected contract fee when the account is
booked and funded.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
Edits

Edits ensure your organization’s guidelines are properly followed and that all exceptions are
sent to the appropriate personnel to review.

You can configure your system so that during the origination process, at each change to an
application’s status, the system will perform a set of edits on the Verification link’s Edits screen
(found on the Application Entry, Underwriting, and Funding windows).

Edits ensure your organization’s guidelines are properly followed and that all exceptions are
sent to the appropriate personnel to review. If the edits check fails, then the system will not
allow the change of status, and the application will remain in its current status. This screen
allows you to define the validations the system must perform on the Verification master tab,
as the status of application changes.

Origination edits are used to validate applications entered through the standard Application
Entry and Applications windows. The Edits screen contains two sections, the Edit Type
Definition section and the Edit Sub Type Definition section.

To set up the Edits

You can either define new Edit Type Definition details or specify a new name in the New Edit
Type field and click Create Copy to create a copy of selected edit type definition with details.

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Edits > Lease.

2. On the Edits screen, choose Origination or Open Interface.
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3. Inthe Edit Type Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
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A brief description of the fields is given below:

Field:

Do this:

Edit

Specify the edit name.

Description

Specify the description for the edit.

Edit Type

Select the edit type code from the drop-down list.

System Defined

Select ‘Yes/, if the entry is system defined. System defined entries
cannot be modified. Select ‘No’, if the entry is not system defined
and it can be modified.

Enabled

Check this box to enable the edit.

Company

Select the portfolio company associated with this edit, from the
drop-down list. This may be ALL or a specific company.

Branch

Select the portfolio branch within the company associated with this
edit, from the drop-down list. This may be ALL or a specific
branch. This must be ALL if you selected ALL in the Company
field.

Channel

Select the channel from the drop-down list, This can be ALL or a
specific channel.

Product

Select the product associated with this edit, from the drop-down
list. This may be ALL or a specific product.

State

Select the state with this edit from the drop-down list. This may be
ALL or a specific product.
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Field:

Do this:

Currency

Select the currency associated with this edit, from the drop-down
list. This may be ALL or a specific branch.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. In the Edit Sub Type Definition section, perform any of the Basic Operations mentioned
in Navigation chapter.

A brief description of the fields is given below:

Responsibility

Field: Do this:

Edit Sub Type Select the edit sub type for the edit, from the drop-down list.

Edit Select the description for the edit, from the drop-down list.

Result Select the result type for the edit, from the drop-down list.

Enabled Check this box to enable the edit.

Value Specify the expected value for the first edit. The Value field records
the threshold value for the edit. The actual function of the entered
value is dependent on the edit category.

Override Select the responsibility that can override the edit, from the

drop-down list, if the edit result is an override. Designates the
user responsibility level required to continue processing
applications that fail the edit based on the Value field. You
may define the same edit multiple times with a Result =
OVERRIDE and different Value and Override Responsibility
combinations to encompass various results.

System Defined

Select ‘Yes, if the entry is system defined. System defined entries
cannot be modified. Select ‘No’, if the entry is not system defined
and it can be modified.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

Using the Edit Type field of the Edit Type Definition section, you can define when you want
the edits check to occur by selecting from the following list of edit types:

Edit type: Description:

APP ENTRY Edits that normally run on Application Entry form.

EDITS

APP Edits that run between application entry and the pulling of a

PRESCREENIN credit bureau. These edits determine whether the application

G EDITS should be reviewed further, and whether a credit bureau should
be pulled.

PRE Qualify Edits that run to check whether the minimum details which are

Edits required to prequalify the application are satisfied or not.
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Edit type: Description:

APP Edits that run after a credit bureau has been pulled and scored.

AUTOMATIC These edits determine whether an application should be

APPROVAL automatically approved or declined.

EDITS

APP Edits that run whenever an application is manually

APPROVAL changed to a status/sub status that indicates the application (in

EDITS its current state) should be approved.

APP DECLINE Edits that run whenever an application is manually changed to

EDITS a status/sub status that indicates the application (in its current
state) should be declined.

APP Edits that run whenever an APPROVED or CONDITIONED-

CONTRACT APPROVED application is about to be funded. These edits

EDITS ensure the validity of the contract data.

Each entry in the Edit Sub Type field is grouped into the following categories:

Origination edit I

. Description
sub types:
ORIGINATION Edits that pertain to data entered for an applicant on an
APPLICANT EDITS | application.
ORIGINATION Edits that pertain to data entered for the requested loan.
APPLICATION
EDITS
ORIGINATION Edits that pertain to data entered for asset entered on the
ASSET EDITS application.
ORIGINATION Edits that pertain to data entered for the contract on the
CONTRACT EDITS | application.
ORIGINATION Edits that pertain to data gathered from the credit bureau
CREDIT BUREAU reports for the applicants on the application.
EDITS
ORIGINATION Edits that pertain to data required to make a decision on
DECISION EDITS the application.

Each entry in the Edit Sub Type field can be set up with more than one entry in the Description

field. The purpose of specific edits fall into the following types:

Description . N . .

starts with: (Edit Category) Description of Edit Category:

CHD: (RECORD POPULATION EDITS) Check for the existence
of an entire data record.

DUPLICATE: (DUPLICATION EDITS) Check for duplication of existing
data.
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Description

starts with: (Edit Category) Description of Edit Category:

RANGE: (VALUE RANGE/TOLERANCE EDITS) Check to determine
whether data entered for a specific data field is within the
specific tolerance.

REQUIRED: (REQUIRED FIELD EDITS) Check to determine whether a
specific data field has been populated within a data
record.

FLK: (LOOKUP VALUE EDIT) Check API entered data against
the existence of that value in the related lookup types
lookup codes.

XVL: (CROSS VALIDATION EDIT) Check to determine whether
specific field, or set of fields, value corresponds to a value
obtained by calculating them from another field or set of
fields (for example, Total Payments = Terms * Standard
payment amount).

An Edits check can produce one of three results: an ERROR, a WARNING, or an OVERRIDE.

Edit type: Results:

ERROR The system will prevent you from proceeding when an edits
check fails. The only option is to change the source data. The
application will revert to its previous status/sub status. The user
will be directed to correct the specific error. Until the edits that
return an ERROR value are addressed, the user cannot
continue processing the application.

Warning When an edits check fails in these cases, the system allows the
process to continue. Warnings serve as informational messages
and can be ignored. The user will be notified that an edit failed,
but the failure need not stop the current processing of the
application. The user can either ignore the error, or have the
application revert to its previous status/sub status and address
the error before processing the application further.

Override The edit check has failed; however, the system allows users
with the responsibility specified in the Override Responsibility
field to continue. Multiple override levels can be setup
depending upon the resulting value of the edit. If the user has
override responsibility, the application will process as if the edit
had not failed. If the user does not have override responsibility,
the application will revert to its previous status/sub status and
the sub status changes to OVERRIDE REQUIRED. The system
will then direct the application to a user with the authority to
process the application. (See the Queues chapter for more
information).

Note

Do not set the Result field to Override for credit application edits.
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4.9

Interfacing Oracle Financial Services Lending and Leasing with Oracle
Rule Author

Oracle Business Rules is a component of Oracle Application Server that enables applications
to rapidly adapt to regulatory and competitive pressures. This increased agility is possible due
to the adoption of Oracle Rule author wherein a lending Institution can create or change a
business rule without having to indulge in coding and also without stopping the business
process. Also, externalizing business rules allows to manage business rules directly, without
involving programmers. It provides best of breed solutions that would help in configuring the
rules very quickly by a business analyst or user with some insight on the database.

Cycles

The Cycles screen allows you to define the origination workflow process of your organization.
As you delineate the steps in the origination process, you will also define:

e The user responsibilities that have access to perform the steps
e Any edits you want the system to perform between changes in status/sub status.

The following diagram displays the general concept of workflow:

| Apphcation entry H Prescreening criteria I

T B
Application passes Application fails
prescreening criteria prescreening criteria
{ Prequalifying _ criteria |
e T e —
Application passes Application fails _w Rehashing |
prequalify criteria prequalify  criteria

Decision the

Application

—

o o
{ Approve ] | Condition | Reject
Verify Check
contract canditions

| Fund

Cycle code definitions drive the application cycle. The following pairs of status/sub status
define status/sub statuses that have system defined meanings and should be included in your
origination workflow, if they are not already included.

After entering the basic details of the applicant, you can check whether the application pre-
qualifies or not. If the pre-qualified edits are satisfied, the status is changed to NEW-
PREQUALIFY APPROVED and you can modify or update any further details in the
Application Entry screen. If the edits are not satisfied, the application will be pushed to the
REJECTED APPLICATIONS queue with a status update to REJECTED-PREQUALIFY
REJECTED, then you can also view the rejected pre-qualification in the Underwriting window.
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Note

The system status and sub status lists are predefined and cannot be changed by the ad-
ministrator. If you require additional sub status codes, please contact Oracle Financial Ser-

vices Software to determine whether they can be added.

Status/Sub oy
Description:

status:

NEW-BLANK This is the status/sub status of applications during data entry.
Applications remain NEW-BLANK until you choose the Next
Application on the Application Entry form and the system
successfully performs the application edits check.

NEW- The system processes the prescreen edits to determine whether a

PRESCREEN credit report should be pulled for this application or not.

NEW- Applications in this status/sub status have passed the prescreen

PRESCREEN edits. The system will now request a credit bureau pull.

APPROVED

NEW- The system checks the applicant details whether it is qualified or not.

PREQUALIFIC

ATION

NEW- If the pre-qualified edits are satisfied, the status is changed to NEW-

PREQUALIFY PREQUALIFY APPROVED and you can modify or update any further

APPROVED details in the Application Entry screen.

REJECTED- If the edits are not satisfied, the application will be pushed to the

PREQUALFY REJECTED APPLICATIONS queue with a status update to

REJECTED REJECTED-PREQUALIFY REJECTED.

REJECTED- Applications in this status/sub status failed the prescreen edits. These

PRESCREEN applications will receive no further processing. The producer will be

REJECTED sent a decision fax and the consumer will receive an adverse action
letter.

NEW- REVIEW | Either based on the scoring of the application’s credit bureau(s) pull,

REQUIRED or the fact that a credit bureau report was not successfully obtained,
the application needs to be reviewed by an underwriter.

NEW- Based on the scoring of the application’s credit bureau(s) pull, the

RECOMMEND application should be reviewed by an underwriter. However, based on

APPROVAL the current setup, the system recommends approving this application.

NEW- Based on the scoring of the application’s credit bureau(s) pull, the

RECOMMEND application should be reviewed by an underwriter. However, based on

REJECTION the current setup, the system recommends rejecting this application.

APPROVED- Based on the scoring of the application’s credit bureau(s) pull, the

AUTO system automatically approves the application. The producer will be

APPROVED sent a decision fax, and the application will be passed to funding.

REJECTED- Based on the scoring of the application’s credit bureau(s) pull, the

AUTO system automatically rejects the application. The producer will be

REJECTED sent a decision fax and the consumer will receive an adverse action
letter.

4-34

ORACLE



Status/Sub i
. Description:

status:

APPROVED- Application has been manually approved. Normally this occurs when

BLANK an application is in the NEW- RECOMMEND APPROVAL, NEW-
RECOMMEND APPROVAL status/sub status, or less often in the
NEW- RECOMMEND REJECTION status/sub status. Any cycle code
definition with next values of APPROVED-BLANK should have a
lookup value of APP APPROVAL EDITS to ensure that all of the
required data has been gathered in making the decision to approve
the application (unless the application is currently in a status/sub
status that assures the APP APPROVAL EDITS have been run).

NEW- A user without sufficient override authority attempted to approve an

OVERRIDE application, which, based on setup, required a higher over-ride

REQUIRED authority to approve.

APPROVED- Contract has been received from the producer.

VERIFYING

APPROVED- The contract has been reviewed and the data is correct. Normally this

FINAL occurs when an application is in APPROVED-FINAL DOCUMENT

DOCUMENT CHECK OR CONDITIONED-FINAL DOCUMENT CHECK status/sub

CHECK status. Any cycle code definition with next values of APPROVED-
FINAL DOCUMENT CHECK or CONDITIONED-FINAL DOCUMENT
CHECK should have a value of APP CONTRACT EDITS to ensure that
all of the required data has been gathered in making the decision to
approve the application, unless the application is currently in a status/
sub status that assures the APP CONTRACT EDITS have run.

APPROVED- The application has been processed and is awaiting funding.

VERIFIED

APPROVED- The application has been funded, and a check requisition has been

FUNDED created. If Customer Service form is being used, then an account is
also created at this time.

REJECTED- The application for whatever reason is being manually rejected

BLANK regardless of its current status/sub status. Any cycle code definition
with Next values of REJECTED-BLANK should have a lookup value of
APP DECLINE EDITS to ensure that all of the required data has been
gathered in making the decision to approve the application (unless
the application is currently in a status/sub status that assures the APP
DECLINE EDITS have run).

WITHDRAWN- The applicants have indicated that they are no longer pursuing this

BLANK loan.

CONDITIONED | These status/sub status pairs are analogous to the corresponding

-<ANY> APPROVED-<ANY> pair and indicate that the application has had
additional conditions placed on its approval.

<ANY>-<ANY Requires OVERRIDE approval. The meaning of the sub status is

OVERRIDE> analogous to the corresponding OVERRIDE sub status, and may
require that specific EDITS run before proceeding.

<ANY>-AGED These applications have been decisioned but no contract has been

APPLICATION received after a period of time determined by setup. If not acted on,
these applications will become VOID.
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Status/Sub

status: Description:

<ANY>-AGED Contracts have been received after a period of time determined by
CONTRACT setup. If not acted on these applications will become VOID.
<ANY>-VOID Indicate application previously had a sub status of AGED CONTRACT

or AGED APPLICATION. These applications have not been
completed and were made VOID after another period of time had
passed.

Using these status
section.

and sub status, let us re-examine the early workflow diagram in this
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Note

It is extremely important that the APP CONTRACT EDITS run prior to an application being
funded. All cycle code definitions should be reviewed to ensure that there are no paths
through the origination cycle that bypass this EDIT type.

To set up the Cycles

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup >
Setup > Administration > User > Products > Cycles > Lease
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2.
Navigation chapter.

ORACLE'
Financial Services Lending and Leasing

In the Cycle Definition section, perform any of the Basic Operations mentioned in
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A brief description of the fields is given below:

Field: Do this:
Cycle Specify the cycle code.
Type Displays the cycle type.
Product Select the product from the drop-down list.
3. Inthe Cycle Code Definition section, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Current Code

Select the current code to transition FROM, from the drop-down
list.

Current Sub Code | Select the current sub code to transition FROM, from the drop-
down list.
Next Code Select the current code to transition TO from the drop-down list.

Next Sub Code

Select the next sub code to transition TO, from the drop-down list.

Origination Stage
Code

Select the origination stage code of the application from the
adjoining drop-down list.

Edit Type

Select the edit type to associate to the cycles, from the drop-down
list.
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4.10.1

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. Inthe Cycle Code Responsibility Definition section, you can define the responsibilities
that are authorized to change the code. Perform any of the Basic Operations mentioned
in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Responsibility Select the responsibility that will be capable of executing this
transition, from the drop-down list.

Allowed Select ‘Yes’ to allow change to the status responsibility and ‘No’
to disallow.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

Scoring Models

The Scoring screen allows you to setup individual and multiple scoring models. You can
define different scoring models by company, branch, currency and product. Scoring models
are used to automate the decisioning process during underwriting and grade applications.

When you complete the Application Entry process, the system determines which scoring
model to use by finding a best match. The system searches the Company, Branch, Currency
and Product fields of all enabled scoring models that contain either the exact value on the
application or ALL. (Exact matches for each field are given a higher weight than matches to
ALL.) The system then ranks the returned matches in descending order, based on the
weighted values and the hierarchical position of the field and then by Start Date. The system
recognizes the first row returned as the best match. This scoring model information is then
used to determine the next status and sub status of the application.

If you use a standard bureau score as a scoring model, you can set up the system to use the
adverse action reasons provided by the standard bureau score on the Stipulations sub
screen.

To set up the Scoring
1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup

> Administration > User > Products > Scoring Models > Lease. You can set the
following categories of scoring models:

e Credit Score Models

e Behavioural Score Models

Credit Score Models

You can either define new Credit Score Model or specify a new name in the New Credit
Model field and click Create Copy to create a copy of selected score model with details.

1. Click Setup > Setup > Administration > User > Products > Scoring Models > Lease
> Credit Score Models.
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e Inthe Score Models section, perform any of the Basic Operations mentioned in

Navigation chapter.
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A brief description of the fields is given below:

Field: Do this:

Model Specify the code for the scoring model.

Description Specify a description of the scoring model.

Start Dt Specify the start date for the scoring model. You can even select the

date from the adjoining Calendar icon.

End Dt Specify the end date for the scoring model. You can even select the
date from the adjoining Calendar icon.

Enabled Check this box to enable the scoring model.

Results section

Specify the maximum score allowed. (This is normally the sum of the

Max Score Max Value fields within the scoring parameters.).

Selection Criteria section

Select the company for the scoring model, from the drop-down list.

Company This may be ALL or a specific company.

Branch Select branch within the company for the scoring model, from the
drop-down list. (This may be ALL or a specific branch. However, if
you have selected ‘ALL" in Company field, then you must select ‘ALL
for this field).

Product Select the product for the scoring model, from the drop-down list.
This may be ALL or a specific product.

Currency Select the currency for the scoring model, from the drop-down list.
This may be ALL or a specific currency.

Bureau Score Check this box to use the score reasons supplied by the credit

Reasons bureau. If unchecked, then automatically rejected applications
scored using this scoring model display the Adverse Action Reasons
from the Parameters sub screen.

Auto Decision Check this box to assign an application, a status/sub status based on

the grade associated with the score returned for this scoring model. If
not selected, the system assigns applications scored using this
scoring model a status/sub status of NEW-REVIEW REQUIRED.

2. Perform any of the Basic Actions mentioned in Navigation chapter.
Parameters

The Parameters records the parameters used to determine the score calculated by the
scoring model. You can define multiple parameters and adverse action reason associated
with each parameter in a scoring model. Each scoring parameter can have maximum values
set. The score range is based upon the information in the Range Definition section on the
Parameters sub tab.
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The system calculates a final score by adding the score for each parameter in the scoring
model. A parameter weighted value is used to find the four adverse action reasons, if bureau
reasons are not used.

Note

— A character parameter range definition should contain the exact value of the
parameter.

— Each scoring parameter should have range definitions defined that encompass all
of the values that might result.

1. Click Setup > Setup > Administration > User > Products > Scoring Models > Lease
> Credit Score Models > Parameters.

2. Inthe Parameters section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:
Parameter Select the parameter from the field, from the drop-down list.
Max Value Specify the maximum value allowed for the selected parameter.

Adverse Action | Select the adverse action reason, from the drop-down list. (If, on the
Reason Scoring Models screen, the Bureau Screen check box is checked for
the scoring model, you cannot update this field).

Weighted Value | Specify the adverse action weighted value. This indicates the priority
of this parameter when determining which adverse action reasons to
use on the application. The top ten adverse action reasons based on
the weighted value of the parameter will be populated.

Enabled Check this box to enable the parameter.

Perform any of the Basic Actions mentioned in Navigation chapter.

4. The Range Definition section allows you to translate the calculated value for a scoring
parameter into the value to be used, depending on the returned value of the parameter

5. In the Range Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Value From Specify the lowest calculated value to apply the specific translation. The
ceiling of the range definition is based on the range definition with the
next highest Value From or the Max Value of the scoring parameter
(whichever is less).
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Field:

Do this:

Value From

Select the following options to determine how values for a scoring
parameters are translated:

% Max Value — If selected, then the calculated values within the range
definition receives a value based on a percentage of the Max Value of the
scoring parameter.

% Param — If selected, then the calculated values within the range
definition receives a value based on a percentage of the calculated value
of the scoring parameter.

Value - If selected, then the calculated values with in the range definition
receives a specific value.

Percent /
Value

Specify the percent or value to be used in the translation of the calculated
value of the scoring parameter.

Enabled

Check this box to consider this range definition while translating values
for this scoring parameter.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

Grades

The Grades sub screen allows you to define how the system translates the scoring model
scores into your organization’s grade. The system uses these grades in the auto-decisioning
process. Each grade has a specific status/sub status that informs the system what to do with
the application of a particular grade as it continues through the origination cycle.

Note

Each scoring model should have grade definitions defined that encompass all of the val-
ues that might result.

1. Click Setup > Setup > Administration > User > Products > Scoring Models > Lease
> Credit Score Models > Grades.

2. In the Grade Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Score Specify the score the application receives.

Credit Grade | Select the grade to assign to an application, from the drop-
down list.

Application Select the status to assign to applications with a score

Status starting with the value of this grade definition, from the drop-
down list.

4-42 ORACLE



4.10.2

Field:

Do this:

Sub Status

Select the sub status to assign to applications with a score
starting with the value of this grade definition, from the drop-
down list.

Credit scoring allows you to select the following status/sub
status pairs:

APPROVED - AUTO APPROVED
REJECTED - AUTO REJECTED
NEW - REVIEW REQUIRED

NEW - RECOMMEND APPROVAL
NEW - RECOMMEND REJECTION.

Enabled

Check this box to indicate that this grade definition will be

model.

considered when grading an application using this scoring

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Behavioral Score Models

You can either define new Behavioral Score Model details or specify a new name in the New
Behavioral Model field and click Create Copy to create a copy of selected score model with

details.

1. Click Setup > Setup > Administration > User > Products > Scoring Models > Lease

> Behavioral Score Models.

2. In the Score Models section, perform any of the Basic Operations mentioned in

Navigation chapter.
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A brief description of the fields is given below:

Field: Do this:

Model Specify the code for the scoring model.

Description Specify a description of the scoring model.

Start Dt Specify the start date for the scoring model. You can even select the
date from the adjoining Calendar icon.

End Dt Specify the end date for the scoring model. You can even select the
date from the adjoining Calendar icon.

Enabled Check this box to enable the scoring model.

Result section

Max Score Specify the maximum score allowed. (This is normally the sum of the
Max Value fields within the scoring parameters.).

Selection Criteria section

Select the company for the scoring model, from the drop-down list.

Company This may be ALL or a specific company.

Branch Select branch within the company for the scoring model, from the
drop-down list. (This may be ALL or a specific branch. However, if
you have selected ‘ALL’ in Company field, then you must select ‘ALL’
for this field).

Product Select the product for the scoring model, from the drop-down list.
This may be ALL or a specific product.

Currency Select the currency for the scoring model, from the drop-down list.

This may be ALL or a specific currency.

Bureau Score
Reasons

Check this box if bureau score reason is applicable.

Auto Decision

Check this box if auto decision is applicable.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Click ‘Create Copy’ button on the Score Models screen to create copy of the selected
record with details.

The Parameters section records the parameters used to determine the score calculated by
the scoring model. You can define multiple parameters and adverse action reason associated
with each parameter in a scoring model. Each scoring parameter can have maximum values
set. The score range is based upon the information in the Range Definition section on the
Parameters sub tab.

The system calculates a final score by adding the score for each parameter in the scoring
model. A parameter weighted value is used to find the four adverse action reasons, if bureau
reasons are not used.
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Note

— A character parameter range definition should contain the exact value of the
parameter.

— Each scoring parameter should have range definitions defined that encompass all
of the values that might result.

5. Inthe Parameters section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:
Parameter Select the parameter from the field, from the drop-down list.
Max Value Specify the maximum value allowed for the selected parameter.

Adverse Action | Select the adverse action reason.
Reason

Weighted Value | Specify the weighted value.

Enabled Check this box to enable the parameter.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

7. The Range Definition section allows you to translate the calculated value for a scoring
parameter into the value to be used, depending on the returned value of the parameter.

8. In the Range Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Value From Specify the lowest calculated value to apply the specific translation. The
ceiling of the range definition is based on the range definition with the
next highest Value From or the Max Value of the scoring parameter
(whichever is less).

Value From Select the following options to determine how values for a scoring
parameters are translated:

% Max Value — If selected, then the calculated values within the range
definition receives a value based on a percentage of the Max Value of the
scoring parameter.

% Param — If selected, then the calculated values within the range
definition receives a value based on a percentage of the calculated value
of the scoring parameter.

Value - If selected, then the calculated values with in the range definition
receives a specific value.

Percent / Specify the percent or value to be used in the translation of the calculated
Value value of the scoring parameter.
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Field: Do this:

Enabled Check this box to consider this range definition while translating values

for this scoring parameter.

9. Perform any of the Basic Actions mentioned in Navigation chapter.
Fees

The Fee screen allows you to define fees that may be automatically assessed by the system.
The Fee Definition section records fees not defined within the Contract screen’s Fees sub
screen.

The following fee types are currently supported for automatic assessment:

e Late charge

o NSF

e Extension

e Advance

e Over Credit Limit

e Membership

e Prepayment penalty
e Phone Pay

e Payoff Quote

e Periodic Maintenance
e Rental Fee

e ACH Fee

e Delay Fee

e Other Fee and Tax

Fees can be calculated as either a flat amount or a percentage of payment due based on fee
type.

You can specify minimums and maximums for fee amounts in the Min Amt and Max Amt
fields. Different fee rules can be setup at the company/branch level.

When Fees are assessed, the system determines the best match using all enabled fee
definitions that meet the following criteria:

e Exactly match the fee type being assessed.
e Have an effective date that is greater than or equal to the start date.

e Have a Txn Amt From that is greater than or equal to the outstanding amount related to
the fee assessment.

e Match either the value or ALL for all other criteria (Exact matches for each field are
given a higher weight than matches to ALL.)

The returned rows are then given a descending rank based on the weighted values and the
hierarchical position of the following criteria:

1. Company
2. Branch
3. Product
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4.
5.
6. Start date
7. End date
8. Currency

Application state

Transaction amount

On the ranked rows, the first row is returned as the best match.

Note

Certain fees, like late fees, can be set up at contract, as well as state level. In such cases,
the contract fee, if present, is used first. Only if the contract fee is not present in the state

fee used.

To set up the Fee

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Fees > Lease.

2. In the Fee Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
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A brief description of the fields is given below:

About.

Field: Do this:

Fee Rule Specify the fee rule used to identify the particular fee definition.

Fee Type Select the fee type from the drop-down list. The system computes
these drop-down values from the TXN_TYPE_CD Lookup, with FEE
as the sub type.

Start Dt Specify the start date. You can even select the date from the
adjoining Calendar icon.

End Dt Specify the end date. You can even select the date from the

adjoining Calendar icon.
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Field: Do this:

Enabled Check this box to enable the fee.

Calc Method | Select one of the following method of calculating the fee, from the
drop-down list.

If ‘Flat Amount' is selected, then minimum fee will be charged.

If ‘Percentage’ is selected, then the amount charged will be based
on percentage defined subject to minimum and maximum amount
(i.e. 'Txn Amt From').

Min Amt Specify the minimum amount for the fee.

Max Amt Specify the maximum amount for the fee. If you selected FLAT
AMOUNT in the Calc Method field, then this field is not used and is
normally populated as $0.00.

Percent Specify the percentage value of the outstanding transaction amount
to be assessed as a fee. This amount will be adjusted to fall within
the Min Amount and the Max Amount.

Selection Criteria section

Company Select the portfolio company from the drop-down list. This may be
ALL or a specific company.

Branch Select the portfolio branch from the drop-down list. This may be ALL
or a specific branch. (This must be ALL, if you have selected ‘ALL’ in
the Company field).

Channel Select the channel from the drop-down list, This can be ALL or a
specific channel.

Product Select the product from the drop-down list. This may be ALL or a
specific product. The available values come from a validated field
based on the selected Billing Cycle setup and the Product setup.

State Select the state for this fee, from the drop-down list. This may be
ALL or a specific state.

Currency Select the currency for this fee, from the drop-down list. This may be
ALL or a specific currency.
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Field: Do this:

Txn Amt Specify the transaction or balance amount. The fee is calculated
From using the specifications of this record only if the transaction amount
is greater than the value specified in this field (and less than this
field in another record for the same fee).

IMPORTANT:

When you select the fee to use, the system searches for a best
match using the following attributes:

1 Company

2 Branch

3 Product

4 State

5 Amount (Txn Amt From)

6 Effective/start date (Start Dt)

Hence, Oracle Financial Services Software recommends creating a
version of each fee, where ALL is the value in the these fields.

It is also recommended that you define a default printer for an
Organization, Division and Department.

Gross Specify the minimum value of gross capitalization cost.
Capitalized
Cost From

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Origination Fees

The system supports the auto computation of origination itemized fees. System
administrators can define and maintain the itemization formula on the Origination Fees
screen.

An itemization formula can be set up as a computation of other itemizations (such as adding
or subtracting one itemization from another) and can consist of multiple itemizations. An
itemization formula will have a minimum and maximum value. You can set up a formula value
range to be used as the final value.

Itemizations are linked to a product with the Products screen’s Product ltemizations subtab.

One itemization can be based on one formula, while the same formula can be attached to
multiple itemizations. If a formula is attached to a contract itemization and that formula
requires an itemization not present in Formula Definitions screen, then the system displays
an error message.

The system will search for any “circular dependency” at the time the contract is enabled. An
example of a circular dependency is when ltemization1 has Formula1 attached requiring
Itemization2 for computation and Itemization2 has Formula2 attached requiring ltemization1
for computation.
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To set up the Origination Fees
1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Origination Fees > Lease.

2. In the Formula Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.
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3. A brief description of the fields is given below:

Field: Do this:

Formula Specify the formula code to define computation.

Description Specify the description for the formula.

Min Amt Specify the minimum value that should be considered to compute the
final value of formula.

Max Amt Specify the maximum value that should be considered to compute the
final value of formula.

Enabled Check this box to allow the origination fees.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

In the Formula Details section of Setup > Setup > Administration > User > Products >
Origination Fees > Lease > Detail, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Iltemization Select the itemization based on which the itemization formula will derive
its computed value, from the drop-down list.
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Field: Do this:

Percentage Specify the percentage value that should be considered while
computing value for itemization formula.

Sort Specify the sort sequence for the itemization to be considered while
computing the value of the itemization formula.

Sign Select the +ve or -ve sign that needs to be considered between two
itemizations for computing the value of the itemization formula.

Enabled Check this box to allow the itemization details to be used by the system.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

7. In the Range Details section of Setup > Setup > Administration > User > Products >
Origination Fees > Lease, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Amt From Specify the value up to which the percentage of final value of the
itemization formula to be considered for the final value of itemization
formula.

Percent Specify the percentage value that should be considered while computing
the value for the final value of the itemization formula.

Enabled Check this box to allow the range details to be used by the system.

8. Perform any of the Basic Actions mentioned in Navigation chapter.

413 Compensation

With the Compensation screen, you can define compensation plans for producers who supply
the financial institution with applications for loans. These compensation plans can be set up
at various levels depending upon your organization’s needs.

This information is used on the Compensation sub screen on the Contract link of the
Applications window. The Compensation Plan field lists the plans available based on the
contract in use for the application. When you click Load on the Compensation sub screen, the
system adds the information setup on the Compensation screen.

Compensation can be paid to a producer in a number of ways:

Payment

calculation Description:

method:

AS EARNED The compensation amount is paid out in pieces over the life of the

product based upon the interest earned.

PAY AS U GO The compensation amount is paid out in pieces over the life of the
product based upon the interest received by virtue of the payment.
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Payment

calculation Description:

method:

UPFRONT The entire compensation amount is paid at the time of booking the
loan.

UPFRONT The entire compensation amount is paid at the month-end of booking

MONTH END the loan.

UPFRONT The amount financed will be amortized at a rate equal to the

MONTH END difference between the contract rate and buy rate. The finance

(amortize charge thus derived would be considered the base compensation

spread amount. the system then allows this base compensation to be split

formula) into two components:

1) Upfront compensation amount
2) Remaining compensation amount.

The disbursement method will apply to the remaining compensation
portion (total compensation minus the upfront amount).

Compensations can be charged back from a producer, if a product is prematurely paid or
charged off. The charge back amount can be calculated using the following methods:

e Earned

e Percentage

You can specify whether the unearned portion or a certain percentage of the total
compensation is to be charged back in case of early payoff or charge off.

The period for which the charge back plan can remain active can be set up according to:

e Number of days

e Term (number of months)

To set up the Compensation

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup

> Administration > User > Products > Compensation > Lease.
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2. In the Compensation Plan Definition section, perform any of the Basic Operations
mentioned in Navigation chapter.
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A brief description of the fields is given below:

Field: Do this:

Code Specify the compensation code.

Description Specify a description of the compensation plan being defined.

Start Dt Specify the start date for the compensation plan. You can even select
the date from the adjoining Calendar icon.

End Dt Specify the end date for the compensation plan. You can even select the
date from the adjoining Calendar icon.

Enabled Check this box to enable the compensation plan.

Result section

Disburseme | Select the method for calculating the compensation disbursement to be
nt Method paid, from the drop-down list.

Formula Select the type of formula to be used to calculate the compensation to
Method be paid, from the drop-down list. The system uses following formula
methods:

FLAT AMOUNT
- Flat amount is paid.
SPREAD BASE FORMULA

- A formula based on the spread between the buy rate and the interest
rate offered to the consumer is used.
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Field: Do this:

Formula Select the spread formula to be used to calculate Compensation, from
the drop-down list.

Factor Specify the compensation factor; that is, the percentage applied to the
compensation to be paid. If this value is not 100.00, it will reduce the
compensation amount.

Addl Factor Specify the additional compensation factor. If this value is not 100.00, it
will further reduce the compensation amount.

Max Spread Specify the maximum compensation spread. This limits the spread on
which compensation will be paid. Spreads exceeding this value will be
treated as if the spread was the specified value.

Max Markup | Enter the maximum compensation markup.

Flat Amount | Enter the flat compensation amount.

Selection Criteria section

Company Select the portfolio company, from the drop-down list. This may be ALL
or a specific company.

Branch Select the portfolio branch within the company for the selected
compensation plan, from the drop-down list. This may be ALL or a
specific branch. This must be ALL if in the Company field you selected

ALL.

Billing Cycle | Select the billing cycle for the compensation plan, from the drop-down
list.

Product Select the product for the selected compensation plan, from the drop-

down list. This may be ALL or a specific product. The available values
come from a validated field based on the selected Billing Cycle setup
and the Product setup.

State Select the state for the selected compensation plan, from the drop-down
list. This may be ALL or a specific state.

Currency Select the currency for the selected compensation plan, from the drop-
down list. This may be ALL or a specific currency.

Pro Group Select the producer group for the compensation plan, from the drop-
down list. This may be ALL or a specific producer group.

Pro Type Select the producer type for the compensation plan, from the drop-down
list. This may be ALL or a specific producer type.

Producer Select the producer for the compensation plan, from the drop-down list.
This may be ALL or a specific producer. The available values come
from a validated field based on the Pro Group and Pro Type.

Grade Select the credit grade for this compensation plan, from the drop-down
list. This may be ALL or a specific grade.

Amt Specify the minimum amount financed for the compensation plan.

Term Specify the minimum term for the compensation plan.
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414

Field: Do this:

Asset Class Select the asset class for the compensation plan, from the drop-down
list. This may be ALL or a specific asset class. The available values
come from a validated field based on the Collateral Type.

Asset Type Select asset type for the compensation plan, from the drop-down list.
This may be ALL or a specific asset type. The available values come
from a validated field based on your assets setup.

SubType Select the asset sub type for this compensation plan, from the drop-
down list. This may be ALL or a specific asset sub type. The available
values come from a validated field based on your assets setup.

Asset Make Specify the asset make from the drop-down list. If ALL was selected for
either Asset Type or Asset Sub Type, then ALL will be the only available
selection for the asset make.

Asset Model | View the asset model from the drop-down list. If ALL was selected for
either Asset Type or Asset Sub Type, then ALL will be the only available
selection for the asset model (display only).

Age Specify the asset age.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Checklists

A checklist is an optional set of steps to follow when completing a task in the system, such as
the underwriting and funding processes.

Checklists can be used as guidelines to help ensure that the system users follow your
business’s standard operating procedures and enter all required data. Some checklists are
optional, but others such as those related to application decisions or contract verification, may
be required depending on the edit sets defined in your system. The Checklists screen allows
you to specify the contents of the checklist.

You can define additional checklists for your organization. You can set up multiple checklists
for a single type of checklist. These checklists can be differentiated by:

e Company

e Branch

e Product

e Account state

To set up the Checklists

You can either define new Checklist Type Definition details or specify a new code in the New
Checklist field and click Create Copy to create a copy of selected checklist type definition
with details.

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Checklists > Lease.
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2. In the Checklist Type Definition section, perform any of the Basic Operations mentioned
in Navigation chapter.
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3. A brief description of the fields is given below:

Field:

Do this:

Checklist Code

Specify the checklist code that identifies checklist being defined.

Description

Specify the description for the checklist.

Checklist Type | Select the checklist type from the drop-down list, to define where the
specific checklist will be available in the system.

Company Select the portfolio company associated with the checklist from the
drop-down list. This may be ALL or a specific company.

Branch Select the portfolio branch associated with the checklist from the
drop-down list. This may be ALL or a specific branch. This must be
ALL if in the Company field you selected ALL).

Channel Select the channel from the drop-down list, This can be ALL or a
specific channel.

Product Select the product associated with the checklist from the drop-down

list. This may be ALL or a specific product. The available values
come from a validated list based on the selected Billing Cycle setup
and the Product setup.
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Field: Do this:

State Select the state associated with the checklist type from the drop-down
list. This may be ALL or a specific state.

IMPORTANT: By selecting which edits type to use, the system
searches for a best match using the following attributes:

1 Company
2 Branch

3 Product
4 State

Hence, Oracle Financial Services Software recommends creating one
version of each checklist type where ALL is the value in these fields.

Currency Select the currency associated with the checklist from the drop-down
list. This may be ALL or a specific currency.

Enabled Check this box to enable the checkilist.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
Checklist actions are steps (a set of one or more tasks) related to the checklist you are
creating. They are loaded on the Checklist Action Definition section.

5. Inthe Checklist Action Definition - Regular section, perform any of the Basic Operations
mentioned in Navigation chapter

A brief description of the fields is given below:

Field: Do this:

Action Code | Specify the action code for the checklist.

Description Specify the description for the action type.

Sort Specify the sort order to define the placement of the action type on the
Checklist sub screen.

Enabled Check this box to include this action in the checklist.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

7. In the Checklist Action Definition - Document section, perform any of the Basic
Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Action Code | Specify the action code for the checklist.

Description Specify the description for the action type.

Document Select the document type from the drop-down list.
Type
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4.15

Field:

Do this:

Document Select the document sub type from the drop-down list.

Sub Type

Document Check this box to indicate that the document is mandatory.

Mandatory

Sort Specify the sort order to define the placement of the action type on the
Checklist sub screen.

Enabled Check this box to include this action in the checklist.

8. Perform any of the Basic Actions mentioned in Navigation chapter.

Stipulations

The system supports the automatic generation of default stipulations for loans during
origination on the Underwriting window’s Stipulation sub screen (Decision link). The default
stipulations can be maintained by company, branch, product, state, application status and
application sub-status on the Stipulations screen.

To set up the Stipulations

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Stipulations > Lease.

2. In the Stipulation Setup section, perform any of the Basic Operations mentioned in

Navigation chapter.
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A brief description of the fields is given below:

Field: Do this:

Company Select the portfolio company associated with the default stipulations,
from the drop-down list.

Branch Select the portfolio branch associated with the default stipulations, from
the drop-down list.

Product Select the product associated with the default stipulations, from the
drop-down list.

State Select the state associated with the default stipulations, from the drop-
down list.
Currency Select the currency associated with the default stipulations, from the

drop-down list.

Application Select the application status associated with the default stipulations,

Status from the drop-down list.

Application Select the application sub status associated with the default stipulations,
Sub-Status from the drop-down list.

Enabled Check this box to allow the default stipulations to be used.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Stipulation Details section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Stipulations Select the stipulation from the drop-down list.

Sort Specify the sort sequence for the stipulation.
Enabled Check this box to allow the stipulations details to be used by
the system.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

416 Spreads

The Spreads screens allows you to define the payment allocation strategy used by your
business while applying payments to accounts. Spreads are selected on the Payment Entry
(Payment Maintenance) screens.

Depending on account status and condition, you can also define various combinations of
spreads for same account using the Spread Matrix, which can be defaulted when particular
accounts are selected for payments.

The Spreads screens consists of the following tabs:

e Spread Definition
e Spread Matrix
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4.16.1

Spread Definition

The Spread Definition section is used to define individual spreads. Many common spreads
have already been defined. With each spread, you can define the due date advancement
method to use, BRING CURRENT, FUTURE, or NONE.

The Spreads screen records the order in which balances are satisfied when a payment is
applied to an account. (Unless someone indicates otherwise, payments will be applied
against each balance type, in sort order, until either there is no remaining balance, or the
payment has been completely allocated.)

To set up the Spreads

You can either define new Spread Definition details or specify a new name in the New Spread
field and click Create Copy to create a copy of selected spread definition with details.

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup >
Setup > Products > Spreads > Lease > Spread Definition.

In the Spread Definition section, perform any of the Basic Operations mentioned in Navigation
chapter.

opACiE

Financial Services Lending and Leasing

Close
» DashBoard Spreads x LS
 Origination Loan | Line | Lease
» Senvicing
- ad | /2 ] view | o Au
 Collecions Spread Definition ) depid | Lt | [Elview | o audt
i View~ Fomat~ (5 Freeze 1 Detach Wap ) NewSpread ¥ Create Copy P Load Details
i Spread Description Due Dt Adv Enabled
» Tools N
Setup ACLEASE ACTIVE SPREAD- EASE BRING CURRENT Y
ACEXP-EASE ACTIVE EXPENSE SPREAD-LEASE NONE Y
Setup ACFEE-EASE ACTIVE FEE SPREAD-LEASE NOKE Y
Administrtion CO-EASE CHGOFF SPREAD-LEASE BRING CURRENT ¥
) System SOA-LEASE SALE OF ASSET- BRING CURRENT Y
User TRHHBUY-LEASE TERMINATION B BRING CURRENT Y
Products TRHHNOBUY-LEASE TERMINATION NO BUY ASSET-IEASE BRING CURRENT ¥
Asset Types
Index Rates i
Spread Definition
Currency Exchange
b oy [J saveandadd | [ saveand Sty | [ Sove andRetum | GaReturn
Products b
Pricings * Spread * Enabled
Contract * Description
bs * Due Dt Adv ¥
Oydes
Scoring Hodels i - 5 ;
Fees Spread Transaction Definition dpid | LEdt | Elview | o nudt
Qrigination Fees View~ Fomat= [ Freeze i Detach o @
Compensation Balance Type Cyde Sort Enabled
Commission o data to disply.
Insurance
Checklists
Stipulations
Spreads
Statement Nessages
Letters
Fromations
Subvention
Escrow o

A brief description of the fields is given below:

Field: Do this:

Spread Specify the code identifying the spread.

Description Specify the description for the spread. (This usually reflects
when this spread is used.).
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Field: Do this:

Due Dt Adv Select the due date advancement code that determines how
payments applied using this spread will affect due amounts,
from the drop-down list. The system uses the following
predefined Due Dt Adv Codes:

NONE — Payments applied using this spread will not affect
the due amounts of the account in any way

BRING CURRENT — The payment allocations for
transactions against an account’s outstanding balances that
make up the billed balances. This will be applied against
billed due amounts

FUTURE - The payment allocations for transactions against
an accounts outstanding balances that make up the billed
balances. This will be applied against billed due amounts.
Any remaining amount allocated against billed balances will
be accumulated and applied against future due amounts.

FUTURE WITH PRINCIPAL, INTEREST THEN ESCROW

FUTURE WITH ESCROW, THEN PRINCIPAL AND
INTEREST

Enabled Check this box to enable the spread.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

3. Inthe Spread Transaction Definition section, perform any of the Basic Operations
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:
Balance Select the balance type to allocate a portion of the received payment,
Type from the drop-down list.

Note: Oracle Financial Services Software recommends that you always
setup an ADVANCE/PRINCIPAL balance type for each spread.

Cycle Specify the balance cycle during which to apply payments. This collects
payment on bad (unpaid) cycles. You can go back by only five cycles.
Cycle will have a value of 0 for loans.

Sort Specify the sort order in which the balance type has payments allocated
against it.
Enabled Check this box for the system to consider this spread transaction when

allocating payments.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

To Load Details

1. Create a record in Spread Definition section, with Enabled check box unchecked.

2. Click Load Details button, the system will load the spread transaction definition details.
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4.16.2

Spread Matrix

The Spread Matrix tab in Spreads screens allows you to define and maintain different
combinations of spreads depending on a particular account status, Conditions, Primary
Customer State, Capitalized Cost and Priority.

When there are multiple spreads defined for an account with different conditions, you can set
the priority for the system to sequence the same.

The details maintained here are used to default the ‘Spread’ when a particular account is
selected in the Payment Entry or Payment Maintenance screen.

To set up the Spread Matrix Details

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Products > Spreads > Lease > Spread Matrix.
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2. In the Spread Matrix section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Start Dt Select the start date for the spread from the adjoining
calendar.

End Dt Select the end date for the spread from the adjoining
calendar.

Enabled This check box is selected by default indicating that the
spread is enabled.

Spread Select the required product active spread from the drop-down
list.

Selection Criteria

Account Select the account status for the spread from the drop-down
Status list.
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Field: Do this:

Account Select the account condition for the spread from the drop-

Condition down list.
Note: You can define multiple conditions for the same
account.

State Select the state of the primary applicant from the drop-down
list.

Capitalized Specify the value of capitalization cost from where the system
Cost From should consider the current spread.

Priority Specify the priority when there are multiple conditions posted
on the same account. System considers the least numbered
priority as first in the sequence.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

417 Statement Messaqges

The Messages screen allows you to set up messages that appear on account statements sent
to customers. You can set up statement messages for different products. When the system

generates a statement for an account, all statement messages matching the selection criteria
are included in the statement file for that account.

The system inserts the message in the Text field into the statement file produced during the
nightly batch job for the appropriate consumers.

Arecord of an account’s statement history, including the messages included in the statement,
appears on the Statement’s screen on the Customer Service screen.

To set up the Messages

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Statement Messages > Lease.
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2. In the Statem

ent Messages section, perform any of the Basic Operations mentioned in

Navigation chapter.
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A brief description of the fields is given below:

Field: Do this:

Seq Specify the sort sequence of how the statement message should be
printed.

Code Specify the message code identifying the statement message.

Start Dt Specify the first date the statement message is available. You can
even select the date from the adjoining Calendar icon.

End Dt Specify the last date the statement message is available. You can
even select the date from the adjoining Calendar icon.

Enabled Check this box to enable the message.

Result section

Text

Specify the text of the statement message.

Selection Crite

ria section

Company Select the company for the statement message from the drop-down
list. This may be ALL or a specific company.

Branch Select the branch within the company for the statement message from
the drop-down list. This may be ALL or a specific branch. This must be
ALL if in the Company field you selected ALL.

Product Select the product for which this statement message will be used from

the drop-down list. This may be ALL or a specific product.
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Field:

Do this:

Currency

Select the currency for the statement message from the drop-down
list. This may be ALL or a specific currency.

Producer

Select the producer for the statement message from the drop-down
list. This may be ALL or a specific producer. The available values
come from a validated field based on the Pro Group and Pro Type.

IMPORTANT: By selecting which message to use, the system
searches for a best match using the following attributes:

1. Company
2. Branch
3. Product
4. Producer
5. Currency

Hence, Oracle Financial Services Software recommends creating one
version of each edit type where ALL is the value in these fields.

Letters

The Letters screen allows you to define letters that the system automatically generates when

the application or the account for a products meets certain conditions, or “trigger events.”
Each letter has its own trigger event. For example, you can configure the system to
automatically send a welcome letter when an application becomes an account or send a
collection letters when an account becomes delinquent.

The system supports the following types of letters:

Type of letter:

Definition:

Action letter

ACCOUNT Generated when account is to receive a billing statement (this time is
STATEMENT defined in contract setup). Letter is sent to customer.
ADVERSE Generated in nightly batch jobs for applications that were declined.

This letter is sent to the consumer to indicate the reasons why the
application was declined.

CONDITIONAL Generated in nightly batch jobs for applications that were
ADVERSE
ACTION declined. This letter is sent to the consumer to indicate the reasons
LETTER why the application was declined. This letter also indicates steps that
the consumer may take to gain approval of the application.
COLLECTION Generated when an account becomes delinquent. This is the first
LETTER 1 dunning letter sent to the customer.
COLLECTION Generated when an account remains in delinquency for an extended
LETTER 2 period. This is the second dunning letter sent to the customer.
COLLECTION Generated when an account remains in delinquency for an extended
LETTER 3 period, even after having received previous notices. This is the final

dunning letter sent to the customer.
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Type of letter: Definition:

CONTRACT Generated when an application is APPROVED: FUNDED or
FUNDING fax/ CONDITIONED: FUNDED. This letter is sent to the producer.
email

DECISION FAX/ Generated when an application is APPROVED, CONDITIONED, or
EMAIL REJECTED. This letter is sent to the consumer or producer,
depending on whether the product is a direct or in-direct loan.

PAID IN FULL Generated in nightly batch jobs when the account pays off. This letter
LETTER is sent to the customer.

PAYOFF Generated when a payoff quote is created for an account. This letter
QUOTE is sent to the customer.

LETTER

WELCOME Generated when an application is APPROVED: FUNDED. This letter
LETTER is sent to the consumer.

STATEMENT PAST MATURITY Generated when an accounts are
matured but unpaid.

This letter is sent to the account holders as a reminder to make their
payments.

When the system generates letters, it searches the Letters screen for letter definitions that
meet the following criteria:

e Definition is enabled.
e Definition is an exact match of the letter code being generated.
e Definition is a match of either the application/account value or ALL for all other criteria.

Exact matches for each field are given a higher weight than matches to ALL.

The returned rows are then given a descending rank based on the weighted values and the
hierarchical position of these fields:

Company

Branch

Product

State

o M D=

Currency

On the ranked rows, the first row is returned as the best match.

To set up the Letters

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Letters > Lease.
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2. In the Letter Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

opAcie

Financial Services Lending and Leasing

Closs
> DashBoard fetters Mo
> Origination Loan Lne  Lease
) Servicing

it i ] view | & hu
ol Letter Definition Pl | /it | 5 vien | o mudt
= View Formatv §p  [[|Freere f Detach wa @
. Letter Code Fil Name Letter Type Channel Enabled Batch Printer  Batch User Company Branch Product State Curengy
) Tools ]
setup CHLSCE ADY.LTR lorady_em 121 01 ADVERSEACTIONLETTER  ALL Y ARCHIVE BTCHUSER AL AL AL AL AL
CHLSCE_COLLTRI n10001 COUECTONLETER1 AL Y BRCHIVE BTCHUSR AL AL AL AL AL
il CHLSCE_COLLTR? I COUECTONIETERZ AL Y ARCHIVE BTCHUSR AL AL AL AL AL
Adninistration CHLSCE_COLLTRS ol em 100 01 COLECTONLETTER3 AL Y ARCHIVE BTCHUSR AL AL AL AL AL
> Spstem CHLSCE_CON_TR lorcon_em_100_01  CONTRACTFUNDINGFAXE.. ALL Y BRCHIVE BTCHUSR. AL AL AL AL AL
User CHLSCE DEC_FAX Iordec_em_121 01 DECISION FAY/EHALL AL Y ARCHIVE BTCHUSR AL AL AL AL AL
Products CHLSCE_DEC_MULTIOFFER_.. lrdecem 121,02 DECISIONMULTIOFFER  ALL [ ARCHIVE BTCHUSR AL AL AL AL RALON
Auset Types CHLSCE_POC TR Iespdc_em_ 121,01 POCRENEWALLETTER  ALL Y BRCHIVE BTCHUSR AL AL AL AL AL
IndexRates CHLSCE_STHLTR Iesstm_em 171,01 ACCOUNT STATEMENT ~ ALL Y ARCHIVE BTCHUSR AL AL AL AL AL
Currency Exchange »
Seoring Parameters
Products 1 .
Prcings Letter Definition
Contract H saeandadd | [ saveand sty | B smveandRetum | GaRetum
Eiits
Cycles * Letter Code Result
Scoring Models . » * Company ALL v
Fees Tl * Batch Printer UNDEFTNED v - =
* etter Type v el
Origination Fees * Batch User ¥
i Product ALL v
Compensation Chamel ALL v
Commission * Enabled Selection Criteria *State ALL %
Insurance * Currency AL v
Checklists
Stipuations
Spreads
Statement Messages
Letters
Promotons
Subvention
Escron o
A brief description of the fields is given below:
Field: Do this:
Letter Code Specify the code for the letter.
File Name Specify the file name of the Oracle report used to generate the letter.

The file should be named <File Name>.rep on your server.

Letter Type Select the type of letter you want to generate from the drop-down list.

Channel Select the application source (channel) for the letter from the drop-down
list. This may be ALL or a specific channel.

Enabled Check this box to enable this letter definition.

Result section

Batch Printer | Select the batch printer being used to generate the letter from the drop-
down list.

Batch User Select the user who will submit this letter from the drop-down list. This
will normally be set to BATCH.

Selection Criteria section

Company Select the portfolio company for which this letter will be used from the
drop-down list. This may be ALL or a specific company.

Branch Select the portfolio branch for which this letter will be used from the
drop-down list. This may be ALL or a specific branch. This must be ALL
if in the Company field you selected ALL).
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Field: Do this:

Product Select the product for which this letter will be used from the drop-down
list. This may be ALL or a specific product.

State Select the state for which this letter will be used from the drop-down list.
This may be ALL or a specific state.

Currency Select the currency for which this letter will be used from the drop-down
list. This may be ALL or a specific currency.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.19 Subvention

The Subvention Setup screen’s lease Subvention tab allows you to set up lease subvention
plans for producers (groups or individuals). Multiple producers may contribute to one
subvention plan or a plan can be set for a specific producer.

Subvention Types

Subvention can be offered in many forms for vehicle leases. The most common format is the
Rent factor for vehicle leases. Rent factor subvention involves sharing the finance charge
(interest) by the participant (most frequently with the manufacturer). The finance company
sets its buy rate (the minimum cost to the company to extend the Lease to a customer). If the
customer rate is less than this buy rate, then the amount is equivalent to the interest amount
for the difference (the buy rate minus the customer rate) is paid by the participant as the
subvention amount.

Currently Oracle Financial Services Lending and Leasing supports the following subvention
types:

Lease subvention types:
e Rent factor
e Residual
e Deposit waiver
e Cash bonus
e Buy down

Subvention plans can be defined for one participant (for example, a manufacturer or a
particular dealer) or group of participants (such as a dealer association). One subvention plan
could have multiple sub plans and multiple participants could participate to each sub plan.

Example

Subvention plan:
e “Summer Special Event”
Subvention sub-plans for above plan:
e 1.9% for 36 months
-or-
e 2.99% for 48 months
-or-
e 3.99% for 60 months
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4.19.1

- or -
e $1500.00 cash bonus
Multiple participants may participate in each sub plan. For example, for the 1.9% rate, 1%
might be shared by the manufacturer and 0.9% might be shared by the dealer. Similarly, for

the $1,500 cash bonus, $1,000 might be shared by the manufacturer and $500 by the dealer.
Or, the complete $1,500 might be covered by the manufacturer.

Collection of subvention amounts can be set for each participant in the subvention plan with
the Collection Method.

Oracle Financial Services Lending and Leasing supports following collection methods:

Type Details

UPFRONT The entire subvention amount is collected at the booking of the
Lease from the producer proceed.

UPFRONT The entire subvention amount is collected at the time of the subven-
STATEMENT tion statement.
PAY AS U GO The subvention amount is billed to the producer when the customer

pays the Lease payment. The producer is due for the amount at
each statement.

Subvention Refund

There are times when a Lease is either paid-off early or gets charged off and the finance
company refunds the unearned subvention amount back to the producer. The refund is
available only when the subvention amount is collected from the producer proceeds
(UPFRONT) or the whole amount is billed in the first statement (UPFRONT STATEMENT).

You can set up the system to allow refunds only for a certain period and not beyond that. The
period can be set differently for charge offs and paid offs and can be based on two methods:
1. Days

2. Term

The system provides the following methods for refund amount calculation:
1. Earned

2. Percentage

The earned method is used to refund the unearned portion of the collected subvention
amount. The percentage method is used to refund a certain percentage of the subvention
amount collected.

Lease Subvention Plans

The Lease Subvention Plans screen allows you to set up subventions for Leases.

To set up the Lease Subvention Plans screen.

1. On the Oracle Financial Services Lending and Leasing home screen, Click Setup >
Setup > Products > Subvention > Lease.

2. The system displays the Lease Subvention screen. The details are grouped into three.
e Plan Definition
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3.

Sub Plan Definition
Plan Details.

Navigation chapter.

ORACLE'

Financial Services Lending and Leasing

In the Plan Definition section, perform any of the Basic Operations mentioned in
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A brief description of the fields is given below:

About

Field:

Do this:

Code

Specify the subvention plan code.

Description

Specify the subvention plan description.

Company

Select the company name from the drop-down |

ist.

Branch

Select the branch name from the drop-down list.

State

Select the state from the drop-down list.

Start Date

the date even from the adjoining Calendar icon.

Specify the start date for the subvention plan (required). You can select

End Date

even from the adjoining Calendar icon.

Specify the end date for the subvention plan. You can select the date

Enabled

Check this box to activate the record.

Selection Criteria

Billing Cycle

Select billing cycle from the drop-down list.

Product

Select the product from the drop-down list.

Asset Class

Select the asset class from the drop-down list.
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Field:

Do this:

Asset Type Select the asset type from the drop-down list.
Asset Sub Select asset sub type from the drop-down list.
Type

Asset Make Select asset make from the drop-down list.
Asset Model Select the asset model from the drop-down list.
Asset Age Specify the asset age.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
5.

In the Sub Plan Definition section, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Code Specify the subvention sub plan code.

Description Specify the subvention sub plan description (required).
State Select the state from the drop-down list.

Pro Group Select the producer group from the drop-down list.
Pro Type Select the producer type from the drop-down list.
Producer Select the producer from the drop-down list.
Enabled Check this box to activate the record.

AmtFrom Specify the amount.

Subvention Select the subvention type from the drop-down list.
Type

Grade Select the grade from the drop-down list.

Term Specify the term.

Asset Class Select the asset class from the drop-down list.
Asset Type Select the asset type from the drop-down list.

Sub Type Select asset sub type from the drop-down list
AssetMake Select asset make from the drop-down list.
AssetModel Select the asset model from the drop-down list
Age Specify asset age.

6. Perform any of the Basic Actions mentioned in Navigation chapter.
7.

chapter.
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A brief description of the fields is given below:

Field:

Do this:

Participant

Select the participant from the drop-down list.

Collection Method

Select the collection method for the subvention plan from the
drop-down list.

Transaction Select the transaction code from the drop-down list.
Rate Specify the subvention rate.
Enabled Check this box to activate the record.

Calculation section:

Method

Select the subvention calculation method from the drop-down
list. The list displays the following values:

- SPREAD DEFAULT

- SPREAD DEFAULT - (minus) PRESENT VALUE

- FLAT AMOUNT

- % OF CAPITALIZATION COST GROSS

- % of CAPITALIZATION COST GROSS + FLAT AMOUNT

Override

Check this box to allow overriding the rate at the time of under-
writing / funding.

Max Amt

Specify the maximum subvention amount.

% Capitalized Cost

Specify the percentage of capitalized cost to derive the Subven-
tion Amount.

For example: If Capitalized Cost = 100$, and % of Capitalized
Cost = 5%, then the Subvention Amount = 100 * 0.05 = 5%

Flat Amt Specify the flat amount.
Factor Specify the subvention factor.
Spread Max Specify the maximum subvention spread value.

Refund section:

Paid Off Method

Select the method from the drop-down list, if the account is paid-
off early.

Paid Off Basis

Select the basis from the drop-down list, if the account is paid-off
early.

Paid Off Period

Specify the number of terms in which the subvention can be
refunded to the producer, if the account is paid-off early.

Paid Off Percent

Specify the refund percentage, if the account is paid-off.

Charge Off Calc
Method

Select the calculation method from the drop-down list, if the
account is charged-off.

4-72

ORACLE



Field: Do this:

Charge Off Basis Select the charge off basis from the drop-down list.

Charge Off Period Select the charge off period from the drop-down list.

Charge Off Percent | Select the charge off percent from the drop-down list.

Amortization section:

Balance Type Select the amortize balance type from the drop-down list.
Method Select the amortize method from the drop-down list.
Frequency Select the amortize frequency from the drop-down list.
Cost/ Fee Select the cost / fee from the drop-down list.

Perform any of the Basic Actions mentioned in Navigation chapter.
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Appendix A: Summary of the Application Scoring

A.1

A.2

A.21
A.2.11

A.2.1.2

A21.3

Glossary

Parameters

Term Description

DEROG / DEROGATORY Account has had chargeoffs, collections, bankruptcy, or
repossession.

MINOR DELINQUENCY Less than or equal to 60 days delinquent.

MAJOR DELINQUENCY Greater than 60 days delinquent.

DEBT RATIO Debt / Available credit.

DEBT TO INCOME RATIO | Debt/Income.

“APPLICANT STATED”

Parameter is pulling information stated or in any other way
provided by the applicant on the application on the Applica-
tion Entry form in the system.

“APPLICANT CREDIT Parameter is pulling information from the credit bureau, as

BUREAU” opposed to another source, such as the Application Entry
form.

LOAN FINANCE Refers to companies that provide the loan but are not sell-
ing the actual object financed, if any.
Example: An independent auto finance company.

SALES FINANCE Refers to companies that provide the object being financed

in addition to the financing.

Example: Marshall Fields card.

Scoring Parameters by Category

Applicant Details / Debt Ratios

Applicant Credit Bureau Auto Debt Ratio

This is the sum of all automobile type loan balances and the sum of all automobile type credit
limits. For installment loan, the credit limit is normally equal to the original loan amount. This

applies to open tradelines only.

Applicant Credit Bureau Bank Debt Ratio

This is the sum of all bank type loan balances and the sum of all bank type credit limits. For
installment , the credit limit is normally equal to the original loan amount. This applies to open

tradelines only.

Applicant Credit Bureau Card Debt Ratio

This is the sum of all travel card type loan balances and the sum of all travel card type credit
limits. This applies to open tradelines only.
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A214

A.21.5

A.2.1.6

A.21.7

A.2.1.8

A.21.9

A.2.1.10

A.2.1.11

A.2.1.12

A.2.1.13

Applicant Credit Bureau Debt Ratio

This parameter provides a value for all debt divided by all available credit as shown on the
bureau.

Applicant Credit Bureau FICO Score

This is the FICO score provided for the applicant in the bureau pull. There are usually several
different types of FICO scores available at the bureau. The different score models are set up
to give certain attributes different, weighting based on if the person is buying a car, or a house,
and so on. The type of FICO score pulled is based on credit bureau setup.

Applicant Credit Bureau Inst Debt Ratio

This is the sum of all installment loan balances and the sum of all installment loan credit limits.
For installment loan, the credit limit is normally equal to the original loan amount. This applies
to open tradelines only.

Applicant Credit Bureau Loan Fin Debt Ratio

This is the sum of all loan finance type lease balances and the sum of all loan finance type
credit limits. For installmentloan lease, the credit limit is normally equal to the original loan
amount. This applies to open tradelines only.

Applicant Credit Bureau Mortgage Debt Ratio

This is the sum of all mortgage type loan balances and the sum of all mortgage type credit
limits. For installment loan, the credit limit is normally equal to the original loan amount. This
applies to open tradelines only.

Applicant Credit Bureau Open Public Records

This parameter indicates if there are any open public records in the credit bureau associated
with the applicant. This is a numeric counter covering the full period of time available in the
bureau.

Applicant Credit Bureau Public Records

This parameter indicates, if there are any public records, open or closed, in the credit bureau
associated with the applicant. This is a numeric counter covering the full period of time
available in the bureau.

Applicant Credit Bureau Retail Debt Ratio

This is the sum of all retail type loan balances divided by the sum of all retail type credit limits.
For installment loan, the credit limit is normally equal to the original loan amount. This applies
to open tradelines only. This is expressed as a percent: 50% shows as 50.

Applicant Credit Bureau Rev Debt Ratio

This is the sum of all revolving type loan balances and the sum of all revolving type credit
limits. This applies to open tradelines only. This is expressed as a percent: 50% shows as 50.

Applicant Credit Bureau Sales Fin Debt Ratio

This is the sum of all sales finance type loan balances and the sum of all sales finance type
credit limits. For installment loan, the credit limit is normally equal to the original loan amount.
This applies to open tradelines only. This is expressed as a percent: 50% shows as 50.
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A.2.1.14

A.2.1.15

A.2.1.16

A.2.1.17

A.2.1.18

A.2.1.19

A.2.1.20

A.2.1.21

A.2.1.22

Applicant Debt Ratio Stated After Requested Loan Amount

This is the debt divided by available credit based on the values stated by the applicant after
factoring in the requested loan amount- this information is not taken from the bureau. This is
expressed as a percent: 50% shows as 50.

Applicant Debt Ratio Stated Before Requested Loan Amount

This is the debt divided by available credit based on the values stated by the applicant before
factoring in the requested loan amount- this information is not taken from the bureau. This is
expressed as a percent: 50% shows as 50.

Applicant Debt To Income Ratio Stated After Requested Loan Amount

This is the debt divided by income based on the values stated by the applicant after factoring
in the requested loan amount- this information is not taken from the bureau. This is expressed
as a percent: 50% shows as 50.

Applicant Debt To Income Ratio Stated Before Requested Loan Amount

This is the debt divided by income based on the values stated by the applicant before factoring
in the requested loan amount- this information is not taken from the bureau. This is expressed
as a percent: 50% shows as 50.

Applicant Payment To Income Ratio Stated

This is the total amount of all monthly payments divided by monthly income. These values are
stated by the applicant and not taken from the bureau. This is expressed as a percent: 50%
shows as 50.

Applicant Prior Customer

This parameter indicates whether the applicant is a prior customer. It is populated when the
application is passed to Underwriting for a decision. If the SSN given by the applicant already
exists then the applicant is marked as a prior customer and the parameter value is Y (Yes).

Applicant Revolving Debt Ratio Stated

This is the sum of all revolving type loan amount balances / sum of all revolving type credit
limits. This applies to open tradelines only. This is expressed as a percent: 50% shows as 50.

Applicant Stated Employment Period (In Months)

This parameter looks at the number of months of stated employment for the most recently
entered current employment.

For example, the applicant states that she has been working at her current place of
employment for 3 years and 5 months. This parameter would be populated with (3years * 12
months/year) + 5 months which calculates to 41 stated months. If the applicant enters another
current employment and enters 1 year and 2 months then this parameter will be populated
with 14 months, even though the other employment is still current.

Applicant Stated Monthly Income

This is the monthly income stated by the applicant on the application. It combines the income
for all employment marked as “current” in the system. If the income is stated as anything other
than monthly, the income will be converted to monthly for this parameter.
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A.2.1.23

A.2.1.24

A.2.2
A.2.21

A.2.2.2

A.2.3
A.2.31

A.2.3.2

A.2.3.3

A234

A.23.5

A.2.3.6

For example, the applicant states that he is paid $50,000 with a frequency of ANNUALLY.
This parameter is populated with $50,000/12, which calculates to $4166.67 stated monthly
income.

Applicant Stated Monthly Liability

This is the stated monthly liability as provided by the applicant on the Application Entry
screen.

Applicant Stated Residence Period (In Months)

This parameter looks at the stated residence period for the most recent current address.

Loan Details

Approximate Cash Price

This is the Approximate Cash price taken from the “Approx Price” field on the Application
Entry form’s Loan screen in the system.

Requested Advance Amount

This is the Requested Advance Amount value taken from the Application Entry form’s Loan
screen in the system.

Auto Trades / Inquiries

Applicant Credit Bureau 6month Auto Trades

This is the number of auto trades that have been opened in the last 6 months. Note that these
trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau 12month Auto Trades

This is the number of auto trades that have been opened in the last 12 months. Note that
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so
on.

Applicant Credit Bureau 24month Auto Trades

This is the number of auto trades that have been opened in the last 24 months. Note that
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so
on.

Applicant Credit Bureau Auto Inquries

This is the number of automobile-related credit inquiries the have been made to the bureau.

Applicant Credit Bureau Auto Trades

This is the number of auto trades, both open and closed. Note that these trades may be paid
as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

Applicant Credit Bureau Current Auto Trades

Total number of auto trades that are paid on time right now. These trades may or may not
have been delinquent in the past.
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A.2.3.7

A.2.3.8

A.2.3.9

A24
A.2.41

A.2.4.2

A.2.43

A244

Applicant Credit Bureau Open Auto Trades

This is the number of open auto trades on the account. Note that these trades may be paid
as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

Applicant Credit Bureau Satisfactory Auto

Total number of auto trades paid as agreed (no delinquencies) for the entire life of the trade.
This could be a few months or several years- the parameter makes no distinction.

Applicant Credit Bureau Worst Auto Trade

The rating code used for this parameter is the same rating code system displayed for the
tradelines. The different bureaus use different systems so Oracle Financial Services Lending
and Leasing changes them to a common format that is used in the scoring:

1 = current

2 = 30-59 days late

3 = 60-89 days late

4 =90-119 days late

5 = 120-149 days late

6 = 150- days late

7 = involved in a bankruptcy

8 = repossession, foreclosure

9 = charge-off

Bank Trades / Inquiries

Applicant Credit Bureau 12month Bank Trades

This is the number of bank trades that have been opened in the last 12 months. Note that
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so
on.

Applicant Credit Bureau 24month Bank Trades

This is the number of bank trades that have been opened in the last 24 months. Note that
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so
on.

Applicant Credit Bureau 6month Bank Trades

This is the number of bank trades that have been opened in the last 6 months. Note that these
trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau Bank Inquiries

This is the number of bank inquiries against the bureau in the applicant's recorded bureau
history.
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A.2.4.5

A.2.4.6

A.2.4.7

A.2.4.38

A.2.4.9

A.2.410

A.2.4.11

Applicant Credit Bureau Bank Trades

This is the number of open bank trades on the account. Note that bank trades can be
considered a sub type to installment, mortgage, and / or revolving loan.

Applicant Credit Bureau Bank Trades

Total number of bank trades that are paid on time right now. These trades may or may not
have been delinquent in the past.

Applicant Credit Bureau Bank Trades

This is the number of bank trades that are open right now. Note that these trades may now
be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau Bank Trades

This parameter shows the “current” revolving bank balance. If the revolving credit is owned
by a bank, then it will show up here.

Applicant Credit Bureau Bank Trades

This parameter shows the highest cumulative balance among all revolving bank credit over
the bureau history.

NOTE

If the applicant had $5,000 on one account 2 years ago and $10,000 on another account
4 years ago, this parameter would return $15,000. The parameter is of questionable utility
in many situations.

Applicant Credit Bureau Bank Trades

Total number of bank trades paid as agreed (no delinquencies) for the entire life of the trade.
This could be a few months or several years- the parameter makes no distinction.

Applicant Credit Bureau Bank Trades

The rating code used for this parameter is the same rating code system displayed for the
tradelines. The different bureaus use different systems so Oracle Financial Services Lending
and Leasing changes them to a common format that is used in the scoring:

1 = current

2 = 30-59 days late

3 = 60-89 days late

4 =90-119 days late

5 = 120-149 days late

6 = 150- days late

7 = involved in a bankruptcy

8 = repossession, foreclosure
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A.2.5
A.2.51

A.2.5.2

A.2.5.3

A.2.54

A.2.5.5

A.2.5.6

A.2.5.7

A.2.5.8

A.2.5.9

9 = charge-off

Card Trades / Inquiries

Applicant Credit Bureau Bank Trades

This is the number of card trades that have been opened in the last 12 months. Note that
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so
on.

Applicant Credit Bureau Bank Trades

This is the number of card trades that have been opened in the last 24 months. Note that
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so
on.

Applicant Credit Bureau Bank Trades

This is the number of card trades that have been opened in the last 6 months. Note that these
trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau Bank Trades

This is the number of card inquiries that have been made against the bureau for the applicant
in the bureau's recorded history.

Applicant Credit Bureau Card Trades

This is the number of card trades, both open and closed, in the bureau history. Note that these
trades may be paid as agreed, delinquent, derogatory, and so on. The parameter makes no
distinction.

Applicant Credit Bureau Current Card Trades

Total number of card trades that are paid on time right now. These trades may or may not
have been delinquent in the past.

Applicant Credit Bureau Open Card Trades

This is the number of open card trades on the account. Note that these trades may be paid
as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

Applicant Credit Bureau Satisfactory Card

Total number of card trades paid as agreed (no delinquencies) for the entire life of the trade.
This could be a few months or several years- the parameter makes no distinction.

Applicant Credit Bureau Worst Card Trade

The rating code used for this parameter is the same rating code system displayed for the
tradelines. The different bureaus use different systems so Oracle Financial Services Lending
and Leasing changes them to a common format that is used in the scoring:

1 = current

2 = 30-59 days late

3 = 60-89 days late
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A.2.6
A.2.6.1

A.2.6.2

A.2.6.3

A.2.6.4

A.2.6.5

A.2.6.6

A.2.6.7

A.2.6.8

4 =90-119 days late

5 = 120-149 days late

6 = 150- days late

7 = involved in a bankruptcy
8 = repossession, foreclosure
9 = charge-off

Installment Trades / Inquiries

Applicant Credit Bureau 12month Inst Trades

This is the number of installment trades that have been opened in the last 12 months. Note
that these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and
so on.

Applicant Credit Bureau 24month Inst Trades

This is the number of installment trades that have been opened in the last 24 months. Note
that these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and
so on.

Applicant Credit Bureau 6month Inst Trades

This is the number of installment trades that have been opened in the last 6 months. Note that
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so
on.

Applicant Credit Bureau Current Inst Trades

Total number of installment trades that are paid on time right now. These trades may or may
not have been delinquent in the past.

Applicant Credit Bureau Inst Trades

This is the number of installment trades, both open and closed. Note that these trades may
be paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

Applicant Credit Bureau Open Inst Trades

This is the number of open installment trades on the account. Note that these trades may be
paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

Applicant Credit Bureau Satisfactory Inst Trades

Total number of installment trades paid as agreed (no delinquencies) for the entire life of the
trade. This could be a few months or several years- the parameter makes no distinction.

Applicant Credit Bureau Worst Inst Trade

The rating code used for this parameter is the same rating code system displayed for the
tradelines. The different bureaus use different systems so Oracle Financial Services Lending
and Leasing changes them to a common format that is used in the scoring:

1 = current
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A.2.7
A.2.71

A.2.7.2

A.2.7.3

A2.74

A.2.7.5

A.2.7.6

A.2.7.7

2 = 30-59 days late

3 = 60-89 days late

4 =90-119 days late

5 = 120-149 days late

6 = 150- days late

7 = involved in a bankruptcy
8 = repossession, foreclosure
9 = charge-off

Loan Finance Trades / Inquiries

Applicant Credit Bureau 12month Loan Fin Trades

This is the number of loan finance trades that have been opened in the last 12 months. Note
that these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and
so on.

Applicant Credit Bureau 24month Loan Fin Trades

This is the number of loan finance trades that have been opened in the last 24 months. Note
that these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and
so on.

Applicant Credit Bureau 6month Loan Fin Trades

This is the number of loan finance trades that have been opened in the last 6 months. Note
that these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and
So on.

Applicant Credit Bureau Current Loan Fin Trades

Total number of loan finance trades that are paid on time right now. These trades may or may
not have been delinquent in the past.

Applicant Credit Bureau Loan Fin Trades

This is the number of loan finance trades, both open and closed. Note that these trades may
be paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

Applicant Credit Bureau Loan Finance Inquiries

This is the number of finance inquires listed on the credit report. The bureaus have their own
limits as to how long they keep an inquiry on the credit report, but this parameter will show
whatever total is shown for that bureau.

Applicant Credit Bureau Open Loan Finance Trades

This is the number of open loan finance trades on the account. Note that these trades may be
paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.
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A.2.7.8

A.2.7.9

A.2.8
A.2.8.1

A.2.8.2

A.2.8.3

A.2.8.4

A.2.8.5

Applicant Credit Bureau Satisfactory Loan Fin

Total number of loan finance trades paid as agreed (no delinquencies) for the entire life of the
trade. This could be a few months or several years- the parameter makes no distinction.

Applicant Credit Bureau Worst Loan Fin Trade

The rating code used for this parameter is the same rating code system displayed for the
tradelines. The different bureaus use different systems so Oracle Financial Services Lending
and Leasing changes them to a common format that is used in the scoring:

1 = current

2 = 30-59 days late

3 = 60-89 days late

4 =90-119 days late

5 =120-149 days late

6 = 150- days late

7 = involved in a bankruptcy

8 = repossession, foreclosure

9 = charge-off

Mortgage Trades / Inquiries

Applicant Credit Bureau 12month Mortgage Trades

This is the number of mortgage trades that have been opened in the last 12 months. Note that
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so
on.

Applicant Credit Bureau 24month Mortgage Trades

This is the number of mortgage trades that have been opened in the last 24 months. Note that
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so
on.

Applicant Credit Bureau 6month Mortgage Trades

This is the number of mortgage trades that have been opened in the last 6 months. Note that
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so
on.

Applicant Credit Bureau Current Mortgage Trades

Total number of mortgage trades that are paid on time right now. These trades may or may
not have been delinquent in the past.

Applicant Credit Bureau Mortgage Trades

This is the total number of mortgage trades, both open and closed. Note that these trades may
be paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.
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A.2.8.6

A.2.8.7

A.2.8.8

A.2.9
A.2.91

A.2.9.2

A.2.9.3

A.294

Applicant Credit Bureau Open Mortgage Trades

This is the number of open mortgage trades on the account. Note that these trades may be
paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

Applicant Credit Bureau Satisfactory Mortgage

Total number of mortgage trades paid as agreed (no delinquencies) for the entire life of the
trade. This could be a few months or several years- the parameter makes no distinction.

Applicant Credit Bureau Worst Mortgage Trade

The rating code used for this parameter is the same rating code system displayed for the
tradelines. The different bureaus use different systems so Oracle Financial Services Lending
and Leasing changes them to a common format that is used in the scoring:

1 = current

2 = 30-59 days late

3 = 60-89 days late

4 =90-119 days late

5 = 120-149 days late

6 = 150- days late

7 = involved in a bankruptcy

8 = repossession, foreclosure

9 = charge-off

Retail Trades / Inquiries

Applicant Credit Bureau 12month Retail Trades

This is the number of retail trades that have been opened in the last 12 months. Note that
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so
on.

Applicant Credit Bureau 24month Retail Trades

This is the number of retail trades that have been opened in the last 24 months. Note that
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so
on.

Applicant Credit Bureau 6month Retail Trades

This is the number of retail trades that have been opened in the last 6 months. Note that these
trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau Current Retail Trades

Total number of retail trades that are paid on time right now. These trades may or may not
have been delinquent in the past.
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A.2.9.5

A.2.9.6

A.2.9.7

A.2.9.8

A.2.9.9

A.210
A.2.10.1

A.2.10.2

Applicant Credit Bureau Open Retail Trades

This is the number of open retail trades on the account. Note that these trades may be paid
as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

Applicant Credit Bureau Retail Inquiries

This is the number of retail inquires listed on the credit report. The bureaus have their own
limits as to how long they keep an inquiry on the credit report, but this parameter will show
whatever total is shown for that bureau.

Applicant Credit Bureau Retail Trades

This is the number of retail trades, both open and closed. Note that these trades may be paid
as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

Applicant Credit Bureau Satisfactory Retail

Total number of retail trades paid as agreed (no delinquencies) for the entire life of the trade.
This could be a few months or several years- the parameter makes no distinction.

Applicant Credit Bureau Worst Retail Trade

The rating code used for this parameter is the same rating code system displayed for the
tradelines. The different bureaus use different systems so Oracle Financial Services Lending
and Leasing changes them to a common format that is used in the scoring:

1 = current

2 = 30-59 days late

3 = 60-89 days late

4 =90-119 days late

5 =120-149 days late

6 = 150- days late

7 = involved in a bankruptcy

8 = repossession, foreclosure

9 = charge-off

Revolving Trades

Applicant Credit Bureau 12month Rev Trades

This is the number of revolving trades that have been opened in the last 12 months. Note that
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so
on.

Applicant Credit Bureau 24month Rev Trades

This is the number of revolving trades that have been opened in the last 24 months. Note that
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so
on.
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A.2.10.3 Applicant Credit Bureau 6month Rev Trades

This is the number of revolving trades that have been opened in the last 6 months. Note that
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so
on.

A.2.10.4 Applicant Credit Bureau Current Rev Trades

Total number of revolving trades that are paid on time right now. These trades may or may
not have been delinquent in the past.

A.2.10.5 Applicant Credit Bureau Open Rev Trades

This is the number of open revolving trades on the account. Note that these trades may be
paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

A.2.10.6 Applicant Credit Bureau Rev Balance

This is the total revolving credit balance shown on the applicant's credit bureau. This applies
to all open revolving trades.

A.2.10.7 Applicant Credit Bureau Rev High Balance

This parameter shows the highest cumulative balance among all revolving credit over the
bureau history.

NOTE

If the applicant had $5,000 on one account 2 years ago and $10,000 on another account
4 years ago, this parameter would return $15,000. The parameter is of questionable utility
in many situations.

A.2.10.8 Applicant Credit Bureau Rev Retail Balance

This is the current revolving retail trade balance shown on the applicant's credit bureau. This
applies to all open retail trades. It shows current, not historical, information.

A.2.10.9 Applicant Credit Bureau Rev Retail High Balance

This parameter shows the highest cumulative balance among all revolving retail credit over
the bureau history.

Note

If the applicant had $5,000 on one account 2 years ago and $10,000 on another account
4 years ago, this parameter would return $15,000. The parameter is of questionable utility
in many situations.

A.2.10.10 Applicant Credit Bureau Rev Trades

This is the number of revolving trades, both open and closed. Note that these trades may be
paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

A.2.10.11 Applicant Credit Bureau Satisfactory Rev Trades

Total number of revolving trades paid as agreed (no delinquencies) for the entire life of the
trade. This could be a few months or several years- the parameter makes no distinction.
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A.2.10.12 Applicant Credit Bureau Worst Rev Trade

A.211
A.2111

The rating code used for this parameter is the same rating code system displayed for the
tradelines. The different bureaus use different systems so Oracle Financial Services Lending
and Leasing changes them to a common format that is used in the scoring:

1 = current

2 = 30-59 days late

3 = 60-89 days late

4 =90-119 days late

5 = 120-149 days late

6 = 150- days late

7 = involved in a bankruptcy

8 = repossession, foreclosure

9 = charge-off

Sales Finance Trades / Inquiries

Applicant Credit Bureau 12month Sales Fin Trades

This is the number of sales finance trades that have been opened in the last 12 months. Note
that these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and
so on.

A.2.11.2 Applicant Credit Bureau 24month Sales Fin Trades

This is the number of sales finance trades that have been opened in the last 24 months. Note
that these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and
so on.

A.2.11.3 Applicant Credit Bureau 6month Sales Fin Trades

This is the number of sales finance trades that have been opened in the last 6 months. Note
that these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and
so on.

A.2.11.4 Applicant Credit Bureau Current Sales Fin Trades

Total number of sales finance trades that are paid on time right now. These trades may or
may not have been delinquent in the past.

A.2.11.5 Applicant Credit Bureau Open Sales Finance Trades

This is the number of open sales finance trades on the account. Note that these trades may
be paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

A.2.11.6 Applicant Credit Bureau Sales Fin Trades

This is the number of sales finance trades, both open and closed. Note that these trades may
be paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.
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A.211.7

A.2.11.8

A.2.11.9

A.2.12
A.2.12.1

A.2.12.2

A.2123

A.2.12.4

Applicant Credit Bureau Sales Finance Inquiries

This is a count of the number of sales finance inquiries that have been made against the
Applicant's bureau information in the bureau history.

Applicant Credit Bureau Satisfactory Sales Fin

Total number of sales finance trades paid as agreed (no delinquencies) for the entire life of
the trade. This could be a few months or several years- the parameter makes no distinction.

Applicant Credit Bureau Worst Sales Fin Trade

The rating code used for this parameter is the same rating code system displayed for the
tradelines. The different bureaus use different systems so Oracle Financial Services Lending
and Leasing changes them to a common format that is used in the scoring:

1 = current

2 = 30-59 days late

3 = 60-89 days late

4 =90-119 days late

5 = 120-149 days late

6 = 150- days late

7 = involved in a bankruptcy

8 = repossession, foreclosure

9 = charge-off

Other Trades

Applicant Credit Bureau 12month Trades

This is the number of all trades that have been opened in the last 12 months. Note that these
trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau 24month Trades

This is the number of all trades that have been opened in the last 24 months. Note that these
trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau 6month Trades

This is the number of all trades that have been opened in the last 6 months. Note that these
trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau Avg Open Trade Age

This is the average trade age in months as calculated using all open trades in the bureau. This
is based on taking all of the open tradelines, then dividing by the age.
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A.2.12.5 Applicant Credit Bureau Avg Trade Age

This is the average trade age in months as calculated using all trades, open and closed, in
the bureau.

A.2.12.6 Applicant Credit Bureau Chargeoff Trades

This parameter is a count of the total number of charged off trades for that applicant in the
bureau.

A.2.12.7 Applicant Credit Bureau Collections

This is the total number of trades in collections for that applicant in the credit bureau. This
refers to accounts assigned to collections agencies.

A.2.12.8 Applicant Credit Bureau Current Trades

This is the total number of trades that are paid on time right now. These trades may or may
not have been delinquent in the past.

A.2.12.9 Applicant Credit Bureau Inquiries

This is the number of inquires listed on the credit report. The bureaus have their own limits as
to how long they keep an inquiry on the credit report, but this parameter will show whatever
total is shown for that bureau.

A.2.12.10 Applicant Credit Bureau Inquiries 12m

This is the total number of inquiries that have been made against the credit bureau for that
applicant in the last 12 months

A.2.12.11 Applicant Credit Bureau Inquiries 24m

This is the total number of inquiries that have been made against the credit bureau for that
applicant in the last 24 months

A.2.12.12 Applicant Credit Bureau Inquiries 6m

This is the total number of inquiries that have been made against the credit bureau for that
applicant in the last 6 months

A.2.12.13 Applicant Credit Bureau Judgments

This is a count of the number of judgments against the applicant in the credit bureau.

A.2.12.14 Applicant Credit Bureau Liens

This is the total number of liens shown for the applicant in the credit bureau for that applicant.

A.2.12.15 Applicant Credit Bureau Newest Inquiry

This is the number of months since the most recent inquiry in the credit bureau for that
applicant. This of course excludes the pull from the immediate past used to do the scoring in
this particular situation in the system.

A.2.12.16 Applicant Credit Bureau Newest Trade

This is the number of months between now and the newest trade in the bureau for that
applicant.
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A.2.12.17 Applicant Credit Bureau Oldest Inquiry

This is the number of months between now and the oldest inquiry in the bureau for that
applicant.

A.2.12.18 Applicant Credit Bureau Oldest Trade

This is the number of months between now and the oldest trade in the bureau for that
applicant. Oldest is determined by looking at the oldest date on any tradeline, and then
showing that.

A.2.12.19 Applicant Credit Bureau Open Collection Trades

This is the number of open trades in collections shown in the bureau for that applicant. This
refers to any accounts assigned to in-house collections departments (as compared to 5.12.7).

A.2.12.20 Applicant Credit Bureau Open Collections

This is the number of open collections in the bureau for that applicant.

A.2.12.21 Applicant Credit Bureau Open Judgments

This is the total number of open (unsatisfied) judgments against the applicant as indicated in
the bureau for that applicant.

A.2.12.22 Applicant Credit Bureau Open Liens

This is the total number of open liens against the applicant as indicated in the bureau for that
applicant.

A.2.12.23 Applicant Credit Bureau Open Trades

This is the number of all open auto trades on the account. Note that these trades may be paid
as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

A.2.12.24 Applicant Credit Bureau Past Due 30

This is the number of trades that have been 30 or more days past due at some point in the
recorded history of the bureau. Note that these trades may be delinquent, derogatory, and so
on. The parameter makes no distinction.

A.2.12.25 Applicant Credit Bureau Past Due 30 12m

This is the number of trades that have been more than 30 days past due in the last 12 months.
The past dues could be for the same or different trades. If one trade has been late 3 times,
this parameter would show 1 if there are no other trades.

A.2.12.26 Applicant Credit Bureau Past Due 30 24m

This is the number of times the applicant has been more than 30 days past due in the last 24
months. The past dues could be for the same or different trades. If one trade has been late 3
times, this parameter would show 1 if there are no other trades.

A.2.12.27 Applicant Credit Bureau Past Due 60

This is the number of times the applicant has been more than 60 days past due in the
recorded history of the bureau. The past dues could be for the same or different trades. If one
trade has been late 3 times, this parameter would show 1 if there are no other trades.
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A.2.12.28 Applicant Credit Bureau Past Due 60 12m

This is the number of times the applicant has been more than 60 days past due in the last 12
months. The past dues could be for the same or different trades. If one trade has been late 3
times, this parameter would show 1 if there are no other trades.

A.2.12.29 Applicant Credit Bureau Past Due 60 24m

This is the number of times the applicant has been more than 60 days past due in the last 24
months. The past dues could be for the same or different trades. If one trade has been late 3
times, this parameter would show 1 if there are no other trades.

A.2.12.30 Applicant Credit Bureau Past Due 90

This is the number of trades that are 90 or more days past due in the recorded history of the
bureau. Note that these trades may be delinquent, derogatory, and so on. The parameter
makes no distinction that one trade has been late 3 times; this parameter would show 1 if
there are no other trades. If one trade has been late 3 times, this parameter would show 1 if
there are no other trades.

A.2.12.31 Applicant Credit Bureau Past Due 90 12m

This is the number of times the applicant has been more than 90 days past due in the last 12
months. The past dues could be for the same or different trades. If one trade has been late 3
times, this parameter would show 1 if there are no other trades.

A.2.12.32 Applicant Credit Bureau Past Due 90 24m

This is the number of times the applicant has been more than 90 days past due in the last 24
months. The past dues could be for the same or different trades. If one trade has been late 3
times, this parameter would show 1 if there are no other trades.

A.2.12.33 Applicant Credit Bureau Past Due Now

This is the number of trades on which the applicant is currently past due, according to the
bureau.

A.2.12.34 Applicant Credit Bureau Repossessions

This is the number of repossessions shown on the bureau for the applicant in the history of
the bureau.

A.2.12.35 Applicant Credit Bureau Satisfactory Trades

This is the total number of trades of all types, paid as agreed (no delinquencies) for the entire
life of the trade. This could be a few months or several years- the parameter makes no
distinction.

A.2.12.36 Applicant Credit Bureau Too New Trades

This shows the number of trades that have been reported where a lender is reporting a brand
new account, but has not even billed the applicant yet.

A.2.12.37 Applicant Credit Bureau Trade Collections

This is the number of trades in collections assigned to collections agencies shown on the
bureau for the applicant in the history of the bureau.
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A.2.12.38 Applicant Credit Bureau Trades

This is the number of trades in the history of the credit bureau for that applicant. Note that
different bureaus store information for varying amounts of time.

A.2.12.39 Applicant Credit Bureau Worst Trades

A.213
A.2.13.1

A.2.13.2

A.2.13.3

A.2.13.4

A.2.13.5

The rating code used for this parameter is the same rating code system displayed for the
tradelines. The different bureaus use different systems so Oracle Financial Services Lending
and Leasing changes them to a common format that is used in the scoring:

1 = current

2 = 30-59 days late

3 = 60-89 days late

4 =90-119 days late

5 =120-149 days late

6 = 150- days late

7 = involved in a bankruptcy

8 = repossession, foreclosure

9 = charge-off

Bankruptcy information

Applicant Credit Bureau 11 Bankruptcies

This parameter provides a count of the number of Chapter 11 Bankruptcies the applicant has
filed in the stored history of the bureau.

Applicant Credit Bureau 13 Bankruptcies

This parameter provides a count of the number of Chapter 13 Bankruptcies the applicant has
filed in the stored history of the bureau.

Applicant Credit Bureau 7 Bankruptcies

This parameter provides a count of the number of Chapter 7 Bankruptcies the applicant has
filed in the stored history of the bureau.

Applicant Credit Bureau Bankruptcies

This parameter provides a count of the number of bankruptcies of any type the applicant has
filed in the stored history of the bureau.

Applicant Credit Bureau Bkrp Score

The bureaus offer two basic types of scores, a FICO type, and a bankruptcy type. The term
FICO score is sometimes used as a generic term for a credit score, but it is supposed to mean
that the score is based on an algorithm purchased or licensed from Fair Isaac Corp. In the
system, if a score is listed as a FICO score, it is based on a Fair Isaac model. A bankruptcy
score is a score that is used to predict the likelihood of a consumer to file bankruptcy. It is
provided much like a FICO score.
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A.2.13.6 Applicant Credit Bureau Open 11 Bankruptcies

This parameter provides a count of the number of open Chapter 11 Bankruptcies associated
with the applicant in the bureau.

A.2.13.7 Applicant Credit Bureau Open 13 Bankruptcies

This parameter provides a count of the number of open Chapter 13 Bankruptcies associated
with the applicant in the bureau.

A.2.13.8 Applicant Credit Bureau Open 7 Bankruptcies

This parameter provides a count of the number of open Chapter 7 Bankruptcies associated
with the applicant in the bureau.

A.2.13.9 Applicant Credit Bureau Open Bankruptcies

This parameter provides a count of the number of bankruptcies of any type the applicant X
has open currently.

A.2.13.10 Applicant Credit Bureau Recent 11 Bankruptcy

For this parameter, “Recent” refers to the number of months since the subject's most recent
bankruptcy filing. One would use this parameter to determine if the subject has filed for
Chapter 11 bankruptcy in the last X months.

A.2.13.11 Applicant Credit Bureau Recent 13 Bankruptcy

For this parameter, “Recent” refers to the number of months since the subject's most recent
bankruptcy filing. One would use this parameter to determine if the subject has filed for
Chapter 13 bankruptcy in the last X months.

A.2.13.12 Applicant Credit Bureau Recent 7 Bankruptcy

For this parameter, “Recent” refers to the number of months since the subject's most recent
bankruptcy filing. One would use this parameter to determine if the subject has filed for
Chapter 7 bankruptcy in the last X months.

A.2.13.13 Applicant Credit Bureau Recent Bankruptcy

For this parameter, “Recent” refers to the number of months since the subject's most recent
bankruptcy filing. One would use this parameter to determine if the subject has filed for any
kind of bankruptcy in the last X months.

A.2.13.14 Applicant Has A Prior Bankruptcy

This parameter tracks whether the applicant has indicated a prior bankruptcy based on the
checkbox in the the system’s Origination module. The prior bankruptcy is setto Y if the
checkbox is checked otherwise it has a value of N.

A.2.14 Delinquency Information

A.2.14.1 Applicant Credit Bureau Longest Since Major

This parameter reflects the longest period (in months) a tradeline has been open since the
last derog.
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A.2.14.2

A.2.14.3

A.2.14.4

A.2.14.5

A.2.14.6

A.2.14.7

A.2.14.8

A.215
A.2.15.1

A.2.15.2

A.2.15.3

Applicant Credit Bureau Longest Since Minor

This parameter reflects the longest period (in months) a tradeline has been open since the
last minor delinquency.

Applicant Credit Bureau Open Longest Since Major

This parameter considers the greatest amount of time (in months) between now and the
corresponding major delinquency for all of the open parameters with major delinquencies, and
reflects the greatest value returned.

Applicant Credit Bureau Open Longest Since Minor

This parameter considers the greatest amount of time (in months) between now and the
corresponding minor delinquency for all of the open parameters with minor delinquencies, and
reflects the greatest value returned.

Applicant Credit Bureau Open Shortest Since Major

This parameter considers the least amount of time (in months) between now and the
corresponding major delinquency for all of the open parameters with major delinquencies, and
reflects the least value returned.

Applicant Credit Bureau Open Shortest Since Minor

This parameter considers the least amount of time (in months) between now and the
corresponding minor delinquency for all of the open parameters with minor delinquencies, and
reflects the least value returned.

Applicant Credit Bureau Shortest Since Major

This parameter considers the least amount of time (in months) between now and the
corresponding major delinquency for all of the parameters (open and closed) with major
delinquencies, and reflects the least value returned.

Applicant Credit Bureau Shortest Since Minor

This parameter considers the least amount of time (in months) between now and the
corresponding minor delinquency for all of the parameters (open and closed) with minor
delinquencies, and reflects the least value returned.

Derogatory Trade Information

Applicant Credit Bureau Derog 12m Trades

Provides the number of trades that were derogatory in the last 12 months. This includes open
and closed trades. These trades may or may not be derogatory now.

Applicant Credit Bureau Derog 24m Trades

Provides the number of trades that were derogatory in the last 24 months. This includes open
and closed trades. These trades may or may not be derogatory now.

Applicant Credit Bureau Derog Now Trades

Provides the number of trades that are derogatory right now. Does this include closed trades?
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A.2.15.4 Applicant Credit Bureau Derog Trades

This parameter addresses the number of derogatory trades associated with the applicant.
This includes open and closed trades.

A.2.15.5 Applicant Credit Bureau Longest Since Derog

This parameter covers the longest period (in months) since last derog.

A.2.15.6 Applicant Credit Bureau Open Longest Since Derog

This parameter covers the longest period (in months) a tradeline has been open since the last
derog.

A.2.15.7 Applicant Credit Bureau Open Shortest Since Derog

This parameter considers the least amount of time (in months) between now and the
corresponding derog for all of the open parameters with derogs, and reflects the least value
returned.

A.2.15.8 Applicant Credit Bureau Shortest Since Derog

This parameter considers the least amount of time (in months) between now and the
corresponding derog for all of the parameters (open and closed) with derogs, and reflects the
least value returned.
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Appendix B: Late Fee Methods Definitions

FLAT AMOUNT

FLAT AMOUNT charges a flat (fixed amount) fee when an account becomes overdue.

For example, if the FLAT AMOUNT late fee is set at $25, and the account is $900 overdue,
then the late fee assessed will be $25. For each month the account is overdue, regardless of
the amount, the late fee assessed will be $25.

PERCENTAGE OF PAYMENT DUE

PERCENT OF PAYMENT DUE charges a late fee based on a percentage of the part of a
payment due that remains to be paid.

For example, if the PERCENT OF PAYMENT DUE late fee is set as 10%, and if only $90 of a
$200 standard payment is due, then the late fee will be $9 (10% of 90).

If $3000 on a loan with a standard payment of $200 is due, the late fee will be $20 (10% of
200). This is because the computed late fee is based only on the payment due for that month
-- not the accumulated due amount.

If the stated monthly payment is $300 and account is delinquent for 3 months ($900), then
every month the late fee is computed only on the amount due for that month ($300 or part of
$300) -- not on $900.

PERCENTAGE OF STANDARD PAYMENT

PERCENTAGE OF STANDARD PAYMENT charges a late fee based on the standard monthly
payment, regardless of the current amount due.

For example, if you set 10% as the PERCENTAGE OF STANDARD PAYMENT late fee, the

standard payment amount was $500, and the account was due for $2000, then the late fee
will be $50 (10% of 500). In other words, every month the system computes the late fee using
monthly standard payment amount ($500), irrespective of the amount paid by the customer.

If the customer pays $400 out of $500, the system still computes the late fee using $500, and
not on $100.

FLAT AMOUNT PYRAMID LAW

FLAT AMOUNT PYRAMID LAW prevents the pyramiding of “flat” late fees. If an account is
overdue, then the system assesses a flat (fixed amount) late fee. However, if the standard
payment is made the following month, then a new late charge will not be created, even if the
payment made does not fulfill the current amount due.

For example, if a customer is assessed a late fee of $25 for 1/2005, and makes his $200
standard payment in 2/2005, that person cannot be assessed a new $25 late fee for 2/2005
(even though his payment only fulfilled the amount owed for 1/2005).

If a customer makes a payment of just $199 in 1/2005 (an amount that does not fulfill the
standard payment), then the customer could also be assessed a $25 late fee for 2/2005.

If the customer makes a payment of $199 in 2/2005 (an amount that does not fulfill the
standard payment), then the customer could be assessed a late fee for 2/2005.
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PERCENTAGE OF PAYMENT DUE PYRAMID LAW

PERCENTAGE OF PAYMENT DUE PYRAMID LAW prevents the pyramiding of “percentage of
payment due” late fees. If an account is overdue, then the system assesses a fee based on
what part of a payment remains to be paid. However, if the standard payment is made the
following month, then the system will not create a new late charge, even if the payment made
does not fulfill the current amount due.

For example, if the PERCENTAGE OF PAYMENT DUE PYRAMID LAW late fee is set as 10%,
and if only $90 of a $200 standard payment was due, then the late fee would be $9.

If $3000 on a loan with a standard payment of $200 was due, the late fee would be $20.
However, if a customer was assessed a late fee of $9 for 1/2005, and makes his $200
standard payment in 2/2005, then that person cannot be assessed a new late fee for 2/2005
(even though his payment only fulfilled the amount owed for 1/2005).

If the customer makes a payment of $199 in 2/2005 (an amount that does not fulfill the
standard payment), then the individual could be assessed a late fee for 2/2005.

Note

The system computes the late fee based on the payment due for only that month and not
the accumulated due amounts.

If the stated monthly payment is $300 and account is delinquent for 3 months ($900), then the
system computes the late fee every month with the amount due for that month ($300 or part
of $300) and not on $900.

PERCENTAGE OF STANDARD PAYMENT PYRAMID LAW

PERCENTAGE OF STANDARD PAYMENT PYRAMID LAW late fee prevents the pyramiding
of “percentage of standard payment” late fees. If an account becomes overdue, then the
system assesses a fee based on the standard monthly payment, regardless of the current
amount due. However, if the standard payment is made the following month, then the system
will not create a new late charge, even if the payment made does not fulfill the current amount
due.

For example, if the PERCENTAGE OF STANDARD PAYMENT PYRAMID LAW late fee is set
as 10%, and the standard payment is $200, then $20 (10% of 200) is owed. If only $90 of a
$200 standard payment was due, then the late fee would still be $20.

If $3000 on a loan with a standard payment of $200 is due, the late fee will be $20, since the
fee is calculated based on the payment due -- not the total outstanding amount due.

However, if a customer is assessed a late fee of $20 for 1/2005, and makes the $200 standard
payment in 2/2005, that person cannot be assessed a new late fee for 2/2005, even though
the payment only fulfills the amount owed for 1/2005. If the customer makes a payment of
$199 in 2/2005 (an amount that does not fulfill the standard payment), then the system could
assess a late fee for 2/2005.
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Appendix C: Rounding Amounts and Rate Attributes

Rounding Amounts

Generally in the lending industry, computed amounts (interest, fees, costs, and so on) are
rounded to the second decimal place. However, there are occasions where the rounding of
the computed amounts has to be carried out using different methods. Oracle Financial
Services Lending and Leasing supports the rounding, raising, or cutting off of calculated
amounts.

Rounding will increase the resulting amount to the next number up to the second decimal,
based on the value of third decimal.

Raising will always increase the resulting amount to the next number up to the second
decimal.

Cutting off will always cut the number after the second decimal.

You can choose the rounding method you want to use by setting the parameter value for the
system parameter CMN_AMOUNT _ROUND_METHOD on the Administration form (Setup
menu bar > Administration link > System link > System Parameters link > System tab).

You can choose the rounding factor you want to use by setting the parameter value for the
system parameter CMN_AMOUNT_ROUND_FACTOR on the Administration form. Currently,

the system supports rounding up to two decimals only.

Examples of how resulting amounts differ by RAISE, ROUND, and CUTOFF:

Example 1: Amount: 234.136

Method Result
Round 234.14
Raise 23414
Cutoff 234.13

Example 2: Amount: 234.134

Method Result
Round 234.13
Raise 234.14
Cutoff 234.13

Example 3: Amount: 234.1319999

Method Result
Round 234.13
Raise 234.14
Cutoff 234.13
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Note

The system rounds only calculated amounts (calculated fees, calculated payment, and so
on) and not user-entered amounts.

Rate Attributes

The system supports the rounding of the index rate to keep the rate calculation as simple as
possible for the customers. The general practice is to round the rate to nearest eighth (1/8th)
(to keep the index rate in the multiple of .125) or fourth (1/4th) (to keep the index rate in the
multiple of 25). The system rounds only the index rate and not the margin or final rate. You
can define the index rounding method on the Product tab’s Product Definition screen for
variable rate line of credits.

Note

Index rounding does not apply to fixed rate leases.

The system currently supports the following rounding of methods.

1. NO ROUNDING TO INDEX RATE
2. INDEX RATE ROUNDED TO NEAREST .25
3. INDEX RATE ROUNDED TO NEAREST .125

NO ROUNDING TO INDEX RATE: Select this method for no rounding.

INDEX RATE ROUNDED TO NEAREST .25: Select this method to round up to 1/4th (to keep
the index rate in the multiple of .25).

Examples
Type Value
Current rate: 5.125

Round of rate: 5.25

Type Value

Current rate: 5.124

Round of rate: 5.00

INDEX RATE ROUNDED TO NEAREST 0.125: Select this method to round up to 1/8th (to keep
the index rate in the multiple of 0.125).
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Examples:

Type Value
Current rate: 5.325
Rate rounded to: 5.375
Type Value
Current rate: 5.312
Rate rounded to: 5.250
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D.1

D.2

Appendix D:System Parameters

Introduction

System defined parameters help in configuring system specific data, User-access, location of
system files; reports related URLs and other administration controlled data. These are
essential to be configured during installation and some of them by nature of application will
have to be reviewed and maintained in a regular and periodic manner.

Following are the types of parameters are used in OFSLL system depending on the areas of
the system that these would apply and impact:

e System Parameters

e Organization Parameters

e Company Parameters

Other Parameters

Note

All the above parameters can be controlled (enabled/disabled) only by System Adminis-
trators, and users with Admin/Super User privileges who would be involved in setting-up
OFSLL system.

System Parameters

System parameters apply to the entire system. They relate to the overall processing of the
system like application server file locations, data purging configurations and so on. Table
below details the list of system parameters with their description and pre-defined values.

SI.No | Parameter Description
1 ACA _DLQ_AMT_EX- This parameter is used to exclude delinquency
CLUDED amount for account ACH
2 ACA_PAYMENT_AU- This parameter is used to control posting directly
TO_LOAD from the ACH file that has been created for cus-
tomer payments. Input parameter value is Boolean
(Yes/No). If the parameter is set to ‘Y’, the system
automatically creates payment batches for the
payments in the ACH file and posts them on the
day of payment.
3 ACA_PRENOTE_DAYS This parameter is used to define the number of
days the prenote should be initiated for customer
ACH (Automated Clearing House) accounts. Input
parameter value is numeric.
4 ACA PRE_PROCESS - This parameter is used to specify the number of
DAYS days before draft day for Account ACH process.
Input parameter value is numeric.
5 ACH_PAYEE_PRENOTE_- | This parameter is used to define the number of
DAYS days for prenote to occur for Producer or Vendor
ACH accounts. Input parameter value is numeric
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Sl.No

Parameter

Description

6 ADMIN_SERVER_URL This parameter is used to define the admin server
URL

7 ADR_DIRECTORY This parameter is used to define the Oracle Direc-
tory Object Name for ADR file location

8 ADR_PROCESSED_DI- This parameter is used to define the Oracle Direc-

RECTORY tory Object Name for ADR file location
9 AGE_APPROVED _ CON- This parameter is used to specify the number of
DITIONED_DAYS days by which an application in ‘Approved’ or
‘Conditioned’ status is treated as Aged Applica-
tion. Input parameter value is numeric with no
upper limit.

10 AGE_CONTRACT_DAYS This parameter is used to specify the number of
days by which a contract is treated as Aged Con-
tract. Input parameter value is numeric with no
upper limit.

11 ASC_COL_SER_ENA- This parameter is used as the Collection Servicing

BLED_IND Enabled Indicator

12 CAC_DIRECTORY This parameter is used to define the Oracle Direc-
tory Object Name for CAC file location

13 CAC_PROCESSED_DI- This parameter is used to define the Oracle Direc-

RECTORY tory Object Name for CAC file location

14 CHECK _PRINT_PREVIEW | Using this parameter we can allow preview of
application in pdf form before printing. Input
parameter value is Boolean (Yes/No).

15 CMN_AMOUNT_ROUND__ | This parameter is used to define the rounding fac-

FACTOR tor for applicable fields (in this case calculated
amounts). Input parameter value is ‘ROUND
AMOUNT TO 2 DECIMALS’. Currently system
supports rounding factor 2 only.

16 CMN_AMOUNT_ROUND_ | This parameter is used to define the amount round

METHOD method during system set-up and would be appli-
cable for all calculated amounts (calculated fees,
payment etc.) across the application. Input values
are ROUND, RAISE and CUTOFF:

ROUND: Rounded to nearest number higher or
lower

RAISE: Rounded to the nearest higher number
CUTOFF: Truncate the digits without rounding or
raising

17 CMN_APP_ACC _TI- This parameter is used to set the Application or

TLE_FN_LN

Account title in one of the formats — First/Last
Name or Last/First Name. Input parameter value is
Boolean (Yes/No). If Yes is chosen, title would be
in the format — First/Last Name, else the other
option.
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SI.No | Parameter Description

18 CMN_APP_- This parameter is used to set the Application
SERVER_HOME Server Home Directory. Input parameter value is
user defined.

19 CMN_CURRENT_MOD- This parameter is used to default the Current

EL _YEAR Model Year.
20 CMN_DEBUG_LEVEL This is the Common Debug Level
21 CMN_DEBUG_METHOD This is the Common Debug Method
22 CMN_- This parameter is used to change incoming/outgo-

FILE_PROCESS_TO_LOB | ing file process to CLOB process

23 CMN_GL_POST_DT This parameter is used to specify the General
Ledger Posting date. If scheduler is enabled, it
automatically updates this to current system date.
Else Admin User would need to set this date man-
ually to ensure correct posting dates in GL.

24 CMN_HTTP_PROX- This parameter is enabled to specify the port to be
Y_PORT used for outgoing HTTP connections. Input
parameter value is user defined.
25 CMN_HTTP_PROXY_- This parameter is enabled to specify the proxy
SERVER server to be used for outgoing HTTP connections.

Input parameter value is user defined. There
exists an interdependency of this parameter with
CMN_HTTP_PROXY_PORT mentioned above.

26 CMN_INT_360 ACCRU- This parameter is used to specify the interest
AL_DAYS_MTHD accrual method for 360 days, to be used by the
System for all calculations with interest. Currently
two methods are supported. Input parameter value
is ‘US’ or ‘EU’ representing American and Euro-
pean method of interest accrual for 360 days.

27 CMN_TEST _TOOL_LOG- | This parameter is used to set testing tool logging

GING parameter
28 CMN_SCHEMA _ID This is used to specify the schema identifier for all
users.

29 CMN_SCHEMA_NAME This is used to specify the Oracle User Name for a
specific schema. Input parameter value is user

defined.
30 CMN_SCHEMA PASS- This captures the password for Oracle, for the
WORD specific schema. Input parameter value is user

defined. This parameter need not be enabled
when in Oracle Network.

31 CMN_SERVER_HOME This parameter captures the Server Home Direc-
tory. Input parameter value is user defined.
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Sl.No

Parameter

Description

32

CMN_-
SERVER_TEMP_DIR

This parameter is used to specify the temporary
directory on the server along with the path. Input
parameter value is user defined.

33

CMN_SER_ENVIRON-
MENT_FILE

This parameter captures the environment file (and
its path) for running the Operating System com-
mands from Job Service. Input parameter value is
user defined.

34

CMN_SYSTEM_UNDER -
MAINTENANCE

This parameter specifies whether the system is
under maintenance or not. Input parameter value
is Boolean (Yes/No).

35

CMN_WALLET_PASS-
WORD

This parameter is used to specify the common
wallet password. Input parameter value is user
defined.

36

CMN_WALLET_PATH

This parameter is used to specify the common
wallet path for oracle database. Input parameter
value is user defined.

37

CPP_NO_OF_PROMISES

This parameter is used to define the maximum
number of promises/chances allowed for a cus-
tomer who is delinquent and promises to pay.
Input parameter value is numeric with no upper
limit.

38

CPP_PROMISE_HELD_-
DAYS

This parameter is used to define the maximum
number of days after the promises made by the
customer to pay are broken to initiate further
actions. Input parameter value is numeric with no
upper limit.

39

CRD_CHS_BIN

This parameter holds the value of the credit card
BIN (Bank Identification Number for Credit Cards),
for CHASE interface. Input parameter value is
user defined.

(P.S: OFSLL supports CHASE interface for credit
card payments processing)

40

CRD_CHS_CUR_CODE

This parameter is used to specify the currency
code of the transacting currency for CHASE inter-
face. Input parameter value is user defined.

41

CRD_CHS_DIR_PATH

This parameter is used to specify the directory
path for CHASE payment interface for Credit
Cards. Input parameter value is user defined.

42

CRD_CHS_IND_TYPE

This is used to specify the industry type for
CHASE payment interface for Credit Cards. Input
parameter value is user defined.

43

CRD_CHS_MER-
CHANT_ID

This captures the merchant ID number for CHASE
payment interface for Credit Cards. Input parame-
ter value is user defined.
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SI.No | Parameter Description
44 CRD_CHS_RE- This captures the remote host name for seeking
MOTE_HOST_NAME approvals for CHASE payment interface. Input
parameter value is user defined.

5 CRD_CHS_SEC_RE- Similar to the previous parameter this captures the

MOTE_HOST_NAME secondary remote host name of CHASE interface
for seeking approvals for credit card payments.
Input parameter value is user defined.

46 CRD_CHS_TIMEOUT This parameter is used to define the timeout limit
when polling the interface for processing credit
card payments. Input parameter value is numeric.

47 CRD_CHS_USR_ID This parameter captures the user id for CHASE
interface which is required whenever the System
needs to access/seek authorizations/process pay-
ments for credit cards etc. Input parameter value
is user defined.

48 CRD_PTB_RE- This is the Protobase Remote Host Name

MOTE_HOST_NAME
49 CRD_PTB_RE- This is the Protobase Remote Host Port
MOTE_HOST_PORT

50 CRD_PTB_TIMEOUT This is the Protobase Timeout Value

51 CRD_SOURCE_TYPE_CD | This is the Source Type Code

52 DDT_CREATE_DUE _- This parameter must be enabled to create a due

DATE_HISTORY date history for any account. Due date history sub
tab under Transaction history displays the delin-
quency history of an account in a tabular format
detailing Due date, Due Amount, Last Payment
date, Payment Amount, Balance Amount, Days
past due and Payment received flag. The input
parameter value for this parameter is Boolean
(Yes/No).

53 DECI- This parameter is used to define the variance in

SION_BUY_RATE_TOL- buy rate

ERANCE

54 EDF_DIALER_ACCT _- This parameter is used to set up the account num-

TYPE ber reference for the dialer file to pick-up records
for Auto dialer interface. Input parameter value is
account number.

55 FIN_TIMEOUT This parameter is used to define the polling inter-
val for Fax-in service, i.e. minutes after which the
Fax-in service would poll to establish a connection
periodically. Input parameter value is numeric.

56 FLL BPEL PROCESS This parameter is set to use BPEL process in

OFSLL. Input parameter value is Boolean (Yes/
No).
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Sl.No

Parameter

Description

57 ICA_INPUT_FILE_FOR- This parameter is used to define the input call
MAT activity file format

58 IFD_DIRECTORY This parameter is used to define the Oracle direc-
tory object name for IFD file location

59 IFD_PROCESSED_DI- This parameter is used to define the Oracle direc-

RECTORY tory object name for IFD file location
60 INCOM- This parameter is used to define the incoming pro-
ING_LOB_PURGE_DAYS | cess file table purge days

61 INPUT_DIRECTORY This parameter is used to define the Oracle direc-
tory object name for INPUT file location

62 ITU_DIRECTORY This parameter is used to define the Oracle direc-
tory object name for ITU file location

63 ITU_PROCESSED_DI- This parameter is used to define the Oracle direc-

RECTORY tory object name for ITU file location

64 IVR_DIRECTORY This parameter is used to define the Oracle direc-
tory object name for IVR file location

65 IVR_PROCESSED _DI- This parameter is used to define the Oracle direc-

RECTORY tory object name for IVR file location
66 JSC_START_OF_BUSI- This parameter is used to set the start of business
NESS_TIME time. Input parameter value is time in 24 hour for-
mat.

67 JSC_TIMEOUT This parameter is used to set the polling interval
for job scheduler. Input parameter value is
numeric. To check whether it represents minutes/
seconds.

68 JSV_ARCHIVE_- This parameter is used to set the configuration file

SERVER_CONFIG for reports archive server. Input parameter value is
user defined.

69 JSV_ARCHIVE._- This parameter is used to specify the archive

SERVER_URL server url. Input parameter value is user defined.

70 JSV_BI_PASSWORD This parameter is used to define the Bl Publisher
Password

71 JSV_BI_USER This parameter is used to define the Bl Publisher
User ID

72 JSV_TEMPORARY_DI- This parameter is used to define Oracle directory

RECTORY object name for Job Service Temp file location

73 JSV_BI_PASSWORD- This parameter is to specify the reports runtime

JSV_REPORTS_RUNT-
IME

program. Input parameter value is user defined.
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SI.No | Parameter Description
74 JSV_REPORTS_RUNT- This parameter is used to specify the reports runt-
IME_CMDFILE ime command file. Input parameter value is user
defined.

75 JSV_REPORTS - This parameter is used to specify the configuration

SERVER_CONFIG file for reports server. Input parameter value is
user defined.

76 JSV_REPORTS - This is used to specify the URL for the reports

SERVER_URL server. Input parameter value is user defined.

77 JSV_REPORT_AR- This is used to specify the path & directory of

CHIVE_DIRECTORY Reports archive, input parameter value being
numeric.

78 JSV_SMTP_SERVER This parameter specifies the SMTP server used by
job service for sending email messages. Input
parameter value is user defined.

79 JSV_TIMEOUT This is to specify the polling interval for the job ser-
vice during time out. Input parameter value is
numeric. To check whether it represents minutes/
seconds.

80 JSV_USE_BI PUBLISHER | This parameter defines whether Bl publisher
should be used to process reports are not. Input
parameter value is Boolean (Yes/No).

81 JSV_USE_REPORTS - This parameter is used to specify whether reports

SERVER server from job service should be used or not.
Input parameter value is Boolean (Yes/No).
82 LBX_TXN_GROUP- This parameter is used to specify the no. of
ING_CNT records per batch for payment transactions and
lock box batch records. Input parameter value is
numeric.

83 LCO _COL_LET- This parameter specifies the number of days post

TER1_GEN_DAYS which first collection letter should be generated for
accounts with dues unpaid. Input parameter value
is numeric.

84 LCO_COL_LET- This parameter specifies the number of days post

TER2_GEN_DAYS which second collection letter should be generated
for accounts with dues unpaid. Input parameter
value is numeric.

85 LCO_COL_LET- This parameter specifies the number of days post

TER3_GEN_DAYS which third collection letter should be generated
for accounts with dues unpaid. Input parameter
value is numeric.

86 LIEN_RELEASE_DAYS This parameter is used to define the Lien Release
Days

87 LOCKBOX_ DIRECTORY This parameter is used to define the Oracle direc-

tory object name for Lockbox file location

D-7 ORACLE




Sl.No
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88 LOCKBOX_PRO- This parameter is used to define the Oracle direc-
CESSED_DIRECTORY tory object name for processed Lockbox file loca-
tion

89 LOR_ADVERSE_AC- This parameter is used to specify the number of

TION_GEN_DAYS days after the third collection letter post which the
adverse action letter is to be generated. Input
parameter value is numeric.

90 LOG_LOB_PURGE_DAYS | This parameter is used to log files header table
purge days

91 MAX_AGED_TXN_AU- This parameter is used to specify the maximum

THORIZE_DAYS number of days within which a transaction should
be authorized. Input parameter value is numeric
and represents the number of days.
92 MAX_VOID_TXN_AU- This parameter is used to set the maximum days
THORIZE_DAYS to authorize transaction

93 OCP_CUSTOMER_P- This parameter is used to set the customer pay-
MT_SITE_ID ment extract file site id

94 OCP_IN- This parameter is used to set the customer pay-
CLUDE_ACH_ACC ment extract including ach accounts

95 OUTGO- This parameter is used to define the outgoing pro-
ING_LOB_PURGE_DAYS | cess file table purge days

96 OUTPUT_DIRECTORY This parameter is used to define Oracle directory
object name for OUTPUT file location

97 PAC_ARCHIVE_DAYS This parameter is used to define number of days
for periodic archiving of account. Input parameter
value is numeric.

98 PAC_OARCHIVE_DAYS This parameter is used to define the number of
days for archiving accounts from ‘O’ tables i.e. old
tables. Input parameter value is numeric

99 PAP_ARCHIVE_DAYS This parameter is used to define the number of
days for archiving applications on a periodic basis.
Input parameter value is numeric.

100 PAP_OARCHIVE_DAYS This parameter is used to define the number of
days for archiving applications from ‘O’ tables.
Input parameter value is numeric.

101 PCU_CHECK_REFUND_- | This parameter is used to specify the maximum

DAYS number of days within which an overpayment from
the customer can be refunded. Input parameter
value is numeric.

102 PDC_PRE_PROCESS_- This parameter value will define the number of

DAYS

days prior to the due day, regular account PDC
process should be initiated. Input parameter value
is numeric.
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103

PENDING_PDC_DAYS

This parameter value will define the number of
days before the initiation day for pending PDC
accounts.

104

PGL_ARCHIVE_DAYS

This parameter defines the number of days, post
which the transactions in GL would be archived.
Input parameter value is numeric

105

PGL_OARCHIVE_DAYS

This parameter is used to define the number of
days, post which the transactions in GL will be
moved to the ‘O’ tables. Input parameter value is
numeric.

106

PJR_PURGE_DAYS

This parameter is used to specify the days post
which the job requests are to be purged. Input
parameter value is numeric.

107

POD_PURGE_DAYS

This parameter is used to define the number of
days after which the Output data file headers are
to be purged. Input parameter value is numeric.

108

PPA_ARCHIVE_DAYS

This parameter is used to specify number of days
after which pools and its transactions archiving is
to be done to ‘O’ tables. Input parameter value is
numeric.

109

PPA_OARCHIVE_DAYS

This parameter is used to specify number of days
after which pools and its transactions archiving is

to be done to ‘OO’ tables. Input parameter value is
numeric

110

PPR_ARCHIVE_DAYS

This is used to specify the days for archival of pro-
ducers details on a regular basis. Input parameter
value is numeric.

111

PPR_OARCHIVE_DAYS

This is used to specify the days after which the
producers details from ‘O’ tables need to be
archived. Input parameter value is numeric.

112

PPX_ARCHIVE_DAYS

This is used to specify the days after which pro-
ducer transactions are to be archived. Input
parameter value is numeric.

113

PPX_OARCHIVE_DAYS

This is used to specify the days after which the
producer transactions are to be moved from ‘O’
tables. Input parameter value is numeric.

114

PJR_COPY_PURGED _-
DATA

This parameter is used to copy data into purge
tables

115

PST_ARCHIVE_DAYS

This parameter specifies the number of days for
which the statements are to be archived. Input
parameter value is numeric.

116

PST_OARCHIVE_DAYS

This parameter specifies the number of days for
which the statements are to be archived in the ‘O’
tables. Input parameter value is numeric.
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117

PTT_PURGE_DAYS

This is used to specify the number of days after
which the PTT table is to be purged. Input parame-
ter value is numeric.

118

PTX_ARCHIVE_DAYS

This parameter is used to specify the number of
days the transactions are to be archived. Input
parameter value is numeric.

119

PTX_OARCHIVE_DAYS

This parameter is used to specify the number of
days after which the archived transactions from ‘O’
tables are to be moved. Input parameter value is
numeric.

120

PTX_TX-
N_LAST PURGE_DT

This parameter stores the date when transactions
were purged last in the OFSLL system. Input
parameter value is date.

121

PUL_PURGE_DAYS

This parameter is used to specify the number of
days post which the User login details are to be
purged. Input parameter value is numeric.

122

PVA_ARCHIVE_DAYS

This parameter stores the number of days for
archival of regular vendor assignments. Input
parameter value is numeric.

123

PUP_ARCHIVE_DAYS

This parameter stores the number of days for
archival of transaction upload. Input parameter
value is numeric

124

PUP_OARCHIVE_DAYS

This parameter is used to specify the number of
days after which the archived transactions from ‘O’
tables are to be moved. Input parameter value is
numeric

125

PUP_TUP_LAST_PURGE

_DT

This parameter stores the date when transactions
upload were purged last in the OFSLL system.
Input parameter value is date.

126

PVA_OARCHIVE_DAYS

This parameter value specifies the number of days
for archival of vendor assignments from ‘O’ tables
to ‘OO0’ tables. Input parameter value is numeric.

127

PVI_ARCHIVE_DAYS

This parameter is used to specify the number of
days for which the regular vendor invoices are to
be archived. Input parameter value is numeric.

128

PVI_OARCHIVE_DAYS

This parameter is used to specify the number of
days post which the regular vendor invoices are to
be moved from ‘O’ tables to ‘OO’ tables. Input
parameter value is numeric.

129

RAC_LOAD_FREQUENCY

This parameter is used to specify Accounts RDH
Load Frequency

130

RAP_LOAD_FREQUENCY

This parameter is used to specify Applications
RDH Load Frequency
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131

RAT_LOAD_FREQUENCY

This parameter is used to specify Asset Tracking
RDH Load Frequency

132 RBK_LOAD_FREQUENCY | This parameter is used to specify Bankruptcy
Details RDH Load Frequency
133 RCA_LOAD_FREQUENCY | This parameter is used to specify Call Activities
RDH Load Frequency
134 RCH_LOAD_FRE- This parameter is used to specify Deficiency
QUENCY Details RDH Load Frequency
135 RCO_LOAD_FRE- This parameter is used to specify Contracts RDH
QUENCY Load Frequency
136 RFO_LOAD_FREQUENCY | This parameter is used to specify Repo-Foreclo-
sure RDH Load Frequency
137 RPR_LOAD_FREQUENCY | This parameter is used to specify Producers Rdh
Load Frequency
138 RST_LOAD_FREQUENCY | This parameter is used to specify Setup Data RDH
Load Frequency
139 RTX_LOAD_FREQUENCY | This parameter is used to specify Txns RDH Load
Frequency
140 SALESAGENT - This parameter is used to specify whether decision
MAIL_SEND_IND fax needs to be sent to sales agent (yes/no)
141 SCORING_PARAME- This parameter is used to set the scoring parame-
TER_ALERT ter alert
142 SQL_DIRECTORY This parameter is used to set the Oracle directory
object name for SQL file location
143 TES_ANA_PRE_PROCES | This parameter is used to specify the pre-process
S CYCLES cycles required for Escrow analysis. Input parame-
ter value is numeric.
144 TES_DSB_ANALY- This parameter is used to specify the percentage
SIS_PERCENT for escrow disbursements. Input parameter value
is numeric.
145 TES_DS- This is used to specify the number of days for pre-
B_PRE_PROCESS_DAYS | process for escrow disbursements. Input parame-
ter value is numeric.
146 TPE_AMORTIZE_AC- This parameter is used to specify that system has
CRUED_INT_ONLY to amortize accrued interest at month end
147 TPE_APPLY_LTC - This parameter is used for pyramid law fee
FROM_CURR_DUE_DT method to apply late charge from current due date
148 TPE_ESC_ANALY- Parameter considers billed but uncollected

SIS_DELQ_AMT

amount for escrow analysis

ORACLE




SI.No | Parameter Description
149 TPE_EXCESS_PAY- Excess payment on the account will be moved to
MENT_TO_MEMO memo payment.
150 TPE_EXCLUDE_ESC_LTC | This parameter defines whether escrow should be
included or excluded while calculating late charge.
Input parameter value is Boolean (Yes/No).
151 TPE_EXT_CY- This parameter is used to define the maximum
CLES_BACKDATED extension cycles allowed for back dating. Input
parameter value is numeric with no upper limit
152 TPE_FUTURE_PAYOFF_- | The value specified in this parameter validates the
DAYS ‘Valid Up to Date’ with ‘Payoff quote’ during mone-
tary transactions posting.
153 TPE_GL_RE- This parameter is used to define the number of
FUND_HOLD_DAYS days the non-refunded amount can be held in GL.
Input parameter value is numeric.
154 TPE_MAX_CY- This parameter is used to define the maximum
CLES_BACKDATED cycles that are allowed for back dating in OFSLL.
Input parameter value is numeric.
155 TPE_MIN_1098 _INT_AMT | This parameter is used to specify the lower limit or
_PAID minimum interest amount paid for 1098 i.e. Mort-
gage Interest Statement. In the US, Fls need to
report mortgage interest of $600 or more received
from individuals, during the course of their busi-
ness. Input parameter value is 600, the minimum
value above which reporting by Fl is required in
form 1098 for each mortgage account.
156 TPE_OLDEST _- This parameter is enabled to specify whether new
DUE_DT_NEW_MTHD method for calculation of oldest due date based on
given data should be used or not. Input parameter
value is Boolean (Yes/No).
157 TPE_PAID _TO_CLOSE_- | This parameter is used to specify the number of
DAYS days allowed post which a paid account would be
closed. Input parameter value is numeric.
158 TPE_PAYMENT _TO - This parameter is enabled to allow one payment
MULTI_ACCOUNTS for dues in multiple accounts. Input parameter
value is Boolean (Yes/No).
159 TPE_PAYOFF_VAL- This parameter is used to specify the number days
ID_THRU_DAYS the pay-off quote is valid by default. i.e. if the
parameter is set as 7, the payoff quote is valid for
7 days and customer can pay the quoted amount
as final closure amount within those days. Input
parameter value is numeric.
160 TPE_PMT_POST_EOD This parameter is used to allow payments when

the batch process for End of Day is running. Input
parameter value is Boolean (Yes/No). If this is set
to Y’, payments can be allowed during EOD.
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161 TPE_SCHGOFF_DLQ_- This parameter is used to define the number of
DAYS delinquent days to treat an account for SCHGOFF
(charge — off). Input parameter value is numeric.
(To verify)
162 TPE_SCHGOFF_RE- This parameter is used to define the number of
VIEW_DAYS days allowed for review of SCHGOFF accounts.
Input parameter value is numeric.
163 TPE_SCRA_DEFAULT_IN- | This parameter is used to define the default inter-
TEREST_RATE est rate that is to be applied for customers who are
in military duty. OFSLL will apply the lower of the
prevailing interest rate or SCRA default interest
rate specified through this parameter. Input
parameter value is numeric (in this case 6, which
is interest rate to be applied for SCRA accounts.
164 TPE_SHOW_BACK- This parameter is used to define whether a warn-
DATE_WARNING ing message is to be shown if monetary transac-
tion is backdated
165 TPE_ST- This parameter is enabled to define whether all
M_INC_ALL_TXNS transactions should be included in the statements
or otherwise. Input parameter value is Boolean
(Yes/No).
166 TPE_STOP_COMP_DELQ | This parameter is used to stop computation when
_DAYS delq days > 60
167 TPE_TXN_POST_DE- This parameter is used to default GL date in date
FAULT_GLDATE type parameters during txn posting (y/n)
168 TPE_VOID_TO_CLOSE_- | This parameter is used to define the number of
DAYS days allowed for closing Void accounts. Input
parameter value is numeric.
169 UIX_DEFAULT_IMAGE_- This parameter is used to define the default image
PATH directory maintained for the purpose of online
attachment of document images to an application
using documents maintenance section under
Account documentation. Input parameter value is
user defined.
170 UIX_DIRECT_LOAN - This parameter when set to yes allows underwrit-
COMBO_ULN_UFN ing and funding to be carried on by a single
responsibility for direct loans only. Input parameter
value is Boolean (Yes/No).
171 UIX_INCOMING_FILE_- This parameter is used to specify incoming file
PATH path of app server
172 UIX_LOCAL_COUN- Through this parameter we can set the local coun-

TRY_CD

try where an FI has multiple branches across dif-
ferent geographies. Input parameter value is user
defined.
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173 UIX_LOCK_UN- This parameter is used to enable the user inter-
LOCK_AND_COPY face lock / unlock and copy features. Input param-
eter value is Boolean (Yes/No).

174 UIX_MAX_ACC - This parameter is used to specify the maximum

SEARCH_ROWS number of account rows to be returned for search
functionality. Input parameter value is numeric.

175 UIX_MAX_APP_- This parameter is used to specify the maximum

SEARCH_ROWS number of application rows to be returned for
search functionality. Input parameter value is
numeric.

176 UIX_OUTGOING_FILE_- This parameter is used to specify outgoing file

PATH path of app server
177 UIX_REPORTS - This parameter can be used to specify the user
SERVER_CONFIG interface reports server configuration file. This is
not required for OFSLL.
178 UIX_REPORTS_- This parameter sets the URL for Reports server.
SERVER_URL Input parameter value is user defined.
179 UIX_SHOW_LN_VARIA- This parameter can be used to show loan variable
BLE_RATE_TABS rate tabs. Input parameter value is Boolean (Yes/
No). This is not required for OFSLL.
180 UIX_UTILITIES_SERV- This parameter can be used to specify the User
LET_URL Interface utilities servlets URL. This is not required
for OFSLL.

181 UPR_PRO_NBR_SYS- This parameter can be used to specify whether

_GENERATED producer number should be system generated or
seek input from user. Input parameter value is
Boolean (Yes/No). Generally this is set to yes for
system generation.

182 VEV_NADA TOKEN_URL | This parameter is used to set the token URL for
vehicle evaluation interface NADA. Input parame-
ter value is user defined.

183 VEV_NADA_UPDATE_- This parameter is used to specify the day of the

DAY month to update the vehicle evaluations every
month. Input parameter value is numeric.

184 VEV_NADA_URL This parameter is used to set the URL for vehicle
evaluation interface NADA. Input parameter value
is user defined.

185 VEV_NADA USER_ID This parameter is used to specify the User id for
login to the NADA interface. Input parameter value
is user defined.

186 VEV_NADA_USER_PASS- | This parameter is used to specify the password for

WORD

login to the NADA interface. Input parameter value
is user defined.
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187

VEV_VALUATION_RE-
GION

This parameter is used to define the default region
for vehicle evaluation. Input parameter value is the
region name, and is user defined.

188

VEV_VALUATION _-
SOURCE_CD

This parameter is used to specify the default vehi-
cle evaluation source code. Input parameter value
is user defined. A number of parameters are pos-
sible in OFSLL as below:

1.Appraisal Company

2.Broker

3.BUC GUIDE

4.DATA QUICK

5.NAMS/SAMS SURVEY - USED

6.REALTOR

7.NADA INTERFACE USED CARS
8.BLACKBOOK INTERFACE USED CARS
9.KELLY INTERFACE

10.NADA — NEW

11.NADA - USED

12.KELLY NEW BLUE BOOK

13.KELLY USED BLUE BOOK

14.INVOICE

15.BLACK BOOK

16.NADA INTERFACE COMMERCIAL TRUCKS
17.COMPANY INVOICE

18.GOLD BOOK

19.GALVS

20.0THER

21.ALG

189

WFP_DIRECTORY

This parameter is used to specify the Oracle direc-
tory object name for WFP file location

190

WFP_MAX_CY-
CLES_BACKDT

This parameter is used to specify the back dated
cycles date for WFP.

191

WFP_PROCESSED_DI-
RECTORY

This parameter is used to define oracle directory
object name for wfp file location.

192

WFP_REVERSE_TX-
N_IND

This parameter is enabled to define the WFP
reversal indicator. Input parameter value is
Boolean (Yes/No).

193

XAE_DEALUPD_MAX_AL-
LOWED_DAYS

This parameter is used to define the max allowed
days for Deal Update

194

XAE_DEALUPD_AL-
LOWED_IND

This parameter is used to indicate whether deal
update is allowed or not

195

XSL_TAX_INTERFACE

This parameter is used to specify the sales tax
interface in OFSLL. Input parameter value is user
defined. In this case it is held as ‘Manual’.

196

OUTBOUND_CALL_Q

This parameter is used to generate reports (includ-
ing emailing statements/letters) using Application
Server instead of Database server.
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197 ACA_PRE_PROCESS - This parameter is used to configure the number of
DAYS_FIRST days before the debit day for ACH process in first
time/ one-time case
198 IPR_PROCESSED_DI- This parameter is used to define the Oracle direc-
RECTORY tory object name for processed IPR file location
199 IPR_DIRECTORY This parameter is used to define the Oracle direc-
tory object name for IPR file location
200 UIX_PWD_MGMT_EX- This parameter is used to set external password
TERNAL_URL management url, if applicable
201 UIX_PWD_MGMT_EX- This parameter is used to define the parameter if
TERNAL password management is external. (SET Y IF
PASSWORD MANAGEMENT IS EXTERNAL (Y/
N)).
202 ICU_PROCESSED_DI- This parameter is used to define the Oracle direc-
RECTORY tory object name for processed ICU file location
203 ICU_DIRECTORY This parameter is used to define the Oracle direc-
tory object name for ICU file location
204 UIX_BILL_CYCLE_AL- This parameter is used to indicate whether Billing
LOWED_IND cycle is allowed at the application level
205 CMN_EOD_SLEEP_MINS | This parameter is used to set in minutes the EOD
sleep time
206 CMN_CORE_BANK_TX- This parameter is used to set code for OFSLL and
N_CD Core Banking integration
207 UIX_DIRECT_DISB_MAN- | This parameter will allow manual selection of dis-
UAL_SELECT bursement mode for direct loans
208 ICC_DLQ_AMT_EX- This parameter enabling will exclude delinquency
CLUDED amount for CASA account
209 CMN_CORE_BANK_IND This parameter is used to set whether OFSLL can
integrate with Core Banking.
210 BKRP_FILE_REC_LIMIT This parameter is used to set the limit of total num-
ber of records allowed to be added in the ‘Input
Data File’ shared from external interface.
Note: if the number of records exceeds the set
limit, multiple ‘Input Data Files’ are to be created.
211 UVN_VEN_NBR_SYS- This parameter is used to validate if ‘Vendor Num-

_GENERATED

ber’ has to be auto generated (if set to Y) or to be
specified manually in the Vendor details screen.

ORACLE




SI.No | Parameter Description

212 METRO_WITHOUT_COL- | This parameter indicates whether Metro Il report-
L_IND ing is handled without OFSLL Collections module
being used. If the parameter value is set as Y’ i.e.
collection module is not used, system updates the
collateral status directly as part of ‘REPO’ call
activity.

However when Collections module is being used,
the Collateral status is tracked with the reposses-
sion details updated in 'Repo/Foreclosure' screen
of Collections module.

213 METROII_- This parameter is used to calculate the first delin-
FIRST_DELQ_DT_ADD_- | quency date that needs to be reported in the Metro
DAY Il reporting file.

By default the parameter is 'disabled' indicating
that the initial delinquency date calculated by the
system is used for Metro Il reporting. The same
needs to be enabled to add the parametrized num-
ber of days to the system calculated first delin-
quency date for the Metro Il reporting purpose.

214 DAYS TO_PULL_CR- This parameter is used to configure the number of
B_REPORT days permitted to pull a Bureau report from the
same company and for the same customer.
215 XWS_ ACS_RESP_- This parameter is used to indicate if multiple
MULTI_RECORD_IND records exist in the response file received for

account search.

Accordingly, when there are multiple records
found and this parameter is enabled and set to
‘No’ (default), system displays an error message
“Too Many Records Found. Please Refine Search
by Adding One More Parameter”

However, when this parameter is set to ‘Yes’, sys-
tem only indicates that there are multiple records/
rows in response file.

216 GRI_DLQ_DAYS_AU- This parameter is used to define the delinquency
TO_STATUS_CHG days which inturn is used to automatically update
the status of a work order to ‘PENDING ON HOLD’
status.
217 TPE_PMT_POSTING - This parameter is used to define the payment
CLS_ACCOUNT posting criteria for Closed - Paid Off/ Charged-off
accounts.

Accordingly, OFSLL accepts payment posting on
closed accounts only when the parameter is set to
‘Y’ and all the payments received through Pay-
ment Entry screen or ‘Payment Upload’ file are
posted to a ‘Suspense’ account.
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SI.No | Parameter Description

218 TPE_BACKDT_P- This parameter is used to define the payment
MT_POSTING posting criteria for backdated payments for the fol-
lowing type of account conditions:
- Paid off
- Charged-off

- Account under activation
- Account under conversion
- Non-performing Account

- PC2 SI (Pre-computed to Simple Interest)
Reschedule

Accordingly, OFSLL accepts backdated payment
posting only when the parameter is set to ‘Y’ and
all the payments received through Payment Entry
screen or ‘Payment Upload’ file are posted to a
‘Suspense’ account.

219 EXP_PA - This parameter when enabled allows ‘Soft Pull’
SOFT_PULL_IND Credit Bureau request, specifically for Experian
Premier Attribute Consumer Report without
impacting the consumer FICO score.

220 PMT_BATCH_POSTING This parameter (PAYMENT BATCH POSTING
PREFERENCE) is used to define the status of
payment transactions which are uploaded in bulk
through a batch process.

Organization Parameters

Organization parameters control the functions related to User login, password expirations,
responsibilities and accessibility limits in the OFSLL system. Individual parameters can be
created with different values for uniquely defined organizations, divisions, and responsibility
combinations.

There are three more dimensions other than parameter name, description and enabling
(similar to system parameters) as indicated below:

1. Organization

2. Division

3. Responsibility

These dimensions help to define the applicability of the responsibility for specific User in an
Organization across selected Divisions/departments.

When determining which parameter to use, OFSLL system selects the best match based on

a hierarchical sort by the Organization, Division, and Responsibility fields, with values of 'ALL'
being a lower order match than an exact match.
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While the system allows for Organization parameters to be defined at all three hierarchical
levels (organization, division, and responsibility), not all will be applicable to each parameter.

SI.No | Parameter Description
1 MAX_PASSWORD_HISTO- | This is used to set limit for number of times a
RY_CHECK password has been repeated during password

change. This can be set for specific branches of
the Organization, Divisions and Users based on
responsibilities. Numeric value to be input to spec-

ify the limit.
2 UCS_GROUP_FOL- This parameter is used to set up the number of
LOWUP_DAYS days range for Group follow-up field in customer

service screen which displays the set of accounts
that share same account condition as the selected
account and bear the same customer ID. The pre-
requisite for this is Group Follow-up indicator
should be enabled in queue setup. Input value is

numeric.
3 UCS_REVIEW_- This is used to specify whether review can be
QUEUE_ALLOWED done by the specific responsibility (user group)

without entering details in call activities/activities.
Parameter value to be input is Boolean (Yes/No).

4 UIX_AP- The system uses this parameter to determine
P_VIEW_ALL_APPS which users have the ability to view all applica-
tions. The system selects the best match based
on a hierarchical sort by Organization, Division
and Responsibility fields, with values of ‘ALL’
being a lower order match than an exact match.
Input parameter value is Boolean (Yes/No).

5 UIX_HIDE_RESTRICT- This is used to hide sensitive data relating to the
ED_DATA Contract / Applicant to a specific group/responsi-
bility etc. Suppose there is a need to hide data
relating to SSN, Bank account details etc. to a
specific user responsibility who will not need such
data, this parameter can be enabled with input
value Boolean (Yes/No). If this parameter is set to
‘Y’, the details appear in a masked format (for e.g.
SSN — XXX-XX-456)

6 UIX_SMTP_SERVER This parameter is used to set up the email server
for user interface. The input value would be
‘SETME’ and check the ‘Enable’ flag.

D-19 ORACLE



Sl.No

Parameter

Description

UIX_VIEW_SE-
CURED_ACCOUNTS

This is used to specify whether an account can be
viewed by a specific responsibility (users). Param-
eter value is Boolean (Yes/No) and when flagged
as Yes, such accounts would be viewable only by
users defined in the Organization, Division hierar-
chy with the specified responsibilities. For exam-
ple, all employee accounts may not be viewable
by all users and should be made available only to
the HR department with specific responsibility lev-
els.

Note: While creating application, selecting appro-
priate applicant’s classification would be essential
for this parameter to be effective.

UIX_VIEW_SE-
CURED_APPLICATION

This is used to specify whether an application can
be viewed by a specific responsibility (users).
Parameter value is Boolean (Yes/No) and when
flagged as Yes, such applications would be viewa-
ble only by users defined in the Organization, Divi-
sion hierarchy with the specified responsibilities.
For example, all employee accounts may not be
viewable by all users and should be made availa-
ble only to the HR department with specific
responsibility levels.

Note: While creating application, selecting appro-
priate applicant’s classification would be essential
for this parameter to be effective.

ULG_DAY_END

This is used to specify the upper limit time in day
for a user to be able to work in the System.
Parameter value is numeric and range is 1-24,
else system will throw error.

10

ULG_DAY_START

This is used to specify the lower limit time in day
for a user to be able to work in the System.
Parameter value is numeric and range is 0-24,
else system will throw error

11

ULG_FAILED_LOGIN_TRI-
ALS_MAX

This parameter is used to specify the maximum
number of login trials allowed before disabling the
User ID due to security reasons. Input parameter
value is numeric with upper limit of
999999999999.

12

ULG_INACTIVITY_DAYS_-
MAX

This parameter is used to specify the maximum
number of days the User ID can be without utiliza-
tion before disabling the User ID due to security
reasons. Within the specified number of days the
User Id must be utilized for sign in at least once.
Input parameter value is numeric with upper limit
of 999999999999.
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13

ULG_PWD_CASE_SENSI-
TIVE_REQ

This is used to allow all passwords to be case sen-
sitive or otherwise. Input parameter value is
Boolean (Yes/No). When this parameter is set as
‘NO’, password would be stored in Upper case. If
this parameter is set to N. then the ULG_P-
WD_LOWER_CHAR_REQ parameter should also
be set to N.

14

ULG_PWD_CHANGE_-
DAYS_ACTUAL

This is used to set the maximum number of days
after which system will force a password change,
in cases where the User has not changed the
password. Input parameter value is numeric with
upper limit of 999999999999.

15

ULG_PWD_CHANGE_-
DAYS_PROMPT

This is used to set the maximum number of days
after which system will prompt the User for pass-
word change, in cases where password has not
been changed within the set period. Input parame-
ter value is numeric.

16

ULG_PWD_LENGTH_MIN

This is used to set the minimum length of pass-
word string that is required. If this criterion is not
met, system would throw an alert specifying mini-
mum character length required to be input.

17

ULG_PWD_LOW-
ER_CHAR_REQ

This is used to allow at least one lower case char-
acter in password strings. Input value is Boolean
(Yes/No). Setting this as ‘NO’ would mean pass-
words would be allowed in uppercase only.

18

ULG_PWD_NBR_REQ

This parameter allows setting password with at
least one numeric character. Input value is
Boolean (Yes/No) and setting this as ‘YES’ would
require passwords to have at least one numeric
character.

19

ULG_PWD_SPE-
CIAL_CHAR_REQ

This parameter is used to allow special characters
like ‘$’, ‘#, ‘@', in passwords. Input value is
Boolean (Yes/No) and setting this as “‘YES’ would
require passwords to have at least one special
character.

20

ULG_PWD_UP-
PER_CHAR_REQ

This is used to allow at least one upper case char-
acter in password strings. Input value is Boolean
(Yes/No). Setting this as ‘NO’ would mean pass-
words would be allowed in lowercase only.

21

ULG_WEEK_END

This parameter enables to set the last day of the
week when a user can have access to the system.
Input parameter value is numeric ranging from 1 to
7. This is useful in business requirements where
the Organization does not need a specific set of
responsibilities (users) to not access the system
on a weekend / week-off day etc.
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22 ULG_WEEK_START This parameter is used to set the start day of the
week when a user is allowed to access the sys-
tem. Input parameter value is numeric.

23 CRB_ERROR_VALIDA- This parameter is used to validate the Credit
TION_IND Bureau report generation request depending on
the number of days permitted to pull a Bureau
report from the same company and for the same
customer and report as either warning/error.

When the number of days is less than or equal to
the permitted days (as defined in parameter
DAYS_TO_PULL_CRB_REPORT), system dis-
plays an ‘Error’ message stating ‘Bureau Report
exists for the same Customer from the same
Bureau for Account# XYZ' along with list of
account number(s) and/or application number(s).
If not, a ‘Warning’ message is display and request
is accepted for processing.

Note: Both ‘CRB_ERROR_VALIDATION_IND’
and ‘DAYS_TO_PULL_CRB_REPORT are to be
enabled for Credit Bureau report processing.

Company Parameters

Company parameters control the processes associated with functions that vary for different
companies and branches. These parameters address credit scoring, credit bureau interfaces,
fax services, and fax generation.

Individual parameters may be set up with different values for uniquely defined company and
branch combinations (i.e. these can be defined to the level of branches in each company or
a group of companies in terms of applicability).

SI.No | Parameter Description
1 AUD_ADV_REASON - This parameter is used to set-up default adverse
MODEL action reasons for scoring models during set-up in

the Parameters sub page. Whenever the flag
‘Bureau Score Reasons’ is unchecked during
credit bureau scoring model set-up, then automat-
ically rejected applications scored using this scor-
ing model picks up the Adverse Action Reasons
from the Parameters sub page.

2 AUD_SCORING_METHOD | This parameter is used to set when/where the
application scoring method has to be applied
within the company. So when the parameter value
is chosen as ‘primary applicant only’, the system
will perform the application scoring for the primary
applicant only and according to other applicable
parameters specified. Other parameter input val-
ues are Minimum Score, Maximum Score, Mini-
mum Tier (Grade), Maximum Tier (Grade).
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SI.No

Parameter

Description

AUD_SCORING_-
METHOD_IN_BUREAU

This parameter is used to define what value to be
picked up for application scoring from the scores
returned from the various bureaus. The input
parameter values are Maximum Score and Mini-
mum Score. If Maximum score is set-up in com-
pany parameters, then for all applications where a
bureau report is pulled, the system will pick-up the
Maximum score from the different bureaus.

CBU_DATA_SET_SIZE

Parameter to define the metro 2 file data selection
criteria, option values are monthly, Daily, weekly,
semi monthly.

CBU_FILE_FORMAT

Metro 2 file format definition, user need to select
from the parameter value drop down.

CMN_ASE_VALIDATE_-
MAKE_MODEL

This parameter is set up to specify to the system
whether it needs to validate the asset make and
model at the time of data entry. In parameter value
is Boolean (Yes/No).

CMN_CMB_DE-
FAULT_PRINTER

This is used to define the default printer for print-
ing. The input parameter value is the printer
name. There is no LOV for this field. If no default
printer is defined and the parameter enabled, the
system would display ‘Undefined’.

CMN_WEEKLY_NONBUSI-
NESS_DAYS

This parameter is used to set-up the weekly holi-
days at the company level. The input parameter
value is character string; if no details specified
and parameter is enabled, system would display
‘UNDEFINED’.

COR_STORAGE_DIREC-
TORY

This parameter is used to specify the path/location
for Oracle directory object template for corre-
spondence documents. Input parameter value is
‘SETME’; if none is specified and parameter ena-
bled, ‘'UNDEFINED’.

10

DBR_-
JOINT_INC_DEBT_WITH_
2NDRY

This parameter defines whether system should
consider income and debt details of the Spouse
and Secondary Applicant along with that Primary
Applicant. Input parameter value is Boolean (Yes/
No).

11

DBR_-
JOINT_INC_DEBT_WITH_
SPOUSE

This parameter is used to define whether system
should consider the income and debt details of
Spouse alone along with that of Primary applicant
details. Input parameter value is Boolean (Yes/
No).
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12

DDP_CRB_EXPIRATION_-
DAYS

This parameter is used to define the credit bureau
report expiration days. So if this is set as 30, sys-
tem will use all available credit bureau reports
pulled which are not older than 30 days from cur-
rent day, during de-dupe. Input value is numeric
with no upper limit.

13

DDP_DE-
DUP_DEBT_WITH_2NDRY

This parameter defines whether the system
should de-dupe credit bureau liabilities for Spouse
and Secondary Applicants, in addition to de-dup-
ing Primary applicant’s liabilities. Input parameter
value is Boolean (Yes/No).

14

DDP_DE-
DUP_DEBT_WITH_SPOU
SE

This parameter defines whether the system
should de-dupe credit bureau liabilities for
Spouse, in addition to de-duping Primary appli-
cant’s liabilities. Input parameter value is Boolean
(Yes/No).

15

DOT_STORAGE_DIREC-
TORY

This parameter is used to define the location/path
of the Oracle Directory Object name for Account
Document Loading. Input parameter value is
‘SETME’.

16

ECB_EDIT -
FAIL_ANY_APL

This parameter is used to set the credit bureau
edit to fail in case the bureau report for any of the
applicant fails. Input parameter value is Boolean
(Yes/No). So if this parameter is set to “YES’, the
edit will fail even if one of the applicant’s bureau
score fails to qualify.

17

ECB_USE_APL_CUR-
RENT_SCORE_CRH

This parameter is used to define whether the sys-
tem should run the credit bureau edits only on the
current scored applicant bureau. Input parameter
value is Boolean (Yes/No).

18

FIN_IMAGE_STATUS_CD

This parameter is used to set-up default image
status for fax-in service. The input parameter val-
ues are ‘RUSH’, ‘NEW’, ‘SKIP’, ‘BAD’, ‘PRO-
CESSED’ and ‘PURGED'.

19

FIN_POP_PASSWORD

This parameter is used to define the pop pass-
word to access the fax-in service. Input parameter
value is user (System Administrator) defined.

20

FIN_POP_SERVER

This parameter is used to define the pop server to
receive the faxes in fax-in service. Input parame-
ter value is location and path of the server.

21

FIN_POP_USERNAME

This parameter is used to define the pop user-
name to access the fax-in service. Input parame-
ter value is user (System Administrator) defined.
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22

FIN_STORAGE_DIREC-
TORY

This parameter is used to set-up the Oracle direc-
tory object name for storing the images received
through the fax-in service. Input parameter value
is user (System Administrator) defined.

23

FIN_TEMP_DIRECTORY

This parameter is used to define the temporary
directory to be used for the fax-in service. Input
parameter value is user (System Administrator)
defined.

24

LOR_AUTOMATIC_CON_-
FUND_FAX

This is used to define the decision fax generation
when an application is funded. The input parame-
ter value is Boolean (Yes/No), and when this is set
as ‘YES’, system automatically generates the fax
approval in the pre-defined template whenever an
application is approved.

25

LOG_STORAGE_DIREC-
TORY

This parameter is used to define the Oracle stor-
age directory. Input parameter value is user (Sys-
tem Administrator) defined.

26

LOR_AUTOMATIC_AP-
PROVAL_FAX

This is used to define the decision fax generation
when an application is approved. The input
parameter value is Boolean (Yes/No), and when
this is set as ‘YES’, system automatically gener-
ates the fax approval in the pre-defined template
whenever an application is approved.

27

LOR_AUTOMATIC_RE-
JECTION_FAX

This is used to define the decision fax generation
when an application is rejected. The input param-
eter value is Boolean (Yes/No), and when this is
set as ‘YES’, system automatically generates the
rejection fax in the pre-defined template whenever
an application is declined.

28

MAX_LEAD_DAY_AGE

This parameter is used to define the maximum no.
of days, post which the sales lead would be con-
sidered cold. Input parameter value is numeric
with no upper limit.

29

MULTI_OFFER

Through this parameter the multiple offers (sub-
tab) in pricing can be enabled or disabled for a
Company/Branch. Input parameter value is
Boolean (Yes/No). If the flag is set as ‘Y’, the
underwriter can view multiple offers and select
one of them to be applied for the specific applica-
tion.

30

MULTI_OFFER_MAX-
_NUMBER

This parameter is used to specify the maximum
number of multiple offers that can be permitted for
an application. Input parameter value is numeric
with no upper limit. If MULTI_OFFER company
parameter is set as ‘N’, this parameter can be
ignored as there is no use specifying a value.
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31 MULTI_OFFER_MAX- This company parameter sets the maximum term
_TERM (as in no. of instalments, whichever billing cycle is
selected) for which multiple offers are calculated
and displayed during pricing. Input parameter
value is numeric.

32 MULTI_OF- This company parameter sets the minimum term

FER_MIN_TERM (as in no. of instalments, whichever billing cycle is
selected) for which multiple offers are calculated
and displayed during pricing. Input parameter
value is numeric.

33 MULTI_OFFER_PMT _TOL- | For Multi offer variance in payment is defined in

ERANCE this parameter.

34 MULTI_OFFER_TERM_- For multi offer Term variance will be defined in the

VAR parameter.

35 PRESENT_VALUE_COM- This parameter will perform Present Value Com-

PUTE_RATE putation Rate (Inflation/Discounting Rate).

36 RATE_CHG_L- This parameter is used to set up the number of

TR_PRE_PROCESS - days prior to rate change effective date to gener-

DAYS ate rate change letters in order to provide
advance intimation to customers. Input parameter
value is numeric with no upper limit.

37 STM_GEN_AFTER_MATU- | This parameter is used to enable the statement

RITY_IND generation for an account after the maturity date
but Account remains unpaid. Input parameter
value is Boolean (Yes/No). If this is set to ‘Y’,
statements will get generated for accounts that
remain unpaid even after maturity.

38 UIX_RUN_AAI_ACT This parameter is used by the system to deter-
mine whether to create and activate an account
online. Input parameter value is Boolean (Yes/
No).

39 UIX_UCS_CAC_MAX - This parameter is used to set up the maximum

FOLLOWUP_DAYS number of days for follow up when the account is
in delinquent state. Input parameter value is
numeric with no upper limit.

40 UIX_UCS_CAC_MAX- This parameter is used to set up the maximum

_PROMISE_DAYS number of days allowed for customers who prom-
ise to pay when following up for delinquent
accounts. Input parameter value is numeric.

41 AUD_QUEUE_INI- This parameter enabling will Queue the applica-

TIAL_CRB_FAILED tion if any bureau failed.

42 UIX_UCS_CUA MAX - This parameter will allow the user to maintain the

FOLLOWUP_DAYS

Collections maximum follow-up days that are
allowed in the system.
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D.5 Other Parameters

The following additional set of parameters are also available to control system specific data
and other administration process.

SI.No | Parameter Description
1 CRB_MAX_BU- This parameter is used to determine the number
REAU_PULL of credit reports automatically per applicant. Input
parameter value is numeric.

2 CRB_ALL_APL_BU- This parameter is used to set up whether credit

REAU_PULL bureau reports should be pulled for the primary
applicant only or to all other applicants also (for
joint applications), regardless of their relationship
with the primary applicant. Input parameter value
is Boolean (Y/N).

3 CBU_FILE_FREQUENCY This parameter is used to set the Metro Il File Fre-
quency and determine whether output file is to be
generated daily or monthly. If this is monthly, then
output file is written with daily data but generated
monthly.

4 JOINT_DE- This parameter is used to determine duplicate lia-

DUP_SPOUSE_LIABILI- bilities in the Spouse’s liabilities in de-duping logic.

TIES Input parameter value is Boolean (Yes/No).

5 JOINT_DEDUP_ALLAP- This parameter is used to determine duplicate lia-

L_LIABILITIES bilities of all applicants’ liabilities in de-duping
logic, irrespective of whether they are related to
each other. Input parameter value is Boolean
(Yes/No).

6 ASC_COL_SER_ENA- This parameter is used for enabling the Collection

BLED_IND Servicing Indicator. Input parameter value is
Boolean (Y/N).

7 CMN_TEST_TOOL_LOG- This parameter is used to set the testing tool log-

GING ging to enable or disable testing tool log in. Input
parameter value is Boolean (Yes/No).

8 FIN_DOWNTIME_BEGIN This parameter is to define the start of period for
down time of Fax-in service. Input parameter
value is time in 24 hour format.

9 FIN_DOWNTIME_END This parameter is used to define the end of period
for down time of Fax-in service. Input parameter
value is time in 24 hour format.

10 FIN_ERROR_LIMIT This parameter is used to define the error limit for
Fax-in service. Input parameter value is numeric.

11 ICA_INPUT_FILE_FOR- This parameter is used to specify the Input format

MAT for call activity file. Two Parameter values are pos-
sible — US format and OFSLL format.
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12 JSV_BI_USER This parameter is used to define the Bl publisher
User ID. Input parameter value is user defined
(Admin user).

13 JSV_BI_PASSWORD This parameter is used to define the Bl publisher
User password. Input parameter value is user
defined (Admin user).

14 PJR_COPY_PURGED_- This parameter is used to specify whether data

DATA should be copied into the purge tables or not.
Input parameter value is Boolean (Yes/No).

15 PUP_ARCHIVE_DAYS This parameter is used to specify the number of
days after which the transactions upload details
are to be archived. Input parameter value is
numeric.

16 PUP_OARCHIVE_DAYS This parameter is used to specify the number of
days after which the transactions upload details
are to be moved from ‘O’ tables. Input parameter
value is numeric.

17 PUP_TUP_LAST PURGE_ | This parameter is used to capture the last date

DT when transactions upload details were purged.
Input parameter value is date.
18 TPE_APPLY_LTC - This parameter is used to specify whether late
FROM_CURR_DUE_DT charge should be applied from current due date
for Pyramid Law fee method. Input parameter
value is Boolean (Yes/No).

19 TPE_EXCESS_PAY- This parameter will make excess payment to the

MENT_TO_MEMO memo payment by marking this Parameter as
YES.
20 TPE_STOP_COMP_DELQ | This parameter is enabled to stop computation if

_DAYS

the account is delinquent for more than 60 days.
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